Altair Engineering Inc. makes no representation or warranties with respect to the contents of this manual or the associated software and especially disclaims any implied warranties of merchantability or fitness for any particular purpose. Further, Altair Engineering Inc. reserves the right to revise this publication and make changes from time to time to its contents without obligation to notify anyone of such revisions or changes.

Altair Monarch software is offered and is to be used in accordance with a SOFTWARE LICENSE AND MAINTENANCE AGREEMENT. This agreement stipulates that this software be used only in the computer system designated in that agreement. The agreement further stipulates that the customer shall not copy or alter, or permit others to copy or alter, the software or related materials in whole or in part, in any media for any purpose, except to make an archive (back-up) copy or to make a copy as an essential step in the use of the software with the customer’s computer.

Altair Engineering Inc. hereby grants the buyer the right to reprint this documentation for internal uses only. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, for any other purposes, without the prior written permission of Altair Engineering Inc.

Altair Monarch Version 15.4 Learning Guide
Copyright © 2018 by Altair Engineering Inc.
All rights reserved. Printed in the U.S.A.
Unpublished - Rights reserved under the copyright law of the United States.

Altair Monarch is a trademark of Altair Engineering Inc. Other products mentioned herein may be trademarks or registered trademarks of their respective owners in the United States or other countries.

For U.S. Government End Users, the software is a “Commercial Item(s),” as that term is defined at 48 C.F.R. Section 2.101, consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. Section 12.212 or 48 C.F.R. Section 227.7202, as applicable. Consistent with 48 C.F.R. Section 12.212 or 48 C.F.R. Sections 227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the Altair Software License and Maintenance Agreement.

SUPPORT HOURS AND CONTACT INFORMATION

US AND CANADA
Phone: +1 800.988.4739
Phone: +1 978.275.8350
Hours: Monday – Friday, 8:30 a.m. – 6:00 p.m.
Eastern (EST/EDT)

EUROPE, MIDDLE EAST, AFRICA
Phone: +44 (0) 8081 892481
Hours: Monday – Friday, 8:30 a.m. – 6:00 p.m.
London (GMT/BST)
# Table of Contents

[1] Using the Monarch Documents ................................................................................. 1

Monarch Learning Guide ................................................................................................. 1
Monarch Help File ............................................................................................................. 1
Monarch Training ............................................................................................................. 1
Monarch Model Building Service ..................................................................................... 2

[2] Introducing Monarch ................................................................................................. 3

What is the Monarch Application? ................................................................................... 3
New Features in This Version .......................................................................................... 3
The Monarch Workflow .................................................................................................... 4
The Monarch Interfaces .................................................................................................... 6
  Report View .................................................................................................................. 6
  Table View .................................................................................................................... 7
  Summary View ............................................................................................................... 8
  Export View ................................................................................................................... 9

[3] Introducing Data Prep Studio ..................................................................................... 10

What is the Data Prep Studio Application? .................................................................... 10
New Features in This Version ........................................................................................ 11
Launching Data Prep Studio ............................................................................................ 11
The Data Prep Studio Workflow ...................................................................................... 12
The Data Prep Studio Interface ....................................................................................... 12
  The Start Page ............................................................................................................... 13
  The Application Menu ................................................................................................... 14
  The Settings Dialogs ..................................................................................................... 15
  The Preview Window ..................................................................................................... 16
  The Transform Dialog .................................................................................................. 17
  The Prepare Window ..................................................................................................... 18
  The Combine Stage ...................................................................................................... 19
  The Report Design Window .......................................................................................... 20
  The Analyze Drop-Down ............................................................................................... 21
  The Export Window ...................................................................................................... 21
Data Prep Studio Hotkeys ............................................................................................... 22
Data Prep Studio Table Icons ......................................................................................... 23


Before You Begin ............................................................................................................. 25
Previewing and Adding Data to a Data Prep Session ..................................................... 26
  Adding Data from a Database File ................................................................................. 26
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Data from a PDF Report</td>
<td>31</td>
</tr>
<tr>
<td>Adding Data from a Website</td>
<td>34</td>
</tr>
<tr>
<td>Adding Data from XML and JSON Files</td>
<td>36</td>
</tr>
<tr>
<td>Adding Data from Monarch Files</td>
<td>38</td>
</tr>
<tr>
<td>Adding Data from Excel Files</td>
<td>39</td>
</tr>
<tr>
<td>Trapping Data from Report Files</td>
<td>40</td>
</tr>
<tr>
<td>Using the Recent Files Panel to Load Data</td>
<td>49</td>
</tr>
<tr>
<td>Displaying Recent Data Sources in the Select Data Source to Open Dialog</td>
<td>51</td>
</tr>
<tr>
<td>Saving Data Sources to the Data Source Library</td>
<td>52</td>
</tr>
<tr>
<td>Saving a Workspace</td>
<td>54</td>
</tr>
<tr>
<td>Using the Altair Data Connectors</td>
<td>55</td>
</tr>
<tr>
<td>Connecting to Hadoop Hive</td>
<td>56</td>
</tr>
<tr>
<td>Connecting to IBM Cloudant</td>
<td>59</td>
</tr>
<tr>
<td>Connecting to OData</td>
<td>60</td>
</tr>
<tr>
<td>Connecting to Monarch Server - Content</td>
<td>62</td>
</tr>
<tr>
<td>Connecting to Business Objects Universe</td>
<td>64</td>
</tr>
<tr>
<td>Connecting to Salesforce</td>
<td>66</td>
</tr>
<tr>
<td>Connecting to MongoDB</td>
<td>67</td>
</tr>
<tr>
<td>Connecting to Google Analytics</td>
<td>69</td>
</tr>
<tr>
<td>Navigating Tables</td>
<td>70</td>
</tr>
<tr>
<td>Navigation Controls</td>
<td>70</td>
</tr>
<tr>
<td>Working with Rows</td>
<td>70</td>
</tr>
<tr>
<td>Searching for Data</td>
<td>71</td>
</tr>
<tr>
<td>Showing Nulls and Whitespace Characters</td>
<td>71</td>
</tr>
<tr>
<td>Docking/Undocking Tables</td>
<td>72</td>
</tr>
<tr>
<td>Loading a Workspace</td>
<td>72</td>
</tr>
<tr>
<td>Joining Data in a Data Prep Session</td>
<td>73</td>
</tr>
<tr>
<td>Analyzing Joins</td>
<td>76</td>
</tr>
<tr>
<td>Creating a New Join</td>
<td>77</td>
</tr>
<tr>
<td>Using Fuzzy Joins</td>
<td>78</td>
</tr>
<tr>
<td>Working with Load Plans</td>
<td>79</td>
</tr>
<tr>
<td>Appending Data in the Preview Window</td>
<td>80</td>
</tr>
<tr>
<td>Appending Data in the Prepare Window</td>
<td>81</td>
</tr>
<tr>
<td>Appending Data via the Context Menu</td>
<td>82</td>
</tr>
<tr>
<td>Appending Data via the Append Helper</td>
<td>83</td>
</tr>
<tr>
<td>Appending Data via the Appending Stage</td>
<td>85</td>
</tr>
<tr>
<td>Transforming Data</td>
<td>88</td>
</tr>
<tr>
<td>Sorting Columns</td>
<td>88</td>
</tr>
<tr>
<td>Pivoting Columns</td>
<td>89</td>
</tr>
<tr>
<td>Unpivoting Columns</td>
<td>92</td>
</tr>
<tr>
<td>Transposing Columns</td>
<td>94</td>
</tr>
<tr>
<td>Grouping Data</td>
<td>94</td>
</tr>
<tr>
<td>Removing/Showing Duplicates</td>
<td>96</td>
</tr>
<tr>
<td>Extracting Rows</td>
<td>98</td>
</tr>
<tr>
<td>Working with Calculated Fields</td>
<td>99</td>
</tr>
<tr>
<td>Filtering Data</td>
<td>100</td>
</tr>
</tbody>
</table>
[9] Special Data Extraction Techniques ............................................. 221

Using the Address Block Feature .................................................. 222
  Special Problems with Addresses .............................................. 222
  Extracting an Address Block .................................................. 222
  Defining Address Blocks ...................................................... 224
Using the Auto-Define Feature in Report View ................................. 227
Using the Auto-Define Trap Feature in Report Design View .................. 228
Using the Floating Trap Type .................................................... 233
  Using the Floating Trap to Capture Lines .................................. 234
  Using the Floating Trap to Define Fields .................................. 236
Using the Multi-Column Region Trapping Feature ............................ 238
  Creating a Template to Trap Multi-Column Data .......................... 243
  Specifying Vertical Boundaries for the MCR .............................. 247
Using the Regular Expression Trap Type ....................................... 250
Using the Exclusion Trap Feature ................................................ 253
Using the Start and End Region Trap Features ................................ 255

[10] Working in Table View ............................................................ 258

Getting to Know Table View ....................................................... 258
  The Table View Interface ..................................................... 258
  The Table View Ribbon ....................................................... 259
  The Table View Context Menu ............................................... 260
Getting to Know Table Design View .............................................. 261
  The Table Design Interface .................................................. 261
  The Table Design Ribbon .................................................... 262
Navigating Through a Table ........................................................ 263
  Finding Information in a Table ............................................... 263
  Displaying the Source of a Record ........................................ 264
  Changing Fonts and Font Sizes ............................................. 266
Formatting Fields ........................................................................ 267
  Filling Empty Cells ............................................................. 267
  Adjusting Field Widths .......................................................... 269
  Ordering Fields ...................................................................... 270
  Hiding Fields ........................................................................ 270
Assigning Field Types ............................................................................................................271
Creating Headers and Footers ..........................................................................................272
  Creating a Page Header ....................................................................................................272
  Creating a Page Footer ....................................................................................................275
Printing Table Data ...........................................................................................................276
  Adjusting Page Setup Options .......................................................................................276
  Printing Table Data ........................................................................................................277
Copying Data to Other Applications ..................................................................................278
Redacting Fields ................................................................................................................280
  Redacting a Single Field .................................................................................................280
  Redacting an Entire Model ..............................................................................................281

  Creating a Sort Order Definition ....................................................................................282
  Sorting on Multiple Fields .............................................................................................285
  Restoring the Original Table Order ................................................................................286
  Duplicating Sorts .............................................................................................................286

[12] Working with Filters ...................................................................................................287
  Creating Value-Based Filters .........................................................................................288
  Creating Formula-Based Filters ....................................................................................290
  Creating Compound Filters ..........................................................................................292
  Using Functions in Filters ..............................................................................................293
  Restoring the Original Table Order ................................................................................294
  Duplicating Filters ........................................................................................................294

  Creating a Formula Field ...............................................................................................296
  Creating a User-Edited Field ..........................................................................................299
    Creating User-Edited Fields .........................................................................................299
    Using User-Edited Fields ............................................................................................300
  Making Comparisons ......................................................................................................301
  Redaction Functions .......................................................................................................304
  Regex Functions ............................................................................................................304
  Hiding and Deleting Calculated Fields ...........................................................................305
  Duplicating Calculated Fields .......................................................................................305

[14] Working with Multiple Instances of a Report ...........................................................306
  Working in Table View ..................................................................................................308
    Sorting .........................................................................................................................308
    Identifying the Source of Each Record ........................................................................310
    The File() Function ....................................................................................................311
    The ID() Function ......................................................................................................313

[15] Extracting Multiple-Line Fields ................................................................................314
[19] Importing Data from HTML, Web Files, and External Databases .................................. 381

Importing Data from an External Database ........................................................................ 382
Working with the Altair ODBC Drivers .............................................................................. 388
  Setting Up the Altair ODBC Drivers .............................................................................. 388
  Connecting to a Database Using the ODBC Drivers ...................................................... 392
  Notes on The Salesforce Database Connection .............................................................. 393
Working with Database Data ............................................................................................... 393
  Setting Field Properties ................................................................................................. 394
  Setting Delimited Text Properties ................................................................................ 395
  Storing Import Parameters in Project Files ................................................................. 396
  Opening Project Files .................................................................................................... 396
Importing Data from an HTML File .................................................................................... 397
Importing Data from a Web File .......................................................................................... 401

[20] Creating External Lookups ............................................................................................. 402

What is an External Lookup? ............................................................................................... 402
Creating an External Lookup from a Report ...................................................................... 404
Storing Lookup Parameters in a Model File ........................................................................ 409
Creating a Lookup from Two Different Reports .............................................................. 409
  Using a Report to Create a Lookup File .................................................................... 410
  Linking to the Lookup File ......................................................................................... 411
Creating a Lookup from Two External Databases ............................................................ 413
  Importing Database Data ............................................................................................ 414
  Linking Database Data ............................................................................................... 415

[21] Using Digital Signatures ............................................................................................... 417

What are Digital Signatures? ............................................................................................... 417
Adding Digital Signatures to an Excel File ........................................................................ 418
Viewing Digital Signatures ............................................................................................... 420

[22] Using Pivot Tables ........................................................................................................ 422

Adding Pivot Tables to an Excel File ................................................................................. 423
Viewing a Pivot Table ........................................................................................................ 425
Working with Pivot Tables ................................................................................................. 426

[23] Working with Asian (CJK) Character Sets .................................................................... 428

Setting Fullwidth Character Mode .................................................................................... 429
Setting Fallback Asian Fonts ............................................................................................ 430
Setting the Date/Time Format ............................................................................................ 430
Setting the Ignore Character Width Option ...................................................................... 431

Copying Models or Projects ........................................................................... 433
Converting Text/XML Models or Projects to the Binary Format ...................... 436
Managing External References in Binary Models or Projects ......................... 438
Managing Authors and Descriptions in Binary Models or Projects ................ 441
Purging Audit Trails in Binary Models or Projects ....................................... 446
Preparing Files for Monarch ......................................................................... 448
Uploading Binary Models to Altair Knowledge Hub ...................................... 452

Conclusion ....................................................................................................... 455
[1] Using the Monarch Documents

The Monarch documentation consists of a Learning Guide and a Help file. This documentation is made available upon installation of the software and on docs.datawatch.com.

Monarch Learning Guide

This Learning Guide contains a short introduction to Monarch Classic and Data Prep Studio, collectively called Monarch Complete, along with a series of lessons designed to quickly acquaint you with the program. The lessons will first introduce you to Data Prep Studio and continue with each of the Monarch views: Report, Table, Summary, and Export. Monarch Table Extractor is also discussed.

Each of the chapters describes a major area of Monarch. First-time users will be well rewarded for the time they spend working through these sections. Advanced topics should be tackled after you become familiar with the basic concepts of Monarch, as these topics will leverage what you learned in previous sections. Each lesson should take from 20 to 30 minutes to complete.

Monarch Help File

The Monarch Help file provides detailed information and step-by-step instructions for performing numerous tasks in Monarch Classic, Data Prep Studio, and Monarch Table Extractor. To access the file while within Monarch, select File, click on the Help ? button, and then select ? Help Topics. You can also launch relevant help topics from within the Monarch windows by clicking the ? button located on the upper right-hand corner of most views.

Monarch Training

Altair provides Monarch training courses to help anyone in your organization rapidly improve his or her Monarch proficiency skills. Available in various locations around the country, these training classes are designed for all levels of expertise. Whether you are just getting started and need the basics or would like to hone your skills and learn new ways to use Monarch, Altair is ready to help you reach new levels of Monarch proficiency. Our objective is to help Monarch users succeed as quickly as possible.
Taught by Altair’s seasoned staff of Monarch experts, the training courses guide you through all aspects of Monarch’s features and capabilities, including tips and techniques on effective, timesaving shortcuts. There is also a lab session at the end of class where you can bring in your own files and receive individual instruction and suggestions for using Monarch to meet your specific requirements.

Monarch onsite training and personal web-based training courses are also available.

To learn more about training, call the Training Department directly:

- Phone: +1-800-445-3311
- Email: training@Altair.com

### Monarch Model Building Service

Altair provides a model building service for its Monarch customers. Altair’s highly trained team of Monarch experts will work with you one on one to create a model that meets your specifications and satisfaction.

When you view your new Monarch model, you will be able to learn from the experts by viewing the way they have trapped your report, created calculated fields and filters, defined summaries, and more. Best of all, this is all done using your own reports.

To learn more about the Monarch Model Building Service, contact the Model Building Services team directly:

- Phone: +1-978-441-2200
- Email: model@Altair.com
[2] Introducing Monarch

What is the Monarch Application?

Altair Monarch (formerly Datawatch Monarch) is a multi-component application that allows you to model and extract analytical assets from both structured and less-than-structured sources, such as PDFs, reports, and EDI streams, and then use the data obtained in a self-service manner on your desktop for broader analytical use.

When a computer generates a report, it creates a report file that contains all of the characters and control codes required by a printer to produce the actual report printout. Monarch reads that same report file. Instead of producing a hardcopy printout with words and numbers frozen on the page, however, it creates a softcopy of the report on screen, with live data you can work with.

Monarch reads report files created within any computing environment. These files are commonly known as print or spool files, but they are also referred to as text (TXT), formatted text, PRN, PDF, and SDF files. Monarch can also read a wide variety of input files, such as delimited (e.g., pipe, comma, semi-colon, etc.) text, HTML, MS-Excel, MS-Access, dBase, PDF, and XPS, among others, and is able to connect to OLE DB and ODBC sources.

The complete features of your Monarch application depend on the license you purchased. In this learning guide, these licenses may be referred to as “Monarch versions.” Click here to learn more about the different Monarch licenses available.

New Features in This Version

In Monarch version 15.4, the Classic application includes the following new features:

- Altair Licensing support
- Template Editor enhancements
- Various bug fixes
- Various UI/UX improvements
The Monarch Workflow

Figure 2-1 shows how report data flow through Monarch. A Monarch session begins when you load a report file into Report view. As the session unfolds, you can produce a variety of outputs from each window. The lessons in this guide correspond to the flow chart. You’ll learn how to bring a report into Monarch, and you will progress step-by-step through the tasks performed in each window.

**Input**

- **Report File**
  - View and explore report
  - Look things up (Find)
  - Use Report Index
  - Print pages
  - Copy to clipboard
  - Define data extraction template

**Output**

- Hardcopy printout of pages
- Clipboard image of data copied from the report, with automatic formatting of the data when pasting into a worksheet
- Export file in fixed width text or PDF format

**Extracted data**

**Table view**

- View extracted data
- Apply filters to extracted data
- Sort data
- Calculate new fields
- Copy to clipboard
- Export selected records
- Print selected records

**Summary Window**

- Analyze selected data
- Copy data to the clipboard
- Export analysis
- Print analysis

- Hardcopy printout of summary report
- Clipboard image of summary (in both text and worksheet formats)
- Export file containing selected data in several formats, including XLS, XLSX, XLSM, PDF, ACCDB, MDB, DBF, HTML, TXT, XML, and delimited text.

Monarch reads both report files and data from database files and OLE DB/ODBC databases, and information from databases can be extracted, manipulated, analyzed, and transformed. It also allows users to access data from additional sources, share user-defined functions, and access data from files that are of the types XLS, XLSX, XLSM, PDF, XPS, DBF, DB, MDB, HTML,
and delimited text, as well as any OLE DB- or ODBC-compliant data source, such as SQL Server, Oracle, and DB2 database management systems.

**Input**

- Database data

**Table view**
- Import data from any XLS, XLSX, XLSM, MDB, DBF, delimited text file, or from any OLE DB/ODBC compliant data source
- View imported data
- Apply filters to data
- Sort data
- Calculate new fields
- Copy to clipboard
- Export selected records
- Print selected records

**Output**
- Hardcopy printout of data in columnar report format
- Clipboard image of data copied from the table, in both text and worksheet formats
- Export file containing selected data in several formats including XLS, ACCDB, MDB, DBF, HTML, XLSX, XLSM, TXT, PDF, XML, and delimited text.

**Imported data**

**Summary Window**
- Analyze selected data
- Copy data to clipboard
- Export analysis
- Print analysis

- Hardcopy printout of summary report
- Clipboard image of summary (in both text and worksheet formats)
- Export file containing selected data in several formats, including XLS, XLSX, XLSM, PDF, MDB, DBF, TXT, XML, and delimited text.

Figure 2-2. The Monarch flow chart showing data imported from a database.

Figure 2-2 shows how data imported from a database flow through Monarch. You may begin a Monarch session by either opening an XLS, XLSX, XLSM, MDB, ACCDB, DBF, or delimited text file or by importing data from an OLE DB/ODBC data source. When importing from a database, you can use all of Monarch’s Table and Summary View capabilities to manipulate, transform, and analyze data.

You can even combine data extracted from report files with database data through a mechanism called an external lookup.

Note that as the capabilities of newer versions of Monarch improve, the expected outputs presented in this section may vary. The basic data flows, however, remain the same.
The Monarch Interfaces

Monarch provides three distinct views of report data, each with its own interface. Each view provides a specific set of functions and operations that will allow you to extract, view, summarize, and export data.

If you are using Monarch for IBM Analytics, you will not have to access the Summary and Export views and you will be unable to access Panopticon Designer through the Table or Summary views.

REPORT VIEW

When you load a report file, a softcopy of the report is displayed in Report view.

![Image of Report View]

Figure 2-3. The Report view of Altair Monarch.

Report view displays opened reports and includes all of the tools you will need to work with them. It also allows you access to Report Design view, an interface through which you can create templates to extract data and create tables.
TABLE VIEW

Data extracted from the report display in Table view.

Figure 2-4. The Table view of Altair Monarch.

Table view allows you to work with the table produced by your report templates. You can click **Table Design** to edit your table and its fields. All of the changes you make to a table (e.g., filters, sorts, functions, etc.) display in this view. If your Monarch license allows it, you will also be able to open tables in Panopticon Designer through this view.

Some of the other activities you can perform in Table view include:

- Set the active filter to limit the fields displayed
- Set the active sort to sort fields
- Auto-size columns
- Hide or display fields
- Find a specific field value
SUMMARY VIEW

User-defined summaries, which analyze report data, are displayed in Summary view.

![Summary View of Altair Monarch](image)

Summary View allows you to work with summaries. From this View, you can also click **Summary Design** to create or edit summaries.

From within Summary View, you can also do the following:

- Navigate a summary
- Zoom in or out
- Automatically adjust column widths
- Freeze panes
- Collapse or expand a summary
- Customize summary font and background
EXPORT VIEW

Exports defined may be viewed in Export view.

Figure 2-6. The Export view of Altair Monarch.

From this window, you can also do the following:

- Run exports
- Create a new export
What is the Data Prep Studio Application?

Data Prep Studio is a Monarch component intended to provide users with rapid data preparation (data prep) capabilities. As a quick data prep solution, Data Prep Studio offers several powerful features, including:

- Drag and drop parsing and extraction
- Report discovery and data combination
- Real-time data preparation
- Export capability to several file types

Data Prep Studio provides easy-to-use interfaces for you to:

- Add data sources
  
  Data Prep Studio allows you to easily load information from databases, reports, and even HTML pages. Special Preview functionality allows you to review the information and improve data quality before committing these into the Data Prep Studio workspace.

- Combine disparate data sources
  
  Data Prep Studio allows you to easily integrate information from various data sources.

- Clean and transform your data
  
  Data Prep Studio’s data preparation capabilities include pre-built functions to quickly and consistently transform your data into clean, analysis-ready information.

- Export data to various file types and applications
  
  Once prepped, data can be exported to several of the most popular formats, including XLSX, CSV, ACCDB, and JSON, among others. You can also export to applications such as Altair Knowledge Hub, IBM Cognos Analytics, and Tableau Server.
New Features in This Version

In Monarch version 15.4, the Data Prep Studio application includes the following new features:

- Altair Licensing Support
- Force all columns to text for Excel data sources
- Delimited Text data type detection options
- Summary enhancements
- New data source connectors
- Append Helper redesign
- Scientific notation parsing
- Table panel and other performance enhancements
- Redesigned context menu and search function
- Settings redesign
- SSL capability for Oracle and SQL Server connectors
- Compatibility with Knowledge Hub 2.3
- Various UI/UX improvements
- Various bug fixes

Launching Data Prep Studio

Data Prep Studio may be launched in several ways:

- Launching Monarch for the first time after installing it.
- Selecting Start > All Programs > Altair Monarch 15 > Altair Monarch 15 Data Prep Studio
- Selecting the Data Prep Studio and Open Table in Data Prep Studio buttons in Monarch’s Home and Table views, respectively.
The Data Prep Studio Workflow

Figure 3-1 illustrates a typical data prep workflow.

All data prep operations are performed in a workspace. Workspaces (including all tables opened or created, joined, cleaned, and transformed) may be saved and loaded in future Data Prep Studio sessions.

The Data Prep Studio Interface

First-time Data Prep Studio users will find the Getting Started video especially helpful in learning about this application’s capabilities.

This video displays the first time Monarch is launched as well as every time the application is started thereafter unless the Show at start up box located at the lower left-hand corner of the screen is unchecked.
Select **Exit Tutorial** to close this video window.

![Image](image1.png)

**Figure 3-2. The Getting Started video.**

**THE START PAGE**

The Start Page displays when the application is launched and the Getting Started video is closed (by clicking **Exit Tutorial**) /disabled. Besides providing access to video tutorials and related documentation and support, the Start Page is your primary jumping-off point for bringing data into the current data prep session.

![Image](image2.png)

**Figure 3-3. The Data Prep Studio Start Page.**
Data Prep Studio features one toolbar and several main screens.

![The Data Prep Studio toolbar.](image)

Each of these tools opens a unique window, dialog, or stage through which Data Prep Studio’s functions may be realized.

THE APPLICATION MENU

The **Application Menu** button displays a list of other Data Prep Studio commands you may wish to apply to the current Data Prep Studio session.

![The Application Menu of Data Prep Studio.](image)

Using this menu, you can:

- Open a new/existing workspace
- Save a workspace
- Close a workspace
- Open a data source
- Import/export change lists
- Switch to or open a table in Classic mode
- Exit Data Prep Studio
- Open Data
- Import Change List
- Export Change List
- Open in Classic Mode
- Switch To Classic Mode
- Exit Monarch Data Prep Studio
THE SETTINGS DIALOOGS

You can specify application default or current workspace settings by clicking the Settings button located to the far right of the toolbar and selecting the appropriate option.

Note that some application settings, folder tracking, for example, are applied only when Data Prep Studio is restarted. Also, settings are serialized from the last closed Data Prep Studio session. This means that when two concurrently running sessions of the application are closed, only settings from the session closed the last are saved and reflected when a new session is started.

The Application Default Settings dialog allows you to specify row limits, default folders, conversion settings, and the like on a global level. You can also configure license settings and create new library files using this dialog.

The Current Workspace Settings dialog allows you to specify workspace-level conversion and time-interval settings. Details on each of these settings may be obtained here.
THE PREVIEW WINDOW

The Preview window allows you to:

- Open a file or a data source
- Preview and confirm the data in the data source
- Load a table into your workspace
Several tools are provided to enable you to open/preview more tables, select one or a group of tables, and close one or a group of tables. You can also append tables from the Preview window.

![Image](image1.png)

**Figure 3-9.** The Preview window tools.

Tables are arranged according to their **Data Source Group**. This grouping system allows you to quickly select, deselect, and remove (close) tables in a group.

![Image](image2.png)

**Figure 3-10.** The Beantown Data Source Group.

The **Search Data Source** panel located on the upper right-hand corner of the Preview window allows you to search for specific tables by Data Source Type or Data Source Name. This functionality is especially useful when you wish to load just one or two tables from a large number of open data sources.

![Image](image3.png)

**Figure 3-11.** The Search Data Source panel.

**THE TRANSFORM DIALOG**

You can quickly transform any table in the Prepare window by clicking on the **Transform** button of the Data Prep Studio toolbar. Doing so launches a **Select Transform Type** dialog that will allow you to extract empty rows in the table, pivot/unpivot columns, group by specific columns, and remove duplicates.
THE PREPARE WINDOW

The Prepare window allows you to transform columns. Pre-defined functions include convert, extract, clean, replace, and split capabilities, among others.
THE COMBINE STAGE

The Combine stage is a switch on/switch off function that allows you to join or append two or more tables to create a new one.

Figure 3-14. Data Prep Studio’s Joining stage is accessed by clicking Combine > Join.

Figure 3-15. Data Prep Studio’s Appending stage is accessed by clicking Combine > Append.
THE REPORT DESIGN WINDOW

The Report Design window allows you to open PDF and PRN report files and extract specific fields from this report to create a table, which then becomes available in the Preview Window.

Figure 3-16. Data Prep Studio’s Report Design window.

Note that you can also open reports, especially those that are text-heavy but contain tables you wish to bring into Data Prep Studio, in Monarch Table Extractor.

More information on this component is available here.

Work in the Report Design window follows a system that closely mimics the report trapping steps in Monarch Classic. Details of each of the tools available in the Report Design window, as well as how they are used to create tables from PDF and PRN files are available here.
THE ANALYZE DROP-DOWN

The Analyze drop-down is your take-off point for creating, viewing, modifying and managing summaries.

![Figure 3-17. Data Prep Studio’s Analyze drop-down.](image)

THE EXPORT WINDOW

The Export window allows you to export table data and summaries from Data Prep Studio to a number of different file types.

![Figure 3-18. Data Prep Studio’s Export window.](image)
You can export table data to:

- Microsoft Excel
- CSV
- IBM Cognos Analytics
- Microsoft Access
- Microsoft Power BI
- Tableau Server
- Tableau TDE
- Qlik
- SAS
- JSON

You can also export to a number of Altair products:

- Altair Panopticon
- Altair Knowledge Studio
- Altair Knowledge Hub

You can also export summaries to CSV and Microsoft Excel.

Data Prep Studio Hotkeys

Keyboard shortcuts (hotkeys) for the main toolbar are enabled in Data Prep Studio to help you quickly access the different windows.

The following table describes the main hotkeys available in Data Prep Studio.

<table>
<thead>
<tr>
<th>USE THIS HOTKEY</th>
<th>TO</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + S</td>
<td>Access the Start Page</td>
</tr>
<tr>
<td>ALT + V</td>
<td>Access the Preview window</td>
</tr>
<tr>
<td>ALT + P</td>
<td>Access the Prepare window</td>
</tr>
<tr>
<td>ALT + T</td>
<td>Launch the Select Transform Type dialog</td>
</tr>
<tr>
<td>ALT + C</td>
<td>Access the Combine stage</td>
</tr>
<tr>
<td>ALT + A</td>
<td>Access the Analyze drop-down</td>
</tr>
<tr>
<td>ALT + E</td>
<td>Launch the Export window</td>
</tr>
<tr>
<td>ALT + G</td>
<td>Launch the Application Default Settings dialog</td>
</tr>
<tr>
<td>ALT + F</td>
<td>Launch the Application Menu</td>
</tr>
</tbody>
</table>

A detailed list of the keyboard shortcuts available in Data Prep Studio may be found [here](#).
Data Prep Studio Table Icons

The right-hand side of tables displayed in the table lists of the Prepare window is marked with icons to help you identify the table type.

<table>
<thead>
<tr>
<th>THIS ICON</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Database Table Icon]</td>
<td>Marks a database table.</td>
</tr>
<tr>
<td>![Join Icon]</td>
<td>Marks a join.</td>
</tr>
<tr>
<td>![Append Icon]</td>
<td>Marks an append.</td>
</tr>
<tr>
<td>![Deduplicate Operation Icon]</td>
<td>Marks a table obtained from a deduplicate operation.</td>
</tr>
<tr>
<td>![Sort Operation Icon]</td>
<td>Marks a table obtained from a sort operation.</td>
</tr>
<tr>
<td>![Pivot Operation Icon]</td>
<td>Marks a table obtained from a pivot operation.</td>
</tr>
<tr>
<td>![Unpivot Operation Icon]</td>
<td>Marks a table obtained from an unpivot operation.</td>
</tr>
<tr>
<td>![Transpose Operation Icon]</td>
<td>Marks a table obtained from a transpose operation.</td>
</tr>
<tr>
<td>![Group-By Operation Icon]</td>
<td>Marks a table obtained from a group-by operation.</td>
</tr>
<tr>
<td>![Extract-Rows Operation Icon]</td>
<td>Marks a table obtained from an extract-rows operation.</td>
</tr>
<tr>
<td>![Monarch Report Node Icon]</td>
<td>Marks a Monarch report node.</td>
</tr>
</tbody>
</table>
Data Prep Studio Lessons

Because most data prep needs may be addressed by Data Prep Studio, we begin this learning guide with lessons on how to work with this exciting add-on.

![Data Prep Studio Start Page](image_url)

Data Prep Studio supports a number of main functions:

- Add data from a wide variety of data sources
- Add data using the Altair Data Connectors
- Join and append table data to create new data tables
- Clean and transform tables for further operations
- Export tables
- Save and load workspaces

The lessons described in this section demonstrate how to use Data Prep Studio and aim to provide users with a basic overview of the application’s capabilities. If you wish to learn about Data Prep Studio’s functions in greater detail, consider consulting the application’s help file.
Before You Begin

Throughout the lessons, we make the following assumptions:

❑ Monarch Complete is properly installed and the Monarch and Data Prep Studio program items are available when you start Windows.

❑ The lesson files are installed and Monarch’s default Report, Model, and Project folders are configured to point to the lesson files (the Setup program ideally automatically assigns these defaults the first time you install the product but you may want to assign other folders instead).

❑ You are using an operating system for which Monarch is certified.

❑ The Date Format setting in Monarch has been set to M/D/Y to handle dates in the sample reports correctly.

NOTE

If you use a different OS, some slight deviations from the steps listed in the lessons will occur (e.g., the default paths, the appearance of screens, and other minor differences), but you can effectively complete the lessons on all versions of Windows that Monarch supports.

This learning guide also assumes that you have copies of the following files stored in your computer:

❑ Beantown.mdb
❑ Payroll.mdb
❑ Classic.pdf
❑ Patient.pdf
❑ Canaccord 042215.pdf

These files are typically installed along with Monarch and are found in C:\Users\Public\Documents\Datawatch Monarch\Data and C:\Users\Public\Documents\Datawatch Monarch\Reports. If you do not have these file, you can download them from here.

We begin our lessons by adding data to a Data Prep session.
Previewing and Adding Data to a Data Prep Session

A Data Prep session begins by placing data, either from a preexisting table or from a table created through the Report Design window, to the Preview window.

The following file types may be opened in Data Prep Studio:

- Delimited text files (.csv)
- Fixed text files (.txt)
- Microsoft Excel files (.xls, .xlsx)
- Microsoft Access files (.mdb, .accdb)
- JSON files (.json)
- XML files (.xml)
- Print files (.dat, .prn, .rpt, .txt)
- PDF files (.pdf)
- XPS files (.xps)
- HTML files (.htm, .html, .asp, .aspx)
- Log files (.log)
- Data Prep workspace files (.dpwx)

**ADDING DATA FROM A DATABASE FILE**

Steps:
1. Launch Data Prep Studio.
2. Select **Open Data** to display the **Select Data Source to Open** dialog.

![Select Data Source to Open dialog](image)

*Figure 4-2. The Select Data Source to Open dialog.*
3. Select the data source option **Database** and then double-click on **Microsoft Access**.

4. In the *Open* dialog that displays, navigate to the folder in which you stored **Beantown.mdb**, select this file, and then click *Open*.

The Access Explorer displays.

![Access Explorer](image1)

**Figure 4-3. The Access Explorer.**

The Access Explorer displays each time you load a Microsoft Access data source; using this explorer, you can select which tables to load to your workspace and even preview these tables before loading if necessary. A similar explorer is available for Excel files.

5. Since we want to load all three tables within the file, tick the box for **Table Name** and then click *Load Selected*.

You are brought to the Prepare window. Each of the tables that make up the database displays in this window.

![Prepare window](image2)

**Figure 4-4. Tables brought into the Preview window.**
Letters beyond the 64th character are truncated when opening tables from Excel files with column names exceeding 64 characters because the Access driver used to read these files imposes a 64-character limit.

Clicking on the drop-down buttons located to the right of these tables displays a context menu that will allow you to perform table operations, including change row limits, edit file paths, pin tables, and the like.

A complete list of the actions that can be performed on tables may be found here.

The bottom of the Prepare window (see figure above) presents several options that will allow you to navigate through your tables easily.

Note that while a database may contain any number of tables, only those tables you selected and loaded from the Preview window display in the Prepare window.

The appearance of opened tables may be modified in a few ways, as described below.

Limiting Rows

You can change the number of rows Data Prep Studio loads on a global basis when it opens tables by selecting Settings from the Data Prep Studio toolbar and then selecting Application Default Settings from the options that display. This setting may be found in the Row Limit tab. Note that while decreasing the row limit when opening tables can improve the performance of Data Prep Studio and speed up response times, this may also result in missed exceptions and problematic rows, particularly if these rows are not included in the limited row set.

If you wish to change the row limit of a specific table that has been opened in the Prepare window, click on the drop-down button located to the right of the table from the table selector and, from the options that display, select Load Options > Change Row Limit.

If you wish to change the row limit of a table while it is in Preview mode, select the Edit Source Row Limit button and use the Edit Source Row Limit dialog that displays to do so.

Changing File Paths

You may wish to change the file path of an open table in the Prepare window (e.g., a file with the same name is located in a different folder in your machine or network). To do so, click on the drop-down button located to the right of the table from the table selector and, from the options that display, select Load Options > Edit File Path. In the Edit File dialog that displays, navigate to the file you wish to use and then click Open. Note that you can only replace the contents of a table with those of another table with the same file extension. Data Prep Studio automatically detects the file extension of the open table to help guide your replacement choices.
Editing Load Options

When your table is one of several tables in an Access database or one of several worksheets in an Excel file, you can select a different table to open by clicking on the drop-down button located to the right of the table from the table selector and, from the options that display, selecting **Load Options > Edit Load Options**. Load options can also be accessed from the Column Information panel that displays when a table is previewed.

For **Access data sources**, the following dialog displays:

![Access Options dialog](image)

**Figure 4-5.** The Access Options dialog.

Select the new table you wish to load from the drop-down list provided and then click **OK**.

For **Excel data sources**, the following dialog displays:

![Excel Options dialog](image)

**Figure 4-6.** The Excel Options dialog.

From the settings provided, specify those most applicable to the table you wish to open and then click **OK**.
For **HTML tables**, the following dialog displays:

![HTML Load Options dialog](image)

**Figure 4-7. The HTML Load Options dialog.**

After specifying the necessary details, click **OK**.

For **delimited text files (e.g., CSV)**, the following dialog displays:

![Delimited Text Options dialog](image)

**Figure 4-8. The Delimited Text Options dialog.**

Using this dialog, you can specify whether to ignore blank rows or allow embedded line breaks. You can also define a delimiter by clicking on the drop-down button beside this field and choosing from several common delimiters which to apply to your table. If the delimiter you are looking for is not on this list (e.g., ^), simply type it into the field. Define a text qualifier by selecting one from the drop-down list provided. If you need to modify Encoding Options, click on the button provided to launch drop-down lists that will allow you to select an encoding type and code page, if applicable.

### Pinning Tables

When a table is pinned in the Prepare window (i.e., click on the drop-down button located to the right of the table from the table selector and, from the options that display, select **Pin Table** from the options that display) and the workspace is saved, a user without direct access to the table source may open the pinned table by opening this same workspace. When pinning
a table, a user may also choose to pin the current rows opened (when a row limit has been set) or pin the entire data set.

Figure 4-9. Pinning a table in the Prepare window.

This functionality allows data-sharing with users who do not necessarily have rights to the source systems required to create working tables. Note, however, that the pinned table cannot be refreshed by a user without access to the data source.

**Refreshing Table Data**

When a table (e.g., an Excel worksheet) is open in the Prepare window of Data Prep Studio, you essentially have a snapshot of the current state of this table. When you or another user makes changes to this table, your table “snapshot” must be rebuilt to reflect these changes. To do so, click on the drop-down button located to the right of the table from the table selector and, from the options that display, select **Refresh Data Table** from the options that display.

Note that tables obtained from drag-and-drop operations in web pages cannot be refreshed because such tables are not sourced from a file path or URL. In these tables, the **Edit File Path** and **Refresh Data Table** buttons are not available.

**ADDING DATA FROM A PDF REPORT**

PDF and PRN reports, when first opened in Data Prep Studio, display in the Report Design window, which will allow you to create templates and traps to enable consistent extraction of data from similarly structured report files. In the following example, we use the Report Design window’s Auto-Define feature to create traps and fields from our report. Note, however, that one should not depend solely on this feature as the application may be unable to process reports with more complex structures or irregularly arranged lines.

To learn how to create templates and trap fields in the Report Design window in greater detail, click **here**. You may also want to review **how trapping is done in Classic**.
Steps:

1. Return to the Preview window and then select Add.

2. In the Select Data Source to Open dialog that displays, click PDF & Text and then double-click on PDF Report to display the Open dialog.

3. Navigate to the folder in which you stored Classic.pdf, select this file, and then click Open. You are brought to the Report Design window.

4. Automatically define fields by selecting the Auto Define button on the Template and Field Properties panel.

5. Click Accept on the Report Design toolbar to close the window and add the table extracted from the report to the Prepare window.
Figure 4-11. The newly defined table in the Preview window.

If you wish to make changes to your newly defined table after bringing it into the Prepare window, click on the drop-down arrow beside its name in the table list and then select **Edit in Report Design**.

Doing this will bring up the Report Design window once more and allow you to make additional changes to your table.

**NOTE**

You can perform some changes to the table extracted from a report, including change its column names and fill nulls with the value preceding the empty cell, in the Report Design window.

These changes do **NOT** form part of the session’s Audit Trail (Change History) because the Report Design window is a settings panel that creates a new table from the settings selected. The Change History function of Data Prep Studio only tracks changes to existing tables.

If you wish to apply more changes to a table you extracted using the Report Design window and have these changes tracked, open the table in the Prepare window instead.
ADDING DATA FROM A WEBSITE

Data Prep Studio is unique from other data prep software because it is capable of intuitively determining tables from webpages and recreating these in the Preview workspace.

Steps:


   This webpage displays, among others, a chart of the pre-market most active stocks listed in the NASDAQ, the second-largest stock exchange in the U.S.

   ![Figure 4-12. NASDAQ’s pre-market most active stocks webpage.](image)

   **Most Active**  **Most Advanced**  **Most Declined**  = Show All

   **NASDAQ - Pre-Market Ten Most Active Share Volume**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Company</th>
<th>Last Sale</th>
<th>Change Net / %</th>
<th>Share Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATAI</td>
<td>ATA Inc.</td>
<td>$2.54</td>
<td>0.42 ▲ 19.81%</td>
<td>1,756,274</td>
</tr>
<tr>
<td>AMD</td>
<td>Advanced Micro Devices, Inc.</td>
<td>$27.46</td>
<td>0.22 ▲ 0.81%</td>
<td>1,289,760</td>
</tr>
<tr>
<td>QQQ</td>
<td>Invesco QQQ Trust, Series 1</td>
<td>$184.76</td>
<td>0.28 ▲ 0.15%</td>
<td>654,186</td>
</tr>
<tr>
<td>SNY</td>
<td>Sanofi</td>
<td>$43.99</td>
<td>0.05 ▼ 0.11%</td>
<td>610,000</td>
</tr>
<tr>
<td>TSLA</td>
<td>Tesla, Inc.</td>
<td>$276.75</td>
<td>4.44 ▲ 1.83%</td>
<td>519,679</td>
</tr>
<tr>
<td>AAPL</td>
<td>Apple Inc.</td>
<td>$198.77</td>
<td>0.73 ▼ 0.37%</td>
<td>504,804</td>
</tr>
<tr>
<td>TVIX</td>
<td>Credit Suisse AG</td>
<td>$24.92</td>
<td>0.47 ▲ 1.05%</td>
<td>404,417</td>
</tr>
<tr>
<td>IQ</td>
<td>iQIYI, Inc.</td>
<td>$23.95</td>
<td>0.07 ▲ 0.29%</td>
<td>357,884</td>
</tr>
<tr>
<td>SQQQ</td>
<td>ProShares UltraPro Short QQQ</td>
<td>$9.37</td>
<td>0.03 ▼ 0.32%</td>
<td>353,370</td>
</tr>
<tr>
<td>TQQQ</td>
<td>ProShares UltraPro QQQ</td>
<td>$61.45</td>
<td>0.26 ▲ 0.42%</td>
<td>260,411</td>
</tr>
</tbody>
</table>

2. Use your mouse to highlight this entire table and then drag and drop the contents of the webpage into the Preview window of Data Prep Studio.

   Data Prep Studio intelligently detects tables in webpages and recreates them so that they can be brought into the Prepare window.
You can also drag and drop tables from HTML files/pages directly into the Prepare window.

![Figure 4-13. The newly defined table in the Prepare window.](image)

Data Prep Studio allows you to open files stored on a web repository, such as Amazon S3, FTP, SFTP, and the like. To do so, click the Open from Web button located at the bottom of the dialog. This action launches an Open Data Source from Web dialog wherein you can enter the URL of the webpage containing the table you wish to bring into Data Prep Studio.

**What’s the Difference between Dragging and Dropping Webpage Content and Using the Open from Web Dialog?**

The browser is not only a rendering engine, but also is a scripting engine. For HTML with no Javascript that is delivered in its complete form and rendered in the browser, the copy/drag/drop content will be the same as the content obtained directly from the URL.

However, if the HTML contains Javascript, which dynamically inserts the tables as HTML when rendered on the browser, only the copy/drag/drop will contain dynamically created tables; the HTML obtained directly from the URL will not contain these tables.
Data Prep Studio allows you to explore and open JSON and XML files.

Steps:

1. Navigate to the location of the JSON or XML file you wish to open, select the file, and then drag and drop it into the Prepare window.

The XML/JSON Explorer displays.

![XML/JSON Explorer](image)

**Figure 4-14.** The XML/JSON Explorer. A similar explorer is made available when opening XML files.

XML and JSON files present a hierarchical arrangement of nodes or tables. Selecting a node (table) displays all of its fields on the right-hand side of the explorer and a preview of the data contained within it.

When checked, the **Use Simplified Column Names** box located on the upper right-hand corner of the explorer instructs Monarch to eliminate extraneous characters (e.g., the `@` sign) from column names.

Use the **Encoding Options** drop-down to select a character encoding system different from the default (UTF-8) if necessary.
Figure 4-15. The XML/JSON Explorer with a node selected.

Selecting a node also shows the number of rows it contains if this number is more than one.

2. Select a node to open by clicking on it.

3. Select **Row Expand Arrays** or **Column Expand Arrays** to display JSON arrays into rows or columns, respectively.

4. Select an **Encoding Option** if necessary.

5. Click **OK**.

Your table is loaded in the Preview window. You can select and add this table to your list of open tables as usual. For the rest of the exercises, however, this is not necessary.
ADDITIONAL DATA FROM MONARCH FILES

Data Prep Studio allows you to work with existing Monarch models and projects.

This means you can take advantage of the robust templating and extraction capabilities of Monarch Classic and use the pre-defined models to work with reports.

However, note that tables that come from Monarch files behave differently from tables that come from other sources:

- Tables associated with a Monarch file are not displayed on the Preview window.
- Data from reports associated with a Monarch file table are displayed as tables on the Prepare window but cannot be prepped.

The following Monarch Classic features are translated in Data Prep Studio when you open a Monarch file:

- All trap types
- Multi-column regions
- Formula-based calculated fields using all built-in Monarch functions
- Lookup table calculated fields
- Multiple reports
- PDF reports
- Projects that use databases
- External lookups
- Runtime parameters

The following Monarch Classic features are currently not supported in Data Prep Studio:

- Summaries. Data Prep Studio will only display data as displayed on a Monarch table.
- Filters. Data Prep Studio will load all of the data from a report and ignore any filters that have been defined in the Model.
- User-defined functions. Fields that use user-defined functions are displayed in Data Prep Studio with null values.
- External Models. External model definitions within a Monarch model are simply ignored when the model is imported into Data Prep Studio.
- User-edited fields. User-edited fields are displayed in Data Prep Studio with null values.
- Sorts
- Password-protected PDF files
- Project exports
❑ Redaction of report fields - Data Prep Studio does not support Consistent Alias Replacement (CAR)-type redactions. In the case where the Monarch model specifies a CAR redaction for some field, the Data Prep Studio substitutes a non-CAR redaction change that best emulates the CAR redaction specified.

❑ Projects with inputs and models from S3, HTTPS, and FTPS (i.e., web sources that require authentication) are not supported in DPS

❑ Bookmarks – Any bookmarks present in the Monarch model are ignored in DPS

❑ Report colors – Any report colors specified in the Monarch model are ignored in DPS

❑ Report index – Any report index definitions present in the Monarch model are ignored in DPS

To open Monarch Files in Data Prep Studio, the following steps are applied.

Steps:

1. Select **Open Data** from the Start Page to launch the **Select Data Source to Open** dialog.

2. Click **Monarch File** and then double-click on **Monarch Model** or **Monarch Project**. From the Open dialog that displays, navigate to the folder in which your Monarch file resides, select it, and then click **Open**.

   If you open a Monarch model only, the model is displayed as a table in the Prepare window. To view data, you must add at least one report that is compatible with this model. To do so, in the Prepare window, click on the drop-down located to the right of this main table and select **Report Options > Add Report**.

   If you open a Monarch project, the model is displayed as the main table in the Prepare window and all other tables obtained from the report associated with the project are displayed as sub-tables.

More information on working with Monarch Files in Data Prep Studio can be found [here](#).

**ADDING DATA FROM EXCEL FILES**

Excel files may be added to your workspace via the Select Data Source to Open dialog or simply dragging and dropping the file into the Start Page, Preview window, or Prepare window.

When opening Excel files, the Excel Explorer dialog displays.
This dialog is used to specify which tables to open and how the data should be displayed. When the necessary specifications have been provided and Load Selected is clicked, the table(s) open as usual and they can be previewed and loaded to the Prepare window.

More information on the Excel Explorer dialog may be found here.

TRAPPING DATA FROM REPORT FILES

Many of today’s reports come in the form of PDF, PRN, and TXT files. You could simply read these files off your computer screen and learn about whatever they contain, but what if you wanted to use the data in these reports to perform further analysis? Let’s say you had a 150-page PDF report listing individual patient visits over a span of 8 months and want to find out which three symptoms are the most common among these patients. How would you go about doing so? Before you can do any such analysis, you clearly have to get data off the PDF and into your computer.

When you bring a report file into Data Prep Studio, you must create a model to extract data from it. A model is a collection of data extraction templates, and modeling is the process of creating these templates. You can define data extraction templates to quickly and consistently select data from a report and arrange them into an orderly table.

Steps:

   The report displays in the Report Design window.
Figure 4-17. Opening Patient.pdf in the Report Design window.

2. Click on the line selection area of the line beginning with Elmerry MO 63343 so that it is selected. Then, in the Report Design panel, click + (Add New) > Detail. This instruction tells Data Prep Studio that we are creating a detail template.

Figure 4-18. Selecting a line to trap.

The Template Editor is activated.
3. Click into the trap line right above the word **BILL** and then, using your keyboard, type out the word **BILL**. Notice how all similar lines (i.e., those with the word **BILL** in the exact same position in the report) are highlighted. Guillelmetes also appear in the line selection area next to lines containing data that match the trap.

You have just manually defined a trap, in this case, an **exact trap**. Let’s move on to defining fields.
4. In the sample text line, highlight the numbers **1839.39**.

Notice how the Data Preview at the bottom of the Template Editor displays what would make the first column of your table. The rows of this table will be populated with the bill amounts you have just instructed the application to pick up.

![Image of a template editor with a highlighted field and a table preview]

**Figure 4-21.** Highlighting fields.

Note also how the **Report Design** panel changes to show the **Field Definition** panel. We’ll use this panel to give our field a more meaningful name.

5. Highlight the text in the **Name** field of the Field Definition panel, rename the field **Bill Amount**, and then click the **Accept** icon that displays next to the field name.
The name of the field indicated in the Data Preview panel changes.

Let’s capture more data from the report.

6. Click on the line selection area next to the line beginning with Michael Canton and then, in the Report Design panel, click + (Add New) > Append.

The contents of the trap line and sample text line are updated with your selection.
7. Let’s trap Service Code data. Click into the trap line directly above A in the service code A0028. Using the trap characters located above the trap line, create the following trap:

![Figure 4-24. Creating a new template to gather more data from the report.](image)

In the present case, we cannot use an exact trap to capture field data because we expect service codes to change for each customer. However, we are sure that the service code will always begin with an alpha character followed by four numeric characters. The trap characters "ÂNNNN" instruct Data Prep Studio to search all of the lines of the report that this specific pattern of characters at the specific location in which it is located. Notice that all lines containing data corresponding to this trap are highlighted in the report. Guillelmet also appear in the line selection area beside these lines.
8. Highlight the text Michael Canton, A0028, and Son had Funny Bone Surgery. You can extend your highlighting a bit to capture names and symptoms that might be slightly longer than you are currently seeing.

All of the data captured by the fields you have just defined display in the Data Preview panel. Your table is nearly done!

**Editing Field Properties**

When fields are captured during report trapping, you can modify each field’s properties. Renaming fields, which we did for the first field we captured in this lesson is just one of several properties you can modify.

**Steps:**

1. In the Data Preview panel, click on header of the field containing the entry Michael Canton so that its properties display at the bottom of the Report Design panel. Change the name of this field to Patient Info.

2. At the bottom of the Field Definition panel, click Next Field to define a new name for the field containing the entry A0028.

3. Change the name of this field to Service Code.

4. Repeat Step 2 and then rename the next field Symptoms.

Your Data Preview panel should display as follows.
Figure 4-27. Newly captured and renamed fields added to our table.

Now, note how, in the original report, the **Symptoms** field can span one or two lines. The Bill amount consistently begins on the third line of the record. Unless we make adjustments to the Symptoms field, we will be unable to capture all of the symptoms written in the original report.

9. Click on the **Advanced** tab of the field definition for **Symptoms**. This tab displays several options that will help you address multiple-line fields. At the moment, all we are concerned with is the end of the multiple-line field.

10. Locate the option **End Field On > Line Count**.

11. Ensure that the radio button for the option is selected and then use the counter to increase the line count to **2**.

Figure 4-28. Specifying advanced settings for a field.
Note the immediate change in the **Symptoms** field.

![Table](image)

Figure 4-29. Specifying advanced settings can help capture fields completely.

We’re almost done!

12. Click **Accept** on the Report Design toolbar to save the table you have just created and add it to the table selector in the Prepare window.

![Table](image)

Figure 4-30. A new table created from Patients.pdf.
USING THE RECENT FILES PANEL TO LOAD DATA

Clicking on the **Recent Files** button located on the upper left-hand corner of the Start Page or the Preview window displays a panel from which you can view all recently opened workspaces, data sources, and tables.

![Recent Files Panel](image)

**Figure 4-31. The Recent Files panel.**

**NOTE**

The Recent Files panel is populated with data sources and tables opened from previous and the current data prep sessions. If you are using Data Prep Studio for the first time, no data sources and tables will display when you expand this panel.

Selecting any item in this panel opens the related data source or table. This functionality allows you faster access to your data and eliminates the need for repeated launching of the Select Data Source to Open dialog just to load more data to the current data prep session.

When clicking on an item in the **Recent Data Sources** panel, say, an MDB file, all of the tables included in this file are loaded into the Preview window and made available for bringing into the Prepare window. In Figure 4-32, we selected Beantown.mdb from the Recent Data Sources panel. The Access Explorer displays. From here, you can select which table(s) to open in the Prepare window as usual.
Figure 4-32. Opening Beantown.mdb from the Recent Data Sources Panel.

Items in the **Recent Data Sources** panel may be closed (i.e., removed from the data sources list) by hovering your mouse on the data source you want to close and then clicking on the **Remove** button that appears to its right.

When an item is selected from the **Recent Tables** panel, only this item is opened and loaded into the Preview window. As in the previous case, items in this panel may be closed by hovering your mouse on the table you want to close and then clicking on the **Remove** button that appears to its right.
DISPLAYING RECENT DATA SOURCES IN THE SELECT DATA SOURCE TO OPEN DIALOG

You can view and open recently opened data sources in the Select Data Source to Open dialog.

![Select Data Source to Open dialog](image)

Figure 4-33. Viewing recently opened data sources via the Select Data Source to Open dialog.

Select any item on this list to load it into the Preview window. Close data sources (i.e., remove them from the list) by hovering your mouse on the data source file you want to close and then clicking on the Remove button that appears to its right.

![Select Data Source to Open dialog with closed data source](image)

Figure 4-34. Closing a recently opened data source via the Select Data Source to Open dialog.
Now that we know how to open data from a table, report, and webpage into the Add Window, we'll explore how to open data from other database types using the Altair Data Connectors. Let's save our current workspace and open a new one.

**Saving Data Sources to the Data Source Library**

Data Prep Studio can save tables you opened in the Prepare window the Data Source Library Library. From here, you can further choose to save the table to your local library or the Altair Knowledge Hub library.

The Altair Knowledge Hub Library includes all data source definitions and workspaces saved with the intention of sharing and using in a specific Altair Knowledge Hub server. The Monarch Public Library includes data sources and workspaces stored in the public Altair Knowledge Hub site (i.e., https://public.altair.com).

When you save a data source or table to this library, Data Prep Studio "remembers" the path or location of this source and applies it when the same is opened in another data prep session. Thus, you can use the Data Source library to access commonly-used data sources quickly and seamlessly without using the Open Data Source dialog, previewing the data source, and selecting individual tables to open.

Let's save the Accounting table to the Data Source library.

**Steps:**

1. In the Prepare window, go to the table selector, and then click on the dropdown arrow to the right of the **Accounting** table to display a context menu.
2. In the context menu, click **Load Options > Save to Library**.

![Figure 4-35. Saving a data source to the Data Source Library.](image)
The Data Source Library displays your newly saved data source.

Figure 4-36. The saved data source displays in the Data Source Library.

To load a data source from the library, select the **Open Library** icon from the Data Prep Studio toolbar or **Open Library** from the Select Data Source to Open dialog. This action launches the Library dialog. Select the table you wish to add to your workspace and then click **Load Selected**.

To perform an action on any data source in this list, select it to activate it and then choose an operation to execute. You can edit the table path, load the data source, preview the data source, or delete the selected data source.

More information on the Data Source Library may be found [here](#).
Saving a Workspace

Your workspace includes:

- The data tables you have loaded
- The join and append definitions you have created
- The transform operations you have carried out
- The change histories of the tables you opened

You can save your workspace anytime as a Data Prep Workspace file (*.dpwx), and you can load this workspace in future Data Prep Studio sessions to continue preparing your data.

Learn more about your workspace here.

Steps:

1. Select the Application Menu button from the Prepare window and, from the menu that displays, select Save Workspace.
2. Select one of the following:
   - Save the workspace on your computer
   - Save the workspace on your computer with a different name
   - Save the workspace with a password
   - Save the workspace with a different name and password
   - Save the workspace to the Altair Knowledge Hub Library
3. In the Save As dialog that displays, navigate to the folder in which you want to save the workspace, enter Workspace1 into the File name field, and then select Save.
4. If you opted to save the workspace with a password, enter and confirm this password in the next dialog that displays. Select OK when you are finished.
5. Close the current workspace by selecting Application Menu > Close Workspace.
Using the Altair Data Connectors

Data Prep Studio allows you direct access to a wide variety of database types through a set of built-in data connectors.

Figure 4-37. The Altair data connectors.

Data Prep Studio allows you to access data from the following database sources and applications:

- DB2
- MySQL
- Oracle
- Sybase IQ
- Business Objects
- Google Drive
- Monarch Server Content
- SharePoint
- Zendesk
- Informix
- ODBC
- PostgreSQL
- Active Directory
- Google AdWords
- Hubspot
- NetSuite
- Splunk
- Microsoft Access
- OLEDB
- SQL Server
- Box Cloud Storage
- Google Analytics
- Jira
- Salesforce
- SugarCRM
It also allows you to access data from the following big data sources:

- Amazon EMR Hive
- Amazon Redshift
- Cassandra
- Cloudera CDH Hive
- Cloudera Impala
- Teradata
- Google BigQuery
- Hadoop Hive
- IBM Cloudant
- MongoDB
- Spark SQL

Finally, data from other sources, such as Google Sheets, SAS Transport, and OData, are also supported in Data Prep Studio.

To connect to any of these sources quickly and successfully, Data Prep Studio makes use of data connectors.

To obtain access to data using this connector, specific information, including host name, server name, user ID, password, and database name, among others, is necessary. Which information you need will depend on the database to which you are attempting to connect. If you wish to use any of the data connectors, contact your database administrator to obtain the necessary connection details.

The following examples illustrate how to use the various data connectors available in Data Prep Studio.

**CONNECTING TO HADOOP HIVE**

The connection dialogs for DB2, Informix, MySQL, Oracle, PostgreSQL, SQL Server, Hadoop Hive, Cloudera Impala, Amazon Redshift, Vertica, and SybaseIQ are similar, although some data connections may require more information than others.

Connecting to an Oracle database, for example, will require you to choose between the Standard or TNSNames connection types; if you choose the Standard connection type, you will need to provide an SID name or service name besides a hostname, user ID, password, and edition name. If you choose the TNSNames connection type, you will need to provide a TNSNames file name. Connecting to a SQL Server will require you to choose between Windows authentication and username/password authentication.

The following typical example describes how to access data from an Apache Hadoop Hive database using the relevant Altair Data Connector. If you do not have information to access a Hadoop Hive database at the moment, simply follow along with this tutorial.

Note that this section simply demonstrates how to use the connector; thus, the tables we opened previously will not appear in the Preview window until we load the workspace we saved in the previous section.
Steps:

1. From the Start Page, select **Open Data**.

2. In the *Select Data Source to Open* dialog that displays, select **Big Data** and then double-click on **Hadoop Hive**.

   The *Hadoop Hive Data Connection* dialog displays.

   ![Figure 4-38. Initiating a connection with Hadoop Hive database.](image)

3. Enter the **hostname**, **user ID**, and **password** to the database you wish to connect to.

4. Choose a **Hive Server Type** from the dropdown field provided.

5. Click **Fetch Databases** and then use the selector to choose a database to connect to.

6. Click **Load Tables** and then use the table selector (drop-down) to select a table to connect to.

   The fields of this table display in the Columns box.
7. Choose the field(s) to load by ticking their checkboxes in the **Columns** box.

8. If you wish to duplicate a column, select this column from the **Add a duplicate column** drop-down.

9. If you wish to parameterize (i.e., filter) or aggregate (group) the data in these fields, tick the relevant boxes and then select a parameter or aggregate type to apply from the drop-down boxes provided.

10. Select **OK** when you are finished. The table displays in the Preview window.

    This table can be selected and loaded into the Prepare window as usual.
CONNECTING TO IBM CLOUDANT

The following steps detail how to connect to a database via IBM Cloudant:

Steps:

1. From the Preview window of Data Prep Studio, select Add.

2. In the Select Data Source to Open dialog that displays, select Big Data and then double-click on IBM Cloudant. The IBM Cloudant Connection dialog displays.

3. Enter the account name or URL of the Cloudant account to which you wish to connect in the Cloudant Account or URL field.

4. If you wish to connect to a specific database, check the box for Connect to a Specific Database and then specify the name of the database in the field adjacent to this box. If you wish to choose from a list of databases, skip this step.

5. Enter the **username** and **password** into the appropriate boxes and then click Login.

Figure 4-40. Connecting an IBM Cloudant database.
Upon successful connection:

- The Database field displays the name of the database you specified in Step 4 or
- The Database field’s drop down control is activated if you skipped Step 4; you can use this field to select a database to connect to.

6. Select a view from the drop-down box provided.
7. Specify other settings using the fields and boxes provided if you wish.
8. Select **Ok**.

The table(s) contained in the database you selected display(s) in the Preview window.
These tables can be selected and loaded into the Prepare window.

**CONNECTING TO ODATA**

The following steps describe how to connect to a database via OData.

**Steps:**
1. From the Preview window of Data Prep Studio, select **Add**.
2. In the **Select Data Source to Open** dialog that displays, select **Web > OData > Get Data**.

The **Odata Connection** dialog displays.

![OData Connection dialog](image)

**Figure 4-41. Initiating an OData connection.**
3. Enter the collection list **URL** into the field provided.

4. Place your cursor in the User ID field and specify a **user ID** and **password** if necessary.

   In the present example, we are using the Northwind database
   (http://services.odata.org/Northwind/Northwind.svc/), which requires no user ID or password.

5. Select **Load Tables**. A list of tables displays in the **Collections** box.

6. Select a **collection (table)** from the list provided.

![Figure 4-42. Selecting fields to open in Data Prep Studio.](image)

7. In the adjacent **Query Parameters** box, select fields to add to your table. You may filter results by specifying an operator and required (filter) value if you wish.
8. Click the **Preview** button to check how your table will look like when opened in Data Prep Studio. You can make adjustments if you wish by repeating steps 6 and 7. When you are satisfied with your table, click **OK**.

   The table you created displays in the Preview window.

   This table can be selected and loaded into the Prepare window as usual.

**CONNECTING TO MONARCH SERVER – CONTENT**

The following steps describe how to connect to Monarch Server content.

**Steps:**

1. From the Preview window of Data Prep Studio, select **Add**.
2. In the **Select Data Source to Open** dialog that displays, select **Application > Monarch Server – Content > Get Data**.

   The **Monarch Server - Content Connection** dialog displays.
3. Enter the **Monarch Server Client URL**, **Username**, and **Password** in the fields provided and then click **Connect** when you are finished.
The contents of the dialog expand to enable you to choose a document type group, document type, model, report date range, report, view, and timezone.

4. Using the drop-downs and boxes provided, specify the data table you wish to open and then click **OK**.

The table/report you selected displays in the Preview window.

This table/report can be selected and loaded into the Prepare window as usual.

**NOTE**

The Monarch Server - Content connector for Data Prep Studio only functions if the Monarch Server security settings are set to Default. Other settings, such as Active Directory, are not yet supported in DPS.

**CONNECTING TO BUSINESS OBJECTS UNIVERSE**

The following steps describe how to connect to data stored in Business Objects Universe.

**Steps:**

1. In the Preview window, select **Add More...** to launch the **Select Data Source to Open** dialog.

2. Select **Application > Business Objects > Get Data** from the list of other database types to open.

   The **Business Objects Universe Connection Settings** dialog displays.
3. Provide the hostname, port, Server, user ID, and password required to connect to the Business Objects Universe. If the port you wish to use is different from the default port, change the default value to the correct one.

4. Select any of the following Authentication Types:
   - Enterprise
   - LDAP
   - WinAD
   - SAPR3

5. Set the Request Timeout. 30 is the default.

6. Click **Connect** to load the selected Universe. The directory path where the selected

7. Select a **universe (table)** to display its contents.

8. In the **Selected Items** panel, by default, all of the **items** (i.e., **columns**) are selected and these are added to your table when opened in DPS. To deselect an item, click on the ✗ icon to its right.
9. If you wish, modify the *Display Name* of an item by clicking on its name box and then entering a new one.

10. Select **Filters** to apply to the universe if you wish.

   **NOTE**

   BOBJ (Business Objects) supports specifying custom filters either in the Filter box or a parameter can be set for any added Item in the Selected Items box.

   There is also a separate list for BOBJ predefined filters that you can use.

11. Click the **Validate** button to ensure that your query is correct.

12. Click **OK** to confirm the selection and retrieve the record set into Designer.

   The flat record set corresponding to the executed SQL is returned from the source database and displayed in Data Prep with the database name as the title and all fields listed displayed in Data Preview.

13. If you wish to make changes to your fields, you may do so now and then click **OK** when you are finished. If you do not wish to make any changes to your data, simply select the **OK** button.

**CONNECTING TO SALESFORCE**

The following steps describe how to connect to Salesforce data.

**Steps:**

1. Open the **Select Data Source to Open** dialog and then select **Application > Salesforce > Get Data**.

   The **Salesforce Connector Settings** dialog displays.
2. Enter a valid **username**, **password**, and **security token** and then click **Connect**.

3. Select the source type for data retrieval, i.e., **Salesforce Objects Table** or **Report**.

4. Select the data source to open according to the source type you selected.

5. Click **OK**.

**CONNECTING TO MONGODDB**

The following steps describe how to connect to MongoDB data.

**Steps:**

1. Open the **Select Data Source to Open** dialog and then select **Big Data > MongoDB > Get Data**.
The *MongoDB Connector Settings* dialog displays.

![MongoDB Connection dialog](image)

**Figure 4-48. The MongoDB Connection dialog.**

2. Enter a valid **username** and **password** and then click **Connect**.

3. Once a connection to the database has been established, select a **database** and **collection** from the drop-down boxes provided. The columns associated with your selection display in the JSON list box.

4. Create a new column if you wish by clicking the **Add Column** button and entering the necessary information. Alternatively, you may click the **Generate Columns** button. Doing so launches a query of the first few database record and builds a table schema from the available information.

5. Specify query options if you wish.

6. Click **OK**.
CONNECTING TO GOOGLE ANALYTICS

The following steps describe how to connect to data stored in Google Analytics.

Steps:

1. From the Preview window, select **Add**.

2. In the **Select Data Source to Open** dialog that displays, select **Application > Google Analytics > Get Data**.

   The Google Analytics Connection dialog displays.

3. Provide a service account email and key file path and then click **Get Accounts**.

4. Use the drop-downs provided to select an **Account, Properties, and View**. Also indicate the **start and end dates** of the data you wish to fetch.

5. Click the **Fetch Dimensions and Metrics** button to populate the Categories, Dimensions, and Metrics list boxes.

6. Select the fields you want to add to your table from these lists and then click **OK**.
More information on this connector may be found here.

The Google Analytics example concludes our exercise on using the Altair Data Connectors. A full list of the connector dialogs available in Data Prep Studio is available here.

If you would like to save this workspace to continue working on it at a later time, you may do so now. Otherwise, select Application Menu > Close Workspace.

Navigating Tables

Tables open in the Prepare window may be easily navigated in a number of ways.

NAVIGATION CONTROLS

The following controls have been enabled in Data Prep Studio to allow quick movement through a table.

- Ctrl + Home – Go to first cell of the first row of the table
- Ctrl + End – Go to the last cell of the last row of the table
- Ctrl + Right arrow – Go to right-most cell in the current row
- Ctrl + Left arrow – Go to the left-most cell in the current row

WORKING WITH ROWS

The row number of any given table is provided at the bottom of your workspace. To go to a specific row in your table, simply enter the row number you wish in the row field provided. To go to the first and last rows of the table, click on the First Row and Last Row buttons, respectively. The Previous Page and Next Page buttons take you to views of previous and next pages of data, respectively.

![Figure 4-50. Viewing the row count of a table.](image)

You can increase row heights by selecting the Row Height button to fit multi-line data into your rows.
SEARCHING FOR DATA

You can search for specific data in tables by using the **Search** field located at the bottom of your workspace. Enter the string you would like to search for and then either press **Enter** on your keyboard or click the **Search for Next** button located to the right of this field. The first cell including the string you are searching for is highlighted. Keep pressing **Enter** or clicking the **Search for Next** button to locate all instances of this string. To reverse the search direction, click on the **Search for Previous** button.

SHOWING NULLS AND WHITESPACE CHARACTERS

Two buttons, which appear at the lower right-hand corner of the Prepare window, have been enabled in Data Prep Studio to help you visualize your data better. The **Show Nulls** button helps you see null values (i.e., empty fields). Clicking on the **Show Whitespace Characters** button displays spaces, tab indents, and line breaks between text characters; these whitespace indicators display as •, →, and ←, respectively.
DOCKING/UNDOCKING TABLES

Docking a table helps you view multiple tables at once or move them to a different location, for example, a second monitor. To undock a table, right click on it from the Prepare window table selector and then select **Undock Table** from the options that display. You can also just drag the table anywhere on your screen. This action undocks the table and allows you to move it anywhere you wish. To dock a table, select the **Dock Table** icon that appears on the upper right corner of an undocked table. This table is returned to the main interface.

Loading a Workspace

Let's load the workspace we saved as **Workspace1** to continue with our tutorial.

Steps:

1. Select **Application Menu** > **Open Workspace**.
2. In the **Open** dialog that displays, go to the folder in which you saved **Workspace1**, select this file, and then click **Open**.

   All of the tables you loaded into Data Prep Studio, joins and appends you created, and transform operations you performed are displayed.

![Image](image.png)

*Figure 4-52. All transformations to tables saved into a Workspace file are automatically performed when the file is loaded into Data Prep Studio.*
NOTE

When a saved workspace is opened, Data Prep Studio attempts to load all of the tables added to the workspace using the file paths provided in a previous session. But what if the paths to these tables are changed or the table are renamed? Learn more about file reconciliation here.

Joining Data in a Data Prep Session

Data Prep Studio allows the following join types:

- **Left outer join**
  
  A left outer join retains all of the rows of the "left" table, regardless of whether or not there is a row that matches on the "right" table.

- **Right outer join**
  
  A right outer join retains all of the rows of the "right" table, regardless of whether or not there is a row that matches on the "left" table.

- **Full outer join**
  
  A full outer join returns all rows from the left and right tables. The full outer join combines the results of both left and right joins.

- **Inner join**
  
  An inner join yields the intersection of two tables, i.e., only the rows they have in common.

These joins essentially allow you to create new tables from preexisting ones so that you can get more information out of your data and more detail into future visualization or analytics work.

But what if you wanted more information on the data that can't be joined? In this case, negative joins are what you will need to generate. You can create a **left negative join**, which shows all rows from the right table for which the join keys do not match, or a **right negative join**, which shows all rows from the left table without matching join keys. If you want to create lookups, you can do so using the Join Configuration dialog too. More information on this topic is available here.

In this exercise, we will join data from two tables. Following the steps outlined in *Previewing and Adding Data to a Data Prep Session – Adding Data from a Database*, load the table in Payroll.mdb into Data Prep Studio.
Steps:

1. Select **Combine > Join** from the Data Prep Studio toolbar to launch the *Joining* stage.

   All of the tables you loaded are displayed on the table list to the left of the screen. Note that the table **Compensation** must display at the bottom of this list if you successfully opened Payroll.mdb in Data Prep Studio.

2. Drag **Accounting** from the table list and into the first **Drag a Table** box. This table will be the “left” table of the join.

3. Drag **Compensation** from the table list and into the second **Drag a Table** box. This table will be the “right” table of the join.

4. Select the **Click to Join** button that displays on top of these tables.

   The **Join Configuration** dialog displays.

   ![Join Configuration Dialog](image)

   Figure 4-53. The resulting Join Configuration dialog.
In this exercise, we will join the two tables via an inner join (i.e., we only want to see rows where key fields from both tables match).

5. Ensure that Standard displays in the Type drop-down and then select the Inner Join icon from the available icons located below the Type field in the Join Configuration dialog.

6. Select Emp_ID as the key field for the Accounting table.

7. Select Emp_ID as the key field for the Compensation table.

8. If you wish to take advantage of Data Prep Studio’s fuzzy matching function, tick the Use Fuzzy Matching for Text Column Pairs box and then set an accuracy threshold using the slider that displays.

9. Select OK.

The resulting table is created and added to the table list. A preview of the table resulting from this join also displays in the Joining stage workspace.

In the Prepare window, the joined table is named, by default, Join. Succeeding joins will be named Join(1), Join(2), and so on. These tables can be renamed to whatever you wish.

![Image](image.png)

Figure 4-54. The results of our join operation.

10. Selecting the Prepare button on the toolbar shows the contents of this new table.
ANALYZING JOINS

Data Prep Studio includes Join Analysis functionality to help you decide which joins will likely produce the best results. This functionality may be accessed by selecting the Show Join Analysis button on the upper right-hand corner of the Combine stage BEFORE Step 4 of the procedure described above.

Alternatively, if you have completed Step 4 of the join procedure, click Recommend Keys in the Join Configuration dialog.

The Join Analysis dialog that displays provides suggestions as to which join fields may be combined to yield the most number of results.
Hovering over each of the boxes in the dialog displays more information about the suggested join.

![Image of Join Analysis dialog]

Figure 4-57. Viewing information of the suggested join.

If you are satisfied with the projected join result, simply click on the box corresponding to the proposed join. The Join Configuration dialog displays and you can proceed with Step 8 of the procedure described above.

**CREATING A NEW JOIN**

If you would like to create a new join after completing a previous one, select the Create New Join button located on the upper left-hand corner of the Combine Stage. Doing so removes all tables already placed in the joining stage, as well as the previous join defined. You can now begin creating a new join.
USING FUZZY JOINS

When joining data, Data Prep Studio makes an allowance for potential errors in spelling that would result in a mismatch even when the keys are highly similar (e.g., "bond" vs. "bund"). Such issues are addressed by using fuzzy joins.

Fuzzy joining is activated by ticking the **Use Fuzzy Matching for Text Column Pairs** checkbox located near the bottom of the Join Configuration dialog.

The options that display when fuzzy matching is employed allow you to specify an accuracy threshold for matching and whether or not to include columns detailing the fuzzy matching results in the table obtained from the join.

Note that join keys MUST be defined before fuzzy matching can be accomplished.

More information on fuzzy matching may be found [here](#).
Working with Load Plans

When you join, append, or transform tables, the resulting table displays in the table selector of the Prepare window as follows:

![Figure 4-59. The Load Plan of a table resulting from join, append, or transform operations.]

Clicking on the icon of the main table minimizes the table display as follows:

![Figure 4-60. The minimized table display.]

The tables that display under a joined, appended, or transformed table (i.e., the “parent” tables) enable you to visualize which specific tables were employed to obtain the newer table (i.e., the “child” table). This functionality is called load plan visualization.

Because joins, appends, and transforms are NOT recorded as changes, these operations will not display in a table’s change history and you may be unable to recreate child tables easily, especially when working with the same workspace at a later date. Load plan visualization addresses this issue by allowing you to recreate new tables from previously existing ones: you’ll know exactly which tables to use and what operation to apply to obtain a desired table.

Note that when pre-existing tables are combined to create new ones, the former are displayed below the latter.

![Figure 4-61. Movement of tables in a load visualization plan.]

As with any other table in the Prepare window, clicking on the drop-down icon located to the right of child tables allows you to edit the operation and pin and refresh the table. You can also rename or close the table, duplicate the table (including all other tables used to achieve it), and discard the operation. In case of the latter, the child table disappears and only the parent tables remain.
Appending Data in the Preview Window

Tables with the same fields may be appended via a single click of a button. To do so, simply select the tables you wish to append from the Preview Window.

Figure 4-62. Specifying tables to append in the Preview window.

If the tables you selected can be appended, Data Prep Studio activates the Append Selected Tables button. Click this button.

Figure 4-63. The appended tables display in the Prepare window.
In the Prepare window, the appended table is named, by default, **Append**. Succeeding appends will be named **Append(1)**, **Append(2)**, and so on. These tables can be renamed to whatever you wish.

Tables cannot be appended if their fields are different.

![Figure 4-64. Tables with different fields cannot be appended.](image)

Note also that you cannot perform append operations on two tables if one of them is used in a load plan and the other is not because these tables belong to different hierarchies. Duplicate the relevant table in the load plan so that it is in the same hierarchy as the table not used in a load plan and then append them as usual. You can append two tables belonging to separate load plans as long as these tables are of the same hierarchy (provided they have the same schema, of course!).

### Appending Data in the Prepare Window

In previous lessons, you learned to append similar tables by selecting these tables in the Preview window and then clicking the Append Selected Tables button. In many instances, this simple operation is adequate. But what happens if the tables you wish to append don't match exactly (e.g., two tables contain the information you want to append but one table contains 1 field more than the other)?

Data Prep Studio addresses this problem by implementing more complex append operations from the Prepare window.
APPENDING DATA VIA THE CONTEXT MENU

For this exercise, open and load the tables of Beantown.mdb.

Steps:

1. Using CTRL+click, select the tables Data Processing and Marketing in this order.

   **NOTE**

   You can select multiple tables from the table selector only if they are of the same rank (e.g., they belong to the same hierarchy in their respective load plans).

2. Right-click on your mouse and then select Append Tables >. You may opt to:

   - **Match columns on name**
     
     This option appends all tables based on name.
   
   - **Match columns on name and type**
     
     This option appends your tables first according to their field names and then according to their field type.
   
   - **Match columns on order**
     
     This option appends your tables according to the order in which you selected them regardless of name or type. If the data types do not match, the data types of the first table are carried over to the appended table. If the first table selected has fewer columns than the second table, the number of columns of the first table are retained.
   
   - **Match columns on order, name, and type**
     
     This option appends your table first according to the order in which you selected them and then according to their field names and types. This type of append is also called a strict append.

3. As your tables are exactly matched, select any of these options listed above.

   A new append table, named Append, is created and added to your table selector.
APPENDING DATA VIA THE APPEND HELPER

The Append Helper is a wizard that can help you in customizing the append operation. Unlike other append methods, you can "force" Data Prep Studio to match columns even if they do not have the same location, name, and/or data type.

![Figure 4-65. The original Accounting table.](image)

For this exercise, double-click on the Last Name field header of the Accounting table and rename it to "Surname." Click on the drop-down button beside this header and then select Column List from the menu that displays to launch the Edit/Move Column Information dialog. Using your mouse, click on the drag-and-drop handle of Surname, drag the field, and drop it after First Name. Do the same for the Department column and drop it after Gender.

Your Accounting table should now look as follows:

![Figure 4-66. The modified Accounting table.](image)

Because we’ve made changes to the Accounting table, it is no longer an exact match to the Data Processing table (to check, select both tables and then append by order, name, and type – failure of the append indicates a some between tables).

Let’s use the Append Helper to match these tables and produce a table with only the Department, First Name, and Surname fields.
Steps:

1. Select the tables **Accounting** and **Data Processing**. Right-click on your mouse and then select **Open Append Helper**.

   ![](Append_Helper.png)

   **Figure 4-67. The Append Helper.**

   The Append Helper is divided into three main panels.

   The **Target Schema** panel displays the columns of the first table, in this case Accounting. The panel in the middle displays the columns of the second table, in this case Data Processing. Note that if you had selected Data Processing first and then selected Accounting, the tables in these two panels would be reversed. The **Output Columns** panel displays the columns your appended table will have.

   The Append Helper will automatically attempt to match the columns of your two tables. As seen in the figure above, most of the columns have been matched correctly by name and type. Columns in the first table selected that cannot be matched to the columns of the second table must be mapped manually.

2. Under the columns of **Data Processing**, click on the drop-down of the column labeled "---" and then click **Last Name** from the options that display.

   This action tells the Append Helper that the contents of this column match those of the Surname column even if they do not have the same name.
3. In the Output Columns panel, tick the box for Surname and then deselect the boxes for Emp_ID, Hire Date, and Gender. Click OK when you are finished.

The new table, named Append(1), displays.

---

Appending Data via the Appending Stage

Besides joining tables, the Combine button on the Data Prep Studio toolbar also allows you to append tables. In this case, the tables are joined by name and data type.

Steps:


   The Appending Stage displays.
2. Drag and drop the tables Data Processing and Marketing into each of the fields marked **Drag a Table** in the Appending stage workspace.

**NOTE**

When creating a new append, you cannot selecting the exact two (or n) tables used to create a previous append.

You can add as many tables as you wish to the append provided that these tables feature identical schema.

3. Click the **Click to Append** button that displays to the right of these tables.
Figure 4-70. Completing the append operation.

The appended table is added to the table list panel.

Figure 4-71. The resulting appended table.
Transforming Data

A Transform dialog is launched when you click on the Data Prep Studio toolbar. This dialog provides further options that will allow you to quickly change how your tables look and how your data are grouped. To reverse a transformation, click on the drop-down arrow to the right of the transformed table and then choose Discard Transform from the options that display. To edit a transformation, repeat these steps but select Edit Transform instead.

SORTING COLUMNS

Sort allows you to arrange the records on a table according to the ascending or descending values of one or more columns.

Data Prep Studio allows you to sort column from several points:

- From the context menu of a column
- From the context menu of a table (via the Sort dialog)

Figure 4-72. The Sort dialog.

More information on sorting columns can be found here.
PIVOTING COLUMNS

Pivoting allows you to transform column values into column headers, thereby changing the look of your data from tall-skinny to short-wide.

For this exercise, open Classic.pdf. In the Report Design window, we create the following traps to extract the indicated fields:

- **Customer**

![Figure 4-73. Extracting the Customer field from Classic.pdf via Report Design.](image-url)
Media

Figure 4-74. Extracting the Media field from Classic.pdf via Report Design.

Amount

Figure 4-75. Extracting the Amount field from Classic.pdf via Report Design.
The resulting table should look as follows in the Prepare window.

<table>
<thead>
<tr>
<th></th>
<th>Customer</th>
<th>Media</th>
<th>#</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>35</td>
<td>96</td>
</tr>
<tr>
<td>2</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>63</td>
<td>00</td>
</tr>
<tr>
<td>3</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>20</td>
<td>38</td>
</tr>
<tr>
<td>4</td>
<td>Betty's Music Store</td>
<td>DVD</td>
<td>53</td>
<td>91</td>
</tr>
<tr>
<td>5</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>65</td>
<td>80</td>
</tr>
<tr>
<td>6</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>71</td>
<td>92</td>
</tr>
<tr>
<td>7</td>
<td>Betty's Music Store</td>
<td>CD</td>
<td>95</td>
<td>90</td>
</tr>
<tr>
<td>8</td>
<td>Betty's Music Store</td>
<td>LP</td>
<td>64</td>
<td>74</td>
</tr>
<tr>
<td>9</td>
<td>Betty's Music Store</td>
<td>DVD</td>
<td>35</td>
<td>94</td>
</tr>
<tr>
<td>10</td>
<td>Big Shanty Music</td>
<td>CD</td>
<td>53</td>
<td>94</td>
</tr>
<tr>
<td>11</td>
<td>Big Shanty Music</td>
<td>CD</td>
<td>9</td>
<td>00</td>
</tr>
<tr>
<td>12</td>
<td>Big Shanty Music</td>
<td>CD</td>
<td>26</td>
<td>97</td>
</tr>
<tr>
<td>13</td>
<td>Big Shanty Music</td>
<td>CD</td>
<td>57</td>
<td>54</td>
</tr>
<tr>
<td>14</td>
<td>Big Shanty Music</td>
<td>CD</td>
<td>10</td>
<td>75</td>
</tr>
<tr>
<td>15</td>
<td>Big Shanty Music</td>
<td>SACD</td>
<td>86</td>
<td>31</td>
</tr>
</tbody>
</table>

Figure 4-76. The resulting table extracted from Classic.pdf.

Now we’re ready to pivot your columns.

Steps:

1. From the Prepare window, select **Transform > Pivot** to display the *Pivot Column* dialog.

Figure 4-77. The Pivot Column dialog.
2. In the **Choose Columns** portion of the dialog, click the **Pivot** icon to the left of the **Media** column.

3. In the **Group Columns** portion of the dialog, tick the box for **Group on all columns**.

4. In the Choose Columns portion of the dialog, tick the box of the **Amount** column and ensure that the Aggregate Type assigned is **Sum**.

5. Click the **Group** icon to the left of the Amount column and then select **OK** when you are finished.

   Your table should be transformed as follows.

   ![Figure 4-78. The pivoted table.](image)

---

**UNPIVOTING COLUMNS**

Unpivoting All of the Pivoted Columns of a Table

When all of the pivoted columns of a table are unpivoted, the data are returned to their tail+skinny look.

Steps:

1. Click on the table you pivoted in the previous lesson in the Prepare window and then select **Transform > Unpivot**.

2. In the **Attribute Columns** portion of the **Unpivot** dialog that displays, ensure that all columns are selected.

3. Click the Unpivot icons to the left of the columns **CD_Sum(Amount)**, **DVD_Sum(Amount)**, **LP_Sum(Amount)**, **SACD_Sum(Amount)**, and **BLU_Sum(Amount)**. These columns should move to the Unpivot Columns portion of the dialog.

4. Click **OK**.

   Your table returns to its original schema.
Now you can use Data Prep Studio’s Split or Extract functions to revert entries in the Attribute column to their original values.

**NOTE**

If you are unpivoting all of the columns you pivoted in a table, effectively completely reversing your change, you can also simply click on the drop-down icon located to the right of the pivoted table and, from the options that display, select **Discard Transform**.

Unpivoting Select Columns of a Pivoted Table

When you opt to unpivot select columns of a pivoted table, you are effectively instructing Data Prep Studio to display the data (values) of these columns (attributes) in a left-to-right manner but keep all other fields and their associated data in their top-bottom form.

In this case, an **Attribute** column, which will contain the name(s) of the column(s) you unpivoted, and a **Values** column, which will contain all of the data corresponding to these columns, are created. Depending on the number of columns you choose to unpivot, the new table created could be much shorter than the original pivoted table.

Steps:

1. Repeat the **Pivoting Columns** exercise to obtain a pivoted table. Ensure that this table is displayed in the Prepare window.

2. From the Data Prep Studio toolbar, select **Transform > Unpivot**.

   The **Unpivot Columns** dialog displays.

3. In the **Attribute Columns** portion of the Unpivot dialog that displays, ensure that all columns are selected.

4. Click the Unpivot icon to the left of the column **BLU_Sum(Amount)**. This column should move to the **Unpivot Columns** portion of the dialog.

5. Check the box for **BLU** and then select **OK**.

   The newly transformed table displays as below.

   **Figure 4-79. The newly transformed table.**
TRANSPOSING COLUMNS

The Transpose transformation allows you to use the rows of a column (vertical display) as column headers (horizontal display).

Steps:

1. In the Prepare window, select the table you wish to transform.
2. Click **Transform > Transpose** to display the Transpose dialog.

![Figure 4-80. The Transpose dialog.](image)

3. Select the corresponding radio button if you wish to:
   - Transpose on the first column
   - Transpose with generic column headers
4. Click **OK** when you are finished.

GROUPING DATA

The Group By transformation allows you to classify or consolidate rows that belong together according to some common value within the row. When you consolidate the records, you can also select column values to aggregate. Let’s use the table in the previous exercise to group our data.
Figure 4-81. Data to be grouped.

Steps:

1. From the Prepare window, select **Transform > Group** to display the Group By dialog.

Figure 4-82. The Group By dialog.
In the table above, we can group all media sales so that only the total amounts for each customer are displayed.

2. Click the **Group** icon of the **Customer** column so that it moves to the **Group Columns** portion of the dialog.

3. In the **Value Column** portion of the dialog, ensure that the box to the left of the **Amount** column is ticked and that its **Aggregation Type** is **Sum**.

4. Ensure that the box to the left of the **Media** column is unchecked.

5. Select **OK** when you are finished.

Your new table displays below.

![The table resulting from a Group By operation.](image)

**Figure 4-83. The table resulting from a Group By operation.**

**REMOVING/SHOWING DUPLICATES**

You can remove or show duplicate rows from tables by selecting **Transform** and, in the dialog that displays, clicking the **Duplicates** option.

**Steps:**

1. In the Prepare window, view the table from which you want to remove duplicate rows to remove and then select **Transform > Duplicates**. The **Duplicates** dialog displays.
2. Select the deduplicate operation to apply to your table from the drop-down provided. You can:
   - Remove Duplicates - Keep first row
   - Show Duplicates - Show all except first row
   - Flag Duplicates - Mark with new column

3. Select the columns to evaluate for the deduplication operation by clicking on the Key icon located to the left of each column of interest.

4. Tick the boxes of the columns you wish to display in the table resulting from the deduplication operation.

5. Click OK.

   The resulting table displays.

   More information on how to remove duplicates from tables may be found here.
EXTRACTING ROWS

To extract empty rows or rows with empty values in a table, select Transform... to launch the Transform dialog and then click Extract Rows.

![Extract Rows dialog]

Figure 4-85. The Extract Rows dialog.

You can:

- Exclude all rows where all columns contain no content, nulls, or whitespace only
- Exclude all rows where any column contains no content, nulls, or whitespace only
- Include all rows where any column contains no content, nulls, or whitespace only

Learn more about this topic here.
Working with Calculated Fields

The ability to create calculated fields is among the more important data prep operations you can perform. Calculated fields can be created from text, date/time, and numeric fields.

A complete list of the functions available in the New Formula Column dialog, as well as their definitions and examples, may be found here.

![New Formula Column dialog](image)

For this exercise, let’s compute what the unit prices of various media from the Classic.pdf report would be if we applied a 10% discount to them.

Steps:

1. From the Classic.pdf report, extract the fields marked by Betty’s Music Store (Customer), Bartok, Sonata for Solo Violin (Description), MK-42625 (Label/No.), and 8.99 (Unt_Prc). Load this table into the Prepare window.

2. Click on the drop-down button beside the Unt_Prc column and then select Column > New Formula Column.

3. In the New Formula Column dialog that displays, enter Discounted Prices in the Field Name box.

4. Double-click on Unt_Prc field in the Fields panel so that the field name appears in the Expression box.

5. In the Operators panel, double-click on the multiplication operator. This operator appears in the Expression box.
6. Using your mouse, click to the right of the multiplication operator in the Expression box and then type in **0.90**. Select **OK** when you are finished.

The **New Formula Column** dialog closes and a new column is added to your table.

7. Select the drop-down button of the **Formula Field** column and then click **Format**. In the **Format Formula Field** dialog that displays, select **Financial** and then click **OK**.

Your table is rebuilt as below.

<table>
<thead>
<tr>
<th>Ab</th>
<th>Customer</th>
<th>Description</th>
<th>Ab</th>
<th>Label/No.</th>
<th>#</th>
<th>Unit_Prc</th>
<th>#</th>
<th>Discounted Prices</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Betty's Music Store</td>
<td>Bartok, Sonata for Solo Violin</td>
<td>MK-42825</td>
<td>8.99</td>
<td>8.09</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Betty's Music Store</td>
<td>Scarlatti, Stabat Mater</td>
<td>SBT 48292</td>
<td>5.99</td>
<td>5.39</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Betty's Music Store</td>
<td>Beethoven, Pathetique Sonata, A1</td>
<td>420153-2</td>
<td>5.99</td>
<td>5.39</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Betty's Music Store</td>
<td>Mendelssohn, War March of the Priests</td>
<td>SMK 47592</td>
<td>5.99</td>
<td>5.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Betty's Music Store</td>
<td>Plizzetti, Messa di Requiem</td>
<td>CHAN 8964</td>
<td>5.99</td>
<td>5.63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Betty's Music Store</td>
<td>Misc., Modern Trombone Masterpieces</td>
<td>ADA 58105</td>
<td>10.97</td>
<td>9.71</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Big Shanty Music</td>
<td>Stalakely, Dambuona Oars Concerto</td>
<td>SMCY 5210</td>
<td>8.99</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Big Shanty Music</td>
<td>Schubert, Sonata in e, D. 506</td>
<td>AS-325</td>
<td>9.00</td>
<td>8.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Big Shanty Music</td>
<td>Mozart, Symphony No. 23 in D</td>
<td>CD-77884</td>
<td>8.99</td>
<td>8.09</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Big Shanty Music</td>
<td>Schoenberg, Ode to Napoleon</td>
<td>CHAN 8116</td>
<td>9.59</td>
<td>8.63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Big Shanty Music</td>
<td>Shostakovich, 24 Preludes for Piano</td>
<td>CDA 6620</td>
<td>5.39</td>
<td>4.55</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Big Shanty Music</td>
<td>Balakirev, Symphony No. 1</td>
<td>ENTP 411</td>
<td>9.95</td>
<td>8.63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Big Shanty Music</td>
<td>Hirt, St. Paul's Suite for Orch</td>
<td>GEF-1020</td>
<td>5.99</td>
<td>5.39</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Bluegrass Records</td>
<td>Faure, 28 Songs, Schumann</td>
<td>RCA 61429</td>
<td>17.95</td>
<td>16.18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Bluegrass Records</td>
<td>Takemitsu, Music of Takemitsu</td>
<td>SMK 53473</td>
<td>3.60</td>
<td>3.24</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Bluegrass Records</td>
<td>Messiaen, Quatuor pour la fin de temps</td>
<td>GEC 54936</td>
<td>9.60</td>
<td>8.64</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Bluegrass Records</td>
<td>Strauss, Ein Heidenbienen, Op. 49</td>
<td>SMSCD-50</td>
<td>8.99</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-87. Adding a calculated field to a table.

**Filtering Data**

You can choose how much data to import from a table into your Data Prep Session by filtering your table and selecting the data you want to view. Let’s find out how using the table we produced from a PDF report. In this example, instead of viewing data for 20 customers, we’ll select only 5 customers and load their data into a new table.

**Steps:**

1. Open **Classic.pdf** and then use the **Auto-Define** button in the Report Design window to extract data from the report.

2. View the resulting table in the Prepare window.

3. Click the drop-down button beside the **Customer** column and then select **Filter > Define Filter**.
The Define Filter dialog displays.

![Define Filter dialog](image)

**Figure 4-88. The Apply Filter dialog.**

4. Click on the **Expression** drop-down and, from the options that display, select **Unique Values**.

   A list of all unique values (i.e., Customer names) displays.

5. Using this list, tick the boxes (i.e., Include) for Betty’s Music Store, Big Shanty Music, Bluegrass Records, Canciones, and Chez Rudy.

6. Select **OK** when you are finished. The resulting table displays in the Prepare window.

![Filter operation result](image)

**Figure 4-89. The table obtained from a filter operation.**

Note that the data of only five customers are displayed.

Different filter operations are available for different field types. Numeric fields, for example, may be filtered by using ranges or specifying less than or greater than values.
To filter date fields, you can specify a date range or before/after date. For text fields, you can specify strings or select discrete values.

Preparing Data

You can prepare columns in a table to prepare them for future visualization or analytics operations. Data Prep Studio includes pre-built functions that allow you to quickly and consistently clean your data, turning them into analysis-ready information. Preparing data in Data Prep Studio is as easy as clicking on the drop-down button located to the right of each column header. Doing so displays a list of prep operations you can perform on that column.

![Figure 4-90. Available prep operations for Text fields in the Prepare window.](image)
## SUMMARY OF DATA PREP OPERATIONS

The following table summarizes the data prep operations possible in Monarch Data Prep Studio.

Details of each operation may be obtained by consulting [Working with Data Prep Studio > Prep Data Column Operations](#) in the Data Prep Studio help file.

<table>
<thead>
<tr>
<th>USE THIS TRANSFORMATION</th>
<th>TO</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FILTER</strong></td>
<td></td>
</tr>
<tr>
<td>Define filter</td>
<td>Create a filter for the selected column</td>
</tr>
<tr>
<td>Discard all filters</td>
<td>Remove all filters applied to a table</td>
</tr>
<tr>
<td><strong>SORT</strong></td>
<td></td>
</tr>
<tr>
<td>Sort selected columns</td>
<td>Sort the column in ascending order</td>
</tr>
<tr>
<td>Define sort</td>
<td>Launch the Sort dialog to create a new sort definition</td>
</tr>
<tr>
<td><strong>COLUMN</strong></td>
<td></td>
</tr>
<tr>
<td>New formula column</td>
<td>Add a new formula column to the table</td>
</tr>
<tr>
<td>New constant-value column</td>
<td>Add a new constant-value column to the table</td>
</tr>
<tr>
<td>New lookup column</td>
<td>Add a new lookup column to the table</td>
</tr>
<tr>
<td>New row number column</td>
<td>Add a new row number column to the table</td>
</tr>
<tr>
<td>New runtime parameter column</td>
<td>Add a new runtime parameter column to the table</td>
</tr>
<tr>
<td>Rename column</td>
<td>Rename the column you selected</td>
</tr>
<tr>
<td>Duplicate column</td>
<td>Produce a duplicate of the column you selected</td>
</tr>
<tr>
<td>Show hidden column</td>
<td>Show a list of hidden columns. Selecting a column from this list</td>
</tr>
<tr>
<td></td>
<td>displays it in the table once more.</td>
</tr>
<tr>
<td>Hide column</td>
<td>Hide the selected column</td>
</tr>
<tr>
<td>Delete column</td>
<td>Remove the selected column from the table</td>
</tr>
<tr>
<td><strong>CASE</strong></td>
<td></td>
</tr>
<tr>
<td>Make proper case</td>
<td>Convert to uppercase the first letter of each word in a string</td>
</tr>
<tr>
<td>Make lower case</td>
<td>Convert the entire string to lowercase letters</td>
</tr>
<tr>
<td>Make upper case</td>
<td>Convert the entire string to uppercase letters</td>
</tr>
<tr>
<td><strong>CLEAN</strong></td>
<td></td>
</tr>
<tr>
<td>Remove leading and trailing spaces</td>
<td>Remove all leading and trailing spaces from a string</td>
</tr>
<tr>
<td>Remove consecutive spaces</td>
<td>Collapse multiple consecutive spaces into one space</td>
</tr>
<tr>
<td>Remove specified characters</td>
<td>Remove the sequence of characters from the values of the column</td>
</tr>
<tr>
<td></td>
<td>you apply this operation to</td>
</tr>
<tr>
<td>USE THIS TRANSFORMATION</td>
<td>TO</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove non-alphanumeric characters</td>
<td>Remove all characters that are not numbers or letters (e.g., periods, commas, other symbols) from the selected fields</td>
</tr>
<tr>
<td>Remove numeric characters</td>
<td>Remove all numerals from the selected fields</td>
</tr>
<tr>
<td><strong>CONVERT</strong></td>
<td></td>
</tr>
<tr>
<td>Text to number</td>
<td>Convert the data type Text into Number</td>
</tr>
<tr>
<td>Text to date/time</td>
<td>Convert the data type Text into Date/Time</td>
</tr>
<tr>
<td>HH:MM:SS to number of secs</td>
<td>Convert HH:MM:SS strings into a number of seconds</td>
</tr>
<tr>
<td>Date/time to text</td>
<td>Convert the data type Date/Time to Text</td>
</tr>
<tr>
<td>Date/time to number</td>
<td>Convert the data type Date/Time to Number</td>
</tr>
<tr>
<td>Number to text</td>
<td>Convert the data type Number into Text</td>
</tr>
<tr>
<td>Number to date/time</td>
<td>Convert the data type Number into Date/Time</td>
</tr>
<tr>
<td>Advanced text to number</td>
<td>Converts text fields with the values &quot;X B,&quot; &quot;X M,&quot; and &quot;X K,&quot; where &quot;X&quot; is any number, into &quot;X,000,000,000,&quot; &quot;X,000,000,&quot; and &quot;X,000,&quot; respectively.</td>
</tr>
<tr>
<td><strong>EXTRACT</strong></td>
<td></td>
</tr>
<tr>
<td>Starting from left</td>
<td>Extract n characters from the beginning of a string</td>
</tr>
<tr>
<td>Starting from right</td>
<td>Extract n characters from the end of a string</td>
</tr>
<tr>
<td>Using position and length</td>
<td>Extract n characters from the xth position from the start</td>
</tr>
<tr>
<td>Using start and end strings</td>
<td>Extract n characters starting from the start and end positions indicated by a string of characters</td>
</tr>
<tr>
<td><strong>FORMAT</strong> (for Date/Time fields)</td>
<td></td>
</tr>
<tr>
<td>Short date</td>
<td>Apply the MM/DD/YYYY form of a date/time field</td>
</tr>
<tr>
<td>Long date</td>
<td>Apply the Day, Date form of a date/time field</td>
</tr>
<tr>
<td>Short date/time</td>
<td>Apply the MM/DD/YYYY HH:MM AM/PM form of a date/time field</td>
</tr>
<tr>
<td>Long date/time</td>
<td>Apply the Day HH:MM AM/PM form of a date/time field</td>
</tr>
<tr>
<td>Time</td>
<td>Apply the HH:MM AM/PM form of a date/time field</td>
</tr>
<tr>
<td>Custom</td>
<td>Specify a custom form (e.g., year, month, day, hour, minute, etc.) for the date/time field</td>
</tr>
<tr>
<td><strong>FORMAT</strong> (for Numeric fields)</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Format the number with a thousands separator and two decimal places</td>
</tr>
<tr>
<td>Financial</td>
<td>Format the number with thousands separator and two decimal places. Negatives are enclosed in parenthesis.</td>
</tr>
<tr>
<td>Currency</td>
<td>Format the number with thousands separator and two decimal places. Adds a currency, and negatives are enclosed in parenthesis.</td>
</tr>
<tr>
<td>Percent</td>
<td>Multiply the number by 100 and add a % sign</td>
</tr>
<tr>
<td>USE THIS TRANSFORMATION</td>
<td>TO</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scientific</td>
<td>Format the number in exponential form</td>
</tr>
<tr>
<td>Custom</td>
<td>Specify a custom form (e.g., 000,000, #0.0E0, # 'degrees,’ etc.) for the number field</td>
</tr>
<tr>
<td>REPLACE</td>
<td></td>
</tr>
<tr>
<td>Using position and length</td>
<td>Replace strings of a certain length and located at a certain start position with another string</td>
</tr>
<tr>
<td>Using find and replace</td>
<td>Replace specific strings with another string</td>
</tr>
<tr>
<td>Ditto</td>
<td>Copy non-null values down to fill null values in subsequent rows in a column</td>
</tr>
<tr>
<td>Blank values</td>
<td>Replace blank values with a specific string</td>
</tr>
<tr>
<td>Nulls</td>
<td>Remove null values and replace with a specific string</td>
</tr>
<tr>
<td>SPLIT</td>
<td></td>
</tr>
<tr>
<td>Into parts from the Left</td>
<td>Start from the left and split a column into two or more columns, depending on a separator you define. The separator may be a single character or substring</td>
</tr>
<tr>
<td>Into Parts from the Right</td>
<td>Start from the right and split a column into two or more columns, depending on a separator you define</td>
</tr>
<tr>
<td>Names Into Parts</td>
<td>Split the value of a name column into its name parts.</td>
</tr>
<tr>
<td>Addresses Into Parts</td>
<td>Split the value of a single address column into its component address or postal parts</td>
</tr>
<tr>
<td>Date/Time into Parts</td>
<td>Split a date/time column into two or more parts according to the date/time components you select. Parts include Year, Quarter, Month, Day, Hour, Minute, Second, Date, Time, DayOfYear, HalfYear, and Week.</td>
</tr>
<tr>
<td>Date/Time into ISO 8601 Parts</td>
<td>Split a date/time field into two or columns according to the ISO 8601 date/time components you select</td>
</tr>
<tr>
<td>Date/Time into Fiscal Parts</td>
<td>Split a date/time field into two or more columns according to the fiscal parts selected</td>
</tr>
<tr>
<td>COMPUTE</td>
<td></td>
</tr>
<tr>
<td>Round with Precision...</td>
<td>Round numbers to a specified number of places to the right (or left) of the decimal point</td>
</tr>
<tr>
<td>Round Up (Ceiling)</td>
<td>Round numbers up to zero decimal places</td>
</tr>
<tr>
<td>Round Down (Floor)</td>
<td>Round numbers down to zero decimal places</td>
</tr>
<tr>
<td>Remove Negative Signs (Abs)</td>
<td>Return the absolute values of numbers</td>
</tr>
<tr>
<td>Remove Decimals (Int)</td>
<td>Return the integer portions of numbers</td>
</tr>
<tr>
<td>Calculator</td>
<td>Creates a calculated field using other numeric fields in the table</td>
</tr>
</tbody>
</table>
## Text Field Operations

For text fields, the following data prep operations may be applied:

<table>
<thead>
<tr>
<th>Data Prep Operation</th>
<th>Details</th>
</tr>
</thead>
</table>
| Filter              | Define filter  
Discard filter |
| Sort                | Sort selected columns  
Define sort |
| Column              | Add new formula column  
Add new constant value column  
Add new lookup column  
Add new row number column  
Add new runtime parameter column  
Rename column  
Duplicate column  
Hide column  
Delete column |
| Case                | Make proper case  
Make lower case  
Make upper case |
| Clean               | Remove leading and trailing spaces (Trim)  
Remove consecutive spaces (Collapse)  
Remove specified characters  
Remove non-alphanumeric characters  
Remove numeric characters |
| Convert             | Text to number  
Advanced text  
Text to date/time  
HH:MM:SS to number of seconds |
| Extract             | Starting from left  
Starting from right  
Using position and length |
| Merge               | |
| Redact              | |
| Replace             | Ditto  
Nulls  
Blank values  
Using find and replace  
Using position and length |
| Split               | Into parts from the left  
Into parts from the right |
### Data Prep Operation Details

<table>
<thead>
<tr>
<th>Data Prep Operation</th>
<th>Details</th>
</tr>
</thead>
</table>
|                     | Names into parts  
|                     | Addresses into parts |

### Date/Time and Numeric Field Operations

For date/time and numeric fields, the following data prep operations may be applied:

<table>
<thead>
<tr>
<th>Data Prep Operation</th>
<th>Details</th>
</tr>
</thead>
</table>
| **Filter**          | Define filter  
|                     | Discard filter |
| **Sort**            | Sort selected columns  
|                     | Define sort |
| **Column**          | Add new formula column  
|                     | Add new constant value column  
|                     | Add new lookup column  
|                     | Add new row number column  
|                     | Add new runtime parameter column  
|                     | Rename column  
|                     | Duplicate column  
|                     | Hide column  
|                     | Delete column |
| **Convert**         | **Date/Time**  
|                     | Date/time to text  
|                     | Date/time to number |
|                     | **Numeric**  
|                     | Number to text  
|                     | Number to date/time |
| **Format**          | **Merge** |
| **Redact**          | **Replace**  
|                     | Ditto  
|                     | Nulls |
| **Split (Date/time)** | Date/time into parts  
|                     | Date/time into ISO 8601 parts  
|                     | Date/time into fiscal parts |
| **Compute (Numeric)** | Round with precision  
|                     | Round up (Ceiling)  
|                     | Round down (Floor)  
|                     | Remove negative signs (Abs)  
|                     | Remove Decimals (Int)  
|                     | Calculator |
CHANGING THE DATA TYPE OF A COLUMN

Besides data prep operations, you can also change the field type of each of the columns in your table (e.g., change a numeric field into a date/time field). To do so, simply click on the field type icon found to the left of the column name and, from the options that display, select the new field type you wish to apply.

Figure 4-91. Available prep operations for Text fields in the Prepare window.

SEARCHING FOR A DATA PREP OPERATION

If the data prep operation you are looking for is not immediately obvious, simply type in the operation into the Search field provided in the drop-down. Doing so filters the prep operations according to your search criteria and displays the results, if any.

Figure 4-92. Available prep operations for Text fields in the Prepare window.
COPYING TABLE DATA

A number of copy operations can be done in Monarch Studio. Once copied, the data can be pasted to some other word processing application.

- To copy all of the data in a single column, click on the drop-down button to the right of the name of the column you wish to copy and then select Copy from the options that display. If you wish to copy all of the data including the header of the column, choose Copy with headers instead.

- To copy a portion of the data in a single column, highlight the data you wish to copy, right-click on your mouse and then select Copy from the options that display. If you wish to copy the data including the column headers, choose Copy with headers instead.

- To copy data from two or more adjacent columns, highlight the data you wish to copy, right-click on your mouse and then select Copy from the options that display. If you wish to copy the data including the column headers, choose Copy with headers instead.

- To copy data from a single column in Monarch Studio and automatically create a new table in your workspace from the selected data, click on the drop-down button to the right of the name of the column you wish to copy and then select Create table from selection from the options that display. The headers of the columns from which you obtained the data are used as headers for the newly generated table.

- To copy data from adjacent columns in Monarch Studio and automatically create a new table in your workspace from the selected data, highlight the data you wish to copy, right-click on your mouse and then select Create table from selection from the options that display. The headers of the columns from which you obtained the data are used as headers for the newly generated table.

MODIFYING COLUMN INFORMATION

You can select the drop-down button located to the right of each column and, from the options that display, click on Column List. Doing so displays the Edit/Move Column Information dialog, which will allow you to make even more detailed changes to your columns, including their order, name, and type. You can also opt to hide or unhide columns by ticking or unticking the Hide box that displays whenever a specific column is selected.
SETTING A ROW AS A COLUMN HEADER

To change the table header and use values from a certain row as column names instead, click on the number of the row you would like to use as a header, effectively highlighting it, right-click on your mouse, and then select **Set Row as Column Headers** from the options that display. Note that when this operation is down, all rows above the row you selected as the column header are removed from the table and a new table (i.e., a transformation) is created.

To reverse (undo) this transformation, in the table selector, right-click on the newly created table and then select **Discard Transform** from the options that display.
ADDING METADATA COLUMNS TO A TABLE

You can add metadata from Excel, delimited text, and PDF/PRN reports as new columns to tables. This is done by clicking the Metadata Columns button that appears at the bottom of the Change History panels of tables opened from these file types.

Let’s transform the Hire Date column of the table Join so that only the hire date and not the hire time displays. In this exercise, we will also transform the Salary and Bonus fields so that the values in these fields resemble monetary values more closely.

Steps:

1. In the Prepare window, load the Join table, which we created in an earlier lesson.
2. Click on the drop-down button located to the right of the Hire Date column header.
3. From the menu that displays, select Format.
4. From the Format Hire Date dialog that displays, select Short Date.
5. Select **OK** when you are finished

The new column displaying only the hire date (without the hire time) displays. Note that the column header has been changed to reflect at least part of the transformation we performed.

---

**Figure 4-95. The Format Hire Date dialog.**

---

**Figure 4-96. The transformed Hire Date column of the Join (Accounting + Compensation) table in the Prepare window.**
6. Click on the drop-down button located to the right of the Salary column header and, from the menu that displays, select Format.

7. In the Format Salary dialog that displays, select Currency and then click OK.

8. Perform Steps 6 and 7 to transform the Bonus field.

Your table should now look as below.

<table>
<thead>
<tr>
<th>#</th>
<th>Department</th>
<th>Job</th>
<th>First Name</th>
<th>Last Name</th>
<th>Emp_ID</th>
<th>Hire Date</th>
<th>Salary</th>
<th>Bonus</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Accounting</td>
<td>Alldridge</td>
<td>Jeff</td>
<td></td>
<td>1507764</td>
<td>10/13/1995</td>
<td>$62,000.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>2</td>
<td>Accounting</td>
<td>Day</td>
<td>William</td>
<td></td>
<td>1577390</td>
<td>1/30/1990</td>
<td>$57,400.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>3</td>
<td>Accounting</td>
<td>George</td>
<td>William</td>
<td></td>
<td>1598792</td>
<td>6/4/2005</td>
<td>$56,400.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>4</td>
<td>Accounting</td>
<td>Gluck</td>
<td>Anne</td>
<td></td>
<td>1593309</td>
<td>5/12/2000</td>
<td>$62,000.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>5</td>
<td>Accounting</td>
<td>Jacobson</td>
<td>Doug</td>
<td></td>
<td>1601562</td>
<td>10/26/1996</td>
<td>$70,050.00</td>
<td>$2,400.00</td>
</tr>
<tr>
<td>6</td>
<td>Accounting</td>
<td>Marshall</td>
<td>Alana</td>
<td></td>
<td>1598246</td>
<td>11/10/2003</td>
<td>$42,750.00</td>
<td>$500.00</td>
</tr>
<tr>
<td>7</td>
<td>Accounting</td>
<td>Martina</td>
<td>Wayne</td>
<td></td>
<td>1594468</td>
<td>4/12/2001</td>
<td>$52,000.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>8</td>
<td>Accounting</td>
<td>Pawley</td>
<td>Texera</td>
<td></td>
<td>15993940</td>
<td>1/4/1996</td>
<td>$50,000.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>9</td>
<td>Accounting</td>
<td>Robertson</td>
<td>Kelly</td>
<td></td>
<td>1598228</td>
<td>5/24/1990</td>
<td>$60,000.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>10</td>
<td>Accounting</td>
<td>Russo</td>
<td>Pablo</td>
<td></td>
<td>1586490</td>
<td>1/5/1990</td>
<td>$42,750.00</td>
<td>$500.00</td>
</tr>
<tr>
<td>11</td>
<td>Accounting</td>
<td>Stanowicz</td>
<td>Mary Beth</td>
<td></td>
<td>1993539</td>
<td>10/11/1997</td>
<td>$62,500.00</td>
<td>$1,000.00</td>
</tr>
<tr>
<td>12</td>
<td>Accounting</td>
<td>Woodoff</td>
<td>Elizabeth</td>
<td></td>
<td>1608325</td>
<td>6/23/2003</td>
<td>$70,050.00</td>
<td>$2,400.00</td>
</tr>
</tbody>
</table>

Figure 4-97. A completely transformed Join (Accounting + Compensation) table in the Prepare window.

Tracking Changes

A change history is the record of all changes that have been made to a table. This list can be reapplied to any table that has columns of the same names and data types in the same order. Change histories may be imported and exported and applied to tables similar to that from which the imported/exported change history was created.

Data Prep Studio features a nifty tool through which you can track your data transformations in a stepwise manner. This tool is called Change History and is found as a panel on the right-hand side of the Prepare window.

Figure 4-98. Accessing the Change History panel.

This panel shows each of the changes we performed in the previous exercise.
If you want to undo an operation, select the **Undo Change** button beside that operation.

If you’d like to edit it, select the Edit button.

Note that selecting **Undo** for one operation will also undo all operations after it and that the Change History functionality is only available in the Prepare window.

A complete discussion on Change History is provided [here](#).

**APPLYING A CHANGE LIST TO A DIFFERENT TABLE**

You can drag and drop single changes (using the header of a change) or whole change lists (using the drag-and-drop handle of the Change History panel) to other tables. When you do so, each of the changes specified in the change list are automatically applied in sequence to the new table if the latter has no change history.

![Figure 4-99. The drag-and-drop handle of the Change History panel.](#)

In Figure 4-100, the change list of the table **Join** (Accounting + Compensation) has been dragged to the table **Join(1)** (Data Processing + Compensation). Assuming that both tables contain the same fields but the latter has a different change list, you are asked if you would like to replace the Change History of the latter table.
Figure 4-100. The change list created from the Join (Accounting + Compensation) table was dragged and dropped to the Join(1) (Data Processing + Compensation) table.

If you select **Replace** in the Change List Drop dialog, the exact same changes in the former table are applied to the latter one. If you select **Append**, the change list of the former is appended to the change list of the latter. If a field is hidden and some change must be applied to it, the hidden field is displayed and the change operations are completed.

In another example below, the Change List of the **Join** table (Accounting + Compensation) has been dragged and dropped to the table **Marketing**.

Figure 4-101. The change list created from the Join (Accounting + Compensation) table was dragged and dropped to the Marketing table.
Because the Marketing table does not contain Salary or Bonus fields, the error shown in Figure 4-101 displays.

**EXPORTING A CHANGE HISTORY LIST**

Change History lists may be exported for use in a similar table in another Data Prep Studio session.

**Steps:**

1. Select **Application Menu** > **Export Change List**.

   Alternatively, you can select the **Export Change List** icon on the Change History panel.

2. In the **Save As** dialog that displays, use the **File Location** drop-down to navigate to the folder in which you want to save the exported change list and then enter **ExportChange1** into the File name field.

3. Click **Save** when you are done.

   The export list is saved into the nominated folder with the extension .dpcl.

**IMPORTING A CHANGE HISTORY LIST**

Importing Change History lists allows you to quickly and easily apply changes made to a previous table to a similar table.

**Steps:**

1. Following the steps outlined in **Joining Data in a Data Prep Session**, join the tables **Marketing** and **Compensation** using an inner join and Emp ID as the key.

   The following table displays.
2. Select Application Menu > Import Change List.

Alternatively, you can select Import Change List icon on the Change History panel.

3. Using the Open dialog that displays, navigate to the folder in which you stored ExportChange1, select this file and then click Open.

The Hire Date, Salary, and Bonus fields of the joined table immediately reflect changes.

Viewing the Change List history of the joined table yields the following results:
MODIFYING ITEMS IN A CHANGE LIST

Now that you know that you can reverse changes you have applied to your tables by using the Change History functionality, what happens if you simply want to modify – not reverse – a change, such as a formula field? You can modify changes such as filters and calculated field definitions by clicking on the Edit icon that displays to the right of a change in the Change History list. Note that if this icon does not appear, the change cannot be modified.

Clicking the Edit icon launches the relevant dialog to enable you to modify your change. If you were to modify the calculated field you added to your table in the previous exercise, for example, you would click on the edit button in the change marked

in your Change History list. Doing so will launch the Update Calculated Field dialog, which you can use to update your field definition.
CREATING CUSTOM CHANGE LISTS

Custom change lists apply to a single column of a single data type at a time, similar essentially to a user-defined function. Users can drag any set of changes that apply to a single data type, e.g., text, numeric, date, and then save them with a name for reuse within a workspace.

When the changes are applied to one or more columns on a table they will be recorded in the change history.

Steps:

1. Select the **Edit or Create Custom Change List** button from the Change History toolbar.

   You can also select the drop-down handle of any column in the Prepare window and then select Custom Change.

   The Custom Change dialog box displays.

2. Drag change history items from an existing Change History list to the Custom Change dialog box.

3. Enter a name for the custom change list in the box provided.

   The list is automatically saved and may be applied to a compatible column.
More information on creating custom change lists may be found here.

**Working with Summaries**

Clicking the **Analyze** tab in the Data Prep Studio toolbar launches a drop-down panel that allows you to create and manage summaries.

A summary tabulates information for selected fields and presents the results in a one- or two-dimensional matrix, thereby allowing deeper analysis of your data. For example, suppose you had a table that listed the details of items purchased by various customers over a span of three months from a record store. You can sort this table and see who bought how many copies of what each day but you wouldn’t know how much in total sales each customer produced for the quarter or what percentage their purchases made up in total sales.

![Figure 4-106. An ordinary table, especially very large ones, does not allow deeper analysis of your data.](image)

In this lesson, we’ll learn how to create and work with summaries to address such issues.
Figure 4-107. A summary of total sales and percentage of sales for each customer.

Summaries tabulate information about a single key field (i.e., row). In this summary, the key field is Customer. Any field that is tabulated (or summed) is called a measure. In each the summary shown above, the Amount field is used as the measure.

The most basic summary requires a single key field, in this case, a row (if you are a Monarch Classic user, you will recognize rows as down keys), and a single measure. However, you can create summary reports that include multiple key fields, items, and measures.

You can also add column fields (Monarch Classic users will recognize these as across keys) to your summary such as in the following summary.

**CREATING SUMMARIES**

The following steps describe how to create a simple summary.

Steps:

1. Select the table Classic.pdf from the Prepare window and then click Analyze from the Data Prep Studio toolbar.

   The Analyze drop-down displays.
2. Click **Add Summary** icon to launch the **Add Summary** dialog.

![Add Summary dialog](image)

**Figure 4-108. Creating a new summary.**

Let’s create the summary shown in Figure 4-107.

3. In the **Name** field, replace **Summary** with **Sales by Customer**.

4. From the **Source Fields** panel, click on the **Row** icon for **Customer**. This field is transferred to the Rows panel of the dialog.

5. From the **Source Fields** panel, click on the **Measures** icon for **Amount**. This field is transferred to the Measures panel of the dialog. Use the **Calculation** drop-down provided to the right of the field to select the **SUM** operation.

6. Repeat Steps 5 but this time, choose **PCT** as the calculation operation.

7. Ensure that the box for **Insert total line** is ticked and then specify 1 in **Insert n blank lines before total line**.

8. Click **OK** at the bottom of the dialog to accept your summary definition.

The summary displays in Summary view.
EDITING SUMMARIES

You can edit your summaries in the following ways:

- Select new/remove rows, columns, and measures
- Modify the field names of individual columns
- Suppress duplicate field values
- Insert blank lines to the summary
- Insert total lines to the summary
- Modify the calculation assigned to a given measure

In this example, let’s add Column fields to our summary.

Steps:

1. Use the **Summary** drop-down to ensure that the summary **Sales by Customer** is selected.

2. Click the **Edit Summary** icon to display the Edit Summary dialog.

![Figure 4-109. The Edit Summary dialog.](image-url)
3. Click on the **Column** icon of the field **Media Qty** and then click **OK**.

Your summary should display as follows in Summary view:

<table>
<thead>
<tr>
<th>Customer</th>
<th>BLU</th>
<th>CD</th>
<th>DVD</th>
<th>LP</th>
<th>SACD</th>
<th>SUM(Amount)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Betty's Music Store</td>
<td>353.05</td>
<td>88.85</td>
<td>64.74</td>
<td>507.64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>158.23</td>
<td>29.95</td>
<td>68.31</td>
<td>274.49</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bluegrass Records</td>
<td>122.34</td>
<td>53.91</td>
<td>71.92</td>
<td>248.17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cenciones</td>
<td>379.14</td>
<td>579.14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chet Rudy</td>
<td>275.51</td>
<td>44.95</td>
<td>320.46</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Classic Exchange</td>
<td>209.08</td>
<td>209.08</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Das Piano</td>
<td>225.93</td>
<td>41.93</td>
<td>111.46</td>
<td>541.14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Die Harmonie</td>
<td>100.04</td>
<td>64.46</td>
<td>164.50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Die Melodie</td>
<td>362.96</td>
<td>23.96</td>
<td>88.31</td>
<td>472.83</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fantastico Records</td>
<td>213.90</td>
<td>11.93</td>
<td>225.88</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hope's Sweet Notes</td>
<td>77.90</td>
<td>401.06</td>
<td>59.93</td>
<td>661.97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mo Town Tunes</td>
<td>211.03</td>
<td>23.95</td>
<td>234.99</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musique du Monde</td>
<td>95.90</td>
<td>283.01</td>
<td>-17.97</td>
<td>360.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musique Royale</td>
<td>515.17</td>
<td>80.26</td>
<td>595.43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nectas Musicales</td>
<td>85.08</td>
<td>168.94</td>
<td>10.76</td>
<td>326.96</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reiner's Symphonic Sounds</td>
<td>361.28</td>
<td>68.28</td>
<td>32.55</td>
<td>462.52</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spinning Records</td>
<td>317.06</td>
<td>68.05</td>
<td>11.56</td>
<td>419.64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Glass Harmonica</td>
<td>9.59</td>
<td>211.56</td>
<td>67.20</td>
<td>280.35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The King's Place</td>
<td>203.02</td>
<td>25.13</td>
<td>105.49</td>
<td>333.64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Record Store</td>
<td>17.97</td>
<td>250.50</td>
<td>60.00</td>
<td>328.56</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Grand Total:</strong></td>
<td><strong>286.44</strong></td>
<td><strong>540.11</strong></td>
<td><strong>612.01</strong></td>
<td><strong>475.57</strong></td>
<td><strong>579.05</strong></td>
<td><strong>7356.18</strong></td>
</tr>
</tbody>
</table>

Figure 4-110. The modified summary showing sales as total amounts.

Now, instead of the 149-row table we extracted for Classic.pdf, we have a 20-row summary listing sales for each customer for each media type. This table is clearly much easier to read and you can quickly tell which media type is purchased the most by which customer.

Note that when we created our original summary, we indicated two measures: sales as total amounts and sales as percentages. In our edited summary, only sales by total amounts display. Where did our column for sales as percentages go?

4. Use the **Active Measure** drop-down to select the measure calculation **PCT(Amt)**.
The summary is rebuilt, this time in terms of sales as percentages.

<table>
<thead>
<tr>
<th>Customer</th>
<th>BLU</th>
<th>CD</th>
<th>DVD</th>
<th>LP</th>
<th>SACD</th>
<th>PCT(Amount)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Betty's Music Store</td>
<td>4.8%</td>
<td>1.2%</td>
<td>0.9%</td>
<td>6.9%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>2.2%</td>
<td>0.4%</td>
<td>1.2%</td>
<td>3.7%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bluegrass Records</td>
<td>1.7%</td>
<td>0.7%</td>
<td>1%</td>
<td>3.4%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canciones</td>
<td>5.2%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chez Rudy</td>
<td>3.7%</td>
<td></td>
<td>0.6%</td>
<td>4.4%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Classic Exchange</td>
<td>2.8%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Das Piano</td>
<td>3.1%</td>
<td>0.6%</td>
<td>1.5%</td>
<td>2.2%</td>
<td>7.4%</td>
<td></td>
</tr>
<tr>
<td>Die Harmonie</td>
<td>1.4%</td>
<td>0.9%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Die Melodie</td>
<td>4.9%</td>
<td></td>
<td>0.3%</td>
<td>1.2%</td>
<td>6.4%</td>
<td></td>
</tr>
<tr>
<td>Fandangos Records</td>
<td>2.6%</td>
<td>0.2%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hope's Sweet Notes</td>
<td>1.1%</td>
<td>6.5%</td>
<td>0.6%</td>
<td>0.6%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mo Town Tunes</td>
<td>2.9%</td>
<td>0.3%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musique du Monde</td>
<td>1.3%</td>
<td>3.6%</td>
<td>-0.2%</td>
<td>4.9%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musique Royale</td>
<td>7%</td>
<td></td>
<td>1.1%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notas Musicales</td>
<td>1.2%</td>
<td>2.3%</td>
<td>0.1%</td>
<td>0.6%</td>
<td>4.4%</td>
<td></td>
</tr>
<tr>
<td>Reiner's Symphonic Sounds</td>
<td>4.9%</td>
<td>0.5%</td>
<td>0.4%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spinning Records</td>
<td>4.3%</td>
<td>1.2%</td>
<td>0.2%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Glass Harmonica</td>
<td>0.1%</td>
<td>2.9%</td>
<td></td>
<td>0.9%</td>
<td>3.0%</td>
<td></td>
</tr>
<tr>
<td>The King's Place</td>
<td>2.8%</td>
<td>0.3%</td>
<td>1.4%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Record Store</td>
<td>0.2%</td>
<td>3.4%</td>
<td>0.6%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td>3.9%</td>
<td>73.4%</td>
<td>8.3%</td>
<td>8.5%</td>
<td>7.9%</td>
<td>103%</td>
</tr>
</tbody>
</table>

Figure 4-111. The modified summary showing sales as percentages.

When multiple measures are defined for an across-key summary, you can only view one measure at a time.

**EXPORTING SUMMARIES**

Summaries are exported in the same way ordinary tables are exported in Data Prep Studio, i.e., via the Export window. You can export summaries to Microsoft Excel or CSV.

In this lesson, let’s export the summary we have just created and modified. Here, we’ll export to CSV (the steps performed to export to Excel are similar).

**Steps:**

1. Click **Export** on the Data Prep Studio toolbar.

   The Export window displays.

2. Click on the **Add Export** button of the table **Classic.pdf** and then select **Summary > CSV**.
3. Change the properties specified in the **Export Definition** panel as follows:

![Figure 4-113. Defining a summary export.](image-url)
Exporting Data

You can export tables in Data Prep Studio. Note that you can only export data from the Prepare window. The following export types are supported in Data Prep Studio:

- Microsoft Excel (.xlsx, .xlsm, .xls)
- Delimited text file (.csv)
- IBM Cognos Analytics
- Microsoft Access (.accdb, .mdb)
- Microsoft Power BI
- Tableau Server
- Tableau data extract file (.tde)
- QlikView (.qvx)
- SAS
- JSON

PROPERTY | SPECIFICATION
---|---
Export Location | C:\Users\Public\Documents\Classic.pdf.csv
Summary | Sales by Customer
Active Measure | SUM(Amt)
Include Column Headers | ✔
Delimiter | Comma
Text Qualifier | Double Quote
When File Exists | Overwrite
Encoding Type | UTF-8
Code Page | 

4. Click Export when you have finished.

When the export operation is completed, the Export Results panel displays. If the export was completed successfully, an export link will appear. Clicking on this link launches the folder to which you saved the exported summary.

This section ends our discussion on summaries. If you would like to learn more about how to create, modify, and manage summaries, click here.
You can also export data to the following Altair products:

- Altair Panopticon
- Altair Knowledge Studio
- Altair Knowledge Hub

An overview of the export process and the general details required by each export is provided [here](#).

**EXPORTING TO MICROSOFT EXCEL, DELIMITED TEXT, MICROSOFT ACCESS, TABLEAU TDE, QLIK, SAS, JSON, ALT AIR PANOPTICON, AND ALT AIR KNOWLEDGE STUDIO**

The following example details how exports to Microsoft Excel are performed. Exports to delimited text, Microsoft Access, Tableau TDE, Qlik, SAS, JSON, Altair Panopticon, and Altair Knowledge Studio are accomplished in the same manner.

**Steps:**

1. **Click Export** on the Data Prep Studio toolbar.
   
   The Export window displays.

   ![Image](image.png)

   **Figure 4-114. The Export window of Data Prep Studio.**

2. **Click the + Add New Export button located to the right of the Join(1) (Data Processing + Compensation) table and then select Microsoft Excel from the options that display.**
3. Use the **Browse** button to navigate to the folder into which you want to save your export. Note that Data Prep Studio will remember the export file path that you use so that you do not have to enter or select this each time you export to the same file type.

4. Specify a filename to which your export should be saved.

5. Specify other properties as necessary. Click **here** for a guide to these properties. If you are exporting multiple tables, note that you must specify export properties for each of these tables.

   For this exercise, maintain default values.

6. Click **Export**.

   When the export operation is completed, the results are displayed in the Results panel.

   ![Figure 4-116. Example of a successful export result.](image)

   To view the exported file, click on the export link provided. Doing so copies the path indicated, and you can use your mouse to paste this path into your file explorer to navigate to the location of the file.
EXPORTING TO IBM COGNOS ANALYTICS

Cognos Analytics is a cloud-based application developed by IBM that allows sharing of data and information across workgroups as well as create and/or personalize dashboards and reports on various types of devices.

![Image of IBM Cognos Analytics Welcome page]

Figure 4-117. The Welcome page of Cognos Analytics.

Exporting to Cognos Analytics is only possible through Monarch Complete and Monarch for IBM Analytics.

Some information is necessary to successfully export and work with your data in IBM Cognos Analytics:

- A correctly set up Cognos Analytics service
- Server URL – The URL of your Cognos Analytics service. This URL must be entered into the field provided in the Server tab of the Settings dialog of Data Prep Studio.
- Namespace – The security connection type employed for the service
- Username
- Password

Steps:

1. Go to the **Server > IBM Cognos Analytics** sub-tab of the Application Default Settings dialog and enter the URL of the Cognos Analytics Service you are connecting to. Select **OK** to save your changes.

2. Using the steps detailed in the previous exercise, export the table **Join(1)** (Data Processing + Compensation) to IBM Cognos Analytics.

3. Enter the necessary export information into the Export Properties panel.
4. If you wish to edit the default URL you provided in the Application Default Settings dialog, click the **Edit Defaults** button.

5. Select **Export** when you are finished.

   The IBM Cognos Analytics login page displays.

   ![IBM Cognos Analytics Login](image)

   **Figure 4-119. Entering Cognos Analytics connection information.**

6. Enter the connection information required by the dialog and then click **OK**.

   **NOTE**

   You will need to provide your login information only once per Data Prep Studio session. Subsequent exports to the same service will use the information you provided upon first export to Cognos Analytics.
The table you exported should display in My Content when you log into your Cognos Analytics service.

![Image](image_url)

Figure 4-120. The exported table displays in the My Content page of IBM Cognos Analytics.

**EXPORTING DATA TO MICROSOFT POWER BI**

Data Prep Studio now supports exports to Power BI by creating files that are automatically placed in your Power BI workspace provided that you have a Microsoft Power BI account. Note that you must have a Microsoft Power BI account to execute exports of this type successfully. If you do not have one yet, you can [sign up for an account here](#).

**Steps:**

1. Using the steps detailed in the previous exercise, export the table **Join(1) (Data Processing + Compensation)** to Microsoft PowerBI.

   When filling out the Export Properties panel for this export, note that table names must range from 1 to 100 characters, should not be preceded or followed by whitespace characters, and cannot include any of the following characters:

   - Exclamation point
   - Backslash
   - Quotation mark
   - Dollar sign
   - Percent sign
   - Ampersand
   - Apostrophe
   - Round brackets
   - Asterisk
   - Plus sign
• Comma
• Period
• Slash

When the **Export Selected** button is clicked, the PowerBIforDPS login page displays.

![PowerBIforDPS login dialog](image)

**Figure 4-121.** The PowerBIforDPS login dialog.

2. Enter a valid email or phone number and password into the fields provided in this dialog. Select **Sign in** when you are finished.

The Authorize PowerBI Export dialog displays for first-time users.
3. Click **Accept**.

The export operation is performed and the table is added as a new dataset in your Microsoft Power BI account.

Figure 4-122. First-time users must authorize Microsoft to perform a number of actions to enable access to exports to Microsoft Power BI.

Figure 4-123. The results of the current export operation.
EXPORTING DATA TO ALTAIR KNOWLEDGE HUB

Altair Knowledge Hub is a self-service data preparation and analytics platform that accelerates the exploration and preparation of data, and delivers timely data discovery through automation and distribution across an organization.

Workspaces and data sources may be exported to the Altair Knowledge Hub Library.

To do so, load the Export window. Select the table to export, click on the Export icon beside it, and then select Altair Knowledge Hub from the options that display.

The Altair Knowledge Hub Export window displays. Confirm the details of the indicated Altair Knowledge Hub Server, modify the table/workspace name and folder location as you wish, and then click OK to complete the export operation.

More details on how to export to Altair Knowledge Hub may be found here.

EXPORTING TO TABLEAU SERVER

Data Prep Studio allows you to export to or update existing worksheets in Tableau Server.

However, to be able to do so successfully, you need to have installed the Tableau TABCMD program first. Click here to download and learn more about the utility. To facilitate exports to this application, provide the necessary information (e.g., server URL, username, password, etc.) in the Server > Tableau Server sub-tab of the Application Default Settings dialog.

To export data to Tableau Server, follow the steps outlined below.

Steps:
1. Open the Export window.
2. Select the table you wish to export, click + Add New Export button located to its right, and then select Tableau Server from the options that display.
3. Provide the necessary details in the Export Properties panel. You will need to enter:
   - Export location
   - Data source name
   - Site
   - Publish Type
   - When file exists
   
   Each of these items is described here.

4. Export your table as usual.
Switching from Data Prep Studio to Monarch Classic

To access Monarch from Data Prep Studio, select **Application Menu > Switch to Classic Mode** and then choose **Classic Mode** in the **Choose Startup View** dialog. When launching Monarch Complete for the first time, the **Choose Startup View** dialog displays.

![Choose Startup View dialog](image)

**Figure 4-124. The Choose Startup View dialog.**

The Home screen of Monarch displays.

![Monarch Classic’s Home screen](image)

**Figure 4-125. Monarch Classic’s Home screen.**

When you specify **Classic Mode** as the startup view, sessions after the current one will automatically display the Monarch Classic view when the application is run. Conversely, if you specify **Data Prep Studio** as the startup view, all sessions after the current one will automatically display the Data Prep Studio view when the application is run.

If you wish to work with Data Prep Studio when the startup view is Monarch Classic, click the **Data Prep Studio** button on the Home ribbon.
Congratulations! You have just completed the Data Prep Studio lessons. We hope you have found them to be a helpful introduction to Data Prep Studio’s capabilities.

For additional information not covered by this tutorial, we suggest you thoroughly explore Data Prep Studio’s help system. To do so, simply click the following link:

http://docs.datawatch.com/dps/help/desktop/About_Monarch_Data_Prep_Studio.htm

More documentation on Data Prep Studio is also available on http://docs.datawatch.com/dps/.

The previous lessons reveal that users who wish to open database tables quickly, clean them, and transform them for further application, such as in data visualization, may find Data Prep Studio a great solution to their needs. However, while data extraction from reports and export capabilities are also provided in Data Prep Studio, these features may not be adequate when you want to extract data from some file types, such as .TXT, or export to a specific format not supported by Data Prep Studio. To do these, you will need to work with Monarch Classic.
Monarch Table Extractor is designed for ordinary people who wish to do extraordinary things with PDF files.

Available only with a Monarch Complete with Table Extractor license, the application allows you to identify tables in text-heavy PDF files, select them, modify them if you wish, and then export them to Data Prep Studio for further data preparation.

Figure 5-1. A typical Monarch Table Extractor workflow.

Monarch Table Extractor provides easy-to-use interfaces to perform the following:

- Automatically look for and define tables in a document
  - within a page,
  - in all pages, or
  - in specific pages.
- Modify tables that have been defined (e.g., modify headers, rename columns, and delete columns)
- Create a custom table
- Export tables to Monarch Data Prep Studio

The lessons outlined in this tutorial provide a very brief overview of what you can do with Monarch Table Extractor. To learn more about this application, click here.
Launching Monarch Table Extractor

Launch Monarch Table Extractor by selecting Start > All Apps > Altair Monarch 15 > Altair Monarch 15 Table Extractor.

The Altair Monarch Table Extractor start page displays.

Figure 5-2. The Monarch Table Extractor Start page.

Opening a Document

The easiest way to open and work with a document is to drag it to the Monarch Table Extractor interface.

The following typical example describes how to open a pdf document and define tables, using a file named Canaccord 042215.pdf. If you do not have access to this document now, simply follow along with this tutorial.

Steps:

1. Navigate to the location of Canaccord 042215.pdf.
2. Drag Canaccord 042215.pdf to the Monarch Table Extractor start page.
Figure 5-3. Starting a Monarch Table Extractor session.

*Canaccord 042215.pdf* is loaded into Monarch Table Extractor.

Figure 5-4. The loaded document.

You can also do the following:

- Select the **Open PDF** button on the **Start** page, and use the standard **File Open** dialog box to locate your document and open it.
Select Open from the Application Menu, and use the standard File Open dialog box to locate your document and open it.

![Monarch Table Extractor’s Application menu](image)

Defining Tables

Define one or all tables by selecting any one of the following from the Table Actions panel:

- Auto Define Page
- Find All Tables
- Find Tables from Pages

For this session, let us auto-define a page. In this section, we will auto-define tables, verify the tables, and delete one of them.

AUTO-DEFINING A PAGE

Select Auto Define Page to ask Monarch Table Extractor to look for and then automatically define all tables in the current page.

Steps:

1. While Page 1 of Canaccord 042215.pdf is displayed, select Find Tables > Auto Define Page from the Table Actions panel.
Monarch Table Extractor looks for data arranged in a tabular structure and converts these into actionable tables.

VIEWING AND MODIFYING A TABLE

Data from the tables are displayed on the table panel.

In addition, a Page/Table list shows the page where a table is located and all the tables defined for that page.

Steps:

1. Select **Page 1 – Table 3** on the Page/Table List.

   The table is highlighted on the document, and the values for the table are displayed on the Table panel.
On the document, the table looks like this:

```
FYE Sep | 2014A | 2015E | 2016E
---|---|---|---
Sales (US$M) | 35.1 | 30.6 | 36.5
Previous | 35.1 | 30.5 | 36.5
EV/Sales (x) | 1.1 | 1.7 | 1.6
EPS Non-GAAP (US$) | (0.53) | 0.015 | 0.43
Previous | (0.53) | 0.017 | 0.43
EBIT Margin (%) Non-GAAP | (27.3) | (38.2) | (12.1)
```

The table is surrounded by a dashed border with handles. Headers (which may be separate from the table) are highlighted in pink. Columns are highlighted in blue.

2. Do one of the following to modify a table or its elements:
   - Right click on a table, header, or column to display context menu items.
Select a table, and then click on a column, to select the column.
Select a table, and then click on a header, to select the header.
• Select specific text via drag-and-drop to display additional context menu items as well.

![Figure 5-11. Selecting specific text via drag and drop.](image)

The context menu items that display will allow you to
• create a new column,
• delete columns,
• exclude values from a table,
• combine tables,
• define a table title,
• modify headers, and
• delete spaces from header and table values.
DELETING A TABLE

You may not need all the tables defined by Monarch Table Extractor. You can easily delete tables via the context menu or the Table panel menu.

Steps:

1. Select **Page 1 – Table 1** on the Page/Table List.

   This table is highlighted:

   ![Image](image)

   **Figure 5-12.** Selecting a table to delete.

   Although this looks like a table, the values are not related as columns or rows. We can delete this table.

2. Right-click on **Page 1 – Table 1** on the Page/Table List.

   A context menu displays.

   ![Image](image)

   **Figure 5-13.** Deleting the selected table.

3. Select **Delete Table** from the context menu.

Exporting Tables

After defining your tables, you can export them to Monarch Data Prep Studio. Once the tables are exported and loaded, you can work on them using Monarch Data Prep Studio's features.

Note that you MUST manually launch both Monarch Table Extractor and Data Prep Studio to enable successful export.
Steps

1. Right-click on **Page 1 – Table 3** on the Page/Table list.
   - A context menu displays.

   ![Figure 5-14. Exporting a table in Monarch Table Extractor to Data Prep Studio.](image)

2. Select Export Table to DPS.
   - Alternatively, you can select the table on the Table Panel, and then select **Export Table to DPS** on the Table Panel Menu.

   ![Figure 5-15. An alternative method to export tables to Data Prep Studio.](image)

This chapter introduces you to the Monarch lessons.

These lessons are designed to quickly acquaint you with basic program operations. For additional material not covered in this guide, consult the Monarch Help file by selecting File, clicking on the Help button menu, and then selecting Help Topics.

- Chapter 7 – Working in Report View
  Shows you how to load a report file, navigate the report on screen, look up information in the report, copy selected data to other applications, and print pages from reports.

- Chapter 8 – Extracting Data from a Report
  Shows you how to create a template to extract data from a simple columnar report, view the data in the Table view, and save the template to a Monarch model file.

- Chapter 9 – Special Data Extraction Techniques
  Deals with special problems caused by address blocks, fields that run together in a report, and data presented in multiple columns.

- Chapter 10 – Working in Table View
  Shows you how to load and navigate through a table, format fields, create headers and footers, print table data, and copy data to other applications.

- Chapter 11 – Working with Sorts
  Shows you how to sort the table, create multiple sort definitions, select a sort definition, and save sort definitions.

- Chapter 12 – Working with Filters
  Shows you how to use a filter to select records based on any field value, create multiple filters, utilize value-based filters, select an active filter, and save filter definitions.

- Chapter 13 – Working with Calculated Fields
  Shows you how to create calculated fields to add information to the table database.

- Chapter 14 – Working with Multiple Instances of a Report
  Shows you how data extracted from multiple reports may be sorted and analyzed in Table view.

- Chapter 15 – Extracting Multiple Line Fields
  Shows you how to extract a multiple line text block from a report. It also introduces memo fields, which are used to hold the contents of a multiple line field, and covers exporting and printing memo fields.
❑ Chapter 16 – Summaries
Teaches you how to create a summary report from your Monarch data, specify summary design preferences, and create quick summaries.

❑ Chapter 17 – Advanced Summary Capabilities
Shows you how to reveal even more information about your data via Monarch’s advanced summary features.

❑ Chapter 18 – Exporting Operations
 Discusses how to export reports, tables, and summaries.

❑ Chapter 19 – Importing Data from HTML and External Databases
 Discusses how to import data from various external sources.

❑ Chapter 20 – Creating External Lookups
 Discusses how external lookups are performed in Monarch.

❑ Chapter 21 – Using Digital Signatures
 Discusses how digital signatures are added to some exports in Monarch and viewed in Microsoft Excel.

❑ Chapter 22 – Using Pivot Tables
 Discusses how pivot tables are added to some exports in Monarch and viewed in Microsoft Excel.

❑ Chapter 23 – Working with Asian (CJK) Character Sets
 Discusses how to work with documents using Asian character sets

❑ Chapter 24 – Using Monarch Utility
 Discusses how to use Monarch Utility to perform a number of functions.

Installing Lesson Files

When installing Monarch, the last screen of the Monarch Setup program provides a checkbox that asks whether to install the lesson files.

When this box is ticked, the Setup program will install the lesson files in the appropriate folders under the Altair Monarch folder in C:\Users\Public\Documents. You can change the location of these folders later on.

Note that the lessons in this learning guide assume that the lesson files are stored in their default locations.
The Options Interface

The **Options** interface allows users to configure several universal Monarch settings, including folders, input information, views, and exports, among others.

![Options Interface Image]

Figure 6-1. The Options window.

Clicking specific buttons on the **Options** ribbon exposes settings you can modify. When you have modified the settings as you wish, simply click **Accept ✔️** to accept your changes and close the interface. You may specify several options before selecting **Accept ✔️**. Select **Cancel ✗** to disregard any changes you made and close the interface. In this case, none of the previous settings are modified.

The following table summarizes the functions of each of the buttons in the **Options** ribbon.

<table>
<thead>
<tr>
<th>Use this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Accept</td>
<td>Accept the changes you made and close the interface</td>
</tr>
<tr>
<td>✗ Cancel</td>
<td>Cancel the changes you made and close the interface</td>
</tr>
<tr>
<td>📁 Folders</td>
<td>Expose folder settings</td>
</tr>
<tr>
<td>📂 Input</td>
<td>Expose input settings</td>
</tr>
<tr>
<td>🖼 View</td>
<td>Expose view settings</td>
</tr>
<tr>
<td>⚙️ Export</td>
<td>Expose export settings</td>
</tr>
<tr>
<td>📌 Clipboard</td>
<td>Expose clipboard settings</td>
</tr>
<tr>
<td>Use this button...</td>
<td>To...</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>🔄 Security</td>
<td>Expose security settings</td>
</tr>
<tr>
<td>🕒 Altair Monarch Server Library</td>
<td>Expose Altair Monarch Server Library settings</td>
</tr>
<tr>
<td>🕒 Time Intervals</td>
<td>Expose time interval settings</td>
</tr>
<tr>
<td>🕒 Advanced</td>
<td>Expose advanced settings</td>
</tr>
<tr>
<td>🕒 Cache</td>
<td>Expose caching options</td>
</tr>
<tr>
<td>🕒 Themes</td>
<td>Expose theme settings</td>
</tr>
<tr>
<td>🕒 Help</td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>

More information on each of the settings available in the Options window is available [here](#).
In this chapter, you will learn how to work in Report view. Lesson topics include:

- Starting a Monarch session
- Opening report files
- Navigating through reports
- Using bookmarks
- Copying data from reports
- Printing data from a report
- Using PDF and XPS files

Most computer applications produce reports as output. Monarch is unusual because it uses reports as input. A Monarch session begins when you open an existing report. The report displays in Report view.

The Report view gives you a scrollable view of your report. You can move around, look things up, copy data to other applications, and print pages on your local or network printer. In this lesson, you will learn the basics of these operations. In later lessons, you will learn how to extract and export data from reports.

Opening Report Files

In Monarch, you can open either one or several reports (up to 1,024 reports!) in a single session.

OPENING A SINGLE REPORT FILE

To begin working with Monarch, you need to open a report file. We use the term “report file” to describe any computer report stored on disk. These files are often referred to as print, spool, TXT, PRN, SDF, PDF, and formatted or fixed-width text files.

Several report files are provided in each Monarch install for use with these lessons. In this lesson, we will first open single report files and then open multiple report files later.
NOTES

Monarch opens a report as a "read-only" file. Monarch can write a new file with data extracted from the report, but the original report remains safe because it cannot be altered.

You can also open reports in zip files or web and other locations.

If you have set up Altair Server Library credentials in the Options interface, you can even open files located in the specified Altair Server Library.

Let’s open a report file, in this case, ClassJan.prn.

Steps:
1. Launch the Monarch Classic application.
2. On the File tab, select **Open > Report > Computer**.

![The Open Report dialog.](image)

The *Open Report* dialog appears. The *Files* list displays all the files in the *Reports* folder with a DAT, PRN, RPT, SDF, or TXT extension. If you don’t see a list of files, make sure you are viewing the *Altair Monarch > Reports* folder and that the file type is set to *Print Files (*.dat, *.rpt, *.prn, *.sdf, *.txt)*, as shown in Figure 7-1.

3. Select **ClassJan.prn** and then click **Open**.
Monarch displays a softcopy of the report in Report view. The report shows customer shipments for a distributor of classical music recordings for the month of January.

![Monarch Report View](image)

**Figure 7-2. The ClassJan.prn shipping report.**

**OPENING MULTIPLE Instances OF A REPORT**

The procedure for opening multiple instances of a report is similar to that required to open a single report.

Since the January shipping report was opened in the previous lesson, we begin this lesson by opening the February shipping report.

**Steps:**

2. Click on **ClassFeb.prn** and then choose **Open**.

   For each additional report you open, Monarch displays the **Retention Options** dialog.
This dialog prompts you to discard or retain any currently open reports and model parameters before opening the new report.

![Retention Options dialog](image.png)

**Figure 7-3. The Retention Options dialog.**

To replace the existing report and model with a new report, leave the *Retain Current Reports* and *Retain Current Model* check boxes unchecked. Since we want to open a new report without closing the currently open one, we'll choose to retain current reports.

3. Ensure that **Retain Current Reports** is selected and then click **OK**.

   The February shipping report replaces the January report in Report view. Note that Monarch does not create a separate window to display each report. Instead, all open reports are viewed in one Report view, with a single report displayed at a time. You can select another report to view by clicking on it in the Report selector. The Document Selectors list all of the open reports, tables, and summaries in each Monarch session.

   Let's open the March shipping report.

4. Select **File > Open > Report > Computer**.

5. Click on **ClassMar.prn** and then choose **Open**.

   This time the *Retain Current Reports* check box is already selected.

   By preserving your most recent dialog settings, Monarch saves you a step each time you open a new instance of the report.

6. Choose **OK**.

   The March shipping report is opened and displayed in Report view.
Getting to Know Report View

THE REPORT VIEW INTERFACE

Let’s take a minute to explore what you can find in the Report interface.

![Figure 7-4. The Report interface.](image)

The Report interface is divided into three distinct areas. The Report ribbon is located on the top-most portion of the interface and spans the entire width of the screen. This ribbon will allow you to perform many of the report functions made available by Monarch. The Report selector displays as a panel on the left-hand side of the interface. You can choose specific reports to view from this selector, a functionality that is especially handy when you have multiple reports open. Finally, the actual report is displayed on the right-hand portion of the interface.

Right-clicking in the Report selector launches a context menu that will allow you to:

- Reopen a file
- Close the current report
- Print a report
- Quick-print a report
- Launch Print Preview
- Create an export
Export the current report
View file information

THE REPORT VIEW RIBBON

The following table summarizes the functions of each of the buttons in the Report ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>❖ Report Design</td>
<td>Launch the Report Design interface</td>
</tr>
<tr>
<td>❖ Auto Define</td>
<td>Automatically creates a template (or sets of templates, if applicable) for an open report. Note that this feature is only enabled in Monarch Complete and that the resultant model is applied to all other open reports.</td>
</tr>
<tr>
<td>❖ Font Style</td>
<td>Select a font style</td>
</tr>
<tr>
<td>❖ Font Size</td>
<td>Select a font size</td>
</tr>
<tr>
<td>❖ Zoom to Fit</td>
<td>Automatically resize the report into the available Report view using the best possible fit</td>
</tr>
<tr>
<td>❖ Greenbar</td>
<td>Add greenbar shading to the report</td>
</tr>
<tr>
<td>❖ Select All</td>
<td>Select all of the text in the report</td>
</tr>
<tr>
<td>❖ Copy</td>
<td>Copy text from the report</td>
</tr>
<tr>
<td>❖ Search</td>
<td>Search for information from the report</td>
</tr>
<tr>
<td>❖ Find in Table</td>
<td>Find the table entry corresponding to a specific line in the report</td>
</tr>
<tr>
<td>❖ Previous Report</td>
<td>Go to the previous report if multiple reports are open</td>
</tr>
<tr>
<td>❖ Previous Page</td>
<td>Go to the previous page of a multiple-page report</td>
</tr>
<tr>
<td>❖ Go to Page</td>
<td>Go to a specific page of a multiple-page report</td>
</tr>
<tr>
<td>❖ Next Report</td>
<td>Go to the next report if multiple reports are open</td>
</tr>
<tr>
<td>❖ Next Page</td>
<td>Go to the next page of a multi-page report</td>
</tr>
<tr>
<td>❖ Go to Chunk</td>
<td>When chunking options have been defined, this button allows you to move to a specific chunk</td>
</tr>
<tr>
<td>❖ Bookmark</td>
<td>Add a bookmark to a specific record</td>
</tr>
<tr>
<td>❖ Next Bookmark</td>
<td>View the next bookmark</td>
</tr>
<tr>
<td>❖ Previous Bookmark</td>
<td>View a previous bookmark</td>
</tr>
</tbody>
</table>
### USE THIS BUTTON…

<table>
<thead>
<tr>
<th>USE THIS BUTTON…</th>
<th>TO…</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clear Bookmark" /></td>
<td>Clear all bookmarks</td>
</tr>
<tr>
<td><img src="image" alt="Report Index" /></td>
<td>Display or define the report index</td>
</tr>
<tr>
<td><img src="image" alt="PDF/XPS Options" /></td>
<td>Specify character spacing options when opening PDF/XPS files</td>
</tr>
<tr>
<td><img src="image" alt="Chunk Options" /></td>
<td>Launches the Set Chunk Options dialog, which you can use to define smaller portions (chunks) of very large reports</td>
</tr>
<tr>
<td><img src="image" alt="Open as a Table in Data Prep Studio" /></td>
<td>Open the report as a table in Data Prep Studio</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>

### THE REPORT VIEW CONTEXT MENU

When you open a report in Report view and right-click on your mouse, a context menu displays. This menu will allow you to:

- Run Report Verify
- Copy text
- Copy as table
- Search for a record
- Find in table
- Add, edit, or remove bookmarks
- Add a new template
- Zoom to fit
- Print
- Print preview
- Export the report to a PDF or TXT file
- Change the encoding applied to the report file
- Launch the Report Design view

Each of these abilities will be discussed in detail throughout this learning guide.
Navigating Through Reports

Although the softcopy report looks just like its hardcopy cousin, you can use Monarch to zoom, scroll, page, jump, and quickly find information within it. These tasks would be a lot more difficult to carry out with a hardcopy report. Let’s look at some of the benefits of viewing and exploring a softcopy report on screen using the three files we opened previously. Make sure that you select the Report tab before you begin.

THE REPORT SELECTOR

Report view opens and Monarch also displays, by default, a panel on the left side of the screen: the Report selector.

Clicking on any report in the Report selector opens the report in Report view. The Search box allows you to search for open reports. This functionality would be useful if, for example, you had a large number of open financial reports and want to search specifically for sales reports for a certain year.
Right-clicking on the Report selector displays a context menu that will allow you to perform the following operations:

- Reopen a report
- Close a report
- Print a report
- Quick print a report
- Preview a report before printing
- Export (all files)
- Export a selected file
- View the File Information dialog (includes details on file path, size, last modified date)

**ADDING GREENBAR**

Because Monarch operates in a graphical environment, you can adjust the display to enhance readability and suit your own visual preferences. Monarch can display a greenbar effect on the screen, which helps your eyes track across sparse columns in a wide report. If you prefer not to display greenbar, however, you can easily remove it.

**Steps:**

2. The report displays with greenbar shading.

---

**Figure 7-7. The report displayed with greenbar shading.**
3. To remove greenbar shading, simply select Greenbar again.

CHANGING FONTS AND FONT SIZES

Monarch allows you to change the font and font size used to display reports on screen.

Steps:

1. To change the font, in the Report ribbon, click the drop-down button on the Font Style box.

Only non-proportional fonts with fixed letter spacing are available because report columns may appear misaligned if proportionally spaced characters were used.

2. Select the Lucida Console font from the list.

   The font style is changed throughout the entire report.
You may change the font size to zoom in or out on a report.

Steps:

1. Click the drop-down button on the **Font Size** box.

![Font Size](image)

Figure 7-9. Changing font sizes.

Font sizes vary depending on the font style selected.

If the size you want isn’t available, use the font list to select another font. You can let Monarch select the font size for you using the **Zoom to Fit** command. This selects the font size that best matches the report width to the display width, so you can view the entire width of the report on screen.

2. To change the font size to match the report width to the display width, from the **Report** ribbon, select **Zoom to Fit**.

If the report is too wide to fit on screen even at the smallest available font size, Monarch will select the smallest font size to fit as much of the report width as possible in the available display area.

**MOVING TO THE NEXT PAGE OF A REPORT**

It can be a tedious chore to dig through page after page of a big hardcopy printout. With softcopy reports on screen, however, your computer does most of the work for you. Monarch lets you move around with just a few clicks of your mouse.

Like most Windows applications, Monarch provides a vertical scroll bar to help you scroll through a report. You can scroll through the report by pressing the up or down arrow on the scroll bar or by clicking and dragging the slider with your mouse.
For example, the following figure shows Page 8 of the ClassJan report.

![Figure 7-10. Scrolling through a report.](image)

To move through the different pages of a report, you can:

- Use the **Previous Page** button
- Use the **Next Page** button
- Use the **Go to Page** button

When you select the **Go to Page** button, the Go to Page dialog displays.

![Go To Page](image)

Figure 7-11. The Go to Page dialog.

Enter the desired page (e.g., 8) into the **Page Number** field and then click **OK**. Monarch displays the specified page in Report view.

Dotted lines indicate page breaks. Monarch relies on page break characters in the report file to determine where breaks belong. If breaks are not explicitly defined in the report file, Monarch breaks pages after a fixed number of lines.

To move left or right, press the left or right arrows on the horizontal scroll bar or drag the slider with your mouse.
MOVING THROUGH SEVERAL REPORTS

To move through different reports when multiple reports are open, you can:

- Use the **Previous Report** button
- Use the **Next Report** button

FINDING INFORMATION IN A REPORT

It’s not always easy to find information buried deep in a hardcopy report. If you’re looking for a particular invoice in a report that is 75 pages long, for example, you can spend a lot of time and effort reading each page and you may not even find the report you want. Fortunately, Monarch can search reports at lightning speed to find whatever you want. Suppose you want to find all references to the composer, Mozart. You can use the **Search** function for this.

**Steps:**

1. Select the ClassJan.prn report and ensure that you are on its first page.

2. Select **Search** from the Report ribbon.

   A *Search* box displays on top of the Report view.

![Figure 7-12. The Search panel.](image)

3. Type **Mozart** in the *Search* field and then click **Find Next**.
The first occurrence of Mozart in the report will be highlighted. By default, search items are returned in a top-down manner. To search in a bottom-up manner, check the **Search Up** box among the **Search** options.

4. Continue clicking the **Find Next** button to locate the next instances of Mozart.

**NOTES**

You can make searches case-sensitive by selecting **Match Case**.

The option **Search all reports** allows you to locate all instances of the search item in all open reports.

5. Close the panel by clicking the **Close X** icon to the right of the Search box.

**Specifying and Moving Through Chunks**

Large reports can be divided into more manageable "chunks." A 100-page report, for example, can be divided into 5-page chunks. Once defined, users can select which chunk (e.g., the third chunk or pages 11-15) to load when the report is opened in Classic. Monarch then extracts and processes only this particular chunk of the report.

Note that when a report in which chunking has been enabled is exported, the entire report is exported, as chunking is designed to limit the data loaded in Table View, not the actual report.

**Steps:**

1. Using ClassFeb.prn, click **Chunk Options** in the Report ribbon.
   
   The **Set Chunk Options** dialog displays.

2. Tick the box marked **Enable breaking report into chunks** to begin defining chunks. Note that if this box is unchecked at any time during your Monarch session, your chunk definitions will not be not applied to the report.

3. Set a chunk size of 2 pages and specify a chunk to load of 2.
Monarch loads pages 3-4 of your report only. Note how all other report pages above and below pages 3-4 are grayed out. When performing trapping operations, you will be able to trap on these two pages only.

Figure 7-13. Viewing chunk #2 as defined in the Set Chunk Options dialog.

Chunking options apply to all open reports. A quick look at ClassJan.prn and ClassMar.prn should show the same results as in ClassFeb.prn.

4. Move through chunks by clicking on the Go To Chunk icon in the Report ribbon. Enter 4 into the dialog that displays.

Monarch loads only pages 7-8 of ClassFeb.prn (and ClassJan.prn and ClassMar.prn).

5. Before moving forward with our lessons, click Chunk Options in the Report ribbon once more and then untick the box for Enable breaking report into chunks.
Using Bookmarks

Monarch allows you to set bookmarks within a session that can be used to navigate quickly between certain lines or sections of a report. You can even annotate bookmarks.

**NOTE**

Although bookmarks aren’t saved in model files, they are saved in project files. When exporting to a PDF file while in the Report view, bookmark comments will be displayed as comments within the PDF file.

Let’s set bookmarks for Spinning Records.

**Steps:**

1. Use the search tool to locate **Spinning Records** in the **ClassMar.prn** report.
2. Click in the left-hand margin next to **CUSTOMER** to highlight that line.
3. Select **Bookmark** from the Report ribbon. The **Add Bookmark** dialog displays, and this dialog will allow you to add a comment to your bookmark. Let’s try doing this.

   ![Figure 7-14. The Add Bookmark dialog.](image)

4. Type whatever text you’d like (e.g., **This is a bookmark comment.**) and then click the **OK** button. A bookmark indicator appears on the left-hand margin next to the highlighted line of text.
5. Place your mouse pointer over the bookmark indicator. The text you typed is displayed.
Figure 7-15. A bookmark is added to Spinning Records.

NOTE

You can click the OK button on the Add Bookmark dialog without actually entering a comment if you wish. To prevent the Add Bookmark dialog from displaying on a specific bookmark, clear the Show when adding check box.

You can move through bookmarks by clicking either Next Bookmark or Previous Bookmark from the Report ribbon. To remove a specific bookmark, select the bookmark you would like to remove and then click the Bookmark button from the Report ribbon. To clear all bookmarks, select Clear Bookmark from the Report ribbon.

Copying Data from Reports

Monarch makes it easy to transfer report data to other applications. Just copy and paste! When you copy data from a report, Monarch creates both a text image and a worksheet image with separate columns and cells in the clipboard.

Let’s copy a customer’s name and address into your word processor. You might use this feature, for example, if you want to insert this name and address into a letter.
Steps:

1. Go to the first page of the ClassJan.prn report.

2. Click at the beginning of the customer’s name (Betty’s Music Store in this case) and drag diagonally down to the right to highlight the entire customer name and address, as in Figure 7-16.

![Figure 7-16. Copying a portion of the report.](image)

3. Select Copy from the Report ribbon.

4. Launch your word processor.

5. Position the cursor where you want the address to appear and use your word processor’s Paste (CTRL + V) command to insert the address into the document.

![Figure 7-17. Pasting to a word processor.](image)

6. Exit your word processor without saving the document and return to Monarch.
NOTE

If you wish to copy all of the text in the report, select the Select All button on the Report ribbon (or click CTRL + A on your keyboard) before clicking the Copy button.

Printing from a Report

Monarch lets you print from the Report view. You can print a block of text, a page or series of pages, or the entire report. Let’s print a single page from the report. We’ll begin with Print Preview to see how the page will look before producing the actual printout.

Steps:

1. Return to the first page of ClassJan.prn and click File > Print > Print Preview. The Print Preview window displays.

Figure 7-18. The Print Preview Window.
2. Examine the Print Preview window to see if your settings for font size, margins, and page orientation are appropriate to produce satisfactory output. If not, you can change the settings until everything looks just right. We'll change settings in a minute, but, first, we'll see how the Print Preview window works.

3. Click **Zoom** on the upper left-hand corner of the window to zoom in or out.

4. Click the **Next Page** or **Previous Page** icons located at the bottom of the window to move forward or back.

Now, we'll adjust our page orientation, margins, and font settings. On many printers, the Classic report prints nicely with a portrait page orientation, half-inch margins, and a 9-point font. You may need to experiment to find the right settings for your printer.

5. Select the drop-down button of the **Page Orientation** menu to confirm that the page orientation is set to **Portrait**.

6. If you wish to change page margin settings, select **Page Setup** to launch the **Page Setup** dialog and adjust the margin settings as necessary for your printer by double-clicking on the margin you wish to modify and entering your desired value. Note that the Page Setup dialog can also be accessed by clicking **File > Page Setup**.

![Figure 7-19. The Page Setup dialog.](image)

Select **OK** when you are finished making your changes.

7. When satisfied, close the Print Preview window by clicking the **Close** button on the upper right-hand corner of the window.

8. Select **File > Print > Print**. We'll print Page 5 of the current report.
9. Select the printer you would like to use for this print operation.

10. Select the **Pages** radio button and then type **5** into the **Pages** box.

11. Select **Print**.

   The selected page will be printed. Monarch prints report pages as composed in the report file. Because Monarch adopts pagination from the report file, you must be careful to select an appropriate font size and margin settings to ensure that the full report image will fit on each page. Lines that do not fit will be carried over to a subsequent page, and columns that do not fit will be truncated.

## Closing Reports

During each Monarch session, you may wish to use specific report files and thus need to close other reports. Let’s do that now.

**Steps:**

1. Ensure that the report **ClassMar.prn** is selected in the Report selector.

2. Select **File > Close** 📄 > **Report** 📄.

   If you had other files open, such as a model, a database file, or a project, that you wish to close, you can also select these from the options presented when you select **Close**.
3. A message box displays to confirm closure of ClassMar.prn. Click **Yes** if you wish to continue.

   The selected report is closed and the Report selector displays the two remaining open reports.

   Repeat Steps 1–3 to close the remaining reports.

   If you had both report and model files open and wished to close these files at the same time, you can use the **Close All** command, which is called when you select **File > Close All**. When this command is called, you will be asked whether to save model changes if you defined templates during the Monarch session.

**Using PDF and XPS Files**

Monarch can convert PDF/XPS files into text so that they can be utilized like any normal text report in Monarch. You can then create data extraction templates to extract information in exactly the same way as you would approach a text report file.

PDF/XPS is an open standard, and there are many different applications that can create PDF/XPS files using many different techniques. This has the side effect of having PDF/XPS files that may look identical on screen but are structurally very different internally.

Monarch uses very sophisticated techniques to analyze and reformat data and then produce the best possible "Monarch-friendly" results to enable accurate trapping after a PDF/XPS report is imported.

Despite these technologies, however, some poorly formatted and unusual PDF/XPS files may not convert accurately enough to enable easy trapping in Monarch. Files that do not convert perfectly may still be processed very effectively by Monarch via features such as the floating trap and calculated fields, each of which will be discussed in detail in later lessons.

For now, let’s begin by importing a PDF file into Monarch.

**Steps:**

1. Click **File > Open ➔ Report > Computer** to display the **Open Report** dialog.

2. Select the **Adobe PDF files (*.pdf)** option from the **Files of Type** drop-down list, select the **ClassJan.pdf** file, and then click the **Open** button to open the report in the **PDF Import Options** window.

   ClassicJan.pdf is a PDF version of the ClassicJan.prn report, which we are already familiar with.
Figure 7-21. The opened PDF file.

3. For now, simply select **Accept** on the **PDF Import Options** window to display the report.

   To import an XPS file into Monarch, follow the same procedures outlined above, but choose the **XPS files (*.xps)** option from the **Files of Type** drop-down list instead.

When opening a PDF/XPS file, Monarch analyzes the file to try and determine the optimum method of transforming the data accurately. In most cases, Monarch's auto-detection routines will produce the best results, but, under certain conditions, adjustments to the PDF/XPS import options may be necessary. For example, the following conditions may require the PDF/XPS import options to be adjusted:

- The PDF/XPS contains tables with tightly compacted columns.
- The PDF/XPS contains multiple font sizes and the data of interest are in a smaller font than most of the other text in the PDF, thereby causing the auto-calculated font size to be too large.
- Mixed mono- and variable-spaced fonts exist in the PDF/XPS where the data of interest uses mono-spaced fonts.
- Mixed freeform and tabular data exist in the PDF/XPS.

Let's examine the PDF/XPS import options more closely and see how adjusting them will affect the transformation of data.
THE STRETCH OPTION

The stretch option governs how much spacing is used during the conversion process. When Monarch analyzes a PDF/XPS file, it tries to match the spacing as closely as possible to the original document. However, many factors can make it necessary to introduce more spacing into the conversion than appears to exist in the original file, including hidden data in the PDF/XPS file itself, i.e., data which are not visible on screen but still exist within the file. For example, in columns with truncated data, missing data may not be apparent at first glance, but Monarch will still convert all of the data in the PDF/XPS file, not just what might be visible in a PDF/XPS viewing application. In this case, to try and maintain proper column justification, Monarch will recalculate and pad the text spacing, as the original column spacing may not be adequate to hold the data safely.

In general, Monarch uses a larger amount of spacing (i.e., a higher stretch value) than that applied in the original document, which can make the document look like it is stretched wider than the original PDF/XPS. The application errs on the side of caution, so that columns do not run into each other in a document. This is also done so that if a later iteration of the same report (or a similar one) contains wider data values, the model will still “work” with it.

If you know your reports well, you can decrease the stretch value to make the reports look more presentable by avoiding horizontal scrolling or very small font sizes in the Report view.

Stretch values may be increased or decreased via the PDF/XPS Import Options window, which is launched when you select PDF/XPS Options in the Report ribbon or when you open a PDF/XPS file.

THE MONO-SPACED OPTION

Monarch’s Report view uses mono-spaced fonts, which are fonts bearing characters with the same width. For example, in a mono-spaced font, the “o” and “i” characters would have the same width (i.e., they would take up the same amount of horizontal space on a line). Other terms for mono-spaced are fixed-width and non-proportional.

NOTE

The opposite of mono-spacing is proportional spacing, in which different characters have different widths, e.g., in a proportionally spaced font, the letter “o” would be wider than the letter “I.”

Note that the Monospaced option is selected by default in the PDF/XPS Import Options window. When you import a PDF/XPS file into Monarch, Monarch tries to detect when mono-spaced fonts are used and optimizes the conversion accordingly. In some cases, Monarch may not detect that mono-spaced fonts were used for the PDF/XPS file. When this failure occurs, it is usually due to the simultaneous presence of mono-spaced and proportional fonts in the same PDF/XPS file. If you know that the PDF/XPS file uses mono-spaced fonts, and the Monospaced option is not selected during the import analysis, you can select this setting to force Monarch to optimize for mono-spaced fonts.
While proportionally spaced fonts look more appealing, mono-spaced fonts are superior for tabular data because the uniform width of each character makes alignment of columns easier.

**NOTE**

In general, PDF/XPS files generated using mono-spaced fonts will convert more successfully. Thus, if you are trying to optimize your PDF/XPS-producing application for Monarch, use mono-spaced fonts. Some of the more common fonts include Andale Mono, Anonymous, Crystal, Bitstream Vera Sans Mono, Courier, Courier New, Elronet Mono-space, Everson Mono Latin 6, Fixedsys, Lucida Sans Typewriter, Lucida Console, and PrestigeFixed.

**THE FREEFORM OPTION**

The Freeform option tries to optimize text that is more free-form than columnar or grouped columnar. A columnar document is a simple table format, where grouped columnar might be something similar to one of the Monarch sample reports, such as Classic.pdf.

A typical document that might benefit from using this setting would be an academic report that is 95% text, but which contains a few tables you want to extract. Selecting this setting will sometimes work effectively on columnar documents when the default settings do not produce good results.

**THE CROP OPTION**

The crop feature allows you to crop the outer edges of a document. For example, you may have a document printed from a website that has graphics or other non-tabular information around its edges that is unnecessary. Using the crop feature to discard the undesired information will not only reduce the amount of data you need to import, but also assist in the parsing of the data, ensuring the best possible alignment.

**NOTE**

The PDF Import Options window provides an easy way to open PDF files and import them into Monarch for data extraction into tables, but it is not the only way to do so. Annual reports, for example, may include tabular data you wish to analyze, but their text-heavy nature cannot be properly addressed by just this window. In this case, the powerful features of Monarch’s Table Extractor may be necessary.
To continue this lesson, let’s try importing a PDF/XPS file that will require us to modify the PDF/XPS import options into Monarch.

CUSTOMIZING PDF/XPS IMPORT OPTIONS

Steps:

1. Close all previous reports.

2. Click File > Open > Report > Computer.

3. In the Files of type drop-down box, select Adobe PDF files (*.pdf).


You can also perform the next steps with an XPS file. In this case, open CustomerSummary.xps instead.

Monarch opens the PDF Import Options window and displays the PDF file. Let’s zoom into the report (by 145% in the following example) so that we can view more of the sample data.

Notice that for Bluegrass Records, the value in the Amount 1 column begins one space too far to the right, so that it doesn’t line up properly with the Amount 1 values for the other three customers.

Let’s assume that we know the font used to generate this PDF was Tahoma, which is a proportional font. A quick visual investigation tells us this is not a freeform document but a columnar report. Let’s try adjusting the Stretch setting to see if this improves the conversion.
5. In the *Stretch size* indicator, shift the marker until the size reads **7.0**. You may need to resize the window to the right to see all of the data. Monarch applies the stretch setting and shows the results on the sample page. Note that the *Amount 1* value for Bluegrass Records now lines up correctly with the *Amount 1* values of the other customers.

![Figure 7-23. Viewing the adjusted sample page.](image)

The current adjustment will now allow you to correctly capture the data in this column, a key Monarch feature, and place them in a table.

6. Click the **Accept** button to close the *PDF/XPS Import Options* window and open the PDF file as a report.

A closer look at all of the options available in the PDF/XPS Import Options window may be found [here](#).

This completes Chapter 6. If you plan to go on to Chapter 7 now, you may leave Monarch open but select the **File** tab and then click **Close All**. Select **No** when asked if you want to save changes to the model or project you created. If you plan to go on to Chapter 7 at a later time, select **File > Exit Monarch**.
[8] Extracting Data from a Report

In Chapter 7, you learned how to use the Report view to explore a report on screen. While this function is very useful, you probably won’t find anything new or useful that is different from simply reading the report off-screen.

Monarch’s technology gives you access to the data buried in your reports and allows you to analyze them to obtain new information. By defining data extraction templates, you can extract data from any report and then analyze them using the Table and Summary windows. In this chapter, you will learn how to extract data from a typical report. The lesson topics include:

- Determining what an extraction template is
- Creating various data extraction templates
- Displaying data in Table view
- Modifying some template properties
- Saving your work to a model file

To get started on this lesson, close all previous reports and open Classic.prn.

Getting to Know Report Design View

Our jump-off point for creating data extraction templates is the Report Design interface, which is accessed by selecting Report Design from the Report ribbon.
THE REPORT DESIGN INTERFACE

![Figure 8-1. Launching the Report Design interface and Template Editor.](image)

Let’s take a minute to explore what you can find in the Report Design interface. The **Report Design interface** is divided into five distinct areas:

- **The Report Design ribbon** is located on the top-most portion of the interface and spans the entire width of the screen. This ribbon will allow you to perform many of the report design functions made available by Monarch.

- **The Template Selector** displays as a panel on the left-hand side of the interface. You can choose specific templates to view and modify from this selector, a functionality that is especially handy when you have defined multiple templates. You can also float, dock, dock as a document, auto-hide, or close this panel.

- **The Template Editor** is displayed in the middle of the interface. The Template Editor remains disabled until you select a new template to create.

- The right-hand side of the interface displays the general properties of a field in the **Field Properties panel**. Each field you define in a template has its own properties. You can set new properties or edit existing ones using this panel. Similar to the Template selector, you can also float, dock, dock as a document, auto-hide, or close this panel.

- **Below the Template Editor is a Data Preview panel**. This panel automatically generates a preview of what your table will look like, including all of its content, while you build templates to extract the desired data from your report. Similar to the Template selector and Field Properties panel, you can float, dock, dock as a document, auto-hide, or close this panel.
The figures below show examples of what a Data Preview panel might contain:

**Figure 8-2.** The Data Preview tab provides users with a tabular sample of their extracted data. In this example, data from a Detail template are shown.

**Figure 8-3.** The Data Preview panel showing the data captured by an Order Number Level (append) template.

**Figure 8-4.** The Data Preview panel shows the data captured by a Page Header template.

Note that as each template is selected from the Template selector, the corresponding columns defined by this template are highlighted in the Data Preview panel and characterized by a specific color, which we will learn to modify later in this chapter.
THE REPORT DESIGN RIBBON

The following table summarizes the functions of each of the buttons in the Report Design ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark] Accept</td>
<td>Accept the new template or changes to an existing template</td>
</tr>
<tr>
<td>![X] Cancel</td>
<td>Cancel the new template or changes to an existing template</td>
</tr>
<tr>
<td>![Detail] Template Name</td>
<td>Specify a new template name or modify an existing one</td>
</tr>
<tr>
<td>![Detail] Template Role</td>
<td>Display the role of the template selected</td>
</tr>
<tr>
<td>![New] New Template</td>
<td>Specify a new template</td>
</tr>
<tr>
<td>![Delete] Delete Template</td>
<td>Delete a template</td>
</tr>
<tr>
<td>![Replace Sample Text]</td>
<td>Select a new line in the report with which to base a template</td>
</tr>
<tr>
<td>![Clearing Template]</td>
<td>For footers and appendis, remove “assumed” values copied up (for footers) or down (for appendis) when only intermittent data are available. More information on this feature may be found <a href="#">here</a>.</td>
</tr>
<tr>
<td>![Auto-Define Trap]</td>
<td>Allow Monarch to automatically create traps for selected lines in the report</td>
</tr>
<tr>
<td>![Auto-Define Fields]</td>
<td>Allow Monarch to automatically specify table fields based on selected lines in the report</td>
</tr>
<tr>
<td>![Multi-Column Region]</td>
<td>Specify multi-column region settings</td>
</tr>
<tr>
<td>![Run Report Verify]</td>
<td>Verify that the boundaries of fields are properly defined</td>
</tr>
<tr>
<td>![Report Colors]</td>
<td>Specify template colors</td>
</tr>
<tr>
<td>![Help]</td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>

THE REPORT DESIGN CONTEXT MENU

When you open a report in Report Design view and right-click on your mouse in the Template Editor, a context menu displays. This menu will allow you to:

- Copy text
- Search for a record
Extracting Data Using Templates

Imagine taking a piece of cardboard and cutting holes in it at certain locations. If you place this imaginary cardboard template on a printed report, you will see only the information that shows through the holes. Monarch uses electronic templates to extract information from your report files in a similar manner. If your report is sorted on several levels, i.e., if you have blocks of data arranged in a repeating manner throughout your report and you want to extract the same, you define a separate template for each sort level.

Classic.prn report a simple structure, so extracting information from it is relatively easy. The file represents a monthly shipment report for a distributor of classical music recordings. Like many reports, Classic.prn is organized into multiple sort levels. The entire report is sorted by customer. Within each customer, orders are sorted by ship date. Within each order, shipments are itemized on detail lines. In addition, three header lines appear at the top of each page.

In this chapter, Monarch will draw data out of each level in the report based on templates that you define. You will start by defining a detail template. Then, you’ll define an append template to extract fields from each sort level and a page header template to extract fields
Fields from the append templates and the page header template will be appended to fields from the detail template to produce database records.

We'll use a sample line to identify all of the other detail lines throughout the report via a process called **trapping**. By setting a trap, you tell Monarch which lines to capture and which to ignore.

A **detail trap** identifies common features shared by all of the detail lines throughout the report, but not shared by other lines in the report, such as page header lines, lines containing labels, or lines from higher sort levels. A proper detail trap will capture only those lines we want while ignoring lines from headers and other sort levels.

In the Classic.prn report, we need to look for features that differentiate the order information lines from the title, date, and page number lines at the top of each page. Specifically, we need to look for characters, such as letters, numbers, or punctuation, which always appear at the same position in the detail lines, but do not appear in any other lines.

![Figure 8-6. The Template Editor allows users to define templates with which to trap data.](image)

Selecting a new template to create or opting to edit an existing one activates the **Template Editor**. In the Template Editor, the **Template Name** and **Template Role** fields are automatically populated with the type of template we are going to create. In the example above, we opted to create a new **detail template**. The Template selector on the left side of the image also displays the template name. We can change this name by simply changing the entry in the **Template Name** field.
Note also that most of the buttons that were previously deactivated in the Report Design view are activated in the Template Editor.

The line you select for trapping displays on a yellow background on the Editor. This line is called the **Sample Text box**. Above the Sample Text box is the **Trap line**, which we will use to create our traps. The different trap types we can use are found in the **Action bar**. To the left of the Template Editor is the **Line Selection area**, which we will use extensively to select lines to trap.

## Table of Trap Types

<table>
<thead>
<tr>
<th><strong>USE THIS TRAP...</strong></th>
<th><strong>TO...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha trap</td>
<td>Trap any letter</td>
</tr>
<tr>
<td>Numeric trap</td>
<td>Trap any number</td>
</tr>
<tr>
<td>Blank trap</td>
<td>Trap blank spaces</td>
</tr>
<tr>
<td>Not blank trap</td>
<td>Trap any character that is not a space</td>
</tr>
</tbody>
</table>
Numeric OR trap

A special trap, used to trap numbers which may or may not appear in certain positions. A good example is an accounting report, where a number may appear in a credit or debit column, but not both. Using two numeric OR traps will trap a number in either position.

Character trap

Trap special characters

NOT trap

Trap any character EXCEPT the specified trap character

Exact match trap

Trap a specific character or series of characters. Exact-match traps are created by typing the exact characters or series of characters in the trap line.

Aside from simply creating traps, the Action bar allows you to perform other actions:

 Trap Type
Specify the trap type to create: Standard Trap, Regular Expression Trap, or Floating Trap

Options
Select options to apply when creating regular expression traps: Ignore Case, Explicit Capture, or Ignore Pattern Whitespace

Trap Line
Specify a different trap line on which to base a template if the sample text is composed of multiple lines

Push Left
Adjust a selected trap character or field one character to the left

Push Right
Adjust a selected trap character or field one character to the right

Reset Trap Line
Discard all changes made to the Trap line and start again

Reset Fields
Discard all fields specified and start again

Delete Field
Delete a specific field

Edit Field
Launch the Field Definition window

To generate a table, Monarch produces one record for each detail line extracted from the report. The detail line contains the data that changes most often in the report and is usually the report’s lowest sort level. Append templates add, or append, information from higher sort levels to the table. In this lesson, we will extract fields from four levels in the report: the detail level, two sort levels, and the page header.
Creating a Detail Template

A detail template extracts data from the lowest level in the report, which, in this case, are the lines representing individual shipments.

To create the detail template, we'll select a sample detail line, use this line to identify other detail lines, and highlight the fields to extract. For this lesson, we'll use **Classic.prn** and keep the Field Properties panel auto-hidden from view until we need it.

**SELECTING A LINE TO TRAP**

Steps:

1. In the **Report** ribbon, select the **Report Design** button.
   - The **Report Design** view displays.
   - As expected, most of the buttons in the ribbon are deactivated.

![Image](image.png)

Figure 8-9. Most of the buttons in the Report Design interface remain deactivated until you activate the Template Editor.
2. Click on the line selection area to the left of the line containing the item description *Bartok, Sonata for Solo Violin*.

3. On the Report Design ribbon, select **New Template > Detail**.

4. Type "**Line Item Detail**" into the **Template Name** field and then press **Enter** on your keyboard.

   This step changes the template name. Changes are immediately reflected in the Template Selector.

5. Ensure that the **Trap Type** is set to **Standard Trap**.

**TRAPPING THE DETAIL LINES**

Let’s create our detail trap.

**Steps:**

1. Click in the **Trap line** above the number 4. If the cursor is not positioned correctly, you can use the Push Left ← or Push Right → keys to move it to the correct position.

2. Click the **Numeric Trap Ñ** icon. "Ñ" appears in the Trap line, representing any number in the designated column position.

3. Click the **Blank Trap ßß** button twice. "ßß" appears adjacent to the first trap character, representing a blank in each column.

4. Click the **Non-blank Trap Ø** button. "Ø" appears in the Trap line, representing any non-blank character.

   By combining these trap characters (see Figure 8-10), we’re telling Monarch to "trap only those lines with a number, followed by two blank characters, followed by a non-blank character in the specified positions."

![Template Editor](image)

Figure 8-10. The completed trap definition.

5. Scroll through the report to ensure that the trap captured all of the detail lines and no other lines.
The results of our trap are indicated by guillemets (») appearing in the line selection area to the left of each line that is selected by the trap, and only those lines including the data you wish to capture should display these marks.

Figure 8-11. Results of the detail trap.

**NOTE**

If you make mistakes when entering the trap characters, you can highlight the incorrect trap characters and press **DELETE** on your keyboard to remove them. To delete all trap characters, click **Reset Trap Line**.

**HIGHLIGHTING DETAIL FIELDS**

When the trap you specified has captured all of the detail lines and no other lines, you’re ready to highlight the fields to extract.

Although we can manually highlight and name the fields to be extracted, let’s try using the Template Editor’s **Auto-Define Fields** feature, which allows us to automatically highlight fields in the template. This feature uses Monarch’s built-in parsing and data recognition capabilities to determine where fields begin and end.

The **Auto-Define Fields** button automatically highlights fields in your template. You can use this capability as a jump-start when highlighting fields in your templates, and we will in fact use this in our lesson, but you should not rely upon this feature exclusively, as Monarch cannot predict which fields you might want to extract and which you want to leave out, nor can it deal with the subtleties of report design that allow fields to wrap onto multiple lines or about one another.
Steps:

1. Click **Auto-Define Fields** on the Report Design ribbon.

   Each field that is found in the detail template is highlighted.

![Template Editor](image)

Figure 8-12. Results of the Auto-Define Fields command.

2. Check the Data Preview panel to see what your table will look like with the information obtained by your template.

![Data Preview](image)

Figure 8-13. Data Preview results of the Auto Define Fields command.

3. Click **Accept** to accept your template definition.

   Congratulations! You have just created your first template. Figure 8-14 shows changes that occur in the Report view once a template is defined for a report.
Figure 8-14. The completed detail template.

**VERIFYING FIELD BOUNDARIES**

Although you could scroll through the report to ensure that each field highlight is long enough to capture all of your data, this method becomes tedious when you are working with large reports. Therefore, a **Field Verification** feature is provided to read the entire report and verify that your fields are properly defined.

When you activate the field verification feature, Monarch scans the entire report and examines field boundaries. If any characters are found immediately adjacent to a field, Monarch will highlight the field to alert you that the field definition may be too short to accommodate a field value or that the field may be defined at the wrong location.

The **Report Verify** window displays when you select **Run Report Verify** from the **Report Design** ribbon. The following table describes each of the buttons in this ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Accept</td>
<td>Accept the results of a verify operation</td>
</tr>
<tr>
<td>❌ Cancel</td>
<td>Cancel the verify operation</td>
</tr>
<tr>
<td>🔄 Adjust left</td>
<td>Adjust the highlighting of the field one character to the left</td>
</tr>
<tr>
<td>🔄 Adjust right</td>
<td>Adjust the highlighting of the field one character to the right</td>
</tr>
<tr>
<td>USE THIS BUTTON...</td>
<td>TO...</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
</tr>
<tr>
<td>✗ Adjust all fields</td>
<td>Automatically adjust all field definitions, thereby eliminating the need to go over an entire report to ensure that all required fields are captured properly.</td>
</tr>
<tr>
<td>☑ Ignore all</td>
<td>Ignore all field-highlighting issues of the type reported in the template and continue with the verify operation; subsequent verify operations will not highlight issues of the type previously ignored</td>
</tr>
<tr>
<td>▶ Continue</td>
<td>Continue the verify operation after correcting an issue</td>
</tr>
<tr>
<td>⏯ Start over</td>
<td>Restart the verify operation</td>
</tr>
<tr>
<td>⏸ Stop</td>
<td>Stop the verify operation</td>
</tr>
<tr>
<td>🔍 Reset Ignore Rules</td>
<td>Reverse the Ignore all command; subsequent verify operations will highlight issues previously ignored</td>
</tr>
<tr>
<td>✉ Help</td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>

**NOTE**

If multiple reports are loaded, **Report Verify** automatically scans through all of them. When Verify is started it always starts at the first page of the current report, and will continue to report verify hits from that and other reports until it has cycled through all of the reports, thereby completing a full pass.

Verification will start over from the top of the current report and re-scan for verify hits (but with any ignores still in effect). Upon reaching the end of a pass without ever having stopped, the dialog returns a message saying that verification has been completed. In this way the user can clearly see when they have succeeded in making a complete "clean" pass through the report(s).
Let’s verify that our field boundaries are correct.

Steps:

1. Return to Report Design and then click **Run Report Verify**.

   A status dialog displays the current status of the verify operation. When the verify operation is completed without errors, **Verify completed** displays in this dialog. This status indicates that all of our fields are properly defined.

   ![Figure 8-15. A completed Verify operation.]

   We can expect this result for the fields of our detail template because we used Monarch’s Auto-Define Fields feature to define them.

2. Click **OK** to close the Report Verify dialog and **Accept** to accept the Report Verify results.

Creating Append Templates

In the Classic.prn report, orders are sorted by order number. Also at this sort level are ship data. We’ll create an **append template** to extract these two fields and an additional append template to extract the account number and contact fields that appear at the next higher level.

The procedure for extracting fields from each sort level is the same as that for extracting detail fields. First, we’ll select a sample, then we’ll trap other occurrences of the sort level throughout the report, and then we’ll highlight the fields we want to extract.

Steps:

1. In the same report, select **Report Design** once more.

2. Select the line containing the words **ORDER NUMBER**. This line is indented and appears below the line containing several field names and above the item details.

3. On the Report Design ribbon, select **New Template > Append**. Ensure that the Trap Type is set to **Standard Trap**.
The Template Editor is activated and the line we selected is copied into the Sample Text box. Note also that the Template Name and Template Role fields are updated to reflect our selected template tape.

Figure 8-16. The selected ORDER NUMBER line.

NOTE

There can only be one detail template for any model you create. The total number of all append and footer templates cannot exceed 20. For each footer template used, there is one less append template available. For example, if you create three footer templates, then only 17 appends can be used.

TRAPPING THE SHIP DATE LINES

We’ll use an exact match trap to capture all lines representing the order number level. An exact match trap looks for an exact match of a character or series of characters.

Steps:
1. Continuing from the previous exercise, click in the Trap line above the colon following ORDER NUMBER in the sample line.
2. Type a colon (:) in the Trap line directly above the first colon in the Sample Text box.

3. Type another colon (:) directly above the second colon in the Sample Text box.

4. Highlight the fields marked by **536017** and **04/10/10** in the Sample Text box as shown in Figure 8-17.

   **NOTE**

   Remember that your Date Format setting must be set to **M/D/Y** to properly capture date inputs in the sample reports we’ll be using for this guide.

   ![Figure 8-17. Highlighting the Order Number and Ship Date fields.](image)

5. Scroll through the report to see the results. Note that, on the fourth page of the report, the “RETURN AUTHORIZATION” and “RECEIVED” fields have been highlighted (see Figure 8-18). We don’t want to capture these fields, so we need to edit our template definition.

   ![Figure 8-18. Viewing the result of highlighting fields.](image)
6. In the Trap line, place the cursor directly above the "5" that begins the order number (536017) in the sample line, click the **Numeric trap** button, and then check the highlighted fields once more.

The "RETURN AUTHORIZATION" and "RECEIVED" fields are no longer highlighted on Page 4 of the report.

![Image of Template Editor](image)

**Figure 8-19.** Viewing the results of amending the current trap.

7. Replace Append 1 with **Order Number Level** in the Template Name field of the Template Editor.

The fields trapped by the append template we just created can be easily distinguished from those trapped by the detail template due to the different colors that Monarch assigns them.

![Image of Data Preview](image)

**Figure 8-20.** Data preview of the highlighted fields.

8. Select **Accept** ✔ to accept your changes and close the Template Editor. You are returned to Report view when you do so.
TRAPPING THE ACCOUNT NUMBER AND CONTACT LINES

This time, we'll trap the account number and contact lines in another append template. Note that the “ACCOUNT NUMBER” and “CONTACT” fields are on different lines. To capture both fields, we'll select a multiple line sample.

Steps:

1. Switch to the Report Design view.
2. Click down in the line selection area to the left of ACCOUNT NUMBER and drag down two lines to highlight three lines including the CONTACT line.

The three lines we selected are displayed in the Sample Text box of the Template Editor.

For a multiple line sample, you need to indicate which of the sample lines to trap. Generally, you will be able to trap on the first line by identifying features unique to that line. Occasionally, however, there will be no unique features that identify the first line. If it is not possible to trap on line 1, use the Trap Line drop-down to select another line with unique features.

In this lesson, we’ll trap on the first line of the sample, so you won’t need to adjust this setting.

Note that an “ACCOUNT NUMBER” label always precedes the account number field. Let’s use this specific sequence of characters as an exact match trap.
4. Type **Account Number** at the beginning of the trap line. By default, Monarch traps are not case-sensitive, so you need not enter the text exactly as it appears in your sample line.

**NOTE**

You can specify "case-sensitive" as the default case setting for traps by selecting **Options** in the Home ribbon. In the **Options** interface that displays, select the **Input** tab, go to the **Trapping** subtab, and then tick the **Non-Regex Traps are case-sensitive** box.

5. Click **Auto-Define Fields**.

![Figure 8-23. Auto-highlighting the Account Number and Contact fields.](image)

Monarch highlights the fields in the report. You may need to scroll the report to see the results.

6. Replace Append 1 with **Account Number Level** in the **Template Name** box, and then click the **Accept** button to accept the template definition.

Note that Monarch has assigned the same color to the fields trapped by the **Account Number Level** template as to those trapped by the **Order Number Level** template. This is because they are both **append** templates.
Creating a Page Header Template

Page headers often include useful information, such as the report date. In the Classic.prn report, the page header includes the report date and the page number. Let’s extract these two fields.

Steps:
1. Switch to the Report Design view.
2. Select the first line of the report as the sample text.

The Template Editor is activated and the line we selected displays on the Sample Text box.

Figure 8-25. The sample line selected for the page header.
TRAPPING THE PAGE HEADER

Most reports have a form feed character (ASCII 12, HEX 0C) embedded at the page break. Monarch can use this character to identify the beginning of a page header, so you normally do not need to set a trap to capture page headers. However, if your reports do not include the form feed character, you will need to use a trap to capture these. If you are unsure about your report’s internal structure, you should play it safe and create a trap. That’s what we’ll do for this lesson.

Steps:

1. Click the **Numeric Trap** button twice and then type a forward slash (/) in the Trap line. This trap will capture the first line of each page header (where the date is represented in MM/DD/YY format).

2. Highlight the report date and the page number, as shown in Figure 8-26.

**NOTE**

The **Auto-Define Fields** button will not be able to capture the report date field due to the logic it uses to distinguish fields from labels, headings and other static text that appears in reports. Any text that does not change throughout the report is considered a label, even if that text looks like, and, as in this case, is, a field.

![Figure 8-26. Highlighting the page header fields.](image)

The page header fields in the report are highlighted.

3. Click **Accept** to accept the template definition.
Since you did not name the template, a default name is assigned for you. For detail and page header templates, the default names are Detail and Page Header, respectively. For append and footer templates, the default names are Append n, and Footer n, where n is incremented for each new append or footer template.

Note in the report that Monarch has highlighted the fields trapped by the page header template with a unique color to distinguish them from those trapped by other template types.

**Working with Model Files**

After you have created a data extraction template for a report, you can save it in a Monarch model file. A model file saves all of the templates and definitions that you have applied to a report during a Monarch session, including sorts, filters, user-defined functions, and the like. Models save work by allowing you to apply the same templates and definitions to a periodic report every time it is generated.

In the previous lessons, for example, we created four templates that we can save to a single model file. If we had new report files with the exact same structure as Classic.prn (e.g., ClassJan.prn, ClassFeb.prn, and ClassMar.prn), we can reuse this model file to extract data from the new files without needing to rebuild any of the templates we’d already created.

Note that in the current version of Monarch, model files are saved using the .dmod extension. Monarch can read model files saved in previous versions of Monarch using the .xmod extension, but it cannot save changes to this file type.

**SAVING MODEL FILES TO A LOCAL FOLDER**

Let’s save a model file to see how this works.

**Steps:**

1. Select File > Save As > Model > Computer.
   
   You can save model files to a local folder (i.e., Computer), a web server (Amazon S3), the Altair Server Library, or to a zip file.

2. Since we opted to save to a local folder in this example, a Save Model dialog displays. Using this dialog, navigate to the folder in which you want to save your model file and then provide a name for it in the File name field.

3. Ensure that the option Model Files (*.dmod) option is selected in the Save as Type drop-down.
4. Click **Save** to continue saving your model file.

5. If a model file with a name identical to the one you supplied in Step 2 is found in the location you specified, you will be asked to confirm the save operation. Click **Yes** in the dialog box that displays to continue saving your file. Note that continuing with the save operation will result in the newer model file replacing the older one.

6. Select **File** once more and then click **Close All** to close the Classic.prn report and model.
SAVING MODEL FILES TO THE ALTAIR MONARCH SERVER LIBRARY

Monarch allows users to save and access models and projects from Altair Server via the Altair Server Library Browser. Note that this functionality is only available using Altair Server versions 12.5.1 and up.

To save a model to the Altair Server Library, select File > Save As > Model > Altair Monarch Server Library.

If you had previously configured an Altair Server Library in the Options interface and opted to save models and projects to Altair Server as the default save behavior, a dialog like that in Figure 8-28 displays.

![Figure 8-28. Saving a model to the Altair Server Library.](image)

Enter a filename for the model you are saving into the name field and then click Save as new.

The model you have just saved is added to the Models list.

If you wish to simply replace a model that is already on the Models list, select the name of this model and then click Replace.

SAVING MODEL FILES TO AMAZON S3

Monarch also allows users to save and access models and projects from Amazon S3. To save a model to an Amazon S3 folder, select File > Save As > Model > Web. A Save as Web File dialog displays.

Enter the S3 folder to which you want to save the model file in the text field provided and then select Connect.
LOADING SAVED MODEL FILES

Now let’s load the same report with our new model file.

Steps:


2. In the dialog that displays, Classic.prn.
   The Classic.prn report displays in Report view.

3. Select File > Open > Model > Computer.

4. From the dialog box that displays, locate, select, and open Save1.dmod.
   The Report view is updated to reflect the effects of the opened model.

Figure 8-31. Loading the Classic.prn report and the Save1.dmod model file.
Setting Template Colors

Monarch includes a function that allow users to clearly differentiate between the various types of templates that may be created (i.e., Detail, Append, Page Header, Group Footer) via template colors. Template colors allow you to easily determine what type of template is being used to extract information from a selection. Aside from being able to choose your own colors, Monarch also provides a pre-determined set of template colors. If you haven't previously set your template colors yet, we'll do so now.

For this lesson, load Classic.prn and Lesson1.dmod.

CHANGING DEFAULT COLORS

Template colors are changed via the Edit Report Colors dialog box.

Steps:


![Edit Report Colors dialog](image)

Several color themes are available for use as template colors:

- **None** shows no color backgrounds in the report after defining templates.
- **Gray background** displays all templates defined in a report in a gray background.
- **Custom background for each template type** assigns select colors for specific template types. This option is selected by default.
Let’s try changing the color for Detail templates.

2. Click directly on the **Detail** button to launch the color selector. Note that right now, the button is yellow.

![Figure 8-33. The Edit Report Colors dialog displaying the color selector.](image)

3. Select the first color on the first column, first row (**#FF8080**).

4. Click anywhere on the Edit Report Colors dialog to accept your selection and close the color selector.

The color of the **Detail** button changes to bright salmon.

5. Select **OK** to close the dialog box.

A quick look at the Template Editor shows that the Detail template is now a bright salmon color.

![Figure 8-34. The Detail template color is updated with your changes.](image)
RESETTING DEFAULT COLORS

Before we proceed to the next lessons, let’s change the Detail template color back to its original state.

Steps:

1. On the Template Editor, click **Report Colors** once more.
2. Select the **Reset to default colors** button in the dialog that displays.
   
   The **Detail** button now shows the original template color we saw earlier.
3. Click anywhere in the dialog to close the selector and then select **OK** to close the dialog box.

Naming Fields

When data are extracted from a report, they are arranged in columns that are given generic names. You can change these names into more meaningful ones to better describe the contents of each column.

Monarch allows you to name fields via three ways:

- Immediately after highlighting them in the Template Editor using the Field Properties panel
- Via the Table Design view
- Via the Field Definition window.

In this section, we’ll explore these options one by one using **Classic.prn** and **Save1.dmod**.

USING THE FIELD PROPERTIES PANEL

Steps:

1. In Report view, select **Report Design** to view the report (along with the highlighted fields) in Report Design view.
2. Select one template from the Template Selector (in the following example, we selected the **Line Item Detail** template).
3. Click on the highlighted field labeled **CD** in the Sample Text box and then click on the **Field Properties** button to expose the Field Properties panel (remember that we set this panel to auto-hide when we were creating our detail template at the beginning of this chapter).

All of the details associated with this field display in the Field Properties panel.
4. In the Name field of the Field Properties panel, delete the current entry and enter Media in its stead. Click the ✓ button that appears next to the field to accept your changes.

The Data Preview panel is automatically updated to show your changes. Note that the column previously marked “eg_CD” is now labeled “Media.”

![Figure 8-37. Field properties of the field eg_CD.](image)

5. Repeat Steps 3 and 4 to rename the rest of the fields in the detail template using the following guide:

<table>
<thead>
<tr>
<th>RENAME THIS FIELD...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>eg_4</td>
<td>Quantity</td>
</tr>
<tr>
<td>eg_Bartok, Sonata for Solo Viol</td>
<td>Description</td>
</tr>
<tr>
<td>eg_MK-42625</td>
<td>Label Number</td>
</tr>
<tr>
<td>eg_8_99</td>
<td>Unit Price</td>
</tr>
<tr>
<td>eg_35_96</td>
<td>Amount</td>
</tr>
</tbody>
</table>

6. Once you’ve made all of your changes, click Accept ✓ on the Report Design ribbon to save your changes and close the Template Editor.

**USING THE TABLE DESIGN INTERFACE**

When Monarch extracts data from a report, the data are placed in a table, which you can view and manipulate in Table Design view. Similar to the Field Definition window, the Table Design view allows you to change field names and properties; it also allows you to perform external lookups, specify formula fields, and define filters, sorts, and address blocks, among others. We’ll discuss these functionalities one by one in later chapters. For now, we’ll focus on changing field names using the Table Design window.

In this lesson, we’ll rename the rest of the fields extracted from Classic.prn using Table Design view.
Steps:

1. From the Report interface, select the **Table** tab and then click **Table Design** from the Table ribbon.

   The Table Design view presents a list of all of the fields you have trapped and will appear on your table; the general properties of each field are also displayed.

   ![Table Design view](image)

   **Figure 8-38.** The Table Design interface displays names and properties for all fields.

   If you wish to view the properties of the template used to capture a field, simply check the box labeled **Show Template Properties** at the lower left-hand corner of the view. You’ll also see the now-familiar **Data Preview** panel at the bottom left corner of the interface.

2. In the name field, locate the cell with the entry **ACCOUNT NUMBER** and change it to **Account Number** by clicking on the cell and typing over the original entry.

3. Locate the cell with the entry **CONTACT** and rename it **Contact**.

4. Replace the name **eg_536017** with **Order Number**.

5. Replace the name **eg_04/10/10** with **Ship Date**.

6. Replace the field name **eg_05/01/10** with **Report Date**.

7. Replace the field name **eg_01** with **Page Number**.
8. Click **Accept** on the Table Design ribbon to accept your field name definitions and close the view.

The Table Design interface closes and you are returned to Table view.

9. Click **Autosize Columns** on the Table ribbon to fit as much of the cell contents as possible to the column widths.

![Figure 8-39. Renaming fields using the Table Design interface.](image)

![Figure 8-40. The results of our renaming exercise.](image)
USING THE FIELD DEFINITION WINDOW

The Field Definition window provides yet another means to rename columns.

The Field Definition window is accessed by:

- Selecting a field and then clicking Edit Field from the Action bar of the Template Editor
- Selecting Input Fields in Table Design view
- Double-clicking on any field in Table view

In the latter case, the properties of the field you double-clicked on display first in the field list provided.

The Field Definition window displays. Let’s explore this window in detail.

![Field Definition window](image)

**Figure 8-41. Field properties of the field eg_CD.**

The ribbon of the Field Definition window features a Template Name drop-down list from which you can choose any template whose fields you wish to define. The template name you select from the drop-down box specifies which template fields are displayed in the Field Selector located on the left-hand panel of the window. If you wish to display all of the fields from all of the templates simultaneously, simply check the box for Show fields from all templates.

You can select any of the fields from the Template Selector and define properties for them. The Field Definition view displays the characteristics of a single field in three tabs: General, Template, and Advanced.
The **General tab** displays the properties of each individual field, such as its name, type, format, and display width. This tab shows exactly the same content displayed in the Field Properties panel in Report Design view. Thus, if you wish to rename fields using the Field Definition window, you would do so in this tab.

The **Template tab** displays the properties of fields in terms of template characteristics, such as whether the field is properly verified and whether empty cells (fields) in a table should be filled with the corresponding value from the record immediately preceding it. If you wish to redact some of the data you retrieved, you can also do so using this tab.

Finally, the **Advanced tab** displays advanced field properties, which are useful when the field being defined spans several lines in a report.

### Using the Report Index

Now that we've successfully extracted data from a report, let's try using Monarch’s **Report Index** feature.

The Report Index displays a hierarchy of field values within one or more reports, thereby allowing you to quickly and easily explore a report and zero-in on the information you are interested in. Using this tree, you can get a bird's eye view of your report data. When you find the information you desire, you can simply click on the field value to jump to the corresponding page in the report.

For this exercise, we’ll use **Classic.prn** and **Lesson1.dmod**.

### SETTING UP A REPORT INDEX

Let’s build a Report Index so that we can see first-hand how helpful it can be.

**Steps:**

1. Click the **Report Index** drop-down button from the **Report** ribbon and then select **Edit Report Index Fields**.

   The **Edit Report Index Fields** dialog displays.
The fields extracted by the Lesson1 model display in the Available Fields list. We can use up to five of these fields to build our tree.

2. Select the **Account Number** field and then click the **Add >>** button. The Account Number field is removed from the Available Fields list and added to the Selected Fields list.

You can also simply double-click a field in the Available Fields list to add it to the Selected Fields list.

3. Select the **Order Number** field and then click the **Add >>** button. The Order Number field is added to the Selected Fields list.

4. Select the **Description** field and then click the **Add >>** button to add it to the Selected Fields list.

Note that the fields are listed in alphabetical order in the Selected Fields list (see Figure 8-43). Their order in the actual Report Index hierarchy will be determined by their order in the report data, as we’ll see shortly.
Now that we’ve configured the tree definition, let’s see how the Report Index displays in Report view.

5. Click the **OK** button to close the *Edit Report Index Fields* dialog.

Monarch displays the Report Index on the right side of the Table (or Report) window by default. Initially, the tree is collapsed. You can move the panel by clicking on the panel header and then dragging it anywhere you wish on the window.
6. Expand the **Classic.prn** tree on the Report Index by clicking on the node (▼) to the left of the label **Classic.prn**.

**NAVIGATING WITHIN REPORT INDEX**

Monarch provides two modes of navigation within the Report Index, **passive navigation** and **active navigation**. **Passive navigation** involves expanding or collapsing branches to view underlying items without updating the Report view display. **Active navigation** involves highlighting a branch in the tree. Whenever a branch is highlighted, the Report view is automatically updated to display the corresponding page in the report.

Typically, you will use a combination of passive and active navigation in Report Index, e.g., you would click on the **arrow (▼)** to the left of a branch to expand it (passive navigation), and then, when you find an item of interest to you, you would click the item to display the corresponding page of the report (active navigation).

Let's perform both modes of navigation within Report Index.

**Passive Navigation**

**Steps:**

1. In the Report view, click the **node (▼)** next to the first account number (i.e., **11887**) displayed in the tree, and then expand all the underlying branches by clicking their **nodes (▼)**. Note that the two order numbers for the account are nested beneath the account number.

![Figure 8-45. Using passive navigation in Report Index.](image-url)
Active Navigation

Steps:

1. Scroll down to the bottom of the Report Index pane and click the node (▼) next to the last account number (i.e., 14162). Click on order number 536015. Click on the number itself, not the adjacent node (▼).

   Note that the report page (Page 19) containing the corresponding data displays in Report view and the data itself is highlighted.

   ![Figure 8-46. Using active navigation in Report Index.](image)

2. Expand the 536015 order number branch (either double-click it or click the node (▼)) of the tree to reveal the individual line items and then select the second one (i.e., Liszt, Les Preludes). The corresponding line in the Report view is highlighted.

   ![Figure 8-46. Using active navigation in Report Index.](image)

   **NOTE**

   When exporting a report as a PDF file, the Report Index is used to create a list of PDF bookmarks for easy navigation.
Working with Project Files

Project files save time by reducing the number of steps required to store a previous Monarch session. When you save a project file, references to the input file(s) and the model file, as well as the active filter, sort order, summary, and view, are saved. Project files are saved via the File > Save As > Project > <Location> command.

When you have saved your work to a project file and wish to continue your Monarch session (presumably at a later time), simply open the project file you saved by selecting File > Open > Project > <Location>. Doing so automatically loads the input file(s) and model you were working with. All objects defined in your previous Monarch session are also made available.

PROJECT FILE LIMITATIONS

Project files contain only references to a Monarch session’s data source and model file; it does not encapsulate the data source or model file into the project file. Thus, if you delete, move, or rename the data source or model file referenced by the project, you will be unable to restore a previous Monarch session by opening the saved project. This is also true if you move the project file to a system that does not have access to the data source or model file, giving a project file limited portability beyond the system on which it was created.

When a Monarch session using a database table is saved into a project and the column names of this table are changed (e.g., using an external application), an attempt to open the project launches the following prompt:

![Figure 8-47. Opening a project file with a modified table.](image)

Some fields of the external database have incorrect names. Would you like to correct a datasource or fields?

Yes  No
Clicking **Yes** on this dialog launches an error message to describe the issues found:

![Error message](image1)

**Figure 8-48.** Errors observed when opening a project file using a table with a modified name.

Clicking **OK** on this dialog takes you to the Edit Table Properties window, where you can select a new data source instead and/or modify other table properties.

![Edit Table Properties window](image2)

**Figure 8-49.** The Edit Table Properties window.
PROJECT FILES AND AUTOMATOR

Monarch Server Automator Edition (Automator) is a data conversion solution built for Monarch that uses existing ASCII or ANSI reports, PDF files, XPS files, ISAM files, Open XML spreadsheets, HTML files, and OLE DB/ODBC sources, among others, as sources of data. You can import report files into Automator and then export their data to a variety of formats or an OLE DB or ODBC destination. Automator also allows you to export files to a Microsoft Office SharePoint Server, FTP site, email destination, or distribution list. In short, Automator lets you extract, transform, move, and load data faster and more easily than previously possible.

Automator offers far more than just an easy way to automate Monarch. It is an information delivery system, capable of distributing files over the network and to SharePoint locations. It can email users the files they need, or alert them that new files are available and where to get them, either over the network or via the Internet. RSS feeds can be created, integrating with newsreaders or corporate information portals. Thus, users are kept up-to-date on the latest information and can click to download or view the information via a browser.

Automator makes use of project files to create processes. The project file referred to here is the same project file you create in Monarch when you save your work, including references all reports used, model(s), export(s), filter and sort definitions, and the like, to a file with the extension .dprj.

For more information on Automator, click on the link https://www.datawatch.com/our-platform/server/.
In Chapter 8, we created a table using a report with multiple sort levels, but we didn’t extract the customer information from the highest sort level. In this chapter, we’ll use Monarch’s address block feature to extract the customer names and addresses. We’ll also familiarize ourselves with Monarch’s floating trap and multi-column region trapping features. The lesson topics include:

- Special problems with addresses
- Extracting an address block
- Using the address block feature
- Using the floating trap type
- Using the multi-column region trapping feature

To get started, we’ll load the **Classic.prn** report and **Lesson1.dmod** model file.

![Image of Classic report with Lesson model file](image-url)
The customer name and address, account number, and contact name are all at the same sort level in the report. Generally, we define one append template for each sort level. However, we will need to use a special technique to extract address fields, and that technique requires a separate template.

Using the Address Block Feature

SPECIAL PROBLEMS WITH ADDRESSES

Most of the information in reports is contained in fields that are easily located for extraction. However, addresses present special problems. Some may contain three lines, while others have as many as six or seven. As well, fields containing state, province, and postal code information are not found at a fixed position on the lines they occupy. Monarch provides a specialized feature in Table view to solve these data extraction problems easily.

To extract the address fields, Monarch provides the Address Block feature in Table view. The Address Block is capable of taking a block of text and extracting and categorizing the address information contained within it.

EXTRACTING AN ADDRESS BLOCK

The procedure for extracting the address fields is similar to extracting other fields. First, we’ll select a sample address block, then we’ll set a trap to capture all other address blocks throughout the report, and finally, we’ll highlight the address fields to extract.

Let’s start by selecting a sample address block from the report.

Steps:

2. Click on the line selection area to the left of the line containing CUSTOMER and the first line of the address (i.e., Betty’s Music Store).
3. On the ribbon of the Report Design view, select the drop-down button for New Template and then select Append. Ensure that the Trap Type is set to Standard Trap.

The first line of the address block is copied into the Sample Text box of the Template Editor.
4. Name this template **Address Block**.

5. Type **customer** in the Trap line above **CUSTOMER** in the sample line.

6. Highlight the field in the sample line, making sure you allow plenty of space for long address lines throughout the report.

To capture the whole address block, regardless of the number of lines, we need to use the advanced field options available in Monarch.

7. Select **Edit Field** from the Template Editor’s Action bar to launch the Field Properties window.
8. In the General tab, change the field name to **Customer Full** and then click the ✔ button that appears beside the field.

9. Change the field’s **Type** setting to **Memo**.

10. Click the Advanced tab and then, under the **End Field On** heading, select the **Blank Field Values** radio button to terminate the field when a blank line or a series of blank lines is encountered. It is important to note that Monarch does not require the entire line to be blank, only the column positions occupied by the field.

11. Enter the number of blank field values required to terminate the field, which in this case is 1.

12. Click **Accept ✔**.

   The address fields in the report are highlighted. Scroll through enough of the report to confirm that all instances of the address have been captured.

![Figure 9-5. Viewing the trapped address block.](image)

Note that this has correctly captured all of the addresses, even though some have four lines and some have five. This is the advantage of utilizing Advanced Field properties.

13. Click **Accept ✔** to accept the template and close the Editor.

**DEFINING ADDRESS BLOCKS**

When you open Table view, you will see that the field has been extracted and is displayed using standard memo field behavior.

Now we can use the address block feature to extract the data from the block of text we have extracted.

**Steps:**

1. In Table view, select **Table Design ✔** from the Table ribbon to launch the **Table Design** interface and then click **Add > Address Block** to begin defining your address block.
The **Name and Postal Code Formats** tab opens.

![Image of the Address Block Wizard]

**Figure 9-6. The Address Block Wizard.**

2. Enter **Address1** in the **Name** field and then click the ✅ button that appears beside the field.

3. Select the **Input Fields** tab.

4. In the **Available Fields** list, select **Customer Full** and then click the **Add >>** button to add the field to the **Selected Fields** list. This command specifies that our address block will be based on the **Customer Full** field.

   Double-clicking on a field in the Available Fields list also transfers the field to the Selected Fields list.

5. Click the **Output Fields** tab.

6. Select the **Address Line 1** check box.

7. Replace the **Address BlockLine1** entry in the **Output Field Name** field adjacent to the Address Line 1 field with **Customer**.

8. Select **Address Lines 2 and 3**, **City**, **Region**, **Postal Code**, and **Country**, and rename the fields as follows:

   - Address1
   - Address2
   - City
   - State
   - Zip
   - Country
9. Click the **Accept** button after all the fields have been named.

10. Display the Table view window and then scroll right to display the address fields. You can click **Autosize Columns** in the Table view ribbon to display all of the fields properly.

![Image](image.png)

**Figure 9-7.** Sample of extracted addresses in Table view (column widths adjusted to show all seven address fields).

Note that Monarch has extracted all the information contained in the original address block and categorized it correctly into the defined fields.

The final step in this exercise is to hide the original field we used to extract the address block information, Customer Full.

11. Using your mouse, right-click anywhere on the **Customer Full** field. From the context menu that displays, select **Hide Customer Full**.

The table displays once more without the **Customer Full** field.

**NOTE**

To redisplay hidden fields, right-click on your mouse in Table view and then select the **Show Hidden fields** option in the context menu that displays. A list of hidden fields appears. Select the field to redisplay from this list.

12. Close the lesson and model files without saving any changes.

We will cover hiding fields more thoroughly in the next lesson. As you can see from the table, the Address Block is a simple but powerful feature, capable of extracting information from addresses around the world.
Using the Auto-Define Feature in Report View

Now that we know how Monarch allows you to manually create traps to extract data from a report, let’s turn our attention to the Auto-Define feature in Report view. This new feature allows you to automatically define detail traps.

Steps:


```
<table>
<thead>
<tr>
<th>FIRSTNAME</th>
<th>LASTNAME</th>
<th>STREET</th>
<th>CITY</th>
<th>STATE</th>
<th>ZIP</th>
<th>MIDDLENAME</th>
<th>SEX</th>
<th>DEPT</th>
<th>SALARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stephen</td>
<td>McPherson</td>
<td>410 Market St</td>
<td>Boston</td>
<td>MA</td>
<td>02113</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dennis</td>
<td>Bender</td>
<td>624 Holiday Hill</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>11/20/94</td>
<td>M</td>
<td>Shipping</td>
<td>47400</td>
</tr>
<tr>
<td>Vouman</td>
<td>Uppemann</td>
<td>1616 Del Lesseps</td>
<td>Coboud</td>
<td>MA</td>
<td>01742</td>
<td>05/27/65</td>
<td>M</td>
<td>Marketing</td>
<td>39900</td>
</tr>
<tr>
<td>Arnold</td>
<td>Finlay</td>
<td>207 Anglewood Rd</td>
<td>Littleton</td>
<td>MA</td>
<td>01460</td>
<td>05/28/81</td>
<td>M</td>
<td>Shipping</td>
<td>39800</td>
</tr>
<tr>
<td>William</td>
<td>Bailey</td>
<td>5 Devoll Rd</td>
<td>Lexington</td>
<td>MA</td>
<td>02173</td>
<td>01/08/55</td>
<td>M</td>
<td>Accounting</td>
<td>46000</td>
</tr>
<tr>
<td>Mary Beth</td>
<td>Stankovic</td>
<td>91 Belmont St</td>
<td>Maynard</td>
<td>MA</td>
<td>01759</td>
<td>10/26/61</td>
<td>F</td>
<td>Accounting</td>
<td>42500</td>
</tr>
<tr>
<td>Robert</td>
<td>Tracy</td>
<td>33 Mountain View</td>
<td>Maynard</td>
<td>MA</td>
<td>01754</td>
<td>12/12/57</td>
<td>M</td>
<td>Data Processing</td>
<td>55500</td>
</tr>
<tr>
<td>Genevieve</td>
<td>Bradford</td>
<td>406 Centre Park Rd</td>
<td>Somerville</td>
<td>MA</td>
<td>02146</td>
<td>07/24/66</td>
<td>M</td>
<td>Marketing</td>
<td>62000</td>
</tr>
<tr>
<td>Doug</td>
<td>Williams</td>
<td>9 Lawrence St</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>02/26/80</td>
<td>M</td>
<td>Data Processing</td>
<td>52200</td>
</tr>
<tr>
<td>Frances</td>
<td>Laxico</td>
<td>PO Box 1992</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>10/26/93</td>
<td>M</td>
<td>Data Processing</td>
<td>69000</td>
</tr>
<tr>
<td>William</td>
<td>Connolly</td>
<td>218 Washington St</td>
<td>Jamaica Plain</td>
<td>MA</td>
<td>02130</td>
<td>03/12/50</td>
<td>M</td>
<td>Marketing</td>
<td>50000</td>
</tr>
<tr>
<td>Andrew</td>
<td>Bass</td>
<td>44 South Park St</td>
<td>Pittsburgh</td>
<td>PA</td>
<td>01420</td>
<td>03/18/60</td>
<td>M</td>
<td>Data Processing</td>
<td>44000</td>
</tr>
<tr>
<td>Howard</td>
<td>Linder</td>
<td>972 North Vincent</td>
<td>erre</td>
<td>PA</td>
<td>01231</td>
<td>04/20/63</td>
<td>M</td>
<td>Shipping</td>
<td>60250</td>
</tr>
<tr>
<td>Abe</td>
<td>Caster</td>
<td>101 Mayflower St</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>04/29/61</td>
<td>M</td>
<td>Shipping</td>
<td>28500</td>
</tr>
<tr>
<td>Don</td>
<td>Craig</td>
<td>1699 Ahlene St</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>05/24/93</td>
<td>M</td>
<td>Production</td>
<td>97300</td>
</tr>
<tr>
<td>David</td>
<td>Manning</td>
<td>100 Catherine Ave</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>12/18/93</td>
<td>M</td>
<td>Marketing</td>
<td>65000</td>
</tr>
<tr>
<td>Kelly</td>
<td>Rosenberg</td>
<td>31 Welverde Dr</td>
<td>Pittsburgh</td>
<td>PA</td>
<td>01420</td>
<td>09/20/67</td>
<td>F</td>
<td>Accounting</td>
<td>41500</td>
</tr>
<tr>
<td>Joshua</td>
<td>Faison</td>
<td>140th Ct W</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>01/05/82</td>
<td>M</td>
<td>Marketing</td>
<td>63000</td>
</tr>
<tr>
<td>Owen</td>
<td>Davies</td>
<td>2220 Del Este</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>10/23/83</td>
<td>F</td>
<td>Production</td>
<td>52000</td>
</tr>
<tr>
<td>Oliver</td>
<td>Davies</td>
<td>8 George St</td>
<td>Washington</td>
<td>MA</td>
<td>01881</td>
<td>02/28/88</td>
<td>M</td>
<td>Production</td>
<td>28000</td>
</tr>
<tr>
<td>Pauline</td>
<td>Henderson</td>
<td>98 Lincoln St</td>
<td>Boston</td>
<td>MA</td>
<td>02133</td>
<td>07/15/65</td>
<td>F</td>
<td>Marketing</td>
<td>40400</td>
</tr>
<tr>
<td>Marlena</td>
<td>Evan</td>
<td>739 51st St, NE</td>
<td>Lowell</td>
<td>MA</td>
<td>01853</td>
<td>06/26/90</td>
<td>M</td>
<td>Data Processing</td>
<td>41500</td>
</tr>
<tr>
<td>Elizabeth</td>
<td>Woodard</td>
<td>954 East Main</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>06/28/92</td>
<td>F</td>
<td>Accounting</td>
<td>49500</td>
</tr>
<tr>
<td>Wayne</td>
<td>Redinaki</td>
<td>PO Box 449</td>
<td>Lowell</td>
<td>MA</td>
<td>01853</td>
<td>04/22/91</td>
<td>M</td>
<td>Shipping</td>
<td>39400</td>
</tr>
<tr>
<td>George</td>
<td>Miller</td>
<td>13 Saxon St</td>
<td>Hollisbun</td>
<td>MA</td>
<td>01827</td>
<td>05/15/86</td>
<td>M</td>
<td>Data Processing</td>
<td>38000</td>
</tr>
<tr>
<td>Mary</td>
<td>Johnston</td>
<td>173 Bosston St</td>
<td>Boston</td>
<td>MA</td>
<td>02172</td>
<td>12/25/87</td>
<td>F</td>
<td>Marketing</td>
<td>44700</td>
</tr>
<tr>
<td>Liz</td>
<td>Chandler</td>
<td>355 Denise Rd</td>
<td>Reading</td>
<td>PA</td>
<td>01867</td>
<td>05/04/66</td>
<td>F</td>
<td>Marketing</td>
<td>58500</td>
</tr>
<tr>
<td>Teresa</td>
<td>Leberman</td>
<td>254 Wilson Ave</td>
<td>Carlisle</td>
<td>MA</td>
<td>01741</td>
<td>07/30/67</td>
<td>F</td>
<td>Marketing</td>
<td>48250</td>
</tr>
<tr>
<td>Don</td>
<td>Kinnett</td>
<td>9 Rye Rd</td>
<td>Burlington</td>
<td>MA</td>
<td>01803</td>
<td>03/06/85</td>
<td>M</td>
<td>Production</td>
<td>37300</td>
</tr>
<tr>
<td>Joseph</td>
<td>Mandrula</td>
<td>28 Collins Ave</td>
<td>Carlisle</td>
<td>MA</td>
<td>01741</td>
<td>06/29/99</td>
<td>M</td>
<td>Marketing</td>
<td>46700</td>
</tr>
<tr>
<td>Jeff</td>
<td>Aldridge</td>
<td>153 Parker Ave</td>
<td>Westford</td>
<td>MA</td>
<td>02193</td>
<td>10/18/88</td>
<td>M</td>
<td>Accounting</td>
<td>34000</td>
</tr>
<tr>
<td>Maggie</td>
<td>Morson</td>
<td>239 Cypress Rd</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>11/05/55</td>
<td>F</td>
<td>Shipping</td>
<td>24500</td>
</tr>
<tr>
<td>Anne</td>
<td>Bartholomew</td>
<td>940 Mountain St</td>
<td>Brookfield</td>
<td>MA</td>
<td>02317</td>
<td>11/05/53</td>
<td>M</td>
<td>Marketing</td>
<td>62500</td>
</tr>
<tr>
<td>George</td>
<td>Hayler</td>
<td>27 Lenbrook Lane</td>
<td>Sudbury</td>
<td>MA</td>
<td>01776</td>
<td>04/12/82</td>
<td>M</td>
<td>Shipping</td>
<td>28500</td>
</tr>
<tr>
<td>Anna</td>
<td>Bray</td>
<td>99 Soruce Place</td>
<td>Maynard</td>
<td>MA</td>
<td>01754</td>
<td>09/20/53</td>
<td>F</td>
<td>Shoring</td>
<td>24000</td>
</tr>
</tbody>
</table>
```

Figure 9-8. The Employ.prn report.

2. Click Auto-Define on the Report view toolbar. The Template Editor displays with the trapping results. Note that the Trap line is automatically filled with trap characters.
3. Scroll down to view the highlighted lines.

Monarch analyzes the detail line we selected as our sample and selects all the other lines in the report that have the same format.

Using the Auto-Define Trap Feature in Report Design View

Now that we’ve seen how Monarch allows you to manually create traps to extract data from a report, let’s turn our attention to the **Auto-Define Trap** feature. This new feature allows you to automatically define traps.

One way we can explore just how effective this tool can be is to use it on the report we were just working with. Using the Employ.prn report, we can compare the auto-define trapping process with the manual trapping procedure we just performed.

There are three important things to consider when using the auto-define trap feature:

- When selecting your sample line (Step 3 below), it is important to select a line that best represents the bulk of the lines in the report, since Monarch will trap all the lines that feature formatting that matches your sample line.

- After you have selected the **Auto-Define Trap** button (Step 4 below), be sure to examine more than just one or two pages of the report. If you fail to do so, you may
overlook lines of the report that you wanted to capture but Monarch failed to trap due to some anomaly in them.

- Lines left unchecked (Step 6 below) in the Auto-Define Trap window will **not** be trapped by Monarch, so be sure to select the check boxes of **all** of the lines you want trapped.

**Steps:**

1. Open the **Employ.prn** report. The report displays in Report view.

![Figure 9-10. The Employ.prn report.](image)


3. Click on the line selection area to the left of the detail line (e.g., the one containing **Stephen McPherson**) and then select **New Template > Detail**. Ensure that the Trap Type is set to **Standard Trap**.
4. Click **Auto-Define Trap** on the toolbar. The **Auto-Define Trap** window displays.

Figure 9-11. Selecting the detail line.

Figure 9-12. The Auto-Define Trap window.
5. Scroll down to view the highlighted lines. Monarch analyzes the detail line we selected as our sample, and selects all the other lines in the report that have the same format.

   Note, however, that the auto-define trap feature has failed to select all of the detail lines.

   ![Figure 9-13. Viewing detail lines that haven’t been trapped.](image)

   This is because, while the detail line we selected as our sample contained a street address that begins with a number (e.g., “410 Market Street”), a few of the street addresses in Employ.prn begin with a letter, as in “PO Box 1752”. When comparing the sample line with all the detail lines in the report, the auto-define trap feature opted not to trap any lines with such a discrepancy.

   Note that, on the first page of the report, there are two detail lines which weren’t trapped. We obviously want these detail lines to be trapped, however, as well as any that may exist on other pages of the report. Fortunately, the **Auto-Define Trap** window provides an easy way to ensure that they are selected.

4. Select the check boxes for the two detail lines whose street addresses are PO box numbers (see Rows 16 and 30). Note that the text color for these two detail lines changes from black to red. This is simply to notify us that the lines don’t perfectly match the sample detail line.

   ![Figure 9-14. Selecting the additional detail lines.](image)

5. Click the **Apply Changes** button. This tells Monarch to additionally trap any lines that match the format of the newly selected ones. The additional detail lines we selected are now highlighted.
Figure 9-15. Viewing the result of the recalculation.

Although we could check the other pages of the report for detail lines which haven’t been trapped, let’s see if the detail lines we’ve selected are sufficient.

6. Click the Accept button to close the window, and then scroll down to make sure that all of the detail lines have been successfully trapped.

Figure 9-16. Scrolling the report to make sure all the detail lines have been trapped.

Note that the Trap line is automatically filled with trap characters.
Using the Floating Trap Type

In addition to the address block feature, Monarch has another special data extraction feature called the **Floating trap type**. Let’s take a few moments to learn about this powerful feature.

In many reports, particular fields of data, such as names and addresses, occur in consistent locations (i.e., they begin at the same horizontal position throughout the report). For example, in the following report, note how all of the first names begin at the same horizontal position, as do all of the last names, streets, cities, etc.

![Figure 9-17](image-url) A report showing consistent data placement, as is typical of many reports.

Because of the consistent placement of data within the report, defining a trap to capture each occurrence of any one of these fields would be quite easy. With some reports, however, a standard trap won’t work because data placement within them is irregular rather than consistent.

In the following report, for example, note how the occurrences of the date/time field ("[23/Aug/2008...") begin at different horizontal positions.

![Figure 9-18](image-url) A report showing inconsistent placement of the date/time data.

In reports such as this, a standard trap will not work. Fortunately, Monarch includes a special trap called the floating trap, which can successfully extract data from many log files, reports and HTML files in which the data placement is not fixed.
USING THE FLOATING TRAP TO CAPTURE LINES

To familiarize ourselves with the floating trap, let's open the above report and create a floating trap to capture the date/time fields it contains.

Steps:

1. Open the Weblog.prn report and select the first line.


3. Click in the line selection area to highlight the first detail line in the report and then select New Template > Detail. Ensure that the Trap Type is set to Standard Trap.

4. From the Trap Type drop-down, select Floating Trap.

5. In the Trap line, enter a left bracket directly above the left bracket in the Sample Text line, as in the following figure.

6. In the Sample Text line, highlight the date/time field once more.

7. Scroll down through the report once again. Notice that all of the date/time fields are now highlighted, indicating that they will be successfully captured.

The floating trap works by looking across the lines to find the trap characters horizontally, rather than vertically, as in a standard trap. The trap then uses the characters to decide when fields can possibly start and finish. The field we have chosen to trap has a fixed width, but we will explore fields that have variable widths later in the lesson. In this
example, we have only defined that the field should begin after the bracket character; we could also define a close bracket to dictate where the field ends.

Figure 9-21. Previewing the template again. Note that all of the date/time fields are now highlighted.

8. In the Name field of the Field Properties panel, enter Date/Time to name the field and then click the ✓ button that appears below the field.

9. On the Template Editor, replace Detail in the Template Name field with Date/Time to name the template, and then click the Accept ✓ button. Monarch closes the Template Editor and returns to Report view.

10. Select the Table tab to view the Date/Time information in Table view. Scroll downward and note that all 916 date/time fields within the report have been successfully extracted.

Figure 9-22. Viewing the Date/Time table (scrolled to the bottom).
Now that we’ve seen how the floating trap can define lines where the trap character appears, let’s explore another one of its capabilities.

**USING THE FLOATING TRAP TO DEFINE FIELDS**

In addition to defining lines that contain the trap character, the floating trap can be used to define the width of variable length fields. If we return to our Weblog.prn report, we can see how this works.

**Steps:**

1. Select the Report tab and then click Report Design to launch the Template Editor.

   We now want to extract the data from the first field, which has a variable width. In order to do this, we can use a trap character to tell Monarch where the field begins and ends. Since this field is left justified, we only need to be concerned with where the field ends.

2. Position the cursor in the Trap line after `.net`, click the Blank Trap button and then highlight the text in the sample line as in Figure 9-23.

   ![Figure 9-23. Floating Trap with the blank trap added.](image)

   Note the results in the Report view portion of the window.

   ![Figure 9-24. Floating trap with variable width fields.](image)
As you can see, the fields have been highlighted and the highlighting has shrunk to accommodate any field shorter than the fields we originally selected. There are some longer fields, however (e.g., "PPPa28-Resale_Vancouver"), in which the field is wider than the highlighting. This would result in an incomplete extraction of data. To rectify this, we need to manually specify the length of this field.

3. Click the newly defined field **eg_ezvl-30ppp187_epix_net** in the Sample Text box and then select **Edit Field** to display its general properties in the Field Properties window.

4. Click the **Template** tab.

5. On the **Template Width** field in Field Properties, enter **60** and then click enter.

6. Press **Accept** (on the Ribbon) to accept the sizes then view the result.

   Note that all of the data is now trapped correctly.

   ![Figure 9-25. Viewing the finished floating trap.](image)

   **Figure 9-25. Viewing the finished floating trap.**

7. Select the **Accept** button to return to the Report view and then select **File > Close All** to reset the Monarch session. Select **No** when prompted to save changes to the model.
Using the Multi-Column Region Trapping Feature

When working with Monarch, you may occasionally encounter a report that has a layout similar to that of a newspaper, i.e., one with multiple, adjacent columns of data on each page. For example, the following report contains a list of composers, numbered 1 through 90, and the list is broken into three columns, each containing thirty names.

To handle such reports, Monarch includes a Multi-column region (MCR) trapping feature which you can use to trap the data in multiple columns via only one template.

Extracting data via the MCR trapping feature consists of three simple steps. First, you define the multi-column region via the Multi-Column Region Definition window, then you create a template to extract the desired data from the report, and finally you specify the vertical boundaries (i.e., beginning and ending points) for the columns.

Let’s open a multi-column report and extract data from it via the MCR trapping feature.
Steps:

1. Open the **Composers.prn** report.

   ![Composers.prn report](image)

   This report contains the same list of composers we saw a moment ago. Composers.prn lists the names of ninety composers, arranged in three columns of thirty names, and ranked in order of popularity (1 = most popular, 90 = least popular) for each customer.

   Now that our multi-column report is open, let's define the multi-column region.

2. Select the first line of the report, select **Report Design** from the Report ribbon, and then click **Multi-Column Region** on the Report Design interface.

   The **Multi-Column Region (MCR) Definition** window displays.

3. Select **Enable MCR** to activate the window.
A series of red, vertical broken lines – or column indicators – appears over the report to indicate where the columns currently are.

Now we need to examine the report to determine the number of columns we want the multi-column region to contain. This number should obviously equal the number of columns in the report which, in this case, is three.

4. **Enter 3 in the Number of Columns box.**

   The number of columns you specified determines the number of column indicators that appear. Since we entered 3 in the Number of Columns box, three column indicators have appeared, as displayed in Figure 9-29.
Next, we need to specify a left margin for the leftmost column, i.e., specify the position where we want the leftmost column to begin. Since the text in the leftmost column begins at the left edge of the report, the current setting of 1 is the one we want, so we can leave it as is.

**NOTE**

If the text in the leftmost column began one space in from the left edge of the report, then we would enter 2 in the Left Position of First Column box. If the text began two spaces in from the edge of the report, we would enter 3 and so on.

Now we need to adjust the width of the column indicators to match the width of the data columns in the report.

5. In the Width of Each Column box, adjust the value until you obtain the correct width. For this report it is 29.
The column indicators move to the left to reflect the change to the column width. Note that all three columns of composer names and ranking numbers now fall within the column indicators (scroll down to see this, if necessary).

![Figure 9-30. Viewing the column indicators in the Report view.](image)

6. Click **Accept** to accept the current MCR settings and close the window.

The Report Design displays with the column indicators still displayed on the report.
Now that we have determined the necessary number of columns, and have specified their width and the starting position of the leftmost column, we're ready to define a template to extract the data.

**CREATING A TEMPLATE TO TRAP MULTI-COLUMN DATA**

The process of trapping data in a multi-column region report is the same as that for any other report. The first step is to select a template sample.

**Steps:**

1. Ensuring that you are in the Report Design interface, click on the line selection area to select the top line of composer names (i.e., the one beginning with PACHELBEL, J.), select the drop-down button for **New Template**, and then select **Detail**. Ensure that the Trap Type is set to **Standard Trap**.

   Note that the **Multicolumn Design Mode** button is selected in the Template Editor.
Your screen should look as in Figure 9-32.

![Figure 9-32. Selecting the top line of composers.](image)

2. In the Trap line, place the cursor above the "P" of Pachelbel in the Sample Text line, then click the **Non-Blank Trap** button.

3. In the Trap Line, place the cursor above the "1" in the Sample Text line, then click the **Numeric trap** button.

![Figure 9-33. Viewing the results of the non-blank and numeric traps.](image)

4. In the Sample Text line, highlight the composer name and then highlight the number 1.
NOTE

When highlighting the composer’s name, extend the highlight well beyond the end of the name, as some of the composers names are longer than the one in the Sample Text line. Likewise, when highlighting the number “1”, be sure to begin the highlight at least one space before the number, as the numbers extend into the double digits. See Figure 9-34 for an example of how you should highlight the fields.

Figure 9-34. Highlighting the fields.

5. Select the number **1** in the Sample Text box to display its general properties in the Field Properties panel.

6. Type **Rank** in the **Name** field and then click the ✔️ button that appears below the field.

7. Select the text **PACHELBEL, J** in the Sample Text box to display its general properties in the Field Properties panel.

8. Rename this field **Composers** and then click ✔️ to accept your field name definition.

9. Click **Accept ✔️** to save your template definitions.
Now let’s create an append template to extract the contact data from the report. This template will also help us specify our vertical boundaries for the MCR, which we will discuss in the next lesson.


11. Click in the line selection area to highlight the first contact line (i.e., the line containing **CUSTOMER: Betty’s Music Store**), select the drop-down button for **New Template**, and then select **Append**. Ensure that the Trap Type is set to **Standard Trap**.
12. To create the trap, type `customer` in the Trap line above "CUSTOMER" in the sample line and then highlight `Betty's Music Store` in the sample line. Be sure to extend the highlight well beyond the end of the last name, as in Figure 9-37.

![Figure 9-37. Highlighting the Contact field.](image)

13. Rename the field `eg_Betty's Music Store` to `Contact` in the Field Properties panel and then click the ✔ button to accept your changes.

14. Rename the template `Contact` and then click the Accept ✔ button to accept your changes. You are returned to Report view and fields corresponding to the Contact template you have just defined are highlighted.

If we wanted to, we could now create additional append templates to capture more information from the report, such as "CUSTOMER" and "ACCOUNT NUMBER" fields. Instead, let's move on and learn how to specify vertical boundaries for the MCR.

**NOTE**

As an example of a model file that contains additional append templates, Monarch includes a Composers.xmod file in the `Monarch Models` folder.

### SPECIFYING VERTICAL BOUNDARIES FOR THE MCR

So far, we have configured the column indicators to the correct width and have created a detail template that extracts the composer’s names and rank numbers from the report. We also created a `Contact` append template, which will be helpful to us when specifying vertical boundaries for the multi-column region.
When we specify vertical boundaries for the MCR, we specify the top and bottom boundaries for the columns within it.

Steps:


2. On the Report Design ribbon, select Multi-Column Region to display the Multi-Column Region Definition window.

3. Select the Start after > Template radio button option and then ensure that Contact is selected from the Template drop-down list.

A horizontal broken line appears at the top of the composer columns, just below the “CONTACT” line. This line indicates the top boundary of the multi-column region. Everything above this line will be excluded from the MCR.

4. Scroll down through the report to locate the bottom boundary of the multi-column region.

Figure 9-38. Viewing the top boundary of the MCR (just below the CONTACT line).
Note that the current bottom boundary setting for the MCR is **Stop at > Bottom of page**. Notice that the bottom boundary of the MCR occurs just after the end of the columns on Page 1 and before the beginning of Page 2, as specified by the current bottom boundary setting. This boundary will suit our purposes as is, so we don’t need to adjust it.

![Figure 9-39. Viewing the bottom boundary of the MCR.](image)

Now that you’ve seen how helpful templates can be when specifying the top and bottom boundary settings of the MCR, keep this in mind, as you can create blank traps solely for this purpose.

5. Click **Accept** twice, once to save the current MCR settings and then a second time save the current template settings.

Monarch redisplay the Report view.

Let’s view the trapped data in Table view.

6. Select the **Table** tab to display the extracted data in Table view.

7. Select **Autosize Columns** to view all of the fields properly.

Monarch displays the extracted data in the Table view.
At this point, you can either save your work or close the report and model.

Using the Regular Expression Trap Type

Recall that in Chapter 7, we attempted to trap the Ship Date line but also picked up unwanted data as well, i.e., the Return Authorization and Received fields. We rectified this issue by creating an exact trap. We then showed how we can avoid this issue by using an exclusion trap. We could also have created a regular expression trap. Regular expression traps allow sophisticated Monarch users a high level of flexibility when creating templates because this type of trap automatically considers variable spaces between fields of interest. Thus, this trap can be very useful when field positions change on a page or when field positions change with respect to other fields.

All of the traps we have described thus far may be translated into a regular expression trap, and the first step of creating such a trap involves selecting a line with fields we want to trap. Similar to all of the previous traps/templates we created, a detail trap must be created before append, header, or footer traps.

Let’s trap the Customer line of Classic.prn using a regular expression trap.
Steps:

1. Open Classic.prn and Lesson1.dmod.

2. Select **Report Design**, choose the line containing the text **CUSTOMER** as the sample text, and then select **New Template > Append**.

3. Rename this template as **Customer**.

4. From the **Trap Type** drop-down, select **Regular Expression Trap**.

5. Select **Ignore Case** from the **Options** drop-down that displays on the Action toolbar when the regular expression trap type is selected.

6. In the trap line, type in the following: `customer:\s*(?<customer>[A-Z].*)`
   
   The trap we have just created instructs Monarch to look for a line marked “customer:” ignoring case and with any number of spaces following it and then select all of the text following this marker provided that the first character of the text to be captured begins with any character from A to Z.

![Figure 9-41. Creating a Regular Expression trap.](image)

Note that Betty's Music Store is highlighted as though we have selected it as a field.

7. Right-click on Betty's Music Store in the sample text line and select **Create a field from this capture > customer**.
The Customer field is created.

Figure 9-42. Data preview of the newly created Customer field.

Note that regardless of the length of the customer name, the field is always captured correctly.

Figure 9-43. The customer name “Die Melodie” is captured correctly even though we did not specify how large the field length should be.
Using the Exclusion Trap Feature

Monarch offers a solution for instances where you may wish to exclude specific lines from being picked up by a previously defined template. To address this issue, you can create an exclusion template.

Steps:

1. Open the Classic.prn report and go to page 4.

   Note that this page includes details for a return authorization as well as the received date.

   ![Page 4 of the Classic.prn report includes Return Authorization entries.](image)

   If we were to trap the order numbers using an exact trap (e.g., a colon), the return authorization will also be picked up. When we trapped the order number line in a previous exercise, we used an exact trap and specified that all order numbers beginning with 5 must be captured. But what happens when the order number begins with a 3 or a 4? Let’s use an exclusion template to address this issue.

2. Click on the line containing the return authorization entry and then select Report Design.

3. Select New Template > Exclusion. Ensure that the Trap Type is set to Standard Trap.

4. On the trap line, click on the position right above the first letter of the word “Return” and then type in return.
Note the change to the report shown below.

![Figure 9-45. Excluding Return Authorization entries with an exclusion trap.](image)

5. Select **Accept**.

The template we have just defined instructs Monarch to not pick up data from lines marked with "return" at position 7. In Report view, the Return Authorization line is marked as follows:

![Figure 9-46. Report view showing markings of an exclusion template.](image)

You can now trap the Order Number line using a semi-colon if you wish.
Using the Start and End Region Trap

Features

A **Start Region trap** identifies a line in a report where all other types of trapping (e.g., detail traps, append traps) should begin. Correspondingly, an **End Region trap** identifies a line in a report where other types of trapping should end. These trap features may be used in combination to specify a section (or similar sections) of a report containing data that should be further trapped.

Start/End Region traps generally make use of exact-match traps to specify at which line of a report trapping should begin/end. Only one Start and one End Region trap may be created in a model/project.

**NOTE**

Start and End Region traps are not generally used to specify sections that should not be trapped. In this case, exclusion traps should be used.

In the following example, we’ll create start and end traps spanning the first 10 entries of a patient report and then extract the patient name and service code from these entries.

**Steps:**

1. Open the report file *Patient.prn*.
2. In Report Design view, choose the line in the report beginning with "Michael Canton" as the sample text and then select **Start Region** from the New Template drop-down.
3. Create the trap shown below.

![Figure 9-47. Establishing a Start Region trap.](image-url)
Note that guillemets mark the first instance of "Michael" in the report and that all other lines before this one are marked with an X.

Because the entry "Michael Eagan" in page 2 of this report, we can’t simply use the trap “Michael.” Otherwise, data beginning from this line and continuing downward would also be captured.

4. Click to the left of the line beginning with "St Louis MO” so that the line is selected and then choose End Region from the New Template drop-down.

5. Create the trap shown below.

![Template Editor](image)

**Figure 9-48.** Data preview of the newly created Customer field.

Note that guillemets appear to the left of the line marked ”St Louis MO” and that all other lines after this one are marked with an X.

6. Click on the first line of the report marked "Michael Canton" once more and then select Detail from the New Template Region.
7. Create the trap shown below.

![Template Editor](image)

Figure 9-49. Trapping specific patient information.

8. Highlight the fields **Michael Canton** and **A0028**. Extend these fields to ensure that all of the names are correctly captured.

9. Click **Accept** to finish trapping and then select the **Table** tab.

The trapped data display as follows.

![Table](image)

Figure 9-50. The results of the present trapping operation.
[10] Working in Table View

Since you’ve learned how to create several templates for and extract data from a report in the previous lesson, let’s see how you can work between the Report and Table views.

This lesson will show you the basics of navigating and working in the Table view. Later lessons describe how to use Monarch’s built-in expressions to calculate new fields, create filters, and create sort definitions in the Table view.

When analyzing data in Table view, you may want to refer to the actual report to verify whether or not the captured information is correct. You may also want to refer to the Table view, when in the Report view, to obtain a summary of the information relevant to a specific record. The ability to switch between Report view and Table view with ease will certainly benefit your working experience with Monarch.

To start, open the Classic.prn report and the Lesson1.dmod model.

Getting to Know Table View

THE TABLE VIEW INTERFACE

Let’s take a minute to explore what you can find in the Table view interface.

Figure 10-1. An open table in Table view.
The Table interface is divided into three distinct areas. The Table ribbon is located on the topmost portion of the interface and spans the entire width of the screen. This ribbon will allow you to perform many of the table functions made available by Monarch. The Table Selector displays as a panel on the left-hand side of the interface, and the actual table is displayed on the right-hand portion of the interface.

Right-clicking on the Table selector displays a context menu that will allow you to perform the following operations:

- Perform a quick export - This export operation uses the default file extension and values specified in Export Settings and presents the Create Export dialog with all elements prefilled
- Rebuild the table
- Add an external lookup to a table
- Print a table
- Quick print a table
- Preview a table before printing
- View model information
- View project information
- View the model audit trail
- View the project audit trail

**THE TABLE VIEW RIBBON**

The following table summarizes the functions of each of the buttons in the Table ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="..." alt="Table Design" /></td>
<td>Launch the Table Design interface</td>
</tr>
<tr>
<td><img src="..." alt="Font Style" /></td>
<td>Select a font style</td>
</tr>
<tr>
<td><img src="..." alt="Font Size" /></td>
<td>Select a font size</td>
</tr>
<tr>
<td><img src="..." alt="Zoom to Fit" /></td>
<td>Set the zoom level to fit all fields on screen</td>
</tr>
<tr>
<td><img src="..." alt="Autosize Columns" /></td>
<td>Resize columns in a table</td>
</tr>
<tr>
<td><img src="..." alt="Select All" /></td>
<td>Select all of the records in the table</td>
</tr>
<tr>
<td><img src="..." alt="Copy" /></td>
<td>Copy records in the table</td>
</tr>
<tr>
<td><img src="..." alt="Search" /></td>
<td>Search for a specific record in the table</td>
</tr>
<tr>
<td><img src="..." alt="Active Filter" /></td>
<td>Select a filter to apply to the table</td>
</tr>
<tr>
<td><img src="..." alt="Active Sort" /></td>
<td>Select a sort to apply to the table</td>
</tr>
</tbody>
</table>
### USE THIS BUTTON TO...

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Go to Row" /></td>
<td>Locate a specific row or column in a table</td>
</tr>
<tr>
<td><img src="image" alt="Find in Report" /></td>
<td>Find the line in the report from which the value in a table row was obtained</td>
</tr>
<tr>
<td><img src="image" alt="Rebuild Data View" /></td>
<td>Recalculate the table. This can be useful if you use external lookups and wish to check for the most current data.</td>
</tr>
<tr>
<td><img src="image" alt="Show Field Contents" /></td>
<td>Show the contents of memo fields</td>
</tr>
<tr>
<td><img src="image" alt="Freeze Panes" /></td>
<td>Freeze specific columns and/or rows while scrolling through a table</td>
</tr>
<tr>
<td><img src="image" alt="Open Table in Data Prep Studio" /></td>
<td>Open the table in Data Prep Studio</td>
</tr>
<tr>
<td><img src="image" alt="Panopticon Designer" /></td>
<td>Launch Panopticon Designer and create a new data table populated with data from the current table. This option is disabled if you do not have a Panopticon Designer installation.</td>
</tr>
</tbody>
</table>

### THE TABLE VIEW CONTEXT MENU

Right-clicking on any column in Table view reveals a menu that will allow you to quickly do the following:

- Copy text
- Copy with formatting
- Search for a specific record
- Go to a specific row
- Go to a specific column
- Find a specific record in a report
- Autosize columns
- Adjust column widths
- Launch the Field Properties window
- Rename a field
- Hide a field
- Show hidden fields
- Create a new calculated field
- Apply a filter
- Apply a sort
Getting to Know Table Design View

THE TABLE DESIGN INTERFACE

The Table Design interface allows you to actively work with your data to obtain the information you need using the fields you extracted in a report. This interface initially shows you a list of all of the fields you extracted, as well as their properties, and a ribbon from which you can select several tools to further build your data table.

![Figure 10-2. The Table Design interface.](image)

At the bottom of the Table Design interface is a Data Preview panel, which functions exactly like the Data Preview of the Template Editor. This panel will show you how your Table view is going to look once changes made using the Table Design interface have been applied.
THE TABLE DESIGN RIBBON

The following table summarizes the functions of each of the buttons in the Table Design ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Accept</td>
<td>Accept the new template or changes to an existing template</td>
</tr>
<tr>
<td>✗ Cancel</td>
<td>Cancel the new template or changes to an existing template</td>
</tr>
<tr>
<td>✉️ Add</td>
<td>Add a new field to the table. This table could be a formula field, a lookup field, a runtime field, etc.</td>
</tr>
<tr>
<td>☝️ Duplicate</td>
<td>Duplicate the summary</td>
</tr>
<tr>
<td>☞️ Delete</td>
<td>Delete a selected field</td>
</tr>
<tr>
<td>🔗 External Lookups</td>
<td>Add an external lookup to the table</td>
</tr>
<tr>
<td>⌁ Field List</td>
<td>Display the field list</td>
</tr>
<tr>
<td>⌁ Input Fields</td>
<td>Display the properties of each input field</td>
</tr>
<tr>
<td>⌁ Database fields</td>
<td>Display the properties of each database field. This button only displays when a database table is opened.</td>
</tr>
<tr>
<td>⌁ Formula Fields</td>
<td>Add a formula field to the table</td>
</tr>
<tr>
<td>🔎 Lookup Fields</td>
<td>Add a lookup field to the table</td>
</tr>
<tr>
<td>🔌 Runtime Parameter Fields</td>
<td>Add a runtime parameter field to the table</td>
</tr>
<tr>
<td>🔌 User Edit Fields</td>
<td>Add a user-edited field to the table</td>
</tr>
<tr>
<td>🌦️ Filters</td>
<td>Add a filter definition to the table</td>
</tr>
<tr>
<td>🔥 Sorts</td>
<td>Add a sort definition to the table</td>
</tr>
<tr>
<td>🔲 Address Blocks</td>
<td>Extract data from addresses</td>
</tr>
<tr>
<td>🔧 Functions</td>
<td>Add a field function to the table</td>
</tr>
<tr>
<td>🔍 Help</td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>
Navigating Through a Table

FINDING INFORMATION IN A TABLE

While working with Monarch, you may need to locate information in Table view. You can easily do this if the report is short enough using the scroll bars. Classic.prn, for example, spans only 149 rows, so you might opt to use the scroll bar to search for information in this report. However, what if the report spans 1,376 lines? How would you search these lines to locate a single record? Monarch presents an easy way to do this via the Search box, which may be accessed by clicking Search on the Table ribbon.

The search options for Table view varies significantly from the search options for Report view in that the former includes a search option for expressions.

![The Search panel for Table view.](image)

Since we already know how to do basic keyword searches, let’s try searching through Table view using the Expression Builder. Before we do so, ensure that the first field of the first column is selected, signaling the beginning of the table.

Steps:

1. In Table view, select Search from the ribbon so that the Search box displays at the top of the table.
2. Check the box for Expression Search.
3. Let’s search for all records with amounts of greater than or equal to 100. In the search box, type in **Amount >=100** and then click Find Next.
Record 49 in Table view is highlighted. If you scroll all the way to the right of this record, you will see that it has a total amount of 307.20. A quick look through all other amounts preceding Record 49 shows no other record with an amount greater than or equal to 100.

**Figure 10-4.** Record 49 is highlighted, signifying the first record for which the expression \( \text{Amount} \geq 100 \) is true as a search parameter.

4. Click **Find Next** once more.

This time, Record 78 is highlighted, signifying the second record with an Amount value greater than or equal to 100.

5. Close the **Search** box by clicking the **Close X** icon located to the right of the Search box.

**DISPLAYING THE SOURCE OF A RECORD**

To locate the source of Record 28, we’ll use the **Find in Report** button.

**Steps:**

1. From the top of the table, scroll down until Row 28 is visible.

   Notice that Record (Row) 28 has a value of \(-59.90\) entered in the Amount column.

2. In the **Table** ribbon, select **Find in Report**.

   The Report view displays, showing the report for Record 28 in the table. The line from which the detail fields were extracted is highlighted (see Figure 10-5).
Figure 10-5. The details for Record 28 in the Table view are located in the Report view.

NOTE

Using the Find in Table Button

You can also locate the record number (table record) of any item within a report, along with pertinent information regarding the item (the amount of information you can obtain depends on the templates you’ve set up) from the Report view. To do so, click on the detail item of interest in the Report view and then select **Find in Table** from the **Report** ribbon. Table view displays the record number, as well as other information, for the detail item.
CHANGING FONTS AND FONT SIZES

As in Report view, Monarch allows you to change the font and font size used to display tables on screen.

Steps:

1. To change the font, in the **Table** ribbon, click the drop-down button on the **Font Style** box.

   ![Figure 10-6. Changing font styles.]

   2. Select the **Trebuchet MS** font from the list.

   The font style is changed throughout the entire report.

You may also change font size in order to zoom in or zoom out on the table. Experiment with the font size until you find the size you like best.

Steps:

1. Click the drop-down button on the **Font Size** box.

   ![Figure 10-7. Changing font sizes.]
Font sizes vary depending on the font style selected. If the size you want isn’t available, use the font list to select another font.

2. To change the font size to match the table width to the display width, from the Table ribbon, select **Autosize Columns**.

   This selects the font size that matches the table width to the display width so that you can view the entire width of the table, or as much of it as possible, on screen.

   If the table is too wide to fit on screen even at the smallest available font size, Monarch will select the smallest font size to fit as much of the table width as possible in the available display area.

## Formatting Fields

As we’ve seen, Monarch automatically formats the data as it builds the table. The column width is also set for each field to display the widest field value. You can override these automatic assignments, and you can make several other format adjustments, as discussed in the next few sections.

You will learn how to:

- Fill empty cells
- Adjust field widths
- Move fields
- Hide fields

For this lesson, ensure that Classic.prn and Lesson1.dmod are open in Monarch and that you are viewing the Table interface.

### FILLING EMPTY CELLS

Sometimes the report data includes “assumed dittos.” An example would be the Media column sample shown in Figure 10-8.

![Figure 10-8. An assumed ditto in the Report view.](image-url)
In this list, the media identifier "CD" obviously applies to the first three entries in the list, rather than just the first entry, even though it is only shown explicitly in the first entry. When these entries appear in the table (Records 1–3 in Table view), the “CD” is missing from the last two entries.

Monarch has an easy solution to this.

Steps:

1. In Table view, double-click on the Media field to display its properties via the Field Definition window.

2. Select the Template tab of the Field Definition window to display the template properties of the Media field.

3. Check the box for Empty Cells: Copy value from previous record and then click Accept to close the Field Definition window.

The table is rebuilt and Monarch fills in the blank cells in the Media field.

![Figure 10-9. Blank cells are no longer present in the field.](image-url)
ADJUSTING FIELD WIDTHS

When you view a table, the columns may sometimes not be wide enough to display the entire field name. When this happens, the field name will appear truncated. In other instances, even when the field values are not truncated, the columns may appear too close together.

In the figure above, for example, the field width for the Order Number column is so narrow that the field name is truncated and the field width for the Description field is so narrow that the individual records (rows) are truncated.

You can resize field widths to properly display field names and records via four ways:

- Using the Field Definitions window
  - In the Field Definition window, select the field whose width you want to increase and then increase the number shown in the Display Width box in the General tab that displays. Select Accept twice when you are done to apply your changes.

- Using the mouse
  - Move the mouse pointer to the right edge of the relevant field title. The mouse pointer will become a resizing handle, which you can drag left or right to resize the field.

- Using the Autosize Columns button
  - The use of this button resizes all fields to match the widest field value or the field name, whichever is wider.

  - If you reduce the width of a character field or a date field to less than the length of a field value, the field value is truncated on screen. If you reduce the width of a numeric field to less than the width of a field value, the field value is truncated as well.

- Using the Column Widths functionality
  - Right-clicking on a field produces a menu from which you can choose “Column Widths” and then three other options for resizing the width of a field.

    - You can either:
      - Set the column size to the width of the widest column label, or
      - Set the column size to the width of the widest data value, or
• Set the column size to the width of a specific field

**NOTE**

The column width setting affects only the appearance of the data on screen and in printed output. It does not affect the underlying data.

**ORDERING FIELDS**

Table fields may be ordered any way you wish by dragging and dropping a field or several fields into a new location in the table or using the Move Up/Move Down buttons in Table Design view.

**HIDING FIELDS**

Frequently, you may want some data hidden from view but not deleted from the table.

**NOTE**

Hidden table fields are not available for export and copy operations.

For example, the Report Date and Page fields contain useful information, but you may not want them visible while working with data from the other fields. Let’s hide these fields. To do so:

**Steps:**

1. In Table view, click anywhere on the Report date field.
2. Using your mouse, right-click and then select Hide from the context menu that displays.

   The field is immediately hidden.
3. Repeat Steps 1 and 2 to hide the Page field. The selected fields are now hidden (see Figure 10-11).
Assigning Field Types

When Monarch builds a table, it automatically assigns a field type to each field based on the first instance of that field in the report. If Monarch finds a number when it first extracts a field, for example, it assigns the numeric format. Usually, the first instance of a field is representative of other instances; when it is not, however, you must manually override the assigned format to assign the proper format.

You can set fields to have one of the following formats:

- Character
- Numeric
- Date/Time
- Memo

When Monarch assigns an incorrect field format, you can change the setting to a more appropriate one using either the Field Definition window or the Table Design interface.

- Using the Field Definitions window

  Double-click on the field of interest in Table view. In the Field Definitions window that displays, select the appropriate field type from the Type drop-down field in the General tab.
Using the **Table Design** view

On Table view, select **Table Design**. Select the field whose format type you wish to change from the list that displays and then click its corresponding cell under the column **Type**. A drop-down button displays to the right of the cell. Use this drop-down to select a new field type.

At this point, you can either save your work or simply close the report and model you opened.

## Creating Headers and Footers

### CREATING A PAGE HEADER

Monarch allows you to add a descriptive title to the top of each printed page via the **Header Layout** settings of the Page Setup dialog.

A page header is divided into three sections, Left, Center, and Right, all of which represent locations in which you may want to add information. You can dynamically add information to the page header, including page numbers, the print date and time, the names of the active filter and sort, as well as the first value of any field in the table. You can also add any text you wish and even specify the font to use in the header.

Before we begin, ensure that you have the **Classic.prn** report and **Lesson1.dmod** model open and that you are in Table view.

**Steps:**

1. Select **File > Page Setup**.

Note that because you have both a report and a table open in the current Monarch session, the Page Setup dialog slightly differs from the dialog we saw in Chapter 7.

![Figure 10-12. Adding a page header to the printout.](image)
2. On the left-hand side of the dialog, select **Table** from the list of available views.

The **Page Setup** dialog displays page options available for Table view.

![Page Setup dialog](image)

**Figure 10-13.** Page preferences for Table view.

3. Select the **Header Layout** tab.

4. Double click on the first cell of the column labeled **Left**.

A menu options arrow displays on the cell.

![Header Layout dialog](image)

**Figure 10-14.** Adding a page header to the printout.

5. Click the arrow that appears and then select **Date** from the options that display.

6. Double-click on the first row of the column labeled **Center**.

7. Type Classical Music Distributors into the cell.

8. Double-click on the first row of the column labeled **Right**.

9. Click the arrow on the cell and then select **Page Number** from the options that display.
10. Double-click on the second row of the column labeled **Left**.

11. Type **Report:** followed by a space, and then click the arrow on the cell. Select **Input Name** from the options that display.

12. Double-click on the third and last row of the column labeled **Left**.

13. Type **Model:** followed by a space, and then click the arrow on the cell. Select **Model File Name** from the options that display.

   Figure 10-15 shows how the **Page Header** section of your **Page Setup** dialog should look when you are finished.

14. Click **OK** to accept your changes and close the **Page Setup** dialog.

15. To view your new header, select **File > Print 🖨️ > Print Preview**.
Figure 10-16. A fully set up page header.

NOTE

If your table is wider than it is long, you may wish to change your paper orientation to landscape. To do so, select the Paper Orientation icon on the Print Preview window and then select Landscape.

CREATING A PAGE FOOTER

Creating a page footer is no different from creating a page header except that, this time, your definition appears at the foot of the page. Select Footer Layout from the Page Setup dialog to format a page footer for your table.
Printing Table Data

In this lesson, you will learn how to print and copy data from Table view.

This chapter assumes you are familiar with importing and viewing report files, creating data extraction templates and working in the Table view.

ADJUSTING PAGE SETUP OPTIONS

Several page setup options are provided, and you can use these options to establish margins, add a page header to each page, print column titles and row numbers, and print the grid lines that you see on-screen.

To edit the page setup options, we’ll use the Page Setup dialog.

Steps:

1. Select File, and then click Page Setup. The Page Setup dialog displays.
2. On the left-hand side of the dialog, select Table from the list of available views. The Page Setup dialog displays page options available for Table view.

   Figure 10-17. The Page Setup dialog.

   The tab shows the current margin settings and print options for the table.

3. Ensure that the Show Row Numbers box is unchecked to deactivate row numbers in our printout. Click OK when you are finished setting up your page options.
PRINTING TABLE DATA

The table is usually much wider than the report as Monarch combines fields from various levels in the report to create each row of the table. When Monarch prints data from the table, it prints as many fields as will fit across the page. If all of the fields will not fit on a single page, the remaining fields are wrapped to the next page. The amount of information that will fit on each page is determined by several factors:

- The font size has a dramatic effect on the amount of data that fits on each page. To fit all the fields across the page, you may need to select a smaller font size.
- The **Paper orientation** setting specifies the direction that text will print. For wide tables, set the paper orientation to **Landscape** to print the text sideways on the page.
- Margins affect how close text is allowed to print to the edge of the page. You can use the margins to make small adjustments to the amount of text that will fit on each page.

Monarch lets you print just the data you need. You can print the entire table or any selection from the table. Let’s select and print the first page of the report.

Steps:

1. Select **File**, and then click on the arrow of the **Print** menu. Select **Print** from the options that display.

   The **Print** dialog displays.

   ![Print dialog](image)

   Figure 10-18. The Print dialog.
2. Select the printer you would like to use to print the first page of the report if it has not been selected yet. In the above screenshot, for example, the printer **HP Laserjet Professional M1212nf MFP** was selected.

3. In the *Page Range* section, select the button for *Pages*, and then type the number **1** in the box beside it.

4. Choose **Print** to print the page.

   The first page of the report is printed.

### Copying Data to Other Applications

You can use the Windows clipboard to copy table data to other applications. When you copy data to the clipboard, Monarch creates both a text image and a worksheet image (with separate rows and columns). When you subsequently paste the data to another application, the application selects the format it needs.

Let’s copy the records for Betty’s Music Store to your spreadsheet.

**Steps:**

1. Return to **Table** view.

2. Select the first 9 records in the table by clicking down on the row selector to the left of Record 1, then dragging down to Record 9.

3. Select **Copy** from the Table ribbon.

4. Launch your spreadsheet. If you don’t have a spreadsheet, just follow along in the tutorial.

5. Position the cell pointer where you want the data to appear and use your spreadsheet’s **Paste** command to paste the data. For some spreadsheet applications, you may need to use the **Paste Special > Text** command.

6. Adjust the column fields as necessary to view all of the data.
7. Adjust column widths and cell formats in your spreadsheet as necessary.

**NOTE**

Monarch does not set the column widths automatically because this might alter an existing worksheet’s column widths when the data is pasted. If the spreadsheet that you are pasting into is empty, you may prefer to export the data using the **Export** command. When data is exported, the column widths are set appropriately for the data.

7. Exit your spreadsheet without saving it.
Redacting Fields

The redaction feature provides a way to remove private or sensitive data from a report. A simple form of redaction involves overstriking the sensitive data with “X”s. More advanced forms involve replacing the sensitive data with “pseudo” data, i.e., values which are similar in form but have no relation to the actual data. For example, suppose a report contains Social Security numbers. It would be difficult to publish an analysis of this report without compromising the privacy of the SSNs involved. Monarch’s SSN redaction capability solves this problem by replacing the actual SSNs with “pseudo” SSNs – 9 digit numbers that look like Social Security numbers but are actually just patterns of digits. The cleansed data may then be analyzed and published without fear of compromise.

REDACTING A SINGLE FIELD

To define redaction for any report field, simply choose the desired type of redaction from the Redaction dropdown located on the Template tab of the report field editor, as shown below. Choose None if no redaction is desired. Newly created report fields always start with redaction set to None.
It is possible to enable or disable the report field redactions across the entire model, via a checkbox on the Options > Input page as shown below. When this box is checked, each report field is redacted (or not) according to its specific redaction setting. When this box is not checked, then report field redactions are disabled, so each report field behaves as if its redaction was set to None. It should be noted that this setting affects only redactions specified for report fields – it has no effect on the behavior of any redaction functions used in calculated field expressions.

The figure below, for example, shows the redaction properties for all models to be applied in the current Monarch session.

![Figure 10-21. Specifying redaction for an entire model.](image-url)

In this chapter, you will learn how to sort data in Table view. The lesson topics include:

- Sorting the table
- Creating a sort definition
- Sorting on multiple fields
- Duplicating a sort order definition
- Restoring the original sort order

This chapter assumes that you are familiar with importing and viewing report files and working in Table view.

When you extract data from a report file, the information is arranged in the Table view in the order that it appears in the report but you may want to view, print, or export the data in another order. Sorting allows you to re-order the table to suit your needs.

To sort the data in the Table view, you create a sort order definition, which specifies the parameters for sorting. The sort order definition includes the fields to sort on, the sort order for each field (ascending or descending), and the hierarchy for the sort. You can create multiple sort order definitions and switch between them to see different views of your data.

To start this lesson, load Monarch and open the Classic.prn and Lesson2.dmod.

Creating a Sort Order Definition

The Classic report is sorted by Customer and Ship Date. When the report data are extracted and assembled as records in the Table view, the records appear in the same order. Records for Betty's Music Store appear first, then records for Big Shanty Music, and so on. Within each customer, the records are sorted by ship dates. While this sort order is useful, you may want to view the data in another order. Let's sort the table based on the Description field.

To sort the table, you use the Sort Order Definition window to create a sort definition.

Steps:

1. Select Table Design from the ribbon to launch the Table Design interface and then click Add > Sort from the Table Design ribbon.
The Sort Order Definition window displays.

![Figure 11-1. The Sort Order Definition window.](image)

From this window, you can create multiple sort definitions and switch between them to see different views of the table.

The Available Fields box displays the fields from the table. The Selected Fields box displays the fields used in the sort definition, from highest sort level to lowest. To add a field to the definition, select the field from the Fields box, then click Add >>. To remove a field, select the field from the Selected Fields box, then click << Remove.

2. Type **Product Description** into the Name box then select the ✔️ icon that displays next to the field.
NOTE

Sort definition names may be up to 31 characters in length and may contain uppercase and lowercase characters, spaces, and punctuation. However, periods (.), exclamation points (!), accent graves (´), and brackets ([ ]) may not appear in any part of the name. As well, names may not begin with spaces. If a name is entered with leading spaces, the name is accepted but the leading spaces are trimmed.

3. Select the **Description** field from the *Available Fields* box, and then click the **Add >>** button.

   The **Description** field appears in the *Selected Fields* box. When a field is moved to the *Selected Fields* box, its initial sort order is *Ascending*. To change the sort order of a field, right-click on the field to display a context menu and select **Change Order** from the menu. Since we want to sort the field values in ascending order, we’ll leave the sort order as it appears.

4. Choose **Accept ✔** to accept the sort definition and close the *Sort Order Definition* window.

5. On the Table ribbon, select the drop-down button of the **Active Sort** box and then select **Product Description**.

   The data in the Table view is rearranged according to the **Product Description** sort order.

   Figure 11-2. Table view sorted by the Description field values.
Sorting on Multiple Fields

In the previous section, we sorted the table on a single field. Monarch also lets you sort on multiple fields. Let’s sort the table again, this time on two fields, Media (in ascending order) and Amount (in descending order).

Steps:

1. Launch the Sort Definition window once more by selecting **Table Design** > **Add** > **Sort**.

2. Type **Descending Sales by Media** in the **Name** box of the **Sort Order Definition** window that displays and then select the ✔ icon that appears next to this field.

3. Move the **Media** and **Amount** fields to the **Selected Fields** list.

   Let’s change the sort order of the **Amount** field to sort the values in descending order (largest values to smallest value).

4. Right-click on the **Amount** field, then select **Change Order** from the context menu.

   If you don’t provide a name, Monarch will attempt to name the sort definition using the name of the first sort field you specified, in this case, **Media**. If this name is already in use by another sort definition, you will be prompted to enter a name.

5. Choose **Accept ✔** in the Table Design ribbon to accept the sort definition and close the **Sort Order Definition** window.

6. In Table view, click on the drop-down button of the Active Sort box and then select **Descending Sales by Media**.

   The data in the Table view are sorted, first by Media and then by Amount. The **Amount** field values for each media type are sorted in descending order.

![Table view sorted by ascending Media and descending Amount.](image)
Restoring the Original Table Order

You can turn off sorting and restore the original record order by simply selecting the **No Sort** option in the **Active Sort** drop-down.

![Figure 11-4. The original table order displays when the No Sort is applied to the table.](image)

Duplicating Sorts

You may want to create a new sort that closely resembles a sort you previously defined. An easy way to do this is by using the **Duplicate** button. To duplicate a sort, simply select the sort you want to duplicate from the Sort list and then select **Duplicate** from the Table Design ribbon. The duplicated sort appears on the Sort list; this sort will have the name of the sort you duplicated and a number appended to it. Select **Accept** when you are finished to accept and save your new sort definition.
Working with Filters

In this chapter, you will learn how to use a filter to display a subset of the table data. The lesson topics include:

- A discussion of what a filter is
- Creating a filter expression
- Testing a filter expression
- Using functions
- Restoring the original table data
- Working with value-based filters

This chapter assumes that you are familiar with opening reports, creating a data extraction template, and working in Monarch’s Table view.

There are several types of filters you can create:

- **Value-based filters**
  
  Value-based filters offer simple filters that are typically used to obtain records with only one or two specifications. In Classic.prn, for example, you could use a value-based filter to return details for records with descriptions of “Mozart” and “Chopin.” Creating a value-based filter entails identification of a single field on which your filter will be based, and then specifying the exact value(s) of the filter.

- **Formula-based filters**

  Formula-based filters, in their simplest form, function very much like value-based filters. However, formula-based filters offer increased filter-making versatility. Working with Classic.prn again, let’s say you want to filter a table for all CD sales amounting to $50.00 and above. Using a value-based filter here is out of the question because only one field name can be specified with such filters. The filter you want to create specifies conditions for two fields, Media and Amount. Here, a formula-based filter would be more appropriate.

- **Compound filters**

  Compound filters function as extensions of formula-based filters, and help you create longer filters with two or more component filters.
To start the lesson, load Monarch, open Classic.prn and Lesson3.dmod, and then launch Table view.

The table in Figure 12-1 lists transactions for distributors of classical music recordings. Transactions are included for each customer and are broken down by media types, including CDs, LPs, DVDs, SACDs and Blu-ray discs. In all, there are 149 records in the table.

By applying a filter, you can select only those records that interest you and filter out the rest. Let’s use a filter to view only the records for a particular customer, i.e., Big Shanty Music.

Creating Value-Based Filters

To filter table data, you create a filter expression via the Filter Definition window. In the following exercise, we will create a value-based filter such that only records for the customer “Big Shanty Music” are returned.

Steps:

1. From the ribbon of Table view, select Table Design to launch the Table Design interface and then click Add > Filter > Value Based Filter.
The Value-Based Filter Definition window displays.

![Image](image-url)

**Figure 12-2. The Value-Based Filter Definition window.**

Let’s take a moment to study the Value-Based Filter Definition window. The panel on the left-hand side of the window is a Filter Selector. This panel is particularly useful if you want to modify an existing filter, for example, and you have several filters defined. The Value-Based Filter Definition window contains two tabs that help you define your filter. At the bottom of the window, Data Preview button, shows you what your table will look like if the filter you’ve just defined is applied to it.

In the Field Values tab of the Filter Definition window, several options display, each of which can help you create your filter.

Let’s say you are creating a filter where only records for Fandangos Records and Musique Royale are to display. You would then select Customer from the Field drop-down list and specify values for Fandangos Records and Musique Royale. In the Row Selection section, you can specify whether to display all records for either Fandangos Records or Musique Royale or display all records that are not by Fandangos Records or Musique Royale (i.e., all records except those from Fandangos Records and Musique Royale will display). You can also select whether records with blank customer names will display in your table after the filter is applied.

The Value box displays the type of values you must enter for the selected field. For example, when you select the field Quantity, all of the values to be entered into the field must be of the type Numeric. When you select the field type Description, all of the values to be entered into the Value field must be of the type Character. If you enter a character string into the Value field for a numeric field, the filter will not be created.

The Import values filtered by... drop-down list allows you to easily select field values for the Value box, including values you entered for previous filters. When you click on this box, a list of previously created filters displays, including the “No Filter” option. Clicking on any option on the list and then selecting the Add Rows button automatically adds all available values for the selected field name. Again, values to be entered must match the type of field you selected. When you select the No Filter option and then click Add Rows, all possible values for that field display in the Value box. You may delete values added to the box by clicking on the value and then selecting the Delete button.
In the Advanced tab, you can find options that allow you to either display all rows (records) that fit the filter description you specified or limit the display to a certain number of rows.

2. In the Field Values tab, dpublenter Big Shanty Music in the Filter Name box and then select ✔.

3. In the Field drop-list, select Customer.

4. Double-click the first cell in the Value box and then enter Big Shanty Music.

5. Ensure that the radio button for Include rows where the field value matches one of the selected values is selected.

6. Click Accept ✔ to save the details of the filter you specified and close the filter definition window.

7. In Table view, select the drop-down button of the Active Filter field and then select Big Shanty Music.

The table is rebuilt to show only those records from Big Shanty Music.

You have successfully created a value-based filter.

Creating Formula-Based Filters

To display only transactions amounting to US$100.00 and above, we’ll use the following expression:

Amount>=100

To build the expression above, which is a formula-based one, you could type the expression as it appears above, or you could build it by inserting components from the list boxes.

Steps:

1. From the Table Design ribbon, select Add > Filter > Formula-Based Filter.

2. In the Filter Name box, enter Sales >=100 and then select ✔ to accept this name.
NOTE

Filter definition names may be up to 31 characters in length and may contain uppercase and lowercase characters, spaces, and punctuation marks. However, periods (.), exclamation points (!), accent graves (‘), and brackets ([ ] ) may not appear in any part of the name. As well, names may not begin with spaces. If a name is entered with leading spaces, the name is accepted but the leading spaces are trimmed.

3. Double-click Amount from the Fields list
   “Amount” displays on the Expression box.

4. Double-click the greater than or equal to (>=) sign from the Operators list.
   The greater than or equal to sign is added to the expression.

5. Click on the Expression box right after the operator “>=” and then type in 100.

6. Select the Accept ✓ icon that displays in the Expression box to accept your formula.

7. Check the Data Preview panel.
   All of the records that display should have amounts greater than or equal to 100. Note, however, that the Data Preview only shows the first 100 records extracted from a report, or first 100 rows imported from a database, so depending on the data, you may not see rows affected by the filter in the Data Preview.

8. Select Accept ✓ in the Filter Definition ribbon to save your new filter and close the Table Design interface.

9. In Table view, select the drop-down button of the Active Filter box and then choose the filter Sales >=100.
   The table displays only those transactions amounting to US$100.00 or greater (see Figure 12-4).

Figure 12-4. The Table view showing all transactions amounting to or over $100.00.
Creating Compound Filters

Compound filters allow you to create longer, more-complicated filters composed of previously created ones. Let’s create a compound filter using the value- and formula-based ones we specified earlier.

If you wanted to create a filter that will return all records from Big Shanty Music AND all records with transaction amounts greater than or equal to US$ 100.00, you could create a formula-based filter such as the following:

\[ \text{Customer} = \text{"Big Shanty Music"}. \text{AND.} \text{Amount} \geq 100 \]

If you wanted to create a filter that will return all records from Big Shanty Music OR all records with transaction amounts greater than or equal to US$ 100.00, you would create the following formula-based filter:

\[ \text{Customer} = \text{"Big Shanty Music"}. \text{OR.} \text{Amount} \geq 100 \]

While you can create either of the filters this way, selecting fields, operators, and values, as well as determining the correct way to link individual filter expressions may be a tedious task. Here, Monarch allows you to create compound filters whose components you can simply select from a list.

The following steps will show you how to create a compound filter that will return all records that are either by Big Shanty Music or have amounts greater than or equal to US$ 100.00.

Steps:

1. From the Table Design ribbon, select Add > Filter > Compound Filter.
2. In the Filter Name field, enter **Big Shanty Music and Sales>=100** then select ✓.
3. Select **Big Shanty Music** from the Available filters box by clicking on it and then move it to the Component filters box by clicking Add>>.
4. Repeat Step 3 to move the filter **Sales>=100** to the Component filters box.
5. In the Select rows that satisfy section, select the radio button for any one of the component filters.
   - This selection instructs Monarch to display records that have either Big Shanty Music as the customer or transaction amounts greater than or equal to US$ 100.00.
   - If you select all of the component filters, only those records that are by Big Shanty Music and have sales amounts greater than or equal to US$ 100.00 will display in the Table view. Of course, in this case, no records will display because none of Big Shanty Music’s sales amount to over US$100.00.
   - Note that the component filters, as well as the type of link (AND/OR), display in the Component filter expression box. In the present example, the component filter expression should read: **[Big Shanty Music] OR [Sales>=100]**.
6. Click Accept ✓ in the Filter Definition ribbon to accept your new filter definition.
7. From the Active Filter drop-down, select the filter **Big Shanty Music and Sales>=100**.
The table is rebuilt and your filter is applied.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Ship Date</th>
<th>Media</th>
<th>Quantity</th>
<th>Description</th>
<th>Label Number</th>
<th>Unit Price</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Big Shanty Music</td>
<td>20100405</td>
<td>CD</td>
<td>6</td>
<td>Stravinsky, Dumbarton Oaks Suite</td>
<td>SMDG 5120</td>
<td>8.99</td>
<td>53.04</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100403</td>
<td>CD</td>
<td>1</td>
<td>Schubert, Sonata in C, D. 300</td>
<td>AS-320</td>
<td>9.00</td>
<td>9.00</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100405</td>
<td>CD</td>
<td>3</td>
<td>Mozart, Symphony No. 23 in D</td>
<td>CO-77884</td>
<td>8.99</td>
<td>26.97</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100404</td>
<td>CD</td>
<td>6</td>
<td>Schumann, Ode to Napoleon</td>
<td>CHAN 9116</td>
<td>9.59</td>
<td>57.54</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100404</td>
<td>CD</td>
<td>2</td>
<td>Shostakovich, 24 Preludes for Piano</td>
<td>CDX 66620</td>
<td>5.39</td>
<td>10.78</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100414</td>
<td>SACD</td>
<td>9</td>
<td>Rakman, Symphony no. 1</td>
<td>RNTPO 4110</td>
<td>9.59</td>
<td>86.31</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>20100414</td>
<td>DVD</td>
<td>5</td>
<td>Holst, St. Paul’s Suite for Orch.</td>
<td>CBT-1020</td>
<td>5.99</td>
<td>29.95</td>
</tr>
<tr>
<td>Hope’s Sweet Notes</td>
<td>20100418</td>
<td>CD</td>
<td>8</td>
<td>Misc., The Art of Perlman, Itzhak, vn.</td>
<td>4-ZDMZ-64017</td>
<td>38.49</td>
<td>307.10</td>
</tr>
<tr>
<td>Das Piano</td>
<td>20100438</td>
<td>SACD</td>
<td>9</td>
<td>MacDowell, Sonata C major in C</td>
<td>NRP 33017</td>
<td>11.68</td>
<td>157.62</td>
</tr>
<tr>
<td>Reiner’s Symphonic Sounds</td>
<td>20100412</td>
<td>CD</td>
<td>9</td>
<td>Puccini, Madame Butterfly (opera)</td>
<td>CDC 47959</td>
<td>15.58</td>
<td>140.22</td>
</tr>
<tr>
<td>Spring 19 Records</td>
<td>20100418</td>
<td>CD</td>
<td>11</td>
<td>Misc., Nova Schola Gregoriana</td>
<td>ARN 66954</td>
<td>9.59</td>
<td>105.49</td>
</tr>
<tr>
<td>Musique Royale</td>
<td>20100407</td>
<td>CD</td>
<td>4</td>
<td>Glass, Einstein on the Beach</td>
<td>RAK 38712</td>
<td>35.49</td>
<td>143.00</td>
</tr>
<tr>
<td>Musique Royale</td>
<td>20100419</td>
<td>CD</td>
<td>7</td>
<td>Haydn, Paris Symphonies</td>
<td>SMKD 75750</td>
<td>17.98</td>
<td>125.86</td>
</tr>
<tr>
<td>The Glass Harmonia</td>
<td>20100422</td>
<td>SACD</td>
<td>8</td>
<td>Adorno, Postcard from Morocco</td>
<td>GRI 2614</td>
<td>20.38</td>
<td>163.04</td>
</tr>
<tr>
<td>The King’s Piece</td>
<td>20100414</td>
<td>SACD</td>
<td>11</td>
<td>Rachmaninoff, Piano Concerto</td>
<td>MKE 42478</td>
<td>9.59</td>
<td>105.49</td>
</tr>
</tbody>
</table>

Figure 12-5. The resulting compound filter.

**Using Functions in Filters**

Monarch provides a host of functions you can use in your filter expressions. For example, to display only shipments of symphony recordings, you can use the expression:

```plaintext
Instr("Symphony", [Description])
```

The Instr() function searches a field for the occurrence of a string. In the above example, the expression returns only those records where the word “Symphony” appears anywhere in the Description field. The brackets surrounding the Description field name are required, as this field name is longer than 10 characters.

Monarch supports over 70 functions. The Monarch Help file contains detailed information about each function, including examples of their use in filter expressions. Monarch also includes a host of user-defined functions. You can create your own functions to provide an easy way to store and use complex expressions, and these functions can be shared to other co-workers who use Monarch.
Restoring the Original Table Order

You can turn off filtering and re-display all of the table data by selecting the No Filter option in the Filters menu.

Steps:

1. Select the Active Filter drop-down button and then select No Filter to disable all filters.

   Table view displays all of the original table data extracted by Lesson3.dmod from Classic.prn.

   At this point, you can opt to either save your work or simply close the report and model files you opened for this lesson. For the rest of this chapter, we do not need to save our work.

Duplicating Filters

You may want to create a new filter that closely resembles a filter you previously defined. An easy way to do this is by using the Duplicate button. To duplicate a filter, simply select the filter you want to duplicate from the Filters list and then select Duplicate from the Table Design ribbon. The duplicated filter appears on the Filters list; this filter will have the name of the filter you duplicated and a number appended to it. Select this filter to display its properties in the Filter Definition window and make further revisions to it. Select Accept when you are finished to accept and save your new filter definition.
[13] Working with Calculated Fields

In this chapter, you will learn how to calculate new fields from the data in the Table view. The lesson topics include:

- A discussion of what a calculated field is
- Creating a calculated field
- Making comparisons
- Hiding and deleting calculated fields

This chapter assumes that you are familiar with opening reports, creating a data extraction template, and working in the Monarch’s Table view.

A calculated field is a field whose value is derived from other fields in the same record. Calculated fields can be used to perform a variety of tasks, including arithmetical computations, concatenating character fields, and extracting information from a field. You can create and save multiple calculated fields. Once a calculated field is created, you can use it in filter, sort and summary definitions and copy, print and export it along with other fields.

You can create several types of calculated fields in Monarch via the Table Design interface. These fields include:

- Formula-based
  To create a formula-based calculated field, you create a calculated field expression. A calculated field expression is a formula that returns a value to a calculated field.

- Runtime Parameter
  Runtime parameter calculated fields are very much like formula-based ones. The major difference between them is that runtime parameter calculated fields do not contain a formula, just a simple string, number or date value. The user is prompted to supply values for each runtime parameter when the model is loaded.

- Lookup
  A lookup calculated field provides a convenient "table lookup" where the value of a designated input field is checked against a lookup table. They can be useful in avoiding the long and complicated IF statements that can occur in formula-based calculated fields.
A user-edited calculated field is special in that it allows the user to enter text to annotate rows in the table or enter corrections for bad data.

To start this lesson, we’ll load Monarch and open Classic.prn and Lesson9.dmod. Switch to Table view when done.

The table in Figure 13-1 lists transactions for distributors of classical music recordings. We’ve extracted the detail information for each transaction along with the customer name and account number.

By creating calculated fields, we can derive new information from the table data. For example, we can create a new field that calculates a 20% discount for all transactions. Let’s give this a try.

Creating a Formula Field

In the previous lesson, we created a filter using a formula expression. We’ll apply the same concept in this lesson to add a new column to our table.

Steps:

1. Select Table Design to activate the Table Design interface and then click Add > Formula Field from the Table Design ribbon.
The Formula Fields Definition window displays.

![Figure 13-2. The Formula Field Definition window.](image)

2. In the **General** tab of the window, enter **Discount** in the **Name** box and then select the ✔ icon to accept this name. This name will display as the field name when the results of our calculation definition are shown in Table view.

**NOTE**

Field names may be up to 62 characters in length and may contain uppercase and lowercase characters, spaces, and punctuation marks. However, periods (.), exclamation points (!), accent graves (´), and brackets ([ ] may not appear in any part of the name. As well, names may not begin with spaces or underscores (_). If a name is entered with leading spaces, the name is accepted but the leading spaces are trimmed.

Since this expression will result in a numeric value, we need to set the appropriate formatting for the field.

3. From the **Type** drop-down list, select **Numeric**.

4. Enter **2** in the **Decimals** box.

5. Select the **Formula** tab.

To define a calculated field, you build a calculated field expression that returns a value to the field. The calculated field expression appears in the **Expression** box near the bottom of the **Formula** tab. Several list boxes display the field names from the table, arithmetic and logical operators, and functions that you can use in your calculated field expressions.
To calculate a 20% discount for all transactions, we’ll use the expression,

\[ \text{Amount} \times 0.2 \]

To build this expression, you could type the expression as it appears above, or you could build it by inserting components from the list boxes. Let’s start by inserting the *Amount** field.

6. Double-click on the **Amount** field in the **Fields** box.

The *Amount** field is inserted in the **Expression** box. Double-clicking an item also inserts it into the box automatically.

7. From the **Operators** list, double-click the **multiplication sign (\(*\)**) so that it is added to the Expression box.

8. Click on the space beside the \(*\) in the Expression box, type \(0.2\), and then click **Apply**.

The **Data Preview** tab should show a new field containing values obtained from the expression we defined.

9. Choose **Accept** in the Formula Field Definition ribbon to accept the calculated field definition and close the window.

A new field name, labeled **Discount**, is added to the end (far right) of the table.

A table is shown with columns for Account Number, Customer, Shipped Date, Media, Qty, Description, Amount, and Discount. The table includes several rows with details for different music-related transactions, including the calculation of discounts. The table is labeled **Figure 13-3. Table view with Discount calculated field.**
Creating a User-Edited Field

CREATING USER-EDITED FIELDS

Let’s create a user-edited field and see what it can do to a table. Note that user-defined fields are only saved in project files, not model files.

Steps:

1. Select **Table Design** to activate the Table Design interface and then click **Add > User Edit Field** from the Table Design ribbon.

   The User-Edited Field Definition window displays.

   ![Figure 13-4. The User-Edited Field Definition window.]

2. In the **General** tab, enter the name **Comments** and then click the ✔️ icon that displays to accept this name.

3. Change the **Display Width** of the field to 40 and then click **Accept ✔️** to save your field.
Table view displays the new field to the far right of the table.

### USING USER-EDITED FIELDS

**Steps:**

1. Double-click on the first cell of the Comments field (Row 1).
   
   Note that the interface changes and the cell you selected becomes editable.

2. In the cell, type in "New delivery 12/2018" and then click **Apply**.
Making Comparisons

In the previous section, we created a calculated field using a simple arithmetical expression. Monarch lets you create more complex expressions involving comparisons. Let’s use this feature to calculate a discount only for sales amounts of US$75.00 or more. Rather than create a new calculated field, we’ll edit an existing calculated field to apply our new discount strategy.

Steps:

1. Select **Table Design** and then click **Formula Fields** on the ribbon that displays to launch the Formula Field window once more.

2. Select **Discount** from the Formula Field selector and then click on the **Formula** tab to display its properties.

   To apply the discount only for sales amounts of US$75.00 or more, we’ll use the IF() function in our calculated field expression:

   
   \[
   \text{IF}(\text{Amount} \geq 75, \text{Amount} \times 0.2, 0)
   \]

   In plain English, this expression reads, “If the Amount field contains a value of 75 or greater, use the first expression (Amount*0.2) to calculate a discount, otherwise, use the second expression (0) to show no discount.”
3. Enter the calculated field expression above into the Expression box so that it reads as shown in Figure 13-8 and then click the Apply icon that displays subsequently.

![Expression (Numeric)](image)

Figure 13-8. The modified Discount calculated field definition.

4. Click Accept in the Formula Field Definition ribbon to accept the new calculated field definition and close the window.

The field is re-calculated to show a discount only for transactions with an amount of $75.00 or more.

![Figure 13-9. Updated Discount field.](image)

Now let's use another Monarch feature to suppress the zero values so that our discount values will appear more prominent.

5. Select the Home tab, and then click Options.

The Options window displays.

This window includes several options that control the way data appear in Monarch.
6. Select **View** to display the View options.

![View Options window](image)

**Figure 13-10. The View Options window.**

7. Check the Suppress zero values box.

8. Delete any value indicated in the **Display null values as** box.

9. Click **Accept** in the Options ribbon to close the window and apply your settings to the table data.

The table displays with zero values suppressed.

![Zero values suppressed](image)

**Figure 13-11. Zero values suppressed.**

At this point, you can opt to either save your work or simply close the report and model files you opened for this lesson. For now, simply close all open files.
Redaction Functions

Monarch supports a set of redaction functions for use in calculated field expressions. These functions appear in the Redaction section in the Functions list box of the formula editor, as shown below. See the Help file for more information on these functions.

Figure 13-12. Several redaction functions are available in the formula editor.

Regex Functions

Besides redaction functions, Monarch also supports a number of Regex functions. The Monarch Help file contains more information on these functions.

Figure 13-13. Regex functions available in the formula editor.
Hiding and Deleting Calculated Fields

You can temporarily turn off the display of a calculated field by hiding it. Monarch will still re-calculate the hidden field while you make other changes to the table. However, if your calculated field expression is computationally intensive, this can slow down the display of the table.

Of course, you can get rid of a calculated field altogether by deleting it altogether. When you delete a calculated field, the field is removed from the table and the calculated field definition is deleted.

To delete a calculated field, launch the Formula Field Definition window, and then select the name of the calculated field you wish to delete. Select Delete from the ribbon. Be careful to select the correct field name – Monarch has no undo facility for deleted objects.

Duplicating Calculated Fields

You may want to create a new calculated field that closely resembles a calculated field you previously defined. An easy way to do this is by using the Duplicate button. To duplicate a calculated field, simply select the calculated field you want to duplicate from the Calculated Fields list and then select Duplicate from the Table Design ribbon. The duplicated calculated field appears on the Calculated Fields list; this calculated field will have the name of the field you duplicated and a number appended to it. Select this calculated field to display its properties in the Calculated Field Definition window and make further revisions to it. Select Accept when you are finished to accept and save your new calculated field definition.
[14] Working with Multiple Instances of a Report

In the previous chapters, we’ve worked with only one report at a time. In this chapter, you will learn how to open and analyze data from multiple reports. The lesson topics include:

- Analyzing data from a series of reports
- Opening multiple instances of a report
- Extracting data
- Working in the Table view
- Creating a summary to analyze data from multiple reports

In most organizations, reports are run on a regular basis -- typically weekly or monthly. Each instance of a report contains information about a specific period of time.

In addition to producing a new report each week or month, some organizations produce a separate report for each department, division or region. For example, a retailer might divide its market into four distinct regions: Northeast, Central, South and West. A monthly sales report is generated for each region.

![Figure 14-1. Each report includes information for a specific region.](image)

Each instance of the report contains useful sales information for a single region, but it does not tell you how a particular product is selling nationally. For that, you will need to analyze data from all four regions. With Monarch, you can open all four regional reports and create a summary showing sales of the product within each region with a grand total for all four regions. The resulting summary might look like Figure 14-2.

![Figure 14-2. Comparing product sales across four regions.](image)
By analyzing data from all four regional sales reports, you can compare sales results for each region. Since each sales report is generated on a monthly basis, our analysis compares sales for only a single month. We can add another dimension by opening several monthly sales reports for each region. Figure 14-3 compares sales results by region broken down by month for a three-month period.

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>REGION</th>
<th>19960501</th>
<th>19960601</th>
<th>19960701</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>M17 Min Bike</td>
<td>Central</td>
<td>94266</td>
<td>94292</td>
<td>93943</td>
<td>281133</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>94954</td>
<td>96322</td>
<td>93452</td>
<td>284728</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>83782</td>
<td>85625</td>
<td>86883</td>
<td>256290</td>
</tr>
<tr>
<td>West</td>
<td></td>
<td>100937</td>
<td>97349</td>
<td>99750</td>
<td>298036</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>373939</td>
<td>372220</td>
<td>374028</td>
<td>1120187</td>
</tr>
</tbody>
</table>

Figure 14-3. Comparing product sales across four regions for a three-month period.

To create this summary, we opened a total of 12 reports – 3 monthly reports for each of 4 regions (see Figure 14-4).

As we've seen, each report contains only a piece of the overall puzzle. However, taken together, these same reports can reveal a wealth of information about your business.

In the previous chapters, you've become familiar with the Classic.prn report. Classic.prn is a periodic report produced on a monthly basis. Each report contains shipments of classical music recordings for a single month. For this lesson, we've provided three instances of the Classic report representing shipments for the months of January, February, and March.

When you load a model file or create a new model, Monarch applies the model parameters to all open reports. Data extracted from each report is concatenated in the Table view.

**NOTE**

Although you can open multiple report files at the same time, Monarch allows you to open only a single model file. The model file is automatically applied to all open reports. Thus, all reports must have the same format. For example, although the shipping reports used in this lesson all contain different data, they all share the same structure. You cannot extract data from two different types of reports at the same time.

Let's get started by opening ClassJan.prn, ClassFeb.prn, and ClassMar.prn as well as Lesson5.dmod. Go on to Table View and select Autosize Columns to maximize your view all of the fields.
Working in Table View

Working with data from multiple reports is virtually the same as working with data from a single report. You can view, sort, filter, export and print the data just as though it were extracted from a single report. There are, however, a few differences that should be examined.

SORTING

Initially, the data are arranged in the order that the report files were opened. Since we opened the January report first, the January records appear first in the table followed by February and then March. This initial order has no particular relevance. In fact, it may not be desirable at all. By arranging the records this way, Monarch may be violating the natural sort order of the reports. For example, each of our shipping reports is sorted by customer and then by ship date. By concatenating the records from all three reports, we’ve added a higher sort level. Now the data are sorted by period (month) and then, within months, by customer and ship date. Let’s restore the original sort order found in the reports.

Steps:

1. From the Table ribbon, select Table Design to launch the Table Design interface and then click Add > Sort.

The Sort Order Definition window displays.

Figure 14-5. The Sort Order Definition window.
2. Type **Original Sort Order** in the *Name* box and then click the ✔️ icon that displays next to this field to accept your name.

3. Select the **Customer** field from the *Available Fields* box then click the **Add >>** button.

4. Select the **Ship Date** field from the *Fields* box then click the **Add >>** button.

5. Select **Accept ✔️** in the Sort Definition ribbon to accept your changes.

6. Once back in Table view, select **Original Sort Order** from the *Active Sort* drop-down list.

7. Select **Autosize Columns ✏️** from the Table tab to view all the fields properly.

The table is rebuilt, sorted by customer and then by ship date.

<table>
<thead>
<tr>
<th>Report Date</th>
<th>Customer</th>
<th>Ship Date</th>
<th>Media</th>
<th>Quantity</th>
<th>Description</th>
<th>Label Number</th>
<th>Unit Price</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>DVD</td>
<td>9</td>
<td>Scarlatti, Stabat Mater</td>
<td>SBT 4082</td>
<td>5.99</td>
<td>33.41</td>
</tr>
<tr>
<td>6 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>CD</td>
<td>8</td>
<td>Mendelssohn, War March of the Priests</td>
<td>SMK 4792</td>
<td>8.99</td>
<td>71.82</td>
</tr>
<tr>
<td>8 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>CD</td>
<td>6</td>
<td>Misc., Modern Trombone Masterpieces</td>
<td>ADA 381087</td>
<td>10.79</td>
<td>44.79</td>
</tr>
<tr>
<td>10 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>CD</td>
<td>6</td>
<td>Schoenberg, Ode to Napoleon</td>
<td>CHN 9116</td>
<td>9.59</td>
<td>37.54</td>
</tr>
<tr>
<td>12 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>CD</td>
<td>3</td>
<td>Pachelbel, 28 Songs, Zuleman</td>
<td>RCA 61459-2</td>
<td>17.98</td>
<td>35.84</td>
</tr>
<tr>
<td>15 2/1/2010</td>
<td>Betty's Music Store</td>
<td>1/10/2010</td>
<td>CD</td>
<td>1</td>
<td>Vissot, Piano Music</td>
<td>BLU 85513</td>
<td>5.00</td>
<td>9.00</td>
</tr>
<tr>
<td>23 2/1/2010</td>
<td>Shyanty Music</td>
<td>1/10/2010</td>
<td>SACD</td>
<td>9</td>
<td>Bartok, Symphony no. 1</td>
<td>BNTPD 4110</td>
<td>9.59</td>
<td>86.31</td>
</tr>
<tr>
<td>24 2/1/2010</td>
<td>Shyanty Music</td>
<td>1/10/2010</td>
<td>DVD</td>
<td>5</td>
<td>Holst, St. Paul's Suite for Orch.</td>
<td>CBT-1020</td>
<td>5.99</td>
<td>28.95</td>
</tr>
<tr>
<td>25 2/1/2010</td>
<td>Bluegrass Records</td>
<td>1/10/2010</td>
<td>CD</td>
<td>3</td>
<td>Pachelbel, 28 Songs, Zuleman</td>
<td>RCA 61459-2</td>
<td>17.98</td>
<td>35.84</td>
</tr>
<tr>
<td>26 2/1/2010</td>
<td>Bluegrass Records</td>
<td>1/10/2010</td>
<td>CD</td>
<td>3</td>
<td>Takemitsu, Music of Takemitsu</td>
<td>SMK 53473</td>
<td>3.60</td>
<td>10.80</td>
</tr>
<tr>
<td>27 2/1/2010</td>
<td>Bluegrass Records</td>
<td>1/10/2010</td>
<td>CD</td>
<td>6</td>
<td>Messiaen, Quatuor pour la fin des temps</td>
<td>CDC 54915</td>
<td>9.60</td>
<td>37.00</td>
</tr>
<tr>
<td>29 2/1/2010</td>
<td>Bluegrass Records</td>
<td>1/10/2010</td>
<td>DVD</td>
<td>9</td>
<td>Schulman, Manfred Overture, Bar 50</td>
<td>SBT 40720</td>
<td>5.99</td>
<td>53.91</td>
</tr>
<tr>
<td>30 2/1/2010</td>
<td>Bluegrass Records</td>
<td>1/10/2010</td>
<td>CD</td>
<td>7</td>
<td>Hanson, Lament for Beowulf</td>
<td>DE 3150</td>
<td>5.99</td>
<td>41.15</td>
</tr>
</tbody>
</table>

Figure 14-6. Original Sort Order sorts all of the data extracted from all three open reports.

By using **Customer** as the first sort field, Monarch groups all the records from each customer together, regardless of which report each record was extracted from (note the highlighted ship dates for Betty’s Music Store which range from January 10th through March 4th - spanning all three reports).
IDENTIFYING THE SOURCE OF EACH RECORD

There are times when you will need to know from which report each record is extracted. You may want to apply a filter that excludes some or all of the records from one or more reports or create a summary that generates subtotals broken down by period. In either case, Monarch will need to be able to identify the source report for each record.

Sometimes, this information is available within the reports. In our shipping reports, each page header contains the date the report was printed. By extracting this information as a field, you can easily identify the source of each record.

For reports that lack a run date or other unique identifying information, Monarch provides a pair of functions - `File()` and `ID()` - that you can use to identify the source of each record.
THE FILE() FUNCTION

The File() function returns the path and filename of the report file from which each record was extracted. For example, for records extracted from the ClassJan.prn file, the File() function would return the value "C:\Reports\ClassJan.prn", assuming that ClassJan.prn is located in the \Reports folder on drive C.

Let’s create a calculated field using the File() function.

Steps:

1. From the Table ribbon, select **Table Design** to launch the Table Design interface and then click **Add > Formula Field**.

   The Formula Field Definition window displays.

2. In the Name box, type **Filename** and then click the ✔️ icon that displays beside the field to accept your name.

3. From the **Type** drop-down list, select **Character**.

4. Enter **60** in the **Display Width** box and then select the **Formula** tab.

5. Double-click on the **File()** function from the **Functions** list so that it is added to the **Expression** box.

6. Select the **Apply ✔️** icon that appears in the **Expression** box to save the newly defined field and then click **Accept ✔️** in the window’s ribbon to close it.

7. Select **Table Design ✔️** from the Table ribbon once more.

8. Locate the row for **Filename**. In the cell for **Size**, enter the value **65**.

9. Select **Accept ✔️** to apply your changes.

The new field is added to the end of the table.

---

![Figure 14-8. The Filename field, including the path.](image-url)
For each record, the *Filename* field returns the entire path and filename of the report from which the record was extracted. Let’s use another function to reduce the field values to only the file name.

**Steps:**

1. Launch the Formula Field Definition window by selecting **Table Design** > **Formula Fields**.
2. Set the *Display Width* of the *Filename* field to 12.
3. Select the **Formula** tab and then delete the expression `File()` from the *Expression* box using your keyboard.
4. Type the following expression into the *Expression* box instead:
   ```
   RSplit(File(),2,"\",1)
   ```
   This expression separates the path from the filename and returns the filename by itself.
5. Click **Apply** to save your newly defined field and then select **Accept** in the window ribbon to close it.

Now the *Filename* field displays only the name of each report file.

![Figure 14-9. The Filename field, excluding the path.](image)
THE ID() FUNCTION

The ID function assigns a numeric designation to each report at the time the report is opened. The first report opened is assigned 1, the second 2 and so on. If a report is subsequently closed, the list of designations is collapsed to fill any gap in the assigned numbers. Let’s create another calculated field using this function.

Steps:
1. From the Table ribbon, select Table Design to launch the Table Design interface and then click Add > Formula Field.
2. In the Name box, type File ID, select ✔️, and then select Numeric from the Type drop-down list.
3. Select the Formula tab.
4. Double-click on the ID() function from the Functions list so that it is added to the Expression box.
5. Click Apply ✔️ to save your newly defined field and then select Accept ✔️ to close the Formula Field Definition window.

The File ID field displays as a new column in the table.

Since ClassJan.prn was the first report we opened, it is assigned 1. ClassFeb.prn was the second report opened, so it is assigned 2 and ClassMar.prn is assigned 3. By opening the reports in another order, we could change the designations. You can use the ID function to order records in the table or in a summary based on the order in which you open the files, rather than alphabetically by file name.
[15] Extracting Multiple-Line Fields

In many reports, the majority of fields are single line fields - character, numeric and date fields that occupy space on a single line. However, some reports contain large fields that span multiple lines. These multiple line fields are variously known as comment fields, description fields, memo fields, text blocks or word wrapped fields. In this chapter, you’ll learn how to extract a multiple line field from a report and work with it in Monarch.

To get started, load Monarch and open the Homes.prn report and Lesson6.dmod model file.

Homes.prn is a weekly real estate report describing properties that were offered for sale during the previous week. For each property, the report includes the address, style, price, listing broker and numerous other points of interest to prospective buyers. Chief among these is a description of the property provided by the listing broker. The Remarks field is typical of multiple line fields found in many reports. Each instance of the field contains several lines of descriptive text - some of the descriptions are only a few lines long and several are as many as nine lines.

Figure 15-1. The Homes real estate report contains new property listings.
The Lesson 6 model contains a detail template that captures several fields from each property listing. The first line of the multiple line Remarks field is included in the template, but that field is not yet captured. We’ll capture the Remarks field together to illustrate how to capture a multiple line field.

Capturing a Multiple-Line Field

To capture a multiple-line field, you need to tell Monarch where the field begins and ends. Typically, locating the beginning of a multiple line field is easy - most multiple line fields begin at an absolute offset from the first line of the template. Locating the end of a multiple line field is sometimes more difficult. Since the number of lines in the field often varies, you can’t tell Monarch how big the field is in absolute terms. Instead, you must describe some characteristic that is common to the end of the field. For example, the field may end when a blank line is reached or when another field is encountered. Monarch includes these and several more options that you can use to indicate where your multiple line field ends.

Steps:

The Template Editor displays, showing several lines of the detail template. In this example, the detail template contains a total of 16 lines.

We can scroll the template sample text to view the remaining sample lines. The last line of the template contains the beginning of the Remarks field. Let’s scroll down until that line is displayed.
2. Scroll down in the Sample Text box until the Remarks field is visible, as in Figure 15-3.

![Figure 15-3. The last template sample line represents the beginning of the Remarks field.](image)

Let’s also scroll the report to display the first instance of the Remarks field. Having this field displayed on screen will provide valuable feedback during the capture process.

3. Use the vertical scroll bar on the right side of the Template Editor (the lower of the two vertical scroll bars that are visible on screen) to scroll down so that the Remarks field is fully visible on screen, as shown in Figure 15-4.

![Figure 15-4. Displaying the multiple line Remarks field in the Report view to provide feedback.](image)

Now we’re ready to capture the multiple-line Remarks field.

4. In the Sample Text line, use the mouse or the keyboard to highlight only the first line of the Remarks field. Highlight this entire line, making sure to extend several spaces toward the right to capture all of the data for all of the records in the report.
The field highlight should look like that shown in Figure 15-5.

![Figure 15-5](image1)

Figure 15-5. The last template sample line represents the beginning of the Remarks field.

Note that the first line of the field in the report is now highlighted.

![Sample Text box](image2)

Figure 15-6. The Sample Text box displays several template sample lines.

You might be wondering why we highlighted only the first line of the field. Why not highlight the entire field? For a multiple line field, we must indicate the horizontal size of the field and the vertical size. The horizontal size is indicated by highlighting the first line of the field. However, the vertical size cannot be indicated by highlighting multiple lines because the number of lines occupied by each instance of the field varies. What would be correct for the first instance of the field may be incorrect for the others. To indicate the vertical size of a multiple line field, we must tell Monarch where the field begins and where it ends. To do this, we'll use the Field Definition window.

5. Select **Edit Field** on the Action bar of the Template Editor.

The Field Definition window appears, showing all of the fields defined for the Detail template. Note that at the bottom of the list of fields, the field name `eg_Formal, fireplaced dining ro...` may be found. This is the field we are extracting in the current lesson.
6. Select the field **eg_Formal, fireplaced dining ro...** to display its properties. Rename this field **Remarks** and then select ✓.

7. Click the **Advanced** tab.

![Figure 15-7. The Advanced tab.](image)

The **Advanced** tab includes options for indicating the beginning and ending locations of the field. Let’s begin by examining each of the **Start Field On** options. These options tell Monarch how to locate the beginning of a multiple line field. The **Start Field On** options are:

- **Line Number**

  The Line Number option indicates that the first line of the field begins at an absolute offset from the top of the template. The line number represented by this setting is determined by the position of the field highlight in the template sample. Since we painted the first line of the Remarks field at Line Number 16, this option displays as Line Number 16.

**NOTE**

The **Line Number** option is almost always the correct choice for indicating the beginning of a multiple line field. The only time the **Line Number** option would not be the correct choice is when the multiple line field begins after another multiple line field. In this case, the first multiple line field, if it contains a varying number of lines, would cause the beginning position of the second multiple line field to vary (see Figure 15-8). Only then would you need to employ one of the other **Start Field On** options.
• **String**

The String option indicates that the first line of the field begins on the next line down from (i.e., the line below) a line containing a string. This option is particularly useful when trapping HTML data. To use this option, enter the string in the adjacent box.

• **Preceding String**

The Preceding String option indicates that the first line of the field begins to the right of a string, such as a label. To use this option, you simply enter the string in the adjacent box. Figure 15-8 shows a modified version of the Homes report where the Remarks field falls after another multiple line field, the Directions field. Here the Line number option would not work because the varying length of the Directions field would cause the beginning of the Remarks field to bob up and down. In this case, the preceding string option could be used by entering the label "Remarks:" (without the quotation marks).

![Figure 15-8. Offset of Remarks field varies due to preceding multiple line Directions field.](image)
• **After Last Defined Field in Template**

The After Last Defined Field option indicates that the first line of the field begins two lines below a previous multiple line field. Figure 15-9 is an excerpt from Figure 15-8, except this time there is no identifying label next to the Remarks field. In this case, you could use the After Last Defined Field option to indicate that the Remarks field begins immediately after the Directions field. To do this, you must also capture the Directions field so Monarch will know where it ends.

![Figure 15-9](image)

Figure 15-9. Use After Last Defined Field if no label exists to mark the beginning of the second multiple line field.

Since the Remarks field always begins on the same line in the template (Line Number 16), we’ll use the Line Number option to indicate where the field starts. Line Number is the default option, so it’s already selected.

Next, we need to indicate where the multiple line field ends. To do this, we’ll select an End Field On option. The End Field On options tell Monarch how to locate the end of a multiple line field. Let’s examine each option.

• **Line Count**

The Line Count option terminates a multiple line field after a fixed number of lines. This option should be used only when every instance of the field has the same number of lines. This won’t do for our Remarks field, as each instance contains a different number of lines.

• **Nonblank Preceding String of**

The Nonblank Preceding String option terminates a multiple line field when any nonblank character appears within a specified number of columns to the left of the field. Typically, the character is part of a label that appears to the left of a subsequent field. As an example, let’s suppose our fictitious Directions field appeared immediately after the Remarks field rather than before (see Figure 15-10). With no blank line to separate the fields, it is difficult to determine where the Remarks field ends, but we can find the label "Directions:" preceding the first line of the Directions field. We can use this label to terminate the Remarks field by selecting the **Nonblank Preceding String of** option and specifying 3 or more columns.
Monarch will look for any nonblank character in these columns, terminating the field when it encounters the colon (:) in the "Directions:" label.

![Image of property listing with Remarks field and directions]  
Figure 15-10. Use Nonblank Preceding String to terminate a field when another field is encountered.

The Nonblank Preceding String option cannot be used to indicate the end of the Remarks field in the report that we are using for this lesson because there is no label in an appropriate position near the end of the Remarks field.

- **Blank Field Values**

  The Blank Field Values option terminates a multiple line field when Monarch encounters a single blank line or a pair of blank lines. Monarch does not require the entire line to be blank, only the column positions immediately under the field. Since our Remarks field is always followed by a blank line, this option is a good choice.

  In the case of a large text block containing multiple paragraphs, like the one shown in Figure 15-11, you would indicate 2 blank lines - to prevent Monarch from terminating the field when it encounters the blank line that falls between the first and second paragraphs.
Note that using two blank lines to terminate a multiple line field is possible only when the entire text block is followed by at least two blank lines, as is the case in our example below.

<table>
<thead>
<tr>
<th>Lot Size: 65,000</th>
<th>Color: White</th>
<th>Fuel: Gas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basement: Full</td>
<td>Rooms: 8</td>
<td>Hot Water: Gas</td>
</tr>
<tr>
<td>Garage: 3</td>
<td>Bedrooms: 4</td>
<td>Water: Town</td>
</tr>
<tr>
<td>Other Bldg: No</td>
<td>Baths: 2.5</td>
<td>Sewage: Town</td>
</tr>
</tbody>
</table>

**Remarks:** Jerom Billay Foster designed Williamsburg colonial in impeccable condition. Brick floored foyer, gourmet kitchen with breakfast nook overlooking gardens. 1st floor den. 3 season porch, fireplaced master suite with Jacuzzi bath and walk-in closets, fireplaced recreation room, walk-up attic suitable for expansion, heated in-ground pool. Separate pool house w/ sauna.

Located in Nashoba Hills with convenient access to all major routes.

Note: Valley Real Estate will be holding a reservations-only open house on August 17th, 2015 from 11:30am to 4:00pm. Brokers with prospective clients are asked to make their reservations no later than August 10th. Refreshments and a buffet lunch will be served.

Figure 15-11. Example of a multi-paragraph text block with a single blank line between paragraphs.

- **End of Left Justification**

  This option terminates a multiple line field when Monarch encounters a line with a blank in the first column position of the field or any nonblank character in the column immediately preceding the field. Either condition indicates that left justification within the field has ended. This option is useful for capturing left aligned text blocks. However, if the text block contains a blank line, such as that found between paragraphs, Monarch will consider the blank line an end to left justification and will therefore terminate the field. Although this option could be used to terminate the Remarks field, the Blank Fields option is preferable as it better describes the way that the field is actually terminated.

- **None of the Above**

  This option terminates a multiple line field only when Monarch encounters another template, including another instance of the template in which the multiple line field resides. Monarch will also terminate a multiple line field after it extends two pages. The field will be terminated on the second page where the page break character (ASCII 12) is encountered. This prevents a field from continuing without end if the selected End Field On action is not appropriate to end the field.

  This option should be used only when none of the other End Field On options are suitable. By employing the minimum actions, you might capture more data than is actually occupied by the field.
NOTE

The minimum actions described above are always enforced by Monarch, even when the None of the Above option is not selected. Select this option only when none of the other options would apply.

From our review of each of the End Field On options, we find that either the Blank Field Values option or the End of Left Justification option will properly terminate the field. We recommend using the Blank Field Values option in such cases, since it is more descriptive of how the field ends.

8. Select the Blank Field Values option to indicate to Monarch that the field will end when a blank line is encountered. The default value is 1, which tells Monarch that the field should end as soon as 1 blank line is found.

9. Select Accept to accept your changes and close the window.

Note that Monarch has correctly highlighted the first instance of the Remarks field.

Let’s double check the field definition by inspecting several more instances of the multiple-line field.

10. Scroll down in the report to the next Remarks field.

Note that the second instance of the Remarks field is also correctly highlighted.
11. Select Accept ✔️ to accept your changes and close the Template Editor.

### Displaying a Multiple-Line Field in Table View

Now that we are satisfied that the multiple line field is captured properly, we’ll extract the field and display it in the Table view.

**Steps:**

1. Select the Table tab to display the extracted data in Table view.

   The table displays, and the Remarks field is found at the far right.
The initial field type assigned to the Remarks field is character with a data length of 254 - the maximum data length for a character field. The column width is set to the field’s template width, which in this case is 62 characters.

These default settings are appropriate for multiple line fields that extract a small amount of data, i.e., when the largest field value is less than the 254-character maximum for a character field. For multiple line fields that extract large blocks of text, however, such as our Remarks field, the 254-character limit will cause some of the field values to be truncated and the display settings don’t let us see very much of each field value on screen.

**Memo Fields**

To accommodate multiple line fields that contain more than 254 characters, Monarch includes support for memo fields which can handle up to 65,536 characters (64KB).

Let’s change the field type of the Remarks field to Memo.

**Steps:**

1. Select **Table Design** to launch the Table Design interface.
2. In the field list that displays, locate the row for Remarks and then change its type to Memo.
3. Select **Accept** to accept your changes and return to Table view.

   The Remarks field is redisplayed as a memo field.

   To view more information for each memo field, you’ll have to adjust the height of each row. Let’s try doing this now.

4. In the left hand side of the Table view, click on the border between Rows 1 and 2, then drag down to expand the height of the rows to at least six lines.

   Even using a row height of 6 lines, we still may not be able to see all of the text in some of the Remarks fields. To view more information, we could increase the width of the field, but this may still not allow us to view the entire contents of each cell. Although we could adjust the row height again (Monarch allows a maximum row height of 12 lines), let’s try something new instead. Let’s give Monarch’s **Show Field Contents** feature a try, which displays the entire contents of a cell.

5. Select **Show Field Contents** from the **Table** ribbon.

   Monarch opens a small window at the top of the display. This window, called the Field Contents window, displays the entire contents of the selected table cell. Initially, the window height is only a few lines, but you can increase the height to show more lines and you can scroll within the window to view the entire contents of a cell.
As you move the cell pointer from cell to cell in Table view, the Field Contents window will display the contents of the selected cell. You can try this by using the down arrow key on the keyboard to scroll through the Remarks field cells.

Using Memo Fields

Monarch does not allow a memo field to be used in a sort or summary definition. If you intend to include the field in a sort or summary definition, you must leave the field type set to Character, or on rare occasions, change it to Numeric or Date. In addition, there are differences in the way a memo field is exported and printed versus a character, numeric or date field. These differences may or may not provide the results you expect or want. We’ll touch on the export and print issues later in this lesson.

USING MEMO FIELDS IN CALCULATED FIELD AND FILTER EXPRESSIONS

As stated above, you cannot use a memo field in a sort or summary definition. However, you can use a memo field as part of a calculated field expression. By creating a calculated field, you can extract a subset of the memo field that you can then use in a sort or summary definition.

You can also use a memo field in a filter expression. We’ll illustrate this using the Remarks field. Let’s suppose the Real Estate agent has a client interested in purchasing a new home and, among the client’s other criteria, she wants a home with a fireplace. Some of the
property descriptions mention a fireplace and others do not. You could manually review all of the Remarks cells in the table to find the ones that mention a fireplace, but this is a tedious process, especially if there are hundreds of homes for sale.

To find out which homes have a fireplace you can create a filter that will search the entire Remarks field and return only those records where a fireplace is mentioned.

Steps:

1. On the **Table** ribbon, select **Template Design > Add > Filter > Formula based**. The **Filter Definition** window displays.

2. Type **Homes with a Fireplace** in the **Filter Name** box and then select ✔.

3. Type **Instr("fireplace",Remarks)>0** in the **Expression** box.

   The Instr() function will return the character position of the word “fireplace” in the Remarks field. By setting the filter to >0, we are capturing all cases where it appears anywhere in the description text.

4. Choose **Apply ✔** to accept your filter and then close the **Filter Definition** window by clicking **Accept ✔**.

   Monarch applies the filter, which returns 19 records. That may still be more property descriptions than you want to read through, so let’s narrow the choices by adding to the filter definition. While we’re already supposing, let’s further suppose that the client refuses to live in any town other than Tewksbury.

5. Select **Template Design > Filters ▼** tool and then click on the **Homes with a Fireplace** filter from the Filter Selector to display its properties.

6. Add **.And.Town="Tewksbury"** to the filter expression. The entire expression should now read:

   \[
   \text{Instr("fireplace",Remarks)>0.And.Town="Tewksbury"
   \]

   ![Figure 15-16. Viewing the edited filter expression.](image)

7. Choose **Apply ✔** to accept your filter and then close the **Filter Definition** window by clicking **Accept ✔** in the window’s ribbon.
8. Select the **Homes with a Fireplace** filter from the Active Filter drop-down list.

This time Monarch returns only three records representing homes with fireplaces in the town of Tewksbury. Let’s use the **Display Source of Record** feature to browse the original descriptions in the report.

![Figure 15-17. Memo fields used in filter expressions.](image)

9. Click on any cell in the first row of the table.

10. Select the **Find in Report** button from the Table ribbon.

Monarch displays the associated property listing in the Report view.

![Figure 15-18. Displaying the source of a multiple line field.](image)
You may repeat Steps 8–9 to view each of the other property listings. In Step 8, click any cell in the second row to display the second listing or any cell in the third row to view the third listing.

Printing Memo Fields

When you print a memo field, Monarch treats the field as though it were a character field: it prints only that portion of the field that is visible in the Table view. This produces a print image that reflects the data you see on screen. To print the entire contents of a memo field, you can export the table to a text file, and then use a text editor or a word processor to print the file.

At this point, you can either save your work or simply close the report and model files you opened for this lesson.
SUMMARIES

In this chapter, you will learn how to use the Summary window to analyze data from the table. The lesson topics include:

- A discussion of what a summary is
- Creating a summary
- Suppressing duplicate values
- Adding subtotals and blank lines
- Measure calculations
- Adding item fields
- Collapsing and expanding a summary
- Specifying summary design preferences
- Creating a quick summary
- Copying, printing, and exporting summaries

This chapter assumes that you are familiar with importing and viewing report files, creating data extraction templates and working in the Table view. Note also that these features are NOT available in Monarch for IBM Analytics. Consider contacting sales@altair.com to obtain a copy of Monarch Complete and gain access to these additional functions in Monarch.

A summary tabulates information for selected fields and presents the results in a one- or two-dimensional matrix. For example, the summaries shown here show sales totals for a fictional distributor of classical music recordings, first broken down by customer, then by media.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Media</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Betty's Music Store</td>
<td>CD</td>
<td>353.05</td>
</tr>
<tr>
<td>2 Betty's Music Store</td>
<td>DVD</td>
<td>89.85</td>
</tr>
<tr>
<td>3 Betty's Music Store</td>
<td>LP</td>
<td>64.74</td>
</tr>
<tr>
<td>4 Subtotal</td>
<td></td>
<td>507.64</td>
</tr>
<tr>
<td>5 Big Shanty Music</td>
<td>CD</td>
<td>158.23</td>
</tr>
<tr>
<td>6 Big Shanty Music</td>
<td>DVD</td>
<td>29.95</td>
</tr>
<tr>
<td>7 Big Shanty Music</td>
<td>SACD</td>
<td>86.31</td>
</tr>
<tr>
<td>8 Subtotal</td>
<td></td>
<td>274.49</td>
</tr>
<tr>
<td>9 Bluegrass Records</td>
<td>CD</td>
<td>122.34</td>
</tr>
<tr>
<td>10 Bluegrass Records</td>
<td>DVD</td>
<td>53.91</td>
</tr>
<tr>
<td>11 Bluegrass Records</td>
<td>SACD</td>
<td>71.92</td>
</tr>
<tr>
<td>12 Subtotal</td>
<td></td>
<td>248.17</td>
</tr>
</tbody>
</table>

Figure 16-1. Sales by customer and media.
The summaries shown above tabulate information about a single key field. In the first summary, the key field is the Customer field and in the second summary the key field is the Media field. The field that is tabulated (or summed) is called a measure. In both summaries shown above, the Amount field is used as the measure.

Although only a single key field and a single measure are required, a summary may be quite complex, including multiple key fields and measures. Each measure can be used to calculate a variety of information about your data, including the sum total, average, percent of total, minimum, maximum, standard deviation, and variance. Monarch also provides a count function that can be used as a measure. Rather than performing a calculation on a selected measure, the count function counts the number of records for each key.

For example, the summary in Figure 16-3 includes both the Customer and Media fields as key fields, and the count function and Amount field as measures. Separate Amount calculations are used to break down total sales versus average sales.

A summary can also include item fields that expand the summary to show individual transactions. Item fields provide an advantage over viewing individual transactions in the Table view because you can use the summary to break down subtotals.

The summary in Figure 16-4 includes the Customer and Media fields as key fields and the Quantity and Description fields as item fields. This summary displays individual transactions for each media type within each customer. Subtotals are generated for each customer.
THE SUMMARY VIEW INTERFACE

The Summary View interface is similar to the Report and Table view interfaces; it includes a ribbon, the Summary selector, and the Summary window.
THE SUMMARY VIEW CONTEXT MENU

Right-clicking on the Summary selector displays a context menu that will allow you to perform the following operations:

- Perform a quick export - This export operation uses the default file extension and values specified in Export Settings and presents the Create Export dialog with all elements prefilled
- Rename a summary
- Edit a summary (via the Summary Design interface)
- Duplicate a summary
- Rebuild a summary (if a specific summary is selected)
- Rebuild all summaries
- Print a summary
- Quick print a summary
- Preview a summary before printing
- Move a summary to the top of the selector
- Move a summary up one position
- Move a summary down one position
- Move a summary to the bottom of the selector

Similarly, right-clicking in Summary view displays a context menu that will allow you to:

- Copy text
- Copy with formatting
- Search for a record
- Go to a specific row in the summary
- Go to a specific column in the summary
- Find a specific value in the table
- Autosize columns
- Adjust column widths
- Display field properties
- Set the active measure
- Set a summary filter
- Print the table
Launch Print Preview

Export the summary

Launch the Summary Design interface

To start this lesson, load Monarch and open Classic.prn and Lesson7.dmod. Go on to Table view and select Autosize Columns from the ribbon to maximize your view all the fields.

By creating summaries, we can analyze the data to reveal trends and relationships that would otherwise remain buried. Let’s create a simple summary that tabulates sales quantities and totals for each media type (CDs, SACDs, DVDs, etc.) within each customer.

Creating a Summary

To create a summary, you select key fields and measures.

Key fields are used to define the summary matrix. For example, the summary in Figure 16-1 uses the Customer field as the key field. Monarch examines the field and creates a list of all unique values found within the field (e.g., Betty’s Music Store, Big Shanty Music, etc.), then uses these values to create the summary matrix.

Measures are numeric fields that are summed for each unique key field value. For example, in Figure 16-1 the Amount field is broken down into separate totals for each customer. Monarch also provides a count function that can be used as a measure. Rather than calculating a result for a specific field, the count function simply counts the number of records that match each for
each key field value (for example, there may be 10 records for Betty’s Music Store and 8 for Big Shanty Music, etc.).

Let’s begin by creating a summary that displays sales broken down by customer and media type. We’ll use the Customer and Media fields as the key fields and the Amount field as the measure.

Steps:

1. Select the Summary tab and then click Summary Design > Add Summary to activate the Summary Design interface.

![Summary Design interface](image)

Figure 16-7. The Summary Definition window.

The following table summarizes the functions of each of the buttons in the Summary Design ribbon.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Accept</td>
<td>Accept the new template or changes to an existing template</td>
</tr>
<tr>
<td>❌ Cancel</td>
<td>Cancel the new template or changes to an existing template</td>
</tr>
<tr>
<td>🎨 Add summary</td>
<td>Add a new summary</td>
</tr>
<tr>
<td>📝 Duplicate summary</td>
<td>Duplicate a summary</td>
</tr>
<tr>
<td>❌ Delete summary</td>
<td>Delete the selected summary</td>
</tr>
<tr>
<td>🌟 Definition</td>
<td>Add or modify a summary definition.</td>
</tr>
<tr>
<td>📋 Add/Remove fields</td>
<td>Add or remove key, measure, and item fields</td>
</tr>
<tr>
<td><strong>USE THIS BUTTON...</strong></td>
<td><strong>TO...</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>All fields</td>
<td>Display the properties of all of the fields</td>
</tr>
<tr>
<td>Keys</td>
<td>Display the properties of all key fields</td>
</tr>
<tr>
<td>Items</td>
<td>Display the properties of all measure fields</td>
</tr>
<tr>
<td>Measures</td>
<td>Display the properties of all item fields</td>
</tr>
<tr>
<td>Page setup</td>
<td>Launch the Page Setup window</td>
</tr>
<tr>
<td>Help</td>
<td>Launch the Help file</td>
</tr>
</tbody>
</table>

2. In the Name field, type in **Summary1** and then click the adjacent ✅ icon that appears to accept this name.

3. Select **Add/Remove Fields** to begin specifying your key, measure, and item fields.

## Adding Key Fields and Measures

Let's get right to adding key fields and measures by clicking on the **Add/Remove Fields** button. The **Add/Remove Fields** command displays a list of the fields that are available for use in a summary definition. This list includes all the fields available in Table view except for memo fields. To add a field to the summary definition, you select the field from the **Table Field** box, and then click the appropriate button (**Key**, **Item**, or **Measure**) to add the field to the corresponding box at the right. Our summary requires the **Customer** and **Media** fields as key fields, so let’s select those fields.

**Steps:**

1. Select **Customer** from the list of available fields, and then select **Add Key**.
   
   **Customer** displays in the **Key Field** list.

2. Select **Media** from the list of available table fields and then select **Add Key**.

   Now, both **Customer** and **Media** display in the **Key Field** list.

---

**Figure 16-8. Specified key fields.**
Several properties are assigned to each field, as you can see from the entries in the corresponding subtabs in the Key screen. For now, we’ll accept these default properties. (We’ll explore the properties for Key fields, Item fields, and Measures later in this lesson and in the next lesson.)

The next step is to select the measures that we want to include in our summary definition. Since we want our summary to tabulate sales totals, we’ll select the Amount field as a measure.

3. Select Amount from the list, and then click Add Measure.

Amount displays in the Measure Field list.

![Figure 16-9. The specified measure.](image)

We have just finished specifying our key and measure fields.

**Selecting Filters to Apply in Summaries**

When you create a summary definition, you may assign a filter to limit the records available to the summary. The Apply Filter box, which is accessed by selecting the Definition button on the Summary Design ribbon, provides several filtering options.

- You may select a filter to apply when building the summary. The filter you select is applied to the data only to build the summary. It is not applied to Table view and it does not limit the data available to other summaries. When building and displaying the summary, the filter overrides any filter that you may have applied in the Table view - it is not applied along with the active table filter.

- You may select No Filter. The No Filter option turns off filtering for the summary. The summary is built using all records. This option, like the previous option, overrides any filter that you may have applied in the Table view.

- You may select Default Filter. The Default Filter option applies the filter that is currently applied to the Table view. This option uses only the records that are available to the Table view at the time the summary is built. If you switch the filter that is applied to the Table view or modify its definition, the summary is recalculated to reflect the changes.

We want to use all records to build our summary, so we’ll use the default value of No filter to turn off filtering for this summary.
Suppressing Duplicate Values

Most report writers include a facility to suppress duplicate values for selected fields. Suppressing duplicate values reduces the amount of visual clutter in a report and helps to emphasize details. Monarch also includes this facility, allowing you to suppress duplicate values for any key field in a summary (except for the rightmost key field, which never contains duplicate values).

Let’s suppress duplicate values for the Customer key field.

Steps:

1. Select the **Keys** button from the **Summary Design** ribbon.

   A list of specified key fields as well as their corresponding properties displays.

   The Keys screen includes several subtabs that organize key field properties into logical groups. The **Layout** subtab includes key field properties that determine how the key field is displayed, including an option to suppress duplicate values.

2. Select the field **Customer** from the **Key Fields** selector and then click the **Layout** subtab.

   Locate the drop-down box for **Orientation > Down**, click the drop-down arrow, and then select **Suppress duplicates**.

3. Click **Accept ✔️** to accept the changes made to your summary.

   The summary is rebuilt, and duplicate customer names are removed.

   ![Figure 16-10. Duplicate values removed from the Customer column.](image)

---

338  Monarch 15.4 Learning Guide
Adding Subtotals and Blank Lines

You can add subtotals and blank lines to a summary after each logical group of information. Subtotal lines and blank lines are added whenever the value of the selected key field changes. To illustrate this, let’s add subtotals for each customer and add blank lines to separate each customer group.

Steps:

1. Select Summary Design > Keys.
2. Select the Customer key and then click the Layout subtab.
3. Under the “After each key value change” heading, check the Insert subtotal line check box.
4. Select 1 from the “Insert n blank line(s) after each key value change” field drop-down list.
5. Click Accept ✔️ to accept the changes made to your summary.

The summary is rebuilt. A subtotal line and a blank line are added directly underneath each customer group.

![Figure 16-11. Subtotals are displayed for each customer. Blank lines separate each customer group.](image-url)
Adding Measure Calculations

Our summary report breaks out sales totals for each media type and each customer. While this is useful, you may want to perform other analyses on the data. Monarch supports several calculations you can perform when building a summary.

For each measure you include in your summary definition, you can calculate the total, average, percent of total, minimum or maximum value, standard deviation, or variance. To perform multiple calculations, you add multiple copies of a measure to the summary definition, one for each calculation you want to perform. In addition to the measure calculations, a count function is included that you can use to tabulate the number of records matching each set of key field values and a special ratio calculation option that divides subtotals for one field by subtotals for another field.

Let’s edit the summary definition to add the percent of total sales calculation for the Amount measure.

Steps:
1. Select Summary Design > Add/Remove Fields.
2. Select Amount from the list of available fields that displays, and then click Add Measure.
   
   This adds a new Amount field to the Measures screen.
3. Select the Measures button from the Summary Design ribbon.
4. Select this new Amount field (the second one on the list) and then click the Formula subtab.

![Figure 16-12. The new Amount subtab showing the Formula options.](image-url)
5. Delete \textbf{SUM ([Amount])} from the \textit{Expression} field, and then enter \textbf{PCT([Amount])} instead. Click the \textbf{Apply} icon that displays in the field when you are finished.

![Figure 16-13. Entering a new expression.]

6. Select the \textbf{General} subtab.  

   Note that \textbf{Amount} is suggested as the column title. Let’s modify this title to read \textbf{%Amount}.

7. Click on the \textbf{Use default title} check box to deselect this option (the check mark should be removed).

   When the \textit{Use Default Title} option is unselected, the \textit{Title} box is activated.

8. Type \textbf{%Amount} in the \textit{Title} box.

9. Under \textbf{Display Settings}, click on the \textbf{Custom} radio button.

10. Select \textbf{Percentage} from the \textit{Format} drop-down list.

11. Specify a \textit{Decimals} setting of 1.

12. Click \textbf{Accept} in the ribbon to accept your changes and close the \textit{Summary Definition} window.
The summary is rebuilt with the new %Amount measure.

Figure 16-14. Summary with a %Amount calculation.

Adding Item Fields

Item fields are optional fields that you can use to expand a summary to show individual transactions. Item fields provide an advantage over viewing individual transactions in Table view because you can use the summary to break down subtotals.

Let’s add the Quantity and Description fields to our summary definition as item fields.

Steps:

1. Select Summary Design > Add/Remove Fields.
2. Select Quantity from the Table Fields list that displays, and then select Add Item.
3. Select Description from the Table Fields list and then select Add Item.
4. Choose Accept ✔ in the ribbon to accept the modified summary definition.
Monarch rebuilds the summary and displays the item fields.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Media</th>
<th>Quantity</th>
<th>Description</th>
<th>Amount</th>
<th>%Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Betty’s Music Store</td>
<td>CD</td>
<td>2</td>
<td>Luening, Electro…</td>
<td>20.38</td>
<td>0.2%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>4</td>
<td>Bartok, Sonata…</td>
<td>35.96</td>
<td>0.5%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>7</td>
<td>Mozart, Mass in…</td>
<td>63.00</td>
<td>0.9%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>8</td>
<td>Mendelssohn,…</td>
<td>71.02</td>
<td>1.0%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>10</td>
<td>Pizzetti, Melissa…</td>
<td>95.90</td>
<td>1.3%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>11</td>
<td>Beethoven, Pat…</td>
<td>65.09</td>
<td>0.9%</td>
</tr>
<tr>
<td></td>
<td>DVD</td>
<td>6</td>
<td>Gershwin, An A…</td>
<td>35.94</td>
<td>0.5%</td>
</tr>
<tr>
<td></td>
<td>DVD</td>
<td>9</td>
<td>Scarlatti, Statat…</td>
<td>53.91</td>
<td>0.7%</td>
</tr>
<tr>
<td></td>
<td>LP</td>
<td>6</td>
<td>Msc…, Modern T…</td>
<td>64.74</td>
<td>0.9%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Subtotal Betty’s Music Store</td>
<td>507.54</td>
<td>6.9%</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>CD</td>
<td>1</td>
<td>Schubert, Sonat…</td>
<td>9.00</td>
<td>0.1%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>2</td>
<td>Shostakovich, 2…</td>
<td>10.78</td>
<td>0.1%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>3</td>
<td>Mozart, Symph…</td>
<td>26.97</td>
<td>0.4%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>6</td>
<td>Schonberg, Od…</td>
<td>57.54</td>
<td>0.8%</td>
</tr>
<tr>
<td></td>
<td>CD</td>
<td>6</td>
<td>Stravinsky, Du…</td>
<td>53.94</td>
<td>0.7%</td>
</tr>
<tr>
<td></td>
<td>DVD</td>
<td>5</td>
<td>Holst, St. Paul’s…</td>
<td>29.05</td>
<td>0.4%</td>
</tr>
<tr>
<td></td>
<td>SACD</td>
<td>9</td>
<td>Balakirev, Symp…</td>
<td>86.31</td>
<td>1.2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Subtotal Big Shanty Music</td>
<td>274.49</td>
<td>3.7%</td>
</tr>
</tbody>
</table>

Figure 16-15. A newly constructed summary showing item fields.

Collapsing and Expanding a Summary

Expanding or collapsing (referred to as drilling down or drilling up) a summary provides a quick way of exploring summary data.

- **Collapsing (Drilling up)**

  Reduces the level of detail in the summary, revealing higher level information. To collapse a summary, Monarch removes the rightmost key field from the summary, then re-calculates and re-displays the summary.

- **Expanding (Drilling down)**

  Restores the previously removed key fields to the summary display. When item fields are included as part of the summary definition, you view the item fields by drilling down the **itemized level**.

Let’s start by drilling up to hide the item fields we added to our summary definition.
Steps:

1. From the *Summary View* ribbon, select **Drill Up**.

   The item fields are removed, restoring the summary to its initial state.

2. Click **Drill Up** once more.

   Monarch further collapses the summary by removing a key field; in this case, the *Media* field. The collapsed version of the summary shows sales broken down by customer.

   ![Figure 16-16. After drilling up twice, the summary breaks out totals only by customer.](image)

3. Select **Drill Down** from the *Summary View* ribbon.

   The summary is restored to its original state. Let’s expand the summary even further to once again view the item fields we added.

4. Click **Drill Down** once more.

   The summary is expanded to display the item fields. At this **itemized level**, each line in the summary corresponds to an individual transaction from the Classic report.
Copying and Printing Summaries

You can copy summary data to other applications or print it. You perform these operations in the Summary window the same way you perform them in Report view or Table view.

Duplicating Summaries

You may want to create a new summary that closely resembles a summary you previously defined. An easy way to do this is by using the Duplicate button. To duplicate a summary, simply select the summary you want to duplicate from the Summary list and then select Duplicate from the Summary Design ribbon. The duplicated summary appears on the Summary list; this summary will have the name of the summary you duplicated and a number appended to it. Select this summary to display its properties in the Summary Definition window and make further revisions to it. Select Accept when you are finished to accept and save your new summary definition.
In the previous chapter, you learned how to define a summary report using Monarch’s Summary window. In this chapter, you’ll continue your tour of the Summary window and learn how to create more advanced summary reports to reveal more information about your data. The lesson topics include:

- Displaying key field values across
- Sorting a summary
- Creating a top 10 analysis
- Specifying key field values

This chapter assumes that you have completed Chapter 15 and are familiar with the process of creating a summary definition.

To start these lessons, we’ll load Monarch and open Classic.prn and Lesson8.dmod. Go on and display Summary view.

Summary Displays

Summaries can be configured to show various details. The following sections outline the steps to do so.

DISPLAYING KEY FIELD VALUES ACROSS

When more than one key field is included in a summary report, the values for the first key field are repeated (see the values for the Customer field in the preceding illustration). This can sometimes make for a crowded feel and does not offer the most efficient method of displaying data.

While you could suppress duplicate values to provide a cleaner summary display, the summary still requires a large number of rows on screen. With only 20 customers represented in our summary, the summary extends 95 rows, or about two pages.

To provide a more compact summary display, Monarch allows you to display the values for the rightmost key field (in this case, Media) across the top of the summary, creating a two dimensional matrix. This format, sometimes referred to as a crosstab summary, allows for quick comparisons of multiple data groups.
For summaries like the one we’ve created, this format provides an ideal solution since it displays the entire summary matrix on screen at one time. Let’s see how this works.

Steps:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.

2. Select Summary Design > Keys and then select Media from the Key Fields selector to display its properties.

3. Select the Layout subtab, select the Across (row) radio button, and then choose Accept from the ribbon.

The summary is rebuilt with the Media values spread across the top row.

![Figure 17-1. Summary with customer values displayed down and media values displayed across.](image)

**DISPLAYING NULL VALUES**

For some media types, such as BLU (Blu-ray discs) and LP (Long Play albums), no sales have been made to certain customers. For example, see the “---” strings in the BLU column for the first ten customers. In this case, it would be incorrect to display a zero value in the summary report, since zero might suggest that some amount of sales were made to this customer.

For example, consider the case where a customer places an order for several DVDs and in the same period returns several previously purchased DVDs. If the total purchase price of the returned media equals the price of the new media, the value for this customer would be zero, indicating a net purchase of zero. However, if the customer never placed any orders for digital compact cassettes, a zero would not be appropriate. In this case, the value of “---” indicates that no sales or returns have been recorded for this media type.
By default, Monarch displays null values as the string "(null)", but you can specify another string, or even a blank string, to represent null values if you like. You might find the string "(null)" a bit distracting when you’re viewing this type of summary report, so let’s change the default string to something else.

Steps:

1. Select **Home** and then click the **Options** button to launch the **Options** window.

2. Select the **View** button from the Options ribbon to display the **View** options.

   From this screen, you can set several options that affect the way data is displayed on screen in Monarch.

3. Click in the **Display null values as** edit box, change the "(null)” string to “*”, and then click **Accept** in the window’s ribbon.

   The **Sales by Media** summary is redisplayed using the string you specified.

![Figure 17-2. Null values represented by *.

4. Return the previous null value before moving forward with the lesson.

**ADJUSTING COLUMN WIDTHS**

Sometimes, you can avoid scrolling altogether by reducing the column widths in a summary so that all of the information fits on screen. When Monarch builds a summary, it sets the column widths wide enough to handle large numbers, such as 1,000,000.00. If the resulting columns are wider than you need to display your summary data, you can adjust them to fit more columns on screen.
NOTE

Column Widths for Across Keys

All of the columns generated from an across key field (in this case the CD, BLU, LP, DVD, and SACD) columns are based on the column width of the measure. To set the column widths, either use the mouse as described below or double-click on the measure (the last column of the summary) and use the Measure window to change the width of the measure. All columns related to the key field will snap to the width assigned to the measure.

You can use the mouse to set column widths. Using the mouse is less precise than using the window, however, requiring you to estimate the column width. To use the mouse to set a column width, position the mouse cursor at the right edge of the column title. The mouse cursor changes to a resizing handle. Click down and drag left or right until the column title is the desired width.

FREEZING PANES

When you spread key values across the top of the summary matrix, the summary often becomes wider than the display width, especially if you are using a 640 x 480 display. Scrolling right to view more information often removes the most important information from the display, i.e., the highest-level key fields, in this case the Customer field. To prevent columns from scrolling off screen, you can use Monarch’s Freeze Panes command. Let’s freeze the Customer column and then scroll right to view the rest of the summary columns.

Steps:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.
2. Click on the column heading BLU so the entire column is highlighted.
3. Select Freeze Panes from the Summary view ribbon.
   The Freeze Panes command acts just like the same named command in Microsoft Excel: it locks all rows above the cell pointer and all columns to the left of the cell pointer so that they remain on screen when you scroll the rest of the summary. This command also works in the Table view, and is retained in Excel file exports.
4. Click on the arrow on the right side of the horizontal scroll bar to scroll right.
   Note that the Customer column remains visible while you scroll.
5. Use the arrow at the left edge of the scroll bar to scroll back to the left.
6. Select the drop-down button of the Freeze Panes tool and then select Unfreeze Panes to unfreeze the Customer column.
VIEWING OTHER MEASURES

You may have noticed that our summary displays only a single measure calculation, even though it displayed two measures when we started this lesson.

When you elect to display values for a key field across the top of the summary, Monarch forms a two-dimensional matrix that displays a single measure at a time by default. To display results for a different measure, you can select it from the Active Measure drop-down list on the Summary window. This list displays the names for all measures included in the summary definition. When you select a measure from this list, the summary is redisplayed to show the results calculated for that field.

Steps:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.

2. On the Summary view ribbon, click the drop-down arrow of the Active Measure list box. This box currently displays “Amount.”

3. Select %Amount from the list of available measures.
The summary is re-displayed to show media sales as a percent of total sales. Note that the Summary line at the bottom of the summary displays the percentages represented by each media type across all customers and the rightmost column represents percentages for by each customer across all media types.

**DISPLAYING MULTIPLE MEASURES IN ACROSS KEY SUMMARIES**

Monarch allows you to display multiple measures in across key summaries. Let’s try doing this.

**Steps:**

1. Ensure that the Sales by Media summary is selected.
2. Click the drop-down arrow on the Active Measure drop-down list and select All, by Key.

   Monarch displays both of the measures grouped by key.

   **NOTE**

   Choose a smaller font size and auto-size the column widths in order to display all of the data in the summary window.

![Figure 17-5. Displaying both measures grouped by key.](image)

You may have to adjust the font size to 10 to reasonably view all the columns.
We can also choose to view all of the measures grouped by measure.

3. Click the drop-down arrow on the Summary tab’s Active Measure list box and select All, by Measure.

Monarch displays both measures grouped by measure.

<table>
<thead>
<tr>
<th>Customer</th>
<th>BLU</th>
<th>CD</th>
<th>DVD</th>
<th>LP</th>
<th>Total</th>
<th>BLU</th>
<th>CD</th>
<th>DVD</th>
<th>LP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Betty’s Music Store</td>
<td>353.65</td>
<td>80.85</td>
<td>64.74</td>
<td></td>
<td>507.64</td>
<td>4.80</td>
<td>1.22</td>
<td>0.88</td>
<td></td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>158.23</td>
<td>29.95</td>
<td></td>
<td>86.31</td>
<td>274.49</td>
<td>2.15</td>
<td>0.41</td>
<td>1.17</td>
<td>3.73</td>
</tr>
<tr>
<td>Bluegrass Records</td>
<td>122.34</td>
<td>53.91</td>
<td></td>
<td>71.92</td>
<td>248.27</td>
<td>1.66</td>
<td>0.73</td>
<td>0.98</td>
<td>3.37</td>
</tr>
<tr>
<td>Canciones</td>
<td>379.14</td>
<td></td>
<td></td>
<td>379.14</td>
<td></td>
<td>5.15</td>
<td></td>
<td></td>
<td>5.15</td>
</tr>
<tr>
<td>Chez Rudy</td>
<td>275.51</td>
<td>44.95</td>
<td></td>
<td>320.46</td>
<td></td>
<td>3.75</td>
<td>0.61</td>
<td></td>
<td>4.36</td>
</tr>
<tr>
<td>Classic Exchange</td>
<td>209.08</td>
<td></td>
<td></td>
<td>209.08</td>
<td></td>
<td>2.84</td>
<td></td>
<td></td>
<td>2.84</td>
</tr>
<tr>
<td>Das Piano</td>
<td>225.93</td>
<td>41.93</td>
<td>111.46</td>
<td>161.82</td>
<td>541.14</td>
<td>3.07</td>
<td>0.57</td>
<td>1.52</td>
<td>2.20</td>
</tr>
<tr>
<td>Die Harmonie</td>
<td>100.04</td>
<td>64.46</td>
<td></td>
<td></td>
<td>164.50</td>
<td>1.36</td>
<td>0.88</td>
<td></td>
<td>2.24</td>
</tr>
<tr>
<td>Die Melodie</td>
<td>362.56</td>
<td></td>
<td>23.96</td>
<td>86.31</td>
<td>472.83</td>
<td>4.93</td>
<td>0.33</td>
<td>1.17</td>
<td>6.43</td>
</tr>
<tr>
<td>Fandangos Records</td>
<td>213.90</td>
<td>11.98</td>
<td></td>
<td></td>
<td>235.88</td>
<td>2.91</td>
<td>0.16</td>
<td></td>
<td>3.07</td>
</tr>
<tr>
<td>Hope’s Sweet Notes</td>
<td>77.99</td>
<td>481.06</td>
<td>59.90</td>
<td>43.11</td>
<td>661.97</td>
<td>1.06</td>
<td>6.54</td>
<td>0.81</td>
<td>0.59</td>
</tr>
<tr>
<td>Mo Town Tunes</td>
<td>211.03</td>
<td>23.96</td>
<td></td>
<td></td>
<td>234.99</td>
<td>2.87</td>
<td>0.33</td>
<td></td>
<td>3.19</td>
</tr>
<tr>
<td>Musique du Monde</td>
<td>95.90</td>
<td>283.01</td>
<td>-17.97</td>
<td></td>
<td>360.94</td>
<td>1.30</td>
<td>3.85</td>
<td>0.24</td>
<td>4.91</td>
</tr>
<tr>
<td>Musique Royale</td>
<td>515.17</td>
<td></td>
<td>80.26</td>
<td></td>
<td>595.43</td>
<td>7.00</td>
<td></td>
<td>1.09</td>
<td>8.09</td>
</tr>
<tr>
<td>Notas Musicales</td>
<td>85.08</td>
<td>168.94</td>
<td>10.78</td>
<td>62.16</td>
<td>326.96</td>
<td>1.16</td>
<td>2.30</td>
<td>0.85</td>
<td>4.44</td>
</tr>
<tr>
<td>Reiner’s Symphonic</td>
<td>361.29</td>
<td>68.28</td>
<td>32.95</td>
<td></td>
<td>462.52</td>
<td>4.91</td>
<td>0.93</td>
<td>0.45</td>
<td>6.29</td>
</tr>
<tr>
<td>Spinning Records</td>
<td>317.66</td>
<td>89.85</td>
<td>11.98</td>
<td></td>
<td>419.49</td>
<td>4.32</td>
<td>1.22</td>
<td>0.16</td>
<td>5.70</td>
</tr>
<tr>
<td>The Glass Harmonica</td>
<td>9.59</td>
<td>211.56</td>
<td></td>
<td>67.20</td>
<td>288.35</td>
<td>0.13</td>
<td>2.88</td>
<td></td>
<td>0.91</td>
</tr>
<tr>
<td>The King’sRace</td>
<td>203.02</td>
<td>25.13</td>
<td></td>
<td>105.49</td>
<td>333.64</td>
<td>2.76</td>
<td>0.34</td>
<td></td>
<td>1.43</td>
</tr>
<tr>
<td>The Record Store</td>
<td>17.97</td>
<td>259.59</td>
<td>60.00</td>
<td></td>
<td>328.56</td>
<td>0.24</td>
<td>2.44</td>
<td>0.82</td>
<td>4.47</td>
</tr>
<tr>
<td>Summary</td>
<td>266.44</td>
<td>540.11</td>
<td>612.01</td>
<td>475.57</td>
<td>579.05</td>
<td>3.89</td>
<td>73.45</td>
<td>8.32</td>
<td>7.82</td>
</tr>
</tbody>
</table>

Figure 17-6. Displaying both measures grouped by measure.

Let’s return to our across key summary with only one measure.

4. Click the drop-down arrow on the Active Measure list box and select %Amount and restore the font size to 12.

Sorting a Summary

When you define a summary, Monarch initially displays the key field values in ascending alphabetical order. You can see this in the summary in Figure 17-1. Here, the Customer values are displayed starting with Betty’s Music Store, proceeding to The Record Store. The same holds true for the values of the Media field (BLU, CD, DVD, LP, SACD).

If the initial display order is not what you want, you can modify the order for any key field using the Keys window. Let’s change the sort order for the Customer key field to sort the customer field values in descending order.

Steps:

1. Ensure that the Sales by Media summary is selected.

2. Double-click on the Customer column to display the properties of this field. The Keys screen is focused.

3. Click on the Sorting subtab.
4. Under the *Direction* heading, select the *Descending* radio button, and then choose **Accept**.

The summary is redisplayed sorted in descending order by customer.

<table>
<thead>
<tr>
<th>Customer</th>
<th>BLU</th>
<th>CD</th>
<th>DVD</th>
<th>LP</th>
<th>SACD</th>
<th>%Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The Record Store</td>
<td>0.24</td>
<td>3.41</td>
<td>0.82</td>
<td>---</td>
<td>---</td>
<td>4.47</td>
</tr>
<tr>
<td>2. The King's Place</td>
<td>---</td>
<td>2.76</td>
<td>0.34</td>
<td>---</td>
<td>1.43</td>
<td>4.54</td>
</tr>
<tr>
<td>3. The Glass Harmonica</td>
<td>0.13</td>
<td>2.88</td>
<td>---</td>
<td>0.91</td>
<td>---</td>
<td>3.92</td>
</tr>
<tr>
<td>4. Spinning Records</td>
<td>---</td>
<td>4.32</td>
<td>1.22</td>
<td>0.16</td>
<td>---</td>
<td>5.70</td>
</tr>
<tr>
<td>5. Reiner's Symphonic Sounds</td>
<td>---</td>
<td>4.91</td>
<td>0.93</td>
<td>0.45</td>
<td>---</td>
<td>6.29</td>
</tr>
<tr>
<td>6. Notas Musicales</td>
<td>1.16</td>
<td>2.30</td>
<td>0.15</td>
<td>0.85</td>
<td>---</td>
<td>4.44</td>
</tr>
<tr>
<td>7. Musique Royale</td>
<td>---</td>
<td>7.00</td>
<td>---</td>
<td>1.09</td>
<td>---</td>
<td>8.09</td>
</tr>
<tr>
<td>8. Musique du Monde</td>
<td>1.30</td>
<td>3.85</td>
<td>-0.24</td>
<td>---</td>
<td>---</td>
<td>4.91</td>
</tr>
<tr>
<td>9. Mo Town Tunes</td>
<td>---</td>
<td>2.87</td>
<td>0.33</td>
<td>---</td>
<td>---</td>
<td>3.19</td>
</tr>
<tr>
<td>10. Hope's Sweet Notes</td>
<td>1.06</td>
<td>6.54</td>
<td>0.81</td>
<td>0.59</td>
<td>---</td>
<td>9.00</td>
</tr>
<tr>
<td>11. Fandangos Records</td>
<td>---</td>
<td>2.91</td>
<td>0.16</td>
<td>---</td>
<td>---</td>
<td>3.07</td>
</tr>
<tr>
<td>12. Die Melodie</td>
<td>---</td>
<td>4.93</td>
<td>---</td>
<td>0.33</td>
<td>1.17</td>
<td>6.43</td>
</tr>
<tr>
<td>13. Die Harmonie</td>
<td>---</td>
<td>1.36</td>
<td>0.88</td>
<td>---</td>
<td>---</td>
<td>2.24</td>
</tr>
<tr>
<td>14. Das Piano</td>
<td>---</td>
<td>3.07</td>
<td>0.57</td>
<td>1.52</td>
<td>2.20</td>
<td>7.36</td>
</tr>
<tr>
<td>15. Classic Exchange</td>
<td>---</td>
<td>2.84</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>2.84</td>
</tr>
<tr>
<td>16. Chez Rudy</td>
<td>---</td>
<td>3.75</td>
<td>---</td>
<td>0.61</td>
<td>---</td>
<td>4.36</td>
</tr>
<tr>
<td>17. Canciones</td>
<td>---</td>
<td>5.15</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>5.15</td>
</tr>
<tr>
<td>18. Bluegrass Records</td>
<td>---</td>
<td>1.66</td>
<td>0.73</td>
<td>---</td>
<td>0.98</td>
<td>3.37</td>
</tr>
<tr>
<td>19. Big Shanty Music</td>
<td>---</td>
<td>2.15</td>
<td>0.41</td>
<td>---</td>
<td>1.17</td>
<td>3.73</td>
</tr>
<tr>
<td>20. Betty's Music Store</td>
<td>---</td>
<td>4.80</td>
<td>1.22</td>
<td>0.88</td>
<td>---</td>
<td>6.90</td>
</tr>
<tr>
<td>21. Summary</td>
<td>3.89</td>
<td>73.45</td>
<td>8.32</td>
<td>6.46</td>
<td>7.87</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Figure 17-7. Sorting a key field.

**Sorting by Measure Values**

Monarch can also sort a summary based on the values of a measure. Let’s use this feature to sort our customers from largest to smallest. First, we’ll select the *SUM(Amount)* measure calculation to show sales totals for each customer.

**Steps:**

1. Ensure that the **Sales by Media** summary is selected.
2. Select **Amount** from the **Active Measure** drop-down list located on the Summary view ribbon.
   
   Now we’ll sort the **Customer** key field values based on the values of the *SUM(Amount)* field. This has the effect of ranking customers by sales totals. We’ll sort in descending order to rank customer sales from largest to smallest.

3. Double-click on the **Customer** column to display the properties of this field.
4. Click on the **Sorting** subtab of the **Customer** field.
5. Under the **Sort By** heading, select the **Measure** radio button.
   
   The *SUM(Amount)* field is already selected as the measure to sort on.
6. Ensure that the **Descending** option is selected.

7. Choose **Accept**.

The summary is redisplayed with customers sorted in descending order by sales totals. Note that Hope’s Sweet Notes appears first because it has the largest total sales amount of any customer (661.97), followed by Musique Royale with a sales total of 595.43, and so on.

<table>
<thead>
<tr>
<th>Customer</th>
<th>SACD</th>
<th>LP</th>
<th>DVD</th>
<th>CD</th>
<th>BLU</th>
<th>SUM(Amount)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hope’s Sweet Notes</td>
<td>---</td>
<td>43.11</td>
<td>59.90</td>
<td>481.06</td>
<td>77.90</td>
<td>661.97</td>
</tr>
<tr>
<td>Musique Royale</td>
<td>---</td>
<td>80.26</td>
<td>---</td>
<td>515.17</td>
<td>---</td>
<td>595.43</td>
</tr>
<tr>
<td>Das Piano</td>
<td>161.82</td>
<td>111.46</td>
<td>41.93</td>
<td>225.93</td>
<td>---</td>
<td>541.14</td>
</tr>
<tr>
<td>Betty’s Music Store</td>
<td>---</td>
<td>64.74</td>
<td>89.85</td>
<td>353.05</td>
<td>---</td>
<td>507.64</td>
</tr>
<tr>
<td>Die Melodie</td>
<td>86.31</td>
<td>23.96</td>
<td>---</td>
<td>362.56</td>
<td>---</td>
<td>472.83</td>
</tr>
<tr>
<td>Reiner’s Symphonic Sounds</td>
<td>---</td>
<td>32.95</td>
<td>68.28</td>
<td>361.29</td>
<td>---</td>
<td>462.52</td>
</tr>
<tr>
<td>Spinning Records</td>
<td>---</td>
<td>11.98</td>
<td>89.85</td>
<td>317.66</td>
<td>---</td>
<td>419.49</td>
</tr>
<tr>
<td>Canciones</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>379.14</td>
<td>---</td>
<td>379.14</td>
</tr>
<tr>
<td>Musique du Monde</td>
<td>---</td>
<td>---</td>
<td>17.97</td>
<td>283.01</td>
<td>95.90</td>
<td>360.94</td>
</tr>
<tr>
<td>The King’s Place</td>
<td>105.49</td>
<td>---</td>
<td>25.13</td>
<td>203.02</td>
<td>---</td>
<td>333.64</td>
</tr>
<tr>
<td>The Record Store</td>
<td>---</td>
<td>60.00</td>
<td>---</td>
<td>250.59</td>
<td>17.97</td>
<td>328.56</td>
</tr>
<tr>
<td>Notas Musicales</td>
<td>---</td>
<td>62.16</td>
<td>10.78</td>
<td>168.94</td>
<td>85.08</td>
<td>326.96</td>
</tr>
<tr>
<td>Chez Rudy</td>
<td>---</td>
<td>44.95</td>
<td>---</td>
<td>275.51</td>
<td>---</td>
<td>320.46</td>
</tr>
<tr>
<td>The Glass Harmonica</td>
<td>67.20</td>
<td>---</td>
<td>---</td>
<td>211.56</td>
<td>9.59</td>
<td>288.35</td>
</tr>
<tr>
<td>Big Shanty Music</td>
<td>86.31</td>
<td>---</td>
<td>29.95</td>
<td>158.23</td>
<td>---</td>
<td>274.49</td>
</tr>
<tr>
<td>Bluegrass Records</td>
<td>71.92</td>
<td>---</td>
<td>53.91</td>
<td>122.34</td>
<td>---</td>
<td>248.17</td>
</tr>
<tr>
<td>Mo Town Tunes</td>
<td>---</td>
<td>23.96</td>
<td>---</td>
<td>213.03</td>
<td>---</td>
<td>234.99</td>
</tr>
<tr>
<td>Pandangos Records</td>
<td>---</td>
<td>11.98</td>
<td>---</td>
<td>213.90</td>
<td>---</td>
<td>225.88</td>
</tr>
<tr>
<td>Classic Exchange</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>209.08</td>
<td>---</td>
<td>209.08</td>
</tr>
<tr>
<td>Die Harmonie</td>
<td>---</td>
<td>64.46</td>
<td>---</td>
<td>100.04</td>
<td>---</td>
<td>164.50</td>
</tr>
<tr>
<td>Summary</td>
<td>579.05</td>
<td>475.57</td>
<td>612.01</td>
<td>5403.11</td>
<td>286.44</td>
<td>7356.18</td>
</tr>
</tbody>
</table>

Figure 17-8. Sorting a key field based on the values of a measure.

Let’s also sort the **Media** field values in the same manner. The result should show the media type with the largest overall sales first, followed by the second largest in terms of sales, etc.

8. Double click on any cell in the **Customer** column once more.

9. Select the **Media** field and then click on the **Sorting** subtab.

10. Select the **Measure** radio button under the **Sort By** heading.

The **SUM(Amount)** field is already selected as the measure to sort on, but the sort order is set to Ascending. We’ll change this to Descending in order to display the media type with the largest sales first.

11. Select the **Descending** radio button under the **Direction** heading, and then choose **Accept**.

The summary is redisplayed with customers sorted in descending order by sales totals and Media types also sorted in descending order by sales totals.
Figure 17-9. Sorting both Customers and Media types by sales totals.

Note that CD appears first because it has the largest total sales amount across all customers (5403.11), followed by DVD with a sales total of 612.01, and so on. The sales totals appear in the Summary row at the bottom of the summary report.

Restoring the Key Field Direction

So far, we’ve shown how to create a crosstab summary that displays the values for a single key field across the top row, forming a two-dimensional matrix. This format is useful for displaying a lot of information, but it may not be ideal for all summary reports. With Monarch, you can switch between this format and a more traditional report format, choosing the appropriate format for your data and viewing requirements. Let’s reset the Media field to display its values down rather than across.

Steps:

1. Ensure that the Sales by Media summary is selected.
2. Double-click anywhere on the Customer column to display the properties of the Key fields.
3. Click on the Media field and then select the Layout subtab.
4. Under the Orientation heading, select the Down radio button.
   Now, let’s suppress duplicate values in the Customer column to give a summary report a nicer look.
5. Select the Customer field and then click on the Layout subtab.
6. From the Key values drop-down box, select Suppress Duplicates and then select Accept.
The summary is redisplayed suppressing duplicate customer names.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Media</th>
<th>Amount</th>
<th>%Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Hope's Sweet Notes</td>
<td>CD</td>
<td>481.06</td>
<td>6.54</td>
</tr>
<tr>
<td>2 BLU</td>
<td></td>
<td>77.90</td>
<td>1.06</td>
</tr>
<tr>
<td>3 DVD</td>
<td></td>
<td>59.50</td>
<td>0.81</td>
</tr>
<tr>
<td>4 LP</td>
<td></td>
<td>43.11</td>
<td>0.59</td>
</tr>
<tr>
<td>5 Subtotal</td>
<td></td>
<td>661.97</td>
<td>9.00</td>
</tr>
<tr>
<td>6 Musik Royal</td>
<td>CD</td>
<td>515.17</td>
<td>7.00</td>
</tr>
<tr>
<td>8 LP</td>
<td></td>
<td>80.26</td>
<td>1.09</td>
</tr>
<tr>
<td>9 Subtotal</td>
<td></td>
<td>595.43</td>
<td>8.09</td>
</tr>
<tr>
<td>10 Das Piano</td>
<td>CD</td>
<td>225.83</td>
<td>3.07</td>
</tr>
<tr>
<td>12 SACD</td>
<td></td>
<td>161.82</td>
<td>2.20</td>
</tr>
<tr>
<td>13 LP</td>
<td></td>
<td>111.46</td>
<td>1.52</td>
</tr>
<tr>
<td>14 DVD</td>
<td></td>
<td>41.93</td>
<td>0.57</td>
</tr>
<tr>
<td>15 Subtotal</td>
<td></td>
<td>541.14</td>
<td>7.36</td>
</tr>
<tr>
<td>17 Betty's Music Store</td>
<td>CD</td>
<td>353.05</td>
<td>4.80</td>
</tr>
<tr>
<td>18 DVD</td>
<td></td>
<td>89.85</td>
<td>1.22</td>
</tr>
<tr>
<td>19 LP</td>
<td></td>
<td>64.74</td>
<td>0.88</td>
</tr>
<tr>
<td>20 Subtotal</td>
<td></td>
<td>507.64</td>
<td>6.90</td>
</tr>
</tbody>
</table>

Figure 17-10. Restoring the summary to a more traditional display format.

Notice that the summary is still sorted in the same manner, with customer groups sorted in descending order by sales amounts (entire summary groups are sorted based on the subtotal values for each group). Within each customer, the media types are also sorted in descending order by sales. In this format (with no key field displayed across), the summary can display both the $\text{SUM}(\text{Amount})$ and $\%(\text{Amount})$ measure calculations at the same time.

### Top $n$ Analysis

Top $n$ analysis, typically referred to as **Top 10 Analysis**, is a common tool provided by data analysis applications. You can create a top $n$ analysis or bottom $n$ analysis of your summary data by first sorting the data in the appropriate order and then by selecting the first $n$ values, whether $n$ is 10, 3 or some other number. These values then represent either the top $n$ or the bottom $n$ analysis. Let’s see how this works.

We’ll create a top 3 analysis from our sales summary that shows the top three customers in terms of sales. All other customers will be represented using a single summary label, “All Others.” To create our top 3 analysis, we start by sorting the customers in descending order by sales totals. This places the top performing customers at the top of the summary display. We’ve already applied this sort in our previous discussion on sorting. Next, we need to indicate that we want to see only the first three customers (the three customers with the largest sales totals).
Steps:

1. Ensure that the **Sales by Media** summary is selected.

2. Double-click on the **Customer** field to display the properties of the Key fields.

3. Select the **Matching** subtab for the **Customer** field.

4. Select the **First N Values** option and enter 3 in the box (this is the box labeled *Count of distinct values as sorted*).

5. Under the **Accumulator for values after the First N** heading, ensure that **All Others** is entered into the **Label** field.

6. Select the **Media** field.

7. In the **Layout** subtab, select the **Across** orientation and then click **Accept**.

   The summary is rebuilt to show only the top three customers. All other customers are grouped together and represented by the "All Others" label.

---

### Figure 17-11. A Top 3 analysis showing the top performing customers in terms of total sales.

<table>
<thead>
<tr>
<th>Customer</th>
<th>CD</th>
<th>DVD</th>
<th>SACD</th>
<th>LP</th>
<th>BLU</th>
<th>SUM(Amount)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Hope's Sweet Notes</td>
<td>481.06</td>
<td>59.90</td>
<td>---</td>
<td>43.11</td>
<td>77.90</td>
<td>661.97</td>
</tr>
<tr>
<td>2 Musique Royale</td>
<td>515.17</td>
<td>---</td>
<td>80.26</td>
<td>---</td>
<td>---</td>
<td>595.42</td>
</tr>
<tr>
<td>3 Des Pano</td>
<td>225.93</td>
<td>41.93</td>
<td>111.46</td>
<td>---</td>
<td>---</td>
<td>541.31</td>
</tr>
<tr>
<td>4 All Others</td>
<td>4180.95</td>
<td>510.18</td>
<td>417.23</td>
<td>240.74</td>
<td>208.54</td>
<td>5557.64</td>
</tr>
<tr>
<td>5 Summary</td>
<td>5403.11</td>
<td>612.01</td>
<td>579.05</td>
<td>475.57</td>
<td>286.44</td>
<td>7356.18</td>
</tr>
</tbody>
</table>

You can easily modify this summary to show the bottom 3 customers in terms of sales totals by sorting the customer key field in ascending order. Likewise, you can increase or decrease the number of customers that you explicitly break down for analysis by increasing or decreasing the value in the **Customer field's First n Values** option.

A top *n* analysis can be defined at any level in the summary. Within each customer, you can define a top 3 analysis of each media type by sorting the media type in descending order and then selecting the **First n Values** option for the **Media** key field and entering the desired number in its spin box.

---

**Specifying Key Field Values**

While performing a top *n* analysis is useful when you want to determine which items (customers, salespeople, etc.) are the top performers, sometimes you already know which items you want to look at, whether they are the top performers or otherwise. For example, suppose you want to focus on just the digital media types (compact discs, digital versatile discs, and LPs). You could do this by creating a filter in the Table view with the filter expression:

```plaintext
Media="CD".Or.Media="DVD".Or.Media="LP"
```

You could also write this expression as:

```plaintext
Media.In.("CD", "DVD", "LP")
```
By applying the filter to the summary definition, the summary would display information about only the digital media types. However, Monarch provides an easier and, in some cases, more powerful method of achieving this result. For each key field, you can define a list of all values you want to use when building the summary. Further, you can accumulate all values not in your list as a single key value (a feature not available if you use a filter). To demonstrate how this works, let’s create a list of values to use for the Media field.

**Steps:**

1. Ensure that the Sales by Media summary is selected.
2. Double-click on the Customer field to display the properties of the Key fields.
3. Select the Media field and then navigate to the Matching subtab.

![Figure 17-12. Displaying the Matching subtab of the Media tab.](image)

4. Check the **Values from table** option.
5. Click the Add button.
All unique values found within the *Media* field (BLU, CD, DVD, LP, and SACD) are displayed.

6. Select **CD** from the *Key Values* list, and then click the **Add** button to add this value to the *Specified or Upper Limit Values* list.

7. Repeat Step 5 to add the **DVD** and **LP** values to the *Specified or Upper Limit Values* list.

   The selected values appear in the subtab’s *Click to sort values* list.

8. Click the **Finish** button to close the *Key Values* list.

   Let’s accumulate the old media types (BLU and SACD) under a separate heading.

9. Ensure that the *Display* box under the *Accumulator for unmapped values* heading is selected.

10. Type **All Others** in the *Label* box, and then choose **Accept** ✓.

    Monarch rebuilds the summary using only the selected media types. The two media types not specified (BLU and SACD) are combined under the label **All Others**.
Sorting by Key Field Values

Once you have specified key field values, you can sort the summary data by either the specified values themselves (i.e., their names) or by their order in the Specified or Upper Limit Values list on the Matching subtab. To do so, select the Key Field radio button on the Sorting tab, and then choose either the Field Value option (to order the data by the field value names) or the Position in values table option (to order the data by their position in the Specified or Upper Limit Values list).

**NOTE**

The Position in values table option is not available if the Values from table option on the Matching tab has not been chosen.

Upper Limit Values

While the Values from table option lets you select the exact values you want to use in your summary, sometimes you want to group values into ranges, such as weekly or monthly periods. This capability is provided via the Upper Limit Values option. This option lets you define an upper limit for each range of values. An example of this can be seen in the Sales by Ship Date summary.

Steps:

1. Click on the Sales By Ship Date summary in the Summary Selector.

2. Select Autosize Columns from the Summary tab to maximize your view of all of the fields.

   The Sales by Ship Date summary displays. This summary breaks out sales for all customers across four weekly periods during the month of April 2010. We created this summary by using the dates 04/07/2010, 04/14/2010, 04/21/2010, and 04/28/2010 to define the ending dates for each weekly period.
Summary Limit Values

Another way to analyze summary data is to set a limit against a measure. This feature works somewhat like a filter that is applied after the summary is built. For example, the Sales >=400 summary displays only those customers for which totals sales exceed 399.00.

Steps:

1. Click on the Sales >=400 summary in the Summary selector.

The Sales >= 400 summary displays. This summary breaks out only those customers for which total sales are at least 400.00 (There are seven such customers). All other customers are grouped together under an "All Others" label.

To create this summary, simply double-click on the Customer field, and then select the Matching subtab of the Customer field. Select the Measure Limit radio button. Choose the SUM(Amount) field, the ">=" operator, and enter 400 in the adjacent field.
At this point, you can either save your work or simply close the report and model files you opened for this lesson.
One of the key features of Monarch is that you can export input files as well as extracted data into a number of file formats.

This lesson will discuss how to export:

- Reports
- Tables
- Summaries

Reports may be exported as .txt and .pdf files, while tables and summaries may be exported to a wider variety of formats, including .csv, .xls, .xlsx, .mdb, .dbase, .accdb, .htm, and .xml, among others.

Note that if your Monarch license is for Monarch Complete or Monarch Complete with Table Extractor, you can export tables and summaries to the Tableau data extract (.tde/.csv) and QlikView QVX (.qvx) formats. Tables may also be exported as a SAPExport, SAP Transport, or Panopticon Designer Data Source file.

Note also that these features are NOT available in Monarch for IBM Analytics. Consider contacting sales@Altair.com to obtain a copy of Monarch Complete and gain access to these additional functions in Monarch.

We’ll begin by loading the Classic.prn report file and the Lesson8.dmod model file.

Exporting Reports

Monarch allows you to export data from the Report window specifically into a TXT or PDF file. When exporting to a PDF file, if you have configured the Report Index, the tree definition will provide the bookmarks in the PDF file.

Let’s try exporting the Classic.prn file to a PDF file.
Steps:

1. Select the **Export** tab to display Export view.

![Image of Export view interface]

Figure 18-1. The Export view interface.

The Export interface is divided into several panels. To the left of the interface is an **Export Selector**. The right-hand side shows to smaller panels arranged one on top of another. The top panel shows the **Export Job List**. Any export selected from the Export Selector and added to this panel becomes a job. The bottom panel shows the **Export Results**. Each time you run an export/job, the results of the export process are added to this panel.

The following table summarizes the functions of each of the buttons in Export view.

<table>
<thead>
<tr>
<th>USE THIS BUTTON...</th>
<th>TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Export Design]</td>
<td>Launch the Export Design interface</td>
</tr>
<tr>
<td>![Select All Exports]</td>
<td>Select all defined exports</td>
</tr>
<tr>
<td>![Clear Selected Jobs]</td>
<td>Clear all selected jobs</td>
</tr>
<tr>
<td>![Clear Job List]</td>
<td>Clear the job list</td>
</tr>
<tr>
<td>![Create Export]</td>
<td>Create a new export</td>
</tr>
<tr>
<td>![Run Export]</td>
<td>Run the export</td>
</tr>
</tbody>
</table>

2. Select **Create Export** to begin defining your export. The **Create Export** dialog displays.
Let’s take a look at this dialog. The **File Name** field allows you to specify the file name to which the export should be saved. Most of the dialog is divided into two panels, the **Source View panel** and the **Export File Type panel**. The Source View panel allows you to select a view or parts of views (in the case of summaries) to export, and the Export File Type panel allows you to select a file type in which to save the export.

3. Enter the file name **Export1** in the **File Name** field.

4. From the Source View panel, select **Report**.

   Note that the entries in the Export File Type panel change to reflect the different file types to which you can save the export.
5. Select **Adobe PDF (*.pdf)** from the *Export File Type* panel.

For this exercise, let’s choose to password-protect the PDF file.

6. Click on the button **Edit Advanced Options**.

The dialog closes and the Export Design view displays. A PDF Output panel displays on the right side of the view.
You can add a password to your PDF file by checking the box for **Require a password to open the document** and then clicking the **Open Password** button.

If you would like to restrict access to the content of the exported report, you may do so by checking the **Restrict access to document contents** box and then selecting which actions you want to permit. You can even specify a password to allow these actions to be executed by clicking the **Permissions Password** button.

7. **We’re not adding any advanced option to our export at this stage so simply select **Accept** to save the export.**

The Export Design view closes and you are brought to Export view.

Let’s try running our export now.

8. **Double-click on Export1 in the Exports Selector panel so that it is added to the Export Job List. Click on this export in the job list panel.**

9. **Select the **Run Exports** button from the Export ribbon.**

The export runs and the results are displayed on the Export Results panel.

![Figure 18-5. The Export Results panel shows the results of each export run. This export was successfully completed.](image)

To view the exported file, click on the export link provided. Doing so copies the path indicated, and you can use your mouse to paste this path into your file explorer to navigate to the location of the file.

The default folder for exported files is specified in the Options window (typically in C:\Users\Public\Documents\Altair Monarch\Export).
Since we opted to password-protect our PDF file, you will be asked to supply the password you specified before your file can be opened.

![Figure 18-6. The PDF file includes all 20 records of Classic.prn.](image)

Before proceeding with the rest of the lesson, return to Export view and then select **Clear Job List**. All of the jobs added to the job list are run every time you select the **Run Exports** button. Since we are only interested in showing the results of individual exports at this time, we’ll need to clear the Export Job List so that previous jobs are not run together with new jobs.

While it is not required that you do so, you may also clear the Export Results panel by selecting the **Clear Results** button.
Exporting Tables

This time, we’ll try exporting the table we extracted using the templates defined in the Lesson8.dmod model file.

Steps:

1. Select **Create Export** from the Export ribbon.

2. Enter **Export2** in the File Name field of the Create Export dialog that displays.

   **NOTE**

   The export file name (the name of the file to which you will export data) and the export name that displays in the Export Selector have no relation. You can choose to export to any file name you wish. The Export Selector will create export names in the order in which the export was created beginning from Export1.

3. Ensure that **Table** is selected in the Source View panel and then select **Microsoft Excel XLSX (*.xlsx)** from the Export File Type panel.

4. The **Table Name** field is activated at the lower right-hand corner of the dialog. Enter the name **Table1** here.

   **NOTE**

   For Excel files, “Table Name” corresponds to a Worksheet name or Named Range, and Named Ranges must begin with a letter or underscore, must not be “C”/“c” or “R”/“r”, cannot contain spaces, and must not be the same as a cell reference, e.g., R1C1, A1, Z$100, etc., or any other Excel built-in names or objects in the workbook.

5. Select the **Add to Project** button located at the top of the **Create Export** dialog.
You are returned to the Export interface. Note that Export2 has been added to the Export Selector.

Let’s run this export and check our results.

6. Double-click on **Export2** from the Export Selector so that it is added to the Export Job List.

7. Select **Export2** from the job list and then click the **Run Exports** button on the Export ribbon.

![Figure 18-7. The Export Results panel indicates that the export was successfully run.](image)

To view the file to which your table was exported, as in the previous lesson, click on the export link provided. Use your mouse to paste the copied path into your file explorer to navigate to the location of the file. Select the file to open it.

![Figure 18-8. The exported table. Note that the table is named Table1, as specified in the Create Export dialog.](image)

As usual, clear the job list before proceeding to the next lesson.
NOTE

If your Monarch license is for Monarch Complete, your table data may also be exported to the Tableau data extract (.tde) and QlikView QVX (.qvx) formats.

Exporting Summaries

The Lesson8.dmod model includes three summaries. Since we can create more than one summary in a single Monarch session, aside from specifying an export name and export file type, we'll also have to specify which of these summaries to export. You can only export one summary at a time. If you wish to export another summary to the same file name, you'll have to add this summary as a new table to the file. Let's look at how we do this in the following example.

EXPORTING A SINGLE SUMMARY

Steps:

1. Select Create Export from the Export ribbon.
2. Enter Export3 in the File Name field of the Create Export dialog that displays.
3. Ensure that the summary Sales by Ship Date is selected in the Source View panel and then select Microsoft Excel XLS (*.xls) from the Export File Type panel.
4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the name SalesbyShipDate here. Note that table names cannot contain spaces.
5. Select the Edit Advanced Options button located on the upper right-hand corner of the dialog.
The Export Design interface is activated.

![Export Design Interface](image)

Figure 18-9. Advanced Export options for summaries.

The left-hand panel of the Export Design view provides a host of summary options. You can:

- Choose another summary to export using the Summary drop-down
- Specify a drill state (assuming that you had either drilled up or drilled down on the summary)
- Specify an active measure to apply to the summary prior to export
- Split the summary into distinct files or tables according to key values
- Apply a filter to the summary (this option is deactivated if the summary includes no filters)
- Apply a sort order to the summary (this option is deactivated if the summary includes no sorts)

Note that the options you choose to apply to your summary may result in more than one exported file, and you can choose how these files are to be named (i.e., either by file name or by table name).

In the present case, for example, choosing the option **All measures as separate exports** will require you to choose whether the measure title should be applied as individual tables or individual file names. In the former case, you create one file with two tables named according to the measure title. In the latter case, you create two files named according to the measure title.
The right-hand panel of the Export Design view provides your usual export options, including the folder/filename to save your export to, the file format to apply, what tables should be named, etc.

Note that when specifying a file name in which to export your summary, you must ensure that the file extension indicated matches the file type selected in the Export File Type drop-down.

6. For this lesson, let’s use the default summary options as export parameters.

7. In the Export Options section of the Export Design view, ensure that Overwrite file is selected as a When output files exist option.

8. Click the Accept button to save the export you’ve just defined.

You will be returned to the Export interface when you do so. Note that Export3 has been added to the Export Selector.

Let’s run this export and check our results.

9. Double-click on Export3 from the Export Selector so that it is added to the Export Job List.

10. Select Export3 from the job list and then click the Run Exports button on the Export ribbon.

When successfully exported, the summary can be viewed as follows.

![Figure 18-10. The exported summary.](image-url)

Clear the job list before proceeding to the next lesson.
ADDING A SUMMARY TO AN EXPORT FILE

Now we’ll add another summary to the Export3.xls export file.

Steps:
1. Select Create Export from the Export ribbon.
2. Enter Export3.xlsx in the File Name field of the Create Export dialog that displays.
3. This time, select Sales >=400 from the Source View panel and then select Microsoft Excel XLS (*.xls) from the Export File Type panel.
4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the name SalesOf400Above here. Note that table names cannot contain spaces.
5. In the Export Options section located at the lower left-hand corner of the dialog, expand the When output files exist options and then select Add data to file.
6. A drop-down box for When output tables exist options appears. Select Add data to table.
7. Select the Add to Project button located at the top of the dialog.
   You are returned to the Export interface when you do so. Note that the export you’ve just defined displays as Export 4 in the Export Selector because it is the fourth export you defined.
8. Double-click on Export4 from the Export Selector so that it is added to the Export Job List.
9. Select Export4 from the job list and then click the Run Exports button in the Export ribbon.

```
Running export job Export4
Export job Export4:
   Export4 - Completed
   9 records written to C:\Users\Public\Documents\Monarch\export\Export3.xls
   Export time: 00:00:00.0
   Total time: 00:00:00.5
```

Figure 18-11. The Export Results panel indicates that the export was successfully run.
When the exported file is opened, the table **SalesByShipDate** displays as the first table of the file. A second table, **SalesOf400Above**, is also added to the file. Select this table to view its results.

**Figure 18-12.** The exported file showing two tables.

**Figure 18-13.** The SalesOf400Above table displays the data in the Sales>=400 summary.
Exporting Data to Panopticon Designer

Panopticon Designer (Panopticon) software provides a wide range of digital tools or visualizations that allow users to view, analyze, manipulate, and/or present complex information, such as historical, spatial, and statistical data.

The dashboard presented below, for example, displays several charts (visualizations) that allow real-time analysis and monitoring of network traffic for a telecommunications service provider.

Monarch allows the export of tables to Designer workbooks for information visualization.

A Designer workbook may be likened to a Monarch project file. If Monarch project files contain the paths (drive and folder information) and file names of both the data source(s) and the model to be used in a Monarch session, Designer workbooks contain the data sources and dashboards necessary to visualize your data completely and comprehensively, in real time if necessary. Both project files and workbooks save time: When a project file is saved and reopened, the input file(s) and model, as well all other definitions, are automatically called. When a Designer workbook is opened, all defined data tables and previously created dashboards are automatically called.

To create a workbook, one must define a data source, also called a data table, and specify dashboard contents. Each item in a dashboard is called a visualization and you can include any number of visualizations in a single dashboard.

More information regarding Designer workbooks may be found in the Designer Help system, which may be accessed online at http://docs.datawatch.com/.
Exporting Redaction Alias Maps

As Monarch processes a report/model which involves consistent alias replacement redactions, it generates a redaction alias map for each such redaction. The map expresses the relation between the un-redacted and the redacted values for that particular type of redaction (e.g., “Consistent alias text”), and for that particular build. Since the redacted values are generated based (at least partly) on random numbers, the specific aliases recorded in a map will change from build to build, even if Monarch is run against the exact same report and model.

Monarch automatically discards its redaction alias maps when doing a Close All or when exiting. However, in some circumstances, it may be desirable to export a redaction alias map so that it may be archived or used by some downstream process. Monarch provides for exporting redaction alias maps as simple delimited text files.

To export a redaction alias map, launch the Create Export dialog and then dialog select Redaction Alias Map under Source View. Notice that when this view is selected, the only option under Export File Type is Delimited Text.

Figure 18-15. Exporting a redaction alias map.
Use this dialog to specify your desired output file name and the particular Redaction Map Type you wish to export, as shown below.

The Redaction Map Types listed in the dropdown box correspond directly to the five distinct types of consistent alias replacement redactions available.

When you run this export, the redaction alias map of the selected type is exported to the specified output file as delimited text using the delimiter and string quoting mechanism common to all delimited text exports (see the “For Delimited Text Files” settings of the Text Files tab under Options > Export). The exported map file consists of just two columns: the first contains the un-redacted values, and the second contains the corresponding redacted values.
For example, the first few lines of an export of a "Consistent alias text" map might look like this:

"1000-2000-3000-4000","5w7wiyowykwzwxeg8o" 
"alpha","uuuuu" 
"beta","9999" 
"gamma","uuuuz" 
"delta","uuuuo" 
"epsilon","ooooooo" 
"The Quick Brown Fox Jumps Over The Lazy Dog","0h0h4h0hohvhphnj0amnbueevrjgphdjmjn3fts86bgg" 
"7235-5311-6745-2225","zwiwissww5wo9kuooz"

Exporting to Tableau Server

Tableau Server, by Tableau Software®, is an online solution for sharing, distributing, and collaborating on content created in Tableau or exported to Tableau Data Extract form. Monarch offers a simple solution to allow data extracted in the application to be exported to Tableau Server quickly and seamlessly.

Steps:

1. Create an export and select Tableau Data Extracts (.tde) as an export file type.
2. If you created your export via the Create Export dialog, select Edit Advanced Options. If you created your export via Export design, you will not need to perform this step.
3. Check the box for Publish to Tableau Server.
4. The information you entered to access Tableau Server in the Security tab of the Options window displays. If you did not provide the necessary information in this tab, you can do so now.

![Figure 18-17. Specifying Tableau Server connection settings.](image)
5. Enter a **data source name** into the field provided and select a **publish type**.
   - Overwrite Data Source - This option will erase the existing data source and replace it with a new one containing the newly exported data.
   - Replace Data - This option will erase all previous data in the data source and replace it with the newly exported data.
   - Append Data - This option will append the newly exported data to the data in the existing data source.

6. Select **Accept** when you are finished to close Export Design view and add your newly defined export to the Export selector in Export view.

7. Run the export as usual.

**Duplicating Exports**

You may want to create a new export that closely resembles an export you previously defined. An easy way to do this is by using the **Duplicate** button. To duplicate an export, simply select the export you want to duplicate from the Export list and then select **Duplicate** from the Export Design ribbon. The duplicated export appears on the Export list; this export will have the name of the export you duplicated and a number appended to it. Select this export to display its properties in the Export Definition window and make further revisions to it. Select **Accept** when you are finished to accept and save your new export definition.
[19] Importing Data from HTML, Web Files, and External Databases

This chapter, and the ones that follow, deal with advanced capabilities found in Monarch.

For most of its history, Monarch has been the leading report mining tool available in the market, allowing access to data buried in computer generated reports. Monarch transforms static report data into live data that you can explore, analyze, and export to other applications. While its ability to re-deploy data locked inside reports has been the major factor distinguishing Monarch technology from other data access technologies, Monarch also includes powerful data manipulation, analysis, and transformation tools that potentially make it valuable for use with other data sources.

Monarch reads report files and data from database files, spreadsheet files, delimited text files, HTML, ODBC databases, PDF and XPS files, and provides report extraction, data manipulation, analysis, and transformation capabilities. As well, data access from additional sources, including dBase, MS-Excel, and MS-Access files, OLE DB and ODBC compatible data sources, such as SQL Server, Oracle, DB2, MySQL, and others, is possible.

In this chapter, you will learn how to import data from an external data source to begin a Monarch session. You will also learn how to import HTML and web files into Monarch. The lesson topics include:

- Accessing database data with Monarch
- Importing data from an external database
- Adjusting fields
- Storing import parameters in a model file
- Storing import parameters in a project file
- Importing data from an HTML file
- Importing data from a Web file
Importing Data from an External Database

To illustrate Monarch’s database import capability, we’ll import data from an MS-Access database file called Employ.mdb. This file contains information about the employees of a fictitious company. We’ll use Monarch to open the file and import data from its Employee Roster database table.

Steps:

1. Ensure that Monarch is up and running.
2. Select File > Open > Database > Computer.

The Open Database File dialog displays. This dialog allows you to select the data source, either a data file from a local or network drive or an OLE DB/ODBC data source, such as a SQL Server, Oracle, or other OLE DB/ODBC compatible database server.

Monarch can import data from the following local file formats:

<table>
<thead>
<tr>
<th>FILE FORMAT</th>
<th>VERSIONS</th>
<th>EXTENSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS-Access</td>
<td>2003 and earlier</td>
<td>MDB</td>
</tr>
<tr>
<td>MS-Excel</td>
<td>5.0, 8.0</td>
<td>XLS</td>
</tr>
<tr>
<td>dBASE</td>
<td>III, IV, 5.0</td>
<td>DBF</td>
</tr>
<tr>
<td>FILE FORMAT</td>
<td>VERSIONS</td>
<td>EXTENSION</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Delimited text files</td>
<td></td>
<td>CSV, TAB, ASC</td>
</tr>
<tr>
<td>HTML</td>
<td></td>
<td>HTM, HTML, ASP</td>
</tr>
<tr>
<td>PDF files</td>
<td>1.0, 1.1, 1.2, 1.3, 1.4, 1.5, 1.6</td>
<td>PDF</td>
</tr>
<tr>
<td>XPS</td>
<td>1.0</td>
<td>XPS</td>
</tr>
</tbody>
</table>

If you wanted to import from an OLE DB-compatible database (and you have the driver installed), you would select the **OLE DB** option, instead of Computer, and then choose whether to import data via the **Data Link Wizard** or a **Data Link File**. Note that OLE DB is usually faster than ODBC, so if you have a choice of connections to your database, choose OLE DB. If you have existing projects and models that use ODBC, then you may want to change the connection method to benefit from enhanced performance.

If you wanted to import data from an ODBC compatible database you would select the **ODBC connection** option, and then use the **Select an ODBC Data Source** dialog that displays to select the ODBC data source name (DSN) that connects to your ODBC data source. Monarch can import data from ODBC data sources for which you have established an ODBC Data Source Name definition (referred to as a DSN). Monarch does not create a DSN for you – you must create a DSN using the Windows Control Panel ODBC Data Sources applet or a similar utility.

3. Open the **Employ.mdb** file from the Datawatch Monarch\Data folder.

4. Click the **Open** button to open the data source.

   Monarch displays the path to the Employ.mdb file in the dialog’s **Data Source** box.

5. Click the **Select Table** button to launch the **Select Table** dialog.

   The Select Table dialog displays all of the database tables and queries that are available within the selected database. This list does not include system tables or queries, which hold information about the database structure.

![Select Table dialog](image)

Figure 19-2. The Select Table dialog.
Our sample Employ.mdb database file holds only a single database table, called **Employee Roster**.

6. Check the box for **Employee Roster**. Expanding the node beside the table name displays all of the fields associated with the selected table.

![Select Table](image)

Figure 19-3. Fields associated with the selected table.

7. Click **Select** to close the dialog.

**NOTE**

If you wanted to apply a filter to the data, you could do so by selecting the **Apply Filter** button located on the upper right-hand corner of the dialog box to launch the Filters menu.

The right side of the File screen reflects the selections you have made.
The **Model** field allows you to specify a model file to apply to the database. Applying a model to a database is similar to applying a model to a report. The model holds parameters that indicate which fields to extract from the database, along with field properties for each field and filter, sort, calculated field, and summary definitions, if any.

8. Select **Import Data** to bring your data into Table view.

![Figure 19-5. An excerpt of the table we opened via an Open Database operation.](image)
9. If you want to define how the fields of the table should be displayed in table view, in Step 8, choose **Define and Import Data** instead of Import Data.

![Figure 19-6. When you select Define and Import Data, the Edit Table Properties screen displays.](image)

In the Edit Table Properties screen that displays, two tabs may be observed: one to specify which database fields you want to import and another to specify a filter to apply. By default, all of the fields are selected for importation. Note also that import fields and filter definitions are only saved in project files.

You can manually edit the way import column names will appear in Table view by clicking on the appropriate cells under the Table Window Name column in the Import Fields tab.

You can also add a name prefix to one or more of the import column names. To do so, however, you must enter the prefix in the **Name Prefix** box before selecting any of the columns to import. After specifying the prefix, you can then either click the **Select All** button or select individual columns via their check boxes. The names for the columns you chose to import will then be displayed, preceded by the name prefix (e.g., if you specified a Name Prefix of “Test”, for example, the import column name for the “Department” source column would be “TestDepartment.”

10. Since we want to import all fields, leave the default settings as they are and click **Accept**.

Monarch launches Table view and populates it with data imported from the Employ.mdb file’s Employee Roster table. Select **Autosize Columns** to display the fields properly.
NOTE

The Table view may be initially populated using data extracted from report files or using data imported from an external database. You cannot draw data from both sources at the same time to populate the table. If you start a Monarch session by opening a report file, you will not be allowed to import data from an external database in that Monarch session. Conversely, if you start a Monarch session by importing data from an external database, you will not be allowed to open any report files in that Monarch session. These two means of initially populating Monarch’s Table view are mutually exclusive.
Working with the Altair ODBC Drivers

The Altair ODBC Drivers are very similar to the Altair Data Connectors in that both connector types allow you to access data from a number of database types. The Altair ODBC drivers support access to, among others, the following database types:

- IBM Cloudant
- Splunk
- DB2
- Monarch Server – Content
- Hadoop Hive
- Sybase IQ
- Informix
- MongoDB
- MySQL
- Teradata
- Cloudera Impala
- dBase
- Oracle
- OLEDB
- PostgreSQL
- ODBC
- Salesforce
- Business Objects Universe
- SQL Server
- Greenplum
- Amazon Redshift
- OData

Despite their similarities, however, marked differences between these connector types may be observed. The ODBC Drivers are configured “outside” of Monarch through the ODBC Data Source Administrator, whereas the Data Connectors are configured within Data Prep Studio. Whereas the connection settings for the Data Connectors must be specified each time a new database table is to be added to Data Prep Studio, the ODBC drivers are configured only once and can be applied any number of times to a Monarch session thereafter.

Because of these differences, you may want to think about what you aim to achieve when you access an Oracle database, for example. For instances where you only require quick and dirty data prep operations, working with the Data Connectors in Data Prep Studio may be a good choice. If you wish to establish continuous access to a database, however, setting up the ODBC Drivers may be a better strategy.

Of course, if you have opened a table using a Data Connector in Data Prep Studio and wish to add filters and sorts to it, for example, you always can bring this table into Monarch by selecting Application Menu > Open in Classic Mode.

The Altair ODBC Drivers are only available in Monarch Complete.

SETTING UP THE ALTAIR ODBC DRIVERS

The Altair ODBC Drivers are stored in C:\Program Files\Common Files\Datawatch\Drivers.
Similar to Data Prep Studio, connecting to any of the database types supported in Monarch requires some information, including host name, server name, user ID, password, and database name, among others. Which information you need will depend on the database to which you are attempting to connect. If you wish to use any of the data connectors, contact your database administrator to obtain the necessary connection details.

This section describes how to set up the Altair ODBC Drivers. As a typical example, this guide will demonstrate how to set up the ODBC Driver for Cloudera Impala.

Steps:

1. Select Start > Control Panel > Administrative Tools > Data Sources (ODBC).
   
The ODBC Data Source Administrator dialog displays.

2. Select Add.

3. From the Create New Data Source dialog that displays, select Datawatch 7.1 Impala Wire Protocol.
   
The ODBC Impala Wire Protocol Driver Setup dialog displays.
4. Provide a **data source name** so that you can easily identify this driver from a list.

5. Type in the **host name** and the **database name** you wish to gain access to.

6. Select **Test Connect** to check whether or not you have the credentials necessary to access the database you named in Step 4.

7. Enter your **user name** and **password** into the appropriate fields.
8. Click **OK**.

A message box displays to inform you of the status of your connection.

Select **OK** on the *ODBC Impala Wire Protocol Driver Setup* dialog if you are satisfied with the test connection results.

Figure 19-11. The ODBC driver you have just set up is added to the list of allows user data sources in the ODBC Data Source Administrator dialog.

Figure 19-12. Setting up a number of the Altair ODBC drivers.
CONNECTING TO A DATABASE USING THE ODBC DRIVERS

Assuming that you have set up all of the ODBC drivers you need, you can now begin importing data into Monarch.

Steps:

1. Select File > Open > Database > ODBC.

   The Select an ODBC Data Source dialog displays.

   Figure 19-14. The Select an ODBC Data Source dialog.

2. Select Cloudera Impala from the list of data source names that displays and then enter an appropriate Login ID and password to connect to this database type.

   If connection to the database is successful, the Open Database dialog displays and you can select tables as described in Importing Data from an External Database.

   Figure 19-15. The Open Database dialog confirms successful Cloudera Impala connection.
For more information and updates on the Altair ODBC Drivers and Monarch documentation, visit docs.datawatch.com.

**NOTES ON THE SALESFORCE DATABASE CONNECTION**

When setting up the Salesforce driver, the *ODBC Salesforce Driver Setup* dialog displays. After confirming a connection to the database you desire, select the **Web Service** tab of the setup dialog.

![Figure 19-16. Changing the Statement Call Limit of a Salesforce connection.](image)

The *Statement Call Limit* field has a default value of **20** – this limit results in a maximum number of 40,000 rows returned when the database is accessed. To remove this limit, set the Statement Call Limit value to **0**.

Note also that the number of rows returned is generally limited by the type of Salesforce license you have purchased. For more information regarding data limitations, consult your Salesforce sales representative.

**Working with Database Data**

Once you have imported data into the Table view, you can sort, filter, and export the data, create new calculated fields, and use the data in the Summary window where you can create summary reports that perform analyses on the data. In short, you can do anything with imported data that you can do with data extracted from a report file.

Typically, the first thing that you’ll want to do when importing data is to inspect each field to ensure that its column width, type and other properties are set correctly. After adjusting the column widths, you should briefly inspect each field to ensure that Monarch has established the appropriate field type, whether character, numeric, date, or memo. When importing data, Monarch sets the type for each field according to its type in the source database. However, only a subset of the field types available in many database applications is supported, so it maps subtypes to the corresponding base type.
For example, MS Access supports several numeric field types, including Byte, Integer, Long Integer, Single, Double, etc. Monarch supports only Numeric, with General, Thousands, Currency, Percentage, and Time Span formats that determine how a number is represented on screen. When you import a numeric field from an MDB file, Monarch will always set the field type to Numeric and will assign to it a format type of General.

You should inspect each numeric field to ensure that its type and other properties are set appropriately. The Net Income field is the only numeric field in our imported data set. Let’s inspect this field’s properties.

**SETTING FIELD PROPERTIES**

Steps:

1. Double-click on the **Net Income** field to display its properties via the **Field Properties** window.

![Field Properties](image)

Figure 19-17. Field properties for the Net Income field.

Note that the decimal setting of this field is set to 0 (zero) and that its format setting is set to General. Let’s change the field format to Thousands and the decimals to 2. While we’re here, let’s change the name of this field to something more intuitive.

2. Change the field name to **Salary** and then click the ✔ button adjacent to this field.

3. Click the drop-down button on the **Format** list to display the available field formats.

   Note that Monarch displays only numeric field formats. For fields imported from a database, Monarch does not allow you to change the base field type (from Numeric to Character for example).

4. Select **Thousands** as the new field format.

5. Change the **Decimals** setting to 2.
6. Click the **Accept** button to accept the changes to the field properties. The Table is updated to reflect the changes.

![Salary field adjusted](image)

**Figure 19-18. Salary field adjusted.**

## SETTING DELIMITED TEXT PROPERTIES

The following settings may be modified when working with delimited text files imported as databases.

- **First row contains column names** – Check this box to indicate that the first row of the file contains column names
- **Delimiter character** – Specifies the delimiter (i.e., comma, tab, semicolon, pipe, space, other) used in the file to separate values
- **Quoted values may contain embedded line breaks** – Check this box if values may run beyond one line (i.e., the value includes a line break)
- **Text qualifier** – Specifies what character is used (i.e., double quote, single quote, none) to enclose values. When Monarch encounters this qualifier in a line, all of the text following this character and preceding its next instance is imported as one value, regardless of the delimiter used (see Note below).
- **Character set** – Specifies the type of encoding to use when interpreting data
- **Lines to skip at start** – The number indicated in this box instructs Monarch to skip \( n \) lines before beginning data import
NOTE

**Delimiter vs. Qualifier Example:** If the delimiter is a comma (,) and the text qualifier is a double quotation mark ("), "Boston, Massachusetts" is imported into one cell as "Boston, Massachusetts." By contrast, if no character or the single quotation mark (') is specified as the text qualifier, "Boston, Massachusetts" is imported into two adjacent cells as "Boston" and "Massachusetts."

**STORING IMPORT PARAMETERS IN PROJECT FILES**

After making adjustments to the imported fields, it’s a good idea to save your changes to a Monarch project file. Project files store both the input file(s) and the model file, including the original names of each imported field, as well as the Monarch field name and properties you assigned. By opening project files, Monarch preserves the work you did in this session. Let’s save our work to a project file and then reload the session.

Steps:

1. Select **File** and then click on the arrow of the **Save As** menu.
2. Select **Project**, and then type **Import** in the *File name* box of the *Save Project* dialog that displays. Leave the *Save as type* field as is.
3. Click the **Save** button to save the model file.
4. Select **File** and then click **Exit Monarch** to exit the Monarch session.

**OPENING PROJECT FILES**

Now let’s restart Monarch and import the data along with the model file.

Steps:

1. Select the **Monarch** item from the Windows Start menu.
2. Select **File > Open > Project.**
3. In the *Open Project* dialog that displays, select **Import.dprj**.

   Monarch displays the imported data and model files in Table view. Note that the table presents as in Figure 19-18, which indicates that the field definitions we specified in the saved model have been applied to the open database.

4. Select **File** and then click **Close All**. Select **No** when asked if you would like to save changes made to the model file.
Importing Data from an HTML File

One of the features that distinguishes Monarch from other is its ability to utilize HTML files. With Monarch, you can import an HTML file and then create templates to extract data from it just as you would with a typical report.

When you import an HTML file, Monarch parses it into a “Monarch-friendly” format and adds markup you may find helpful when trapping fields.

NOTE

Monarch is best suited to work with dynamically generated HTML pages, such as those resulting from database queries.

Let’s explore Monarch’s HTML capabilities.

Steps:

1. Select File, click on the arrow of the Open menu, and then select Report to display the Open Report dialog.

2. From the Files of type drop-down list, select HTML files (*.htm;*.html;*.asp; *.aspx).

3. Select the Airlines.htm file, and then click the Open button.

Monarch parses the HTML file and displays it in the Report view. Note the markup that Monarch has added (e.g., "<Table–00..."). This markup can be used when trapping fields.
Airlines.htm is a list of flights from Boston, MA to Manchester, England. It contains information such as the price of the flights, the airline providing them, and their earliest and latest travel and return dates.

Let's scroll down the report and look for an appropriate line with which to create a detail template. Remember, a detail template is used for extracting information from the lowest report level.

Notice that for each flight listed, the Latest Return information is the last given. This should do for our detail template, so let's begin by trapping the Latest Return information.


5. Locate one of the **Latest Return** lines in the report. In the line selection area to the left of it, click and drag so that the Latest Return line and the two lines below it are highlighted.

   **NOTE**

   You can easily locate the Latest Return information via the Search function of Monarch.

6. Select **New Template** > **Detail** to activate the Template Editor.

7. Rename this template **Latest Return**.

8. In the Trap line, type **Latest Return:** directly above its occurrence in the Sample Text box, then highlight the latest return information (e.g., "1 months") in the Sample Text box. Extend the highlight by one more character to include instances of two-digit months.
9. The newly defined field’s properties (i.e., those of eg_1 months) display in the Field Properties panel.

10. Type Latest Return in the Name field of this panel and then click the ✅ button that displays next to this field to accept your changes. Click the Accept ✅ icon in the window ribbon to save your changes.

   The Template Editor closes and the Report view displays. Scroll down the report and note that all instances of the Latest Return information are now highlighted.

   Now that we’ve defined our detail template, let’s define some append templates to capture additional information from the HTML file.

11. Click Report Design 🔄 once more.

12. Scroll down the report until you come to one of the price lines (e.g., USD 276.00), and then click in the line selection area to highlight it.

13. Select New Templates > Append to activate the Template Editor.

14. Replace Append 1 with Price in the Template Name field of the Template Editor.
15. In the Trap line, type **USD** directly above its occurrence in the Sample Text box, and then highlight the price in the Sample Text box.

![Image](image1.png)

Figure 19-23. Trapping the Price field.

The properties of this newly defined field display in the Field Properties panel.

16. Type **Price** in the **Name** field, and then click ✅ to accept your changes.

17. Click **Accept** ✅.

The Template Editor closes and the Report view displays. Scroll down the report and note that all instances of the flight price information are highlighted.

Let’s see how the information we’ve trapped will look in Table view.

18. Select the **Table** tab and then click **Autosize Columns** to view all of the fields properly.

Monarch displays the two fields we’ve trapped as columns in the Table view.

![Image](image2.png)

Figure 19-24. Viewing the fields in the Table view.


Using the same techniques that we used to trap the **Latest Return** and **Price** fields, try trapping some of the other fields in the HTML file (e.g., Earliest Return, Earliest Travel, Latest Travel, etc.).

When you’ve finished trapping as many fields as you want to, view them in the Table view to see how successful you are.
Importing Data from a Web File

Importing web files on an FTP site of Amazon S3 is possible in Monarch. To do so, simply select **File > Open > Report > Web** to launch the Open Web File dialog.

![Open Web File dialog](image)

**Figure 19-25. Opening a web file in Monarch.**

The Open Web File dialog allows you to select a file protocol (e.g., http://, https://, ftp://, etc.) from a drop-down menu and enter the name of the file to open in the adjacent text box. Tooltips are provided for each protocol as a guide. The drop-down button located to the right of the filename text box enables you to access recently opened web files.
[20] Creating External Lookups

In this chapter, we’ll discuss external lookups, which allow you to add columns from an external database to the Monarch table. The lesson topics include:

- A discussion of what an external lookup is
- Creating an external lookup from a report
- Storing lookup parameters in a model file
- Creating a lookup from two different reports
- Creating a lookup from two external databases

What is an External Lookup?

An external lookup (in technical terms, a left outer join) combines information from two or more tables into a single table. External lookups are both powerful and easy to use. In Monarch, a lookup can be used to link two or more database sources together or to link a report to one or more database sources.

As an example, consider the tables on the following page. The first table lists employees in the Marketing department of a fictional company. This table includes each employee’s name and the city where he or she lives. The second table lists employee compensation. Both tables share a common column, called Emp_ID, designating a unique ID assigned to each employee. From the Marketing table, you could create a lookup, based on the Emp_ID column, to the Compensation table to find the salary and bonus for each employee in the Marketing department.

<table>
<thead>
<tr>
<th>Emp_ID</th>
<th>Dept</th>
<th>Lastname</th>
<th>Firstname</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>1597429</td>
<td>Marketing</td>
<td>April</td>
<td>Anne</td>
<td>Worcester</td>
</tr>
<tr>
<td>1607768</td>
<td>Marketing</td>
<td>Banning</td>
<td>David</td>
<td>Burlington</td>
</tr>
<tr>
<td>1593642</td>
<td>Marketing</td>
<td>Bartholomew</td>
<td>Anne</td>
<td>Brookfield</td>
</tr>
<tr>
<td>1605798</td>
<td>Marketing</td>
<td>Bradford</td>
<td>Eugene</td>
<td>Brookline</td>
</tr>
<tr>
<td>1588509</td>
<td>Marketing</td>
<td>Carlson</td>
<td>Stephen</td>
<td>Boston</td>
</tr>
</tbody>
</table>
To link data from two tables, you start by defining a lookup between the tables. A lookup connects the tables based on one or more columns that appear in both tables. These columns, referred to as **link columns**, must include at least some values that are common to both tables. In our example, the **Emp_ID** column would be suitable as a link column, as it contains values that are common to both the **Marketing** and **Compensation** tables.

To link these two tables, you would start with the **Marketing** table, and then create a lookup to the **Compensation** table on the **Emp_ID** column. Then you select the **Salary** and **Bonus** columns to add to the **Marketing** table. The resulting table is shown in Figure 20-2.

---

**Figure 20-1. Marketing and Compensation tables with a common Emp_ID column.**

---

**Marketing Table**

<table>
<thead>
<tr>
<th>Emp_ID</th>
<th>Dept</th>
<th>Lastname</th>
<th>Firstname</th>
<th>City</th>
<th>Salary</th>
<th>Bonus</th>
</tr>
</thead>
<tbody>
<tr>
<td>1597429</td>
<td>Marketing</td>
<td>April</td>
<td>Anne</td>
<td>Worcester</td>
<td>55,900.00</td>
<td>5,000.00</td>
</tr>
<tr>
<td>1607768</td>
<td>Marketing</td>
<td>Carlson</td>
<td>Stephen</td>
<td>Boston</td>
<td>49,452.00</td>
<td>5,000.00</td>
</tr>
<tr>
<td>1593642</td>
<td>Marketing</td>
<td>Bartholemew</td>
<td>Anne</td>
<td>Brookfield</td>
<td>42,640.00</td>
<td>4,000.00</td>
</tr>
<tr>
<td>1605798</td>
<td>Marketing</td>
<td>Bradford</td>
<td>Eugene</td>
<td>Brookline</td>
<td>67,990.00</td>
<td>8,500.00</td>
</tr>
</tbody>
</table>

*Figure 20-2. Marketing Employees table with Salary and Bonus columns linked from Compensation table.*

Note that only those records from the **Compensation** table that have corresponding **Emp_ID** values in the **Marketing** table are included in the resulting table. Since the lookup was initiated from the **Marketing** table, only the records that appear in the **Marketing** table are included. **Records in the Compensation table that have no corresponding Emp_ID values in the Marketing table are ignored.**

This behavior is unique to a lookup. In other types of joins, records from both tables are combined, with the resulting table having at least one record for each record in the contributing tables. Monarch doesn’t support these types of joins, so no new records are added when joining data in Monarch.

To begin this lesson, open the **Orders.prn** report file and load the **Lesson9.dmod** model file. Go on and view the table of extracted data.
Creating an External Lookup from a Report

To illustrate Monarch’s database linking capability, we’ll provide a simple example that starts with a slightly modified version of our familiar Classic report file; this report is called Orders.prn. We’ll apply a model file to extract data from the report into the Table view, and then we’ll create a lookup to an external database to add several columns to the table.

Orders.prn is a modified version of Classic.prn. Since you’re familiar with Classic.prn, you’ll notice that we’ve removed the address information below each customer name. For the sake of this lesson, let’s imagine that the report is always produced using only the customer name and that the customer addresses reside in a corporate database. After extracting data from the report using a standard Monarch model file, we’ll use a lookup to retrieve the customer addresses from the database.

The Table view includes all of the columns that we’ve extracted from the report, including each customer’s name and account number. We’ll use the Account Number column to link to the Customer.mdb database, which holds the customer addresses.
Steps:

1. Select **Table Design** from the Table ribbon and then click **Add > External Lookup**. The **Open Database** dialog displays. This dialog is similar to the **Open Database** dialog we used in Chapter 19.

![Open Database dialog](image)

Figure 20-4. The Open Database dialog.

2. Click **Computer**. The **Open Database File** dialog appears.

3. Select the **Customer.mdb** file.

4. Click the **Open** button to select the data source. Monarch displays the path to the Customer.mdb file in the **Data Source** box.

5. Click the **Select Table** button to display the Select Table dialog box. This dialog shows all of the database tables and queries that are available within the selected database. The list does not include system tables or queries that hold information about the database structure.
Our sample Customer.mdb database file holds only a single database table, called **Customer**.

6. Ensure that the box for **Customer** is checked. If you wish, you can also expand the node beside the table name to see all of the fields that make up the table. Click **Select** when you are done to apply your selection and close the **Select Table** dialog.

7. Click the **Import Data** button on the **Open Database** dialog.

The dialog closes and you are transferred to the **External Lookup Field Definition** window.

Figure 20-5. The Select Table dialog displays the Customer screen.

Figure 20-6. The Row Definition screen.
The External Lookup Field Definition window displays a Linking Columns Assignment screen. We'll use this screen to establish an external lookup between the external database and Monarch.

8. Check the Linking Column box for **Acct_Num**.

The `Acct_Num` column in Customer.mdb and `Account Number` column in your extracted table are actually the same column. Each column holds the unique account number assigned to each customer. The column names are not required to be the same, but they must be of the same type (character, numeric, or date), and they must contain matching values that can be used to create a relationship between the two tables.

9. In the first row of the Table Window Name column, use the drop-down provided to ensure that **Account Number** is selected.

The Select column allows you to choose with columns from the database to import into Monarch (i.e., the linked columns). This screen lists the names of all columns that are available in the selected database table or view. Since we want to import the entire address for each customer, we'll make sure all of the available columns selected.

Default names, taken from the source columns, are assigned to the import columns and are displayed under the Table Window Name heading. These are the names that will be assigned to the columns when you import them into Monarch.

If you wish to change the way the name of any of the fields in Customer.mdb displays in Table view, you may do so in the Table Window name column. If you want to apply an import filter to the data, you may also do so by clicking on the External Lookup Filter tab and then specifying a filter expression in the screen that displays.

For now, we'll simply link the appropriate columns in our table and database.

10. Name this lookup **Lookup1**.

11. Click the Accept button to close the window.

Your table is rebuilt and new address columns are added to it. Monarch links the external database table to the Monarch table, adding the selected columns to the Table view as linked columns.

![Table](image)

**Figure 20-7.** The table is rebuilt to include fields from the Customer.mdb database.
NOTE

You can manually edit the import column names by double-clicking on them. You can also add a name prefix to one or more of the import column names. To do so, however, you must enter the prefix in the Name Prefix box of the External Lookup Field Definition window before selecting any of the columns to import. After specifying the prefix, you can then either click the Select All button or select individual columns via their check boxes. The names for the columns you chose to import will then be displayed, preceded by the name prefix (e.g., if you specified a Name Prefix of “Test”, for example, the import column name for the “Address 1” source column would be “TestAddress 1.”

10. Scroll right to view the linked columns.

![Figure 20-8](image-url)

Figure 20-8. The customer address columns are added to each record in the Monarch table.

You can use linked fields just like any other fields in Monarch. Linked fields can be used in filter, sort, calculated field, and summary definitions and can be printed or exported along with fields that you extract from a report.

Note that in this example, the External Lookup table displays below the Main database table and that Data Prep Studio can only open the Main table.
Storing Lookup Parameters in a Model File

Lookup parameters can be saved in a Monarch model file along with other information about your Monarch session. When you load the model file, the lookup parameters are used to re-establish the lookup with the external database.

Storing lookup parameters in a model file is easy. You simply save the model file. That’s all there is to it. The model file records the name of the lookup database along with the fields used to establish the lookup and the fields you linked to the Monarch table. By applying the model in a future Monarch session, Monarch preserves the work you did in this session. Let’s save a model file and then reload the session using the model.

Steps:

1. Select **File > Save As > Model**.
   
The **Save Model** dialog appears.

2. Type **Lookup** in the **File name** box of the dialog (the .dmod extension is automatically added) and then click the **Save** button to save the model file.

3. Select **File** and then click **Close All** to end the current Monarch session.

Creating a Lookup from Two Different Reports

While Monarch’s linking capability is very useful if you happen to have access to a database that includes the information you need, what if your data resides in two different reports? You may have already guessed the answer: Using Monarch’s export capability, you can create a database file from one report, start a new Monarch session to extract data from the second report, and then create a lookup to the exported database file. While this involves a two-pass approach, it’s relatively easy to do.

Let’s imagine that we don’t have access to the database of customer address information that we used in the previous example. Instead, we have the Orders.prn report and another report called Customer.prn that lists all of our customers. Let’s use Monarch to link information from these two reports.
USING A REPORT TO CREATE A LOOKUP FILE

We’ll start by opening the Customer report, applying a model to extract the customer address and account number fields, and then exporting these fields to a database file. We’ll use this file as a lookup file, which we’ll link to the Orders.prn report.

Steps:

1. Open the **Customer.prn** report file as well as the **Customer.dmod** model file.
2. Select the **Table** tab and then click **Autosize Columns** to maximize your view of all of the columns in the table.

![Figure 20-9. Customer address fields extracted from report.](image)

The Table view includes all of the columns that we’ve extracted from the report, including each customer’s name, account number, and address. Now we’ll export the table to a database file.

3. Select the **Export** tab and then click **Create Export** to launch the **Create Export** dialog.
4. Specify a filename of **LookupSource**.
5. Ensure that **Table** is selected in the Source View panel and then select **Microsoft Access MDB (***.mdb**)** as the Export File Type.
6. Type **CustomerAddresses** in the **Table Name** field and then click the **Run this export** button located on the upper left-hand corner of the dialog.

A progress dialog displays. Monarch displays the following message box when the export is finished.
You have just created a lookup file.

**LINKING TO THE LOOKUP FILE**

Now that the first report has been exported to a database file, it’s time to load the second report and link to it.

**Steps:**

1. Close all of the open files in Monarch and then open the *Orders.prn* report and the *Lesson9.dmod* model file. Select No when asked if changes to Customer.dmod or the project should be saved.

2. Select the **Table** tab and then click **Autosize Columns** to maximize your view of the data in the table.
Now we’re ready to link to the database file we created and pull in the address information for each customer.

3. Select Table Design > Add > External Lookup > Database.

4. Click the Browse button beside the Data Source field and select the Local or network file option to display the Open Database File dialog.

5. Select the LookupSource.mdb file from the Altair Monarch\Export folder then click the Open button.

   Monarch displays the path to the LookupSource.mdb file in the Data Source box.

6. Click the Select Table button and check the box for CustomerAddresses from the dialog that displays. Click Select when you are done.

7. Select OK to close the Open Database dialog and launch the External Lookup Field Definition window.

8. Name this lookup Lookup2.

9. Check the Linking Column box for Acct_Num.

10. In the first row of the Table Window Name column, ensure that Account Number is selected.

11. Click the Select All button to instruct Monarch to show all lookup fields in the resulting table.
12. Select **Accept** ✔️ to apply your changes and close the window.

Monarch links the *CustomerAddresses* table to the Monarch table, adding the address columns to the Table view as linked columns. You may need to scroll to the right to view the address columns.

<table>
<thead>
<tr>
<th>Ship Date</th>
<th>Media</th>
<th>Qty</th>
<th>Description</th>
<th>Amount</th>
<th>Address 1</th>
<th>Zip</th>
<th>State</th>
<th>City</th>
<th>Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4/2010</td>
<td>CD</td>
<td>1</td>
<td>Schubert, Sonate in e, D.850</td>
<td>9.00</td>
<td>3658 Springs Ferry</td>
<td>30667</td>
<td>GA</td>
<td>Marietta</td>
<td>Suite C-130</td>
</tr>
<tr>
<td>1/4/2010</td>
<td>CD</td>
<td>2</td>
<td>Mozart, Symphony No.23 in D</td>
<td>26.97</td>
<td>3658 Springs Ferry</td>
<td>30667</td>
<td>GA</td>
<td>Marietta</td>
<td>Suite C-130</td>
</tr>
<tr>
<td>1/4/2010</td>
<td>CD</td>
<td>4</td>
<td>Schumann, Cello Concerto</td>
<td>57.64</td>
<td>3658 Springs Ferry</td>
<td>30667</td>
<td>GA</td>
<td>Marietta</td>
<td>Suite C-130</td>
</tr>
<tr>
<td>1/4/2010</td>
<td>SACD</td>
<td>9</td>
<td>Balakirev, Symphony no. 1</td>
<td>86.35</td>
<td>3658 Springs Ferry</td>
<td>30667</td>
<td>GA</td>
<td>Marietta</td>
<td>Suite C-130</td>
</tr>
<tr>
<td>1/3/2010</td>
<td>DVD</td>
<td>3</td>
<td>Hand, St. Paul's Suite for Orch.</td>
<td>29.95</td>
<td>3658 Springs Ferry</td>
<td>30667</td>
<td>GA</td>
<td>Marietta</td>
<td>Suite C-130</td>
</tr>
<tr>
<td>1/2/2010</td>
<td>CD</td>
<td>7</td>
<td>Sibelius, Tesiolo, Op.112, Ariadne</td>
<td>41.93</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/2/2010</td>
<td>CD</td>
<td>8</td>
<td>Argento, Postcard from Morocco</td>
<td>163.04</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2010</td>
<td>CD</td>
<td>1</td>
<td>Beethoven, Fantasia G for Organ</td>
<td>17.59</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2010</td>
<td>CD</td>
<td>2</td>
<td>Ravel, Music for Pieces of Wood</td>
<td>17.59</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2010</td>
<td>CD</td>
<td>4</td>
<td>Glass, Etinshen on the Beach</td>
<td>143.80</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2010</td>
<td>CD</td>
<td>5</td>
<td>Cage, Music of Changes</td>
<td>53.94</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2010</td>
<td>DND</td>
<td>5</td>
<td>Holst, St. Paul's Suite for Orch.</td>
<td>29.95</td>
<td>179 Rue de la Poste</td>
<td>45400</td>
<td>Fleury-les-Aubrais</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>BLU</td>
<td>6</td>
<td>Beethoven, Pathetique Sonata, Aru</td>
<td>35.04</td>
<td>555 Elisabeth</td>
<td>78250</td>
<td>TX</td>
<td>San Antoine</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>CD</td>
<td>7</td>
<td>Chopin, 4 Scherzi for piano</td>
<td>37.23</td>
<td>555 Elisabeth</td>
<td>78250</td>
<td>TX</td>
<td>San Antoine</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>CD</td>
<td>8</td>
<td>Satie, Parade, Opera in 3 acts</td>
<td>46.46</td>
<td>555 Elisabeth</td>
<td>78250</td>
<td>TX</td>
<td>San Antoine</td>
<td></td>
</tr>
<tr>
<td>1/4/2010</td>
<td>CD</td>
<td>9</td>
<td>Brahms, Sonata for 2 pianos</td>
<td>31.16</td>
<td>555 Elisabeth</td>
<td>78250</td>
<td>TX</td>
<td>San Antoine</td>
<td></td>
</tr>
<tr>
<td>1/4/2010</td>
<td>DND</td>
<td>4</td>
<td>Tanzi, Canc in G, f &amp; bass, Galerie</td>
<td>23.86</td>
<td>555 Elisabeth</td>
<td>78250</td>
<td>TX</td>
<td>San Antoine</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>CD</td>
<td>10</td>
<td>Kroneck, Oxyly spelt auf, V. St. Orcz</td>
<td>65.69</td>
<td>800 East Danforth</td>
<td>71801</td>
<td>AR</td>
<td>Hope</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>CD</td>
<td>8</td>
<td>Mink, The Art of Perkin, Itzak vn.</td>
<td>397.20</td>
<td>800 East Danforth</td>
<td>71801</td>
<td>AR</td>
<td>Hope</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>BLU</td>
<td>10</td>
<td>Beiber, Adagio for Strings, NOSJ</td>
<td>77.90</td>
<td>800 East Danforth</td>
<td>71801</td>
<td>AR</td>
<td>Hope</td>
<td></td>
</tr>
<tr>
<td>1/3/2010</td>
<td>DND</td>
<td>5</td>
<td>Britten, War Requiem</td>
<td>59.90</td>
<td>800 East Danforth</td>
<td>71801</td>
<td>AR</td>
<td>Hope</td>
<td></td>
</tr>
<tr>
<td>1/4/2010</td>
<td>CD</td>
<td>8</td>
<td>Beethoven, 3rd Sym, Karajan, Berlin</td>
<td>72.00</td>
<td>800 East Danforth</td>
<td>71801</td>
<td>AR</td>
<td>Hope</td>
<td></td>
</tr>
</tbody>
</table>

Figure 20-12. Customer addresses linked to Orders.prn report data (column widths autosized).

We started with two disparate reports and ended with data from both reports linked together in the Table view.

13. Select **File**, and then click **Close All** to reset the Monarch session. Select **No** when prompted to save changes to the model.

Creating a Lookup from Two External Databases

In the previous sections, we demonstrated how you can link data from an external database to data extracted from a report. This is useful when a single report doesn’t include all of the data you need, but you can also use Monarch to combine data from two databases, without ever loading a report file.

To see how this process works, let’s return to the example from the beginning of this lesson. In that example, we showed how you could link fields from an employee compensation table to an employee roster table.

The employee roster table is called *Marketing* since it stores information only about employees in the Marketing department. The employee compensation table is called *Compensation*. This table stores salary and bonus information for all employees for the entire company.
IMPORTING DATABASE DATA

We’ll start by importing data from the Marketing table. This table resides in the Beantown.mdb file (the name of our fictional company is Bean Town Investments). The compensation table resides in a file called Payroll.mdb. We’ll create a lookup to this table in order to add the Salary and Bonus field for each employee.

Steps:

1. Select File, click on the arrow of the Open menu, and then select Database.

   The Open Database dialog displays.

2. Click the Data Source Browse button and select the Local or network file option.

   The Open Database File dialog appears.

3. Select the Beantown.mdb file from the Altair Monarch\Data folder and then click Open.

   Monarch displays the path to the Beantown.mdb file in the Data Source box.

4. Click the Select Table button and, in the Select Table dialog that displays, choose Marketing. Click Select when you are done to close the dialog.

5. Select OK in the Open Database dialog.

   The Import Field Definition window displays.

6. Ensure that all fields are selected (click Select All if not) and then click Accept.

   Monarch opens Table view and populates it with data imported from the Beantown.mdb file’s Marketing table.

7. Select Autosize Columns to maximize your view of the fields properly.

---

Figure 20-13. Monarch’s Table view is populated with the data imported from Beantown.mdb, Marketing table.
LINKING DATABASE DATA

Now we’ll link to the Compensation table to add the salary and bonus information for each employee.

Steps:

1. Select Table Design > Add > External Lookup > Database.
2. In the Open Database dialog, click the Browse button next to the Data Source field and then select the Local or Network File option.
   
   The Open Database File dialog appears.
3. Select the Payroll.mdb file from the Altair Monarch\Data folder, and then click the Open button.
   
   Monarch displays the path to the Payroll.mdb file in the dialog’s Data Source box.
4. Click the Select Table button.
   
   The resulting dialog displays all of the database tables and queries that are available within the selected database. Check the Compensation table box and then click Select.
5. Click OK to close the Open Database dialog and launch the External Lookup Field Definition window.
6. Name this lookup Lookup3.
7. In the Linking Columns Assignment screen, check the Linking Column box for Emp_ID.
8. In the first row of the Table Window Name column, ensure that Emp_ID is selected.
   
   This setting indicates that Emp_ID in the Payroll table should match Emp_ID in the Marketing table.
9. Ensure that both the Salary and Bonus fields are selected in the Select column.
10. Click the Accept button to apply your settings and close the External Lookup Field Definition window.

Monarch links the external database table to the Monarch table, adding the selected columns to the Table view as linked columns.
11. Select File, click on the arrow of the Save As menu, and then select Model.

12. Type Compensation in the File name box of the Save Model As dialog box that displays, and then click the Save button to save the model file.

13. Select File and then click Exit Monarch.

NOTE

If prompted to save changes to the project file, select No.

The model file stores the lookup parameters along with the import parameters. However, the model file does not store the name of the import database. To restore the session, use the Open Database dialog to select the Beantown.mdb file and the Compensation model.

Note that on the Dataset selection screen, you may select any of the three employee roster tables (Accounting, Data Processing, or Marketing). The model will work equally well regardless of which table you select. That’s why the data source is not stored in the model file -- the model can be used with any compatible data source. This is similar to how models store information about a report. The report name is not stored in the model so that the model can be used with multiple reports as long as the reports all have a compatible format.
[21] Using Digital Signatures

This chapter introduces a Monarch feature designed to authenticate files, thereby enhancing security. Here, you will learn about digital signatures. The chapter assumes you are familiar with exporting Table or Summary data into XLSX or XLSM formats.

Note that this feature is only available in Monarch Classic and Monarch Complete.

What are Digital Signatures?

Digital signatures are used to authenticate files (i.e., the Excel files that are produced via Monarch Export) by using computer cryptography. Digital signatures help to establish the following assurances:

- **Authenticity**
  The digital signature helps to assure that the signer is who he or she claims to be.

- **Integrity**
  The digital signature helps to assure that the content has not been changed or tampered with since it was digitally signed.

- **Non-repudiation**
  The digital signature helps to prove to all parties the origin of the signed content. "Repudiation" refers to the act of a signer's denying any association with the signed content.

To make these assurances, the content creator must digitally sign the content by using a signature that satisfies the following criteria:

- The digital signature is valid.
- The certificate associated with the digital signature is current (not expired).
- The signing person or organization, known as the publisher, is trusted.
- The certificate associated with the digital signature is issued to the signing publisher by a reputable certificate authority (CA).

To start, let’s open the Classic.prn report and Lesson8.dmod model.
Adding Digital Signatures to an Excel File

Steps:

1. Select the Table tab.

The Table view for the report displays. Select **Autosize Columns** from the Table tab to view all the data properly.
2. Select the **Export** tab and then click the **Create Export** button.
   The Create Export dialog displays.

3. In the *File name* box, enter **Digital1**.

4. Ensure that **Table** is selected in the Source View box and then select **Microsoft Excel XLSX (*.xlsx)** from the Export File Type box.

5. Name the table **DigiCert** in the Table Name box.

6. Click the **Edit Advanced Options** button to launch the Export Design view.

7. Click the **Advanced** tab of the Excel Output panel.

   The *Excel Advanced Features* options of the view display.

   ![Excel Advanced Features panel](image)

   *Figure 21-3. The Excel Advanced features panel in Export Design view.*

8. Check the Digital Signature box.

   When you do this, the *Certificate* drop-down list is activated. This list contains options that allow you to select where the digital certificate you are applying is located. Let’s say that your digital certificate is stored in the same machine in which Monarch is installed.

9. Select **Change to Certificate from File** from the *Certificate* drop-down list.

10. Select the digital certificate you wish to apply to the export, and then click **OK**.

    Depending on the settings of your digital signature, you may or may not be asked to set a password for the certificate. If prompted to do so, simply provide one.

11. Click **Accept ✔** when you are finished to close the Export Design view and return to Export view.
12. Run the export you have just defined. Refer to Chapter 17 – Exporting Operations of this learning guide if necessary.

13. Select File, and then click Exit Monarch. Select No when prompted to save changes to the model and the project.

Viewing Digital Signatures

Digital signatures display when you open the spreadsheet containing the certificate. Let’s do this.

Steps:

1. Launch your spreadsheet. If you don’t have a spreadsheet, just follow along.
2. Select File, and then click Open.
3. Navigate to your Monarch Exports folder (typically in C:\Users\Public\Documents\Altair Monarch\Export), and then open the Digital1.xlsx worksheet.

The worksheet displays in your screen.

![Figure 21-4. The exported table with a digital signature.](image)

Note the following features of the file that are not present in ordinary worksheets or workbooks: An alert with an Edit Anyway button displays on the upper portion of the table to warn you that the workbook has been marked final to discourage editing.

Should you choose to click Edit Anyway to continue editing the workbook, the following dialog displays:
Figure 21-5. Selecting Yes removes any digital signatures applied to the workbook.

Selecting **Yes** on the dialog removes any digital signature applied to the workbook.

As well, on the lower left-hand corner of the workbook, you will find a certificate icon. Hovering on this icon with your mouse yields a callout that informs you that a digital signature has been applied to the workbook.

Figure 21-6. The digital signature callout.

If you click on this icon, a list of all digital signatures applied to the workbook display on the right-hand side of the workbook. You can hover on any of these signatures to display a drop-down button that, upon clicking, will allow you to view the properties of that signature.

Figure 21-7. A list of digital signatures displayed on the right-hand side of the workbook.

4. Close the spreadsheet.
In the previous chapter, you learned about a special Monarch feature you can use to increase the security and authenticity of your report: digital signatures.

In this chapter, you will learn about another special Monarch feature: pivot tables. Pivot tables are interactive tables within Monarch that allow you to further manipulate and view data. They can only be created for XLSX files; they cannot be created for XLS files. If you are using a version of Excel earlier than 2007, you can download the Microsoft Office Compatibility Pack from Microsoft, which will allow Excel 2000 and higher to open XLSX files.

The option to create a Pivot Table is not available for a Summary export, since pivot tables use tabular “raw” data as a source, not summarized data. Monarch will export the table data as a worksheet and the pivot table as a separate worksheet, which refers to the exported data.

Let’s again start by loading the Classic.prn report and the Lesson8.dmod model files.

Figure 22-1. Loading the Classic.prn report and Lesson8.dmod model.
Adding Pivot Tables to an Excel File

Steps:

1. Select the **Table** tab.

   The Table view for the report displays. Select **Autosize Columns** from the **Table** tab to view all the data properly.

   ![Figure 22-2. The Table view for Classic.prn report and Lesson8.dmod model.](image)

2. Select the **Export** tab and then click the **Create Export** button.

   The Create Export dialog displays.

3. In the **File name** box, enter **Pivot1**.

4. Ensure that **Table** is selected in the Source View box and then select **Microsoft Excel XLSX (*.xlsx)** from the Export File Type box.

5. Name the table **PivoTable** in the Table Name box.

6. Click the **Edit Advanced Options** button to launch the Export Design view.

7. Click the **Advanced** tab of the Excel Output panel.
The *Excel Advanced Features* options of the view display.

8. Check the **Include Pivot Table sheet** box to activate the pivot table definition options.

![Figure 22-3. The Excel Advanced features panel in Export Design view.](image)

9. Select Overwrite table from the When sheet with pivot table exists drop-down.

10. Click on the **Options** tab that displays and then enter **PivotTable** into the *Pivot Table name* field. You may leave the other settings in this tab as they are for now. Note that pivot table names must conform to the table-naming guidelines described earlier in this guide.

11. Click the **Fields** tab, click on the **New** drop-down list of the *Row Labels* field and then select (double-click) **Customer**.

12. In the *Column Labels* field, select the **New** drop-down button, and then select (double-click) **Media** from the list that displays.

13. In the *Values* field, select the **New** drop-down button, and then select the values **Amount** and **Unit Price** from the list that displays.

   Note that when you do so, an additional entry (e.g., _VALUES_HEADER_) is added to the *Values* field. This additional entry simply indicates that the separate fields of Amount and Unit Price will have their own headings in the resulting worksheet.

   Use the sorting button that displays beside each pivot field or value to specify a display order (i.e., ascending or descending).

14. Select **Accept** ✔ when you are finished to close Export Design view and return to Export view.

15. Run the export you have just defined. Refer to *Chapter 17 – Exporting Operations* of this learning guide if necessary.

16. Select **File**, and then click **Exit Monarch**. Select **No** when prompted to save the changes in the model and the project.
Viewing a Pivot Table

Steps:

1. Launch your spreadsheet. If you don’t have a spreadsheet, simply follow along.
2. Select File, and then click Open.
3. Navigate to your Monarch Exports folder (typically in C:\Users\Public\Documents\Altair Monarch\Export) and then open the Pivot1.xlsx worksheet.

The worksheet displays in your screen.

Figure 22-4. The exported Pivot1 worksheet.

The PivotTable tab shows an Excel file version of the Classic.prn table.

4. Click on the PivotTable1 tab.

The pivot table displays on your spreadsheet.
For more information regarding pivot tables, you may access the Monarch Help file by selecting File, clicking on the drop-down button of the Help menu, and then select Help Topics from the options that display.

**Working with Pivot Tables**

When we selected pivot table fields in the earlier part of this chapter, we were specifying settings similar to those used when creating a summary. For example, the Row Labels specify down keys, the Column Labels specify across keys, and the Values specify measures.

Clicking on the drop-down buttons on either the Row Labels or Column Labels fields displays a set of options that allow you to sort and filter your data.
To display the unit prices and amounts for only the media types DVD and BLU, for example, simply click on the drop-down button of Column Labels, deselect the boxes for CD, LP, and SACD, and then click OK. When you do this, the Select All checkbox is automatically deselected.

A new table is rebuilt and displayed in your spreadsheet.
[23] Working with Asian (CJK) Character Sets

Displaying fullwidth characters (e.g., Chinese/Japanese/Korean, or CJK, characters) is more complex than displaying standard fixed-width single byte character set (SBCS) characters. This stems from the fact that fullwidth characters usually take up nearly twice as much horizontal space in pixels to display. Due to the grid-like nature of Monarch’s unique trapping process, Monarch requires that all characters are rendered with the same amount of screen space in order for characters to align vertically. This requirement causes issues when SBCS and fullwidth characters are present on the same report.

Notice the indeterminate alignment of these lines:

Test 12345
日本語がだいすきです

Now observe the grid-like alignment of these lines:

Test 12345
日本語がだいすきです

As you can see in the first example, the characters do not line up in any meaningful way. Thus, it is impossible to create a template that traps consistently in this situation. By contrast, in the second example, each character takes up the same amount of space, thereby giving us a grid-like 1-to-1 alignment and making it possible to trap data with predictable results. This is the fundamental challenge that Fullwidth Character Mode addresses.

Working with Asian Character sets may be easily accomplished by specifying four settings:

- Fullwidth Character Mode
- Fallback Asian fonts
- Date/Time format
- Ignore Character Width
## Setting Fullwidth Character Mode

The Fullwidth Character Mode setting toggles Fullwidth Character Mode on and off. While on, all characters will be rendered in the same horizontal space as a Kanji glyph.

Most fonts do not contain glyphs for every character from every language. This issue is addressed by a fallback architecture that renders unknown characters in standard fonts known to contain those characters. The result is text that is drawn in multiple fonts as needed on a per-character basis.

### Input

<table>
<thead>
<tr>
<th>Fallback Asian Fonts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Japanese Font</td>
<td></td>
</tr>
<tr>
<td>MS Gothic</td>
<td></td>
</tr>
<tr>
<td>Default Simplified Chinese Font</td>
<td></td>
</tr>
<tr>
<td>NSimSun</td>
<td></td>
</tr>
<tr>
<td>Default Traditional Chinese Font</td>
<td></td>
</tr>
<tr>
<td>MingLiu</td>
<td></td>
</tr>
</tbody>
</table>

Fullwidth Character Mode

- On
- Off

Figure 23-1. Setting Fullwidth Character Mode on via the Options window.

To set Fullwidth Character Mode on, simply select **Options > Input** from the Home screen that displays when Monarch is launched. Select **Accept** to save your settings when you are finished.

**NOTE**

All other settings for dealing with Japanese input files are applicable only when this setting is enabled.
Setting Fallback Asian Fonts

The Fallback Asian Fonts setting allows the user to select which fonts will be used to render unknown characters in the event of a fallback. Japanese, Simplified Chinese, and Traditional Chinese options are available.

![Fallback Asian Fonts](Image)

Figure 23-2. Recommended fallback Asian fonts.

Language options are also available in the **Input** tab of the Options window.

Setting the Date/Time Format

The most commonly used date format in Japan is yyyy/mm/dd, and the Japanese characters for “year,” “month,” and “day” are inserted usually between numerals. Thus, in the Japanese format, the date December 21, 2013 is presented as:

2013年12月21日

Users trapping the fields of Japanese input files can compel Monarch to convert dates/times into one of two Japanese formats by selecting the appropriate format from the Field Properties panel that displays when a field is defined.
Dates and times may be converted to:

- **Japanese date** – This setting converts dates/times into the standard Japanese format.
- **Japanese Era date** – This setting converts dates/times into the standard Japanese format but also inserts the current era prior to the actual date.

**Setting the Ignore Character Width Option**

Asian reports sometimes use “fullwidth” or “wide” Latin characters. Monarch allows users to ignore the distinction between standard (or “narrow”) and wide Latin characters while searching a report, table, or summary. This option is enabled via the Ignore Character Width setting.

When users opt to ignore character widths, the string “test” would return search hits for both “test” and “t e s t.”

Likewise, the string “t e s t” would return search hits for both “t e s t” and “test.”

Note that in the above example, “t e s t” is using the wide characters for t, e, and s. This distinction is made to clarify that the text is not simply a string with spaces between characters.
To set this option, assuming you have an open report in Report View, select the **Search** button in the Report ribbon and then tick the checkbox for **Ignore Character Width** that appears on the Search panel that displays.

![Figure 23-4. Setting the Ignore Character Width option.](image)

Monarch Utility enables users of Monarch to quickly and easily perform tasks that might otherwise be very time consuming. With Monarch Utility, you can:

- Copy models and projects to new locations
- Convert text/XML models or projects into binary ones
- Manage external references in XML models or projects
- Manage authors and descriptions in XML models or projects
- Purge audit trails in XML models or projects
- Prepare files for use with Monarch
- Upload binary models to Altair Knowledge Hub

The following sections describe how to use Monarch Utility to perform each of the functions listed above.

Copying Models or Projects

Monarch Utility allows users to quickly and seamlessly copy models or projects from one folder or another, provided that the destination folder has proper write permissions.

Steps:

1. Launch the Monarch Utility by selecting Start > All Programs > Altair Monarch 15> Monarch Utility.
2. Select the button **Copy models or projects from one location to another** from the Monarch Utility wizard that displays. Click **Next**.
Figure 24-1. Monarch Utility allows users to copy models and projects from a source folder to a destination folder.

3. In the next screen that displays, enter the path to the source folder containing the files you want moved to a destination folder in the **Source Folder** screen. You can use the **Browse** button located beside this field to search for the appropriate folder.

4. Check the box for **Include subfolders** if you wish to copy all subfolders as well.

5. Enter the path to the destination folder to which you want files copied in the **Destination Folder** screen. You can use the **Browse** button located beside this field to search for the appropriate folder.
6. Click **Next** when you are finished.
The next screen reiterates your instructions for the copy operation. Select **Finish** to proceed with copying if the indicated operation is correct. If you wish to make changes to the operation, select **Back**.

A process log showing the status of the copy operation displays.

**Converting Text/XML Models or Projects to the Binary Format**

Previous Monarch builds saved models in the text and XML formats (e.g., .mod, .prj, .xmod, .xprj). Monarch introduces a change from the old XML formats for models and projects, and replaces these with binary DMOD and DPRJ formats. Monarch cannot save back down to the old XMOD and XPRJ formats but it can read them.

Monarch Utility provides a means of converting previous model and project formats into the .dmod and .dprj formats without requiring that each model and project be opened in Monarch for faster data processing.

Steps:

1. Launch the Monarch Utility wizard and ensure that the button for **Convert text/XML models or projects to Binary** is selected. Press **Next** when you are finished.

Figure 24-4. Monarch Utility allows users to convert text/XML models or projects to binary form.
2. In the next screen that displays, enter the path to the source folder containing the model and project files you want converted in the **Source Folder** screen. You can use the **Browse** button located beside this field to search for the appropriate folder.

3. Check the box for **Include subfolders** if you wish to convert the contents of all subfolders as well.

4. Enter the path to the destination folder to which you want converted files to be placed in the **Destination Folder** screen. You can use the **Browse** button located beside this field to search for the appropriate folder.

![Monarch Utility](image)

**Figure 24-5.** Specifying destination folder for converted models.

5. Select **Next** when you are finished.
The next screen reiterates your instructions for the conversion operation. Select Finish to proceed with conversion if the indicated operation is correct. If you wish to make changes to the operation, select Back.

A process log showing the status of the conversion operation displays.

Managing External References in Binary Models or Projects

Monarch Utility enables you to manage external references in XML models or projects. For example, if a particular model contains a reference to an Access database, and the location of that database has changed, you can use Monarch Utility to update the reference to it in the model.

Steps:

1. Launch the Monarch Utility wizard and ensure that the button for Manage external references in binary models or projects is selected. Press Next when you are finished.
Figure 24-7. Monarch Utility allows users to manage external references to models or projects.

The Specify Source Files screen displays.

Figure 24-8. The Specify Source Files screen.
6. Under the Source heading, enter the path to the location of the XML models or projects you want to manage the external references of in the Folder field or click the adjacent Browse icon and use the Browse for Folder dialog to locate it.

7. Select the Include Subfolders check box to include all XML models or projects contained within any subfolders of the specified folder location.

8. In the Filename field, enter the name of the model or project you want to manage external references in or enter a wildcard to include multiple models. Select Next when you are finished.

The Examine and Modify External References screen displays.

9. Under the Show References To heading, select the check boxes for the items you want to modify the external references in (e.g., models, reports, etc.). The contents of the grid change to reflect the check boxes you have chosen.

10. Make changes if necessary to the current references via the New References cells in the grid.

11. Click the Next button to display the Task Summary screen.
12. Check the task summarized on the Task Summary screen and, if it is correct, click the Finish button.

Managing Authors and Descriptions in Binary Models or Projects

Monarch saves relevant information each time a Model or Project file is created.

This information includes the author of the model as well as its description, all defined templates, fields, filters, sorts, and summaries, and general input settings, among others.

In most cases, model/project information cannot be edited by design. However, Monarch Utility provides an easy way to change such information.
Steps:

1. Launch the Monarch Utility wizard and ensure that the button for **Manage authors and descriptions in binary models or projects** is selected. Press **Next** when you are finished.

Figure 24-11. Viewing model information in Altair Monarch.

Figure 24-12. Managing authors and model/project descriptions in Monarch Utility.
13. In the next screen that displays, enter the path to the source folder containing the model and project files you want to edit in the **Source Folder** screen. You can use the **Browse** button located beside this field to search for the appropriate folder.

14. Check the box for **Include subfolders** if you wish to modify the authors and description of models and projects in all subfolders as well.

![Figure 24-13. Specifying a source folder for revised models or projects.](image)

15. Select **Next** when you are finished.

The next screen displays all of the models and projects for which you can edit authors and descriptions.
16. To find keyword(s) in any of the fields in this list, select the **Find** button, enter the keyword you wish to search for in the **Find what** field of the dialog that displays and then select **Find Next**. Continue selecting **Find Next** to see all instances in which your keyword(s) appears.

17. To replace an author name, select the **Replace** button. Enter the author name to be replaced in the **Find what** field of the dialog that displays and then enter the name of the name to be used as a replacement in the **Replace with** field. Select **Replace** to replace only the next instance of the name indicated in the **Find what** field or **Replace all** to replace all instances of this name.
18. Selecting the **Replace all** button yields the screen below.

![The Replace dialog.](image)

**Figure 24-16. The Replace dialog.**

19. Press **Finish** to execute the replace all operation.

To replace model/project descriptions, highlight the description of the model/project you wish to replace in the model/project list, type in your desired description and then select **Next**. You will need to select Finish in the next screen that appears to perform the replacement operation.
Purging Audit Trails in Binary Models or Projects

Monarch keeps an audit trail of events for Model and Project files.

The audit trail records the Author and the time, as well as changes to any model/project object, including templates, fields, filters, sorts, summaries etc. The audit trail also shows you changes made in the current Monarch session, which will be saved when you save the Model or Project.

Without Monarch Utility, Monarch’s audit trail cannot be disabled or edited.

Steps:

1. Launch the Monarch Utility wizard and ensure that the button for Purge audit trail in binary models or projects is selected. Press Next when you are finished.

20. In the next screen that displays, enter the path to the source folder containing the model and project files you want to edit in the Source Folder screen. You can use the Browse button located beside this field to search for the appropriate folder.

21. Check the box for Include subfolders if you wish to modify the authors and description of models and projects in all subfolders as well.
22. Indicate a date to which the audit trail must be purged in the *Purge All Entries Before Specified Date* field. IMPORTANT: The audit trail will be purged up to the date you indicate. All activities from this date and later will not be purged.

23. Select **Next** when you are finished.

![Monarch Utility](image.png)

**Figure 24-19.** Specifying a date from which to start the purge operation.

24. The next screen reiterates your instructions for the purge operation. Select **Finish** to proceed with purging if the indicated operation is correct. If you wish to make changes to the operation, select **Back**.
Preparing Files for Monarch

Monarch Utility enables you to prepare files for use with Monarch. The following file preparation methods are available:

- Replace a string with another string or an empty one
- Insert line breaks into continuous stream files
- Insert line breaks into files with a long line length (e.g., more than 4000 characters)
- Format EDI files to enable their easier processing via Monarch

Steps:

1. Launch the Monarch Utility wizard and ensure that the button for Prepare files for Monarch (Replace, Insert line breaks, EDI) is selected. Press Next when you are finished.
The **Specify Source and Destination Files** screen displays.

**Figure 24-21. Preparing files for Monarch via Monarch Utility.**

**Figure 24-22. Specifying source and destination folders for prepared files.**
25. In the Source Folder field, enter the path to the folder that contains the file(s) you want to prepare or click the Browse icon and use the Browse for Folder dialog to locate and select it.

26. If you want to move the prepared files to a different location, enter the path to the destination folder in the Destination Folder field (or click the Browse icon and use the Browse for Folder dialog to select it).

27. Click the Next button to display the File Preparation Settings screen.

![Figure 24-23. The File Preparation Settings screen.](image)

28. Specify the desired file preparation options. Click Next when you are done.
29. Review the task summary information and then click the **Finish** button to have Monarch Utility perform the task.

Monarch Utility performs the specified task and then displays the process log.

In the following figures, we used Monarch Utility to change the string “Betty Yoder” to “Betty Red.”

Figure 24-25. Report before Monarch Utility preparation. Note that the contact name is still “Betty Yoder.”
Uploading Binary Models to Altair Knowledge Hub

Monarch Utility provides a means of uploading binary models to Altair Knowledge Hub.

Steps:

1. Launch the Monarch Utility by selecting Start > All Programs > Altair Monarch 15 > Monarch Utility and ensure that the button for Upload binary models to Altair Knowledge Hub is selected in the wizard that displays. Press Next when you are finished.
2. In the next screen that displays, enter the path to the source folder containing the model and project files you want uploaded in the Source Folder screen. You can use the **Browse** button located beside this field to search for the appropriate folder.

3. Check the box for **Include subfolders** if you wish to upload the contents of all subfolders as well.

4. Enter your Altair Knowledge Hub credentials, including server URL, username, and password, into the fields provided. You can test the connection by clicking the **Test** button.

Figure 24-27. Initiating upload of binary models to Altair Knowledge Hub via the Monarch Utility.
5. If you wish to specify a Altair Knowledge Hub folder in which to upload the models, enter the folder name into the field provided. You can also use the **Browse** button to search for this folder in the Altair Knowledge Hub server.

6. The next screen reiterates your instructions for the conversion operation. Select **Finish** to proceed with upload if the indicated operation is correct. If you wish to make changes to the operation, select **Back**.

A process log showing the status of the conversion operation displays.
Conclusion

Congratulations! You have just completed the lessons in the Monarch Learning Guide. We hope you have found them to be a helpful introduction to Monarch’s capabilities.

For additional information not covered in the Learning Guide, we suggest you thoroughly explore Monarch’s help system. To do so, select File, click on the drop-down button of the Help menu, and then select Help Topics from the main menu. You may also click the Help button on any dialog within Monarch to access context-sensitive help.

Updated documentation is available in http://docs.datawatch.com.

Technical assistance is available to registered Monarch owners. Refer to the Appendix C - Contacting Technical Support section of the Monarch Help file for more information.